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Maximum memory, 1
Memory, 1

Memory Capacity, 1
Memory card, 1, 2
Memory connector, 1
Memory cover, 1
Memory speed, 1
Menu item, 1

Menu Settings, 1
MIB compatibility, 1
mm/inch, 1, 2, 3
Modem Speed, 1, 2, 3
Monarch, 1

Multiple Up, 1

Multiple-Up, 1, 2, 3

N

NCR, 1
Network, 1

Network Firmware Version, 1
New Password, 1

No carbon required, 1

No. of Sheets, 1

Non-Copy Job Tone, 1, 2
Non-Dell Toner, 1, 2, 3
Number of Copies, 1

Number pad, 1

O

OCR, 1
OnHook, 1

Online Help, 1, 2

Operation, 1

Operator panel, 1, 2

Button, 1

Optical character recognition, 1
Option problem, 1

Order Supplies at, 1, 2

Ordering printer supplies, 1
Ordering supplies, 1
Orientation, 1,2, 3

Original Type, 1,2, 3

0S, 1

0OS compatibility, 1
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Other Features, 1
Other problems, 1

Out of Paper Tone, 1, 2
Output Result, 1
Output Tray, 1

Owner, 1, 2

Owner's Manual, 1

P

Page display format, 1
Page orientation, 1, 2
Panel, 1

Panel Alert Tone, 1, 2

Panel Language, 1, 2, 3
Panel lock, 1

Panel Lock Set, 1, 2
Panel Select Tone, 1, 2

Panel Settings, 1, 2
Panel settings page, 1, 2
Paper, 1,2
Characteristics, 1

Curl, 1

Fiber content, 1

Grain direction, 1
Moisture content, 1
Smoothness, 1

Weight, 1

Paper Density, 1,2, 3
Paper jam location, 1
Paper Size, 1,2, 3

Paper Type, 1
Paper Used, 1
Parts name, 1
Password, 1

Pause button, 1
PCL, 1

Font, 1
PCL5/PCL6, 1

PCL Fonts List, 1, 2
PCL Macro List, 1, 2
PCL Settings, 1, 2
PDL, 1

Permit printing without specifying user, 1
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Phone Book, 1,2, 3

Phone connector, 1, 2, 3, 4
Phone Number, 1

phone numbers, 1

Plain, 1,2, 3,4

Plain Thick, 1, 2, 3, 4

Polling Receive, 1

Port Settings, 1

Port Status, 1

Port9100, 1, 2, 3, 4

Portrait, 1

Power connecter, 1

Power Saver Time, 1

Power Saver Timer Mode 1, 1, 2
Power Saver Timer Mode 2, 1, 2
Power supply, 1
Power switch, 1

Prefix Dial, 1, 2, 3

Prefix Dial Num, 1

Prefix Dial Number, 1, 2
Premier, 1

Print and hold function, 1
Print cartridge level, 1
PrintID, 1,2, 3

Print Language, 1

Print media, 1, 2
Dimensions, 1
Source, 1, 2
Print Meter, 1, 2

Print quality guarantee, 1
Print Server Reports, 1

Print Server Settings, 1, 2, 3, 4
Print Server Setup Page, 1
Print side, 1, 2

Print Text, 1,2, 3

Print User Limitation, 1

Print User Settings, 1

Print Volume, 1,2, 3

Printer Bitmap, 1

Printer drivers Installing, 1
Printer Events, 1

Printer Information, 1, 2, 3

Printer Jobs, 1, 2, 3
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Printer Maintenance, 1
Printer Page Count, 1
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Printer settings page, 1
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Printer specification, 1

Printer Status, 1, 2
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Printer Type, 1

Printing, 1

Printing held job, 1
Printing on letterhead, 1
Printing problem, 1
Printing Speed, 1

Printing Status Window, 1
Processor Speed, 1
Product Information Guide, 1
Proof Print, 1, 2

Protocol Monitor, 1, 2
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Quantity, 1,2, 3
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RAM Disk, 1, 2, 3
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Regular, 1
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Remote Receive Tone, 1, 2
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Removing toner cartridge, 1
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RESET button, 1

Reset Defaults, 1

Reset Print Server, 1
Resetting Defaults, 1, 2
Resident font, 1

Resident scalable fonts, 1
Restore Settings, 1
Return policy, 1

Right frame, 1

Ring Tone Volume, 1, 2, 3

S

Safety information, 1
Scalable font, 1

Scan Defaults, 1, 2, 3
Scan Service Lock Set, 1, 2
Scan to Application, 1
Scan to E-mail, 1

Scan To Network, 1
Scan to Network, 1, 2, 3
Search PhoneBook, 1
Secure Print, 1

Del after Print, 1, 2
Delete, 1, 2

Print and Save, 1, 2

Secure print, 1
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Secure Settings, 1, 2, 3, 4
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Server Address, 1, 2, 3, 4
Service code, 1

Service tag, 1

Set Date, 1

Set Password, 1, 2, 3

Set Time, 1

Setting, 1

Shared printing
Peer-to-peer, 1

Point and print, 1

Side button, 1

Side cover, 1

Single Sheet Feeder, 1
Capacity, 1

Single Sheet Feeder (SSF), 1
slow scan, 1

SNMP, 1

SNMP Agent, 1,2, 3

SNMP Configuration, 1
SNMP UDP, 1

Software update, 1

Speed Dial, 1, 2, 3

SSF Paper Size, 1, 2,3, 4
SSF Paper Type, 1,2, 3,4
Status Monitor Console, 1
Status of printer supplies, 1
Storage, 1

Storage humidity range, 1
Store Print, 1

Stored Documents, 1, 2
Stored Print, 1

Storing consumables, 1
Storing print media, 1, 2, 3
Straightest lines, 1
Subnet Mask, 1
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contacting Dell, 1
Supported print paper, 1
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Symbol sets, 1

For PCL 5/PCL 6, 1
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System Settings page, 1

T
TCP/IP, 1

TCP/IP Settings, 1, 2
Telephone, 1
telephone numbers, 1
Telephone/Fax, 1
Temperature, 1

TIFF File Format, 1, 2
Time Format, 1

Time Zone, 1

Time-Out, 1, 2, 3
Tone/Pulse, 1, 2,3
Toner cartridge, 1

Toner Refresh, 1

Top frame, 1

Trap Notification (IP), 1
Tray 1,1,2

Tray 1 Custom Size - X, 1
Tray 1 Custom Size -Y, 1
Tray 1 Paper Size, 1
Tray 1 Paper Type, 1
Troubleshooting, 1

Turnon, 1

Typeface, 1

U

Unacceptable paper, 1

UNITED STATES GOVERNMENT RESTRICTED RIGHTS, 1
Upper Limit for Color Print, 1

Upper Limit for Monochrome Print, 1

USB, 1

USB port, 1,2, 3

USB Printing, 1

User Setup Disk Creating Tool, 1

Using Dell Printer Configuration Web Tool, 1

uto Receive Fax/Tel, 1

\Y

Verifying IP settings, 1
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Operator Panel

@ Using the Operator Panel Buttons

@ Pprinting a Panel Settings Page

Using the Operator Panel Buttons

The operator panel has a 4-line by 20-character liquid crystal display (LCD), control buttons, and number pad, which allow you to control your printer.

1 23 4536

1. LCD Panel

2. O (Back) button

1 Returns to the previous screen.

3. €2 buttons

1 In the Menu mode, selects submenus or values.

4. B (Menu) button

1 Enters the operation menu from the top menu, and returns to the top menu from any menu level.

5. AW buttons
1 In the Menu mode, scrolls through menus or items.

1 To enter numbers or passwords, press these buttons.

6. D (Start) button

1 Starts copying, scanning, or faxing.

7. Number pad

1 Enters the characters and numbers, for example, for the Phone Book, and passwords.

8. ¥ (Redial/Pause) button
1 Enters a pause.

1 Redial the last telephone number you called.

9. X (Cancel) button
1 In the Menu mode, returns to the standby mode without saving any settings.

1 Cancels the current working job (copy/scan/fax/print) by choosing the available listed job.

10. ( (Check) button

1 Selects the currently displayed menu or item, or confirms the entry of values.

Printing a Panel Settings Page

The panel settings page shows current settings for the operator panel menus.
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From the Printer Operator Panel

1. Press " until >SETUP appears, and then press v .
2. Press W until >Reports appears, and then press v

3. Press 2 until Panel Setti ngs appears, and then press v .

The panel settings page is printed.

From Your Computer

1. Click start— All Programs— Dell Printers— Additional Color Laser Software— Quick Launch Utility.

The Quick Launch Utility dialog box opens.

2. Click the Tool Box button.

The Tool Box dialog box opens.

3. Select the printer from Printer Name.

The Tool Box opens.

4. Click the Printer Settings Report tab.

5. Select Reports from the list at the left side of the page.

The Reports page is displayed.

6. Click the Panel Settings button.

The panel settings page is printed.

Back to Contents Page
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Understanding the Tool Box Menus

@ Pprinter Settings Report

@ Pprinter Maintenance

@ Diagnosis

The Tool Box allows you to view or specify the system settings. You can also diagnose the system settings by using the Tool Box.

The Tool Box consists of the Printer Settings Report, Printer Maintenance, and Diagnosis tabs.

ﬂ NOTE: A Password dialog box appears the first time you try to change settings on ToolBox when Panel Lock is set on the printer. In this case, input
the password that you have already specified, and click OK to apply the settings.

Printer Settings Report

The Printer Settings Report tab includes the Printer Information, Menu Settings, Reports, TCP/IP Settings, Tray Settings, Defaults Settings, and Fax

Settings pages.

ﬂ NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Printer Information

Purpose:

To display the printer's system information.

Values:

Dell Service Tag Number

Displays the service tag number of your printer.

Printer Serial Number

Displays the serial number of your printer.

Printer Type

Displays the type of printing for the printer. Color Laser is displayed normally.

Asset Tag Number

Displays the asset tag number of your printer.

Memory Capacity

Displays the memory capacity.

Processor Speed

Displays the processing speed.

Firmware Version

Displays the version of the controller.

Network Firmware Version

Displays the NIC version.

MCU Firmware Version

Displays the version of the Machine Control Unit (MCU) firmware.

Printing Speed (Color)

Displays the speed for color printing.

Printing Speed (Monochrome)

Displays the speed for monochrome printing.

Menu Settings

Purpose:

To display the printer's menu settings.

Values:

System Settings

Power Saver Timer
Mode 1

Displays the amount of time before the printer enters the power saver timer mode 1 after it finishes a
job.

Power Saver Timer
Mode 2

Displays the amount of time before the printer enters the power saver timer mode 2 after it finishes a
job.

Auto Reset

Displays the amount of time before the printer automatically resets the settings on the operator panel to
the defaults when no additional settings are made.

Panel Select Tone

Displays the volume of the tone that is emitted when the operator panel input is correct. Off indicates
that the tone is disabled.

Panel Alert Tone

Displays the volume of the tone that is emitted when the operator panel input is incorrect. Off indicates
that the tone is disabled.

Machine Ready Tone

Displays the volume of the tone that is emitted when the printer becomes ready. Off indicates that the
tone is disabled.

Copy Job Tone

Displays the volume of the tone that is emitted when a copy job is complete. Off indicates that the tone
is disabled.

Non-Copy Job Tone

Displays the volume of the tone that is emitted when a job other than copying is complete. Off indicates
that the tone is disabled.

Fault Tone

Displays the volume of the tone that is emitted when a job ends abnormally. Off indicates that the tone
is disabled.
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System Settings

Alert Tone

Displays the volume of the tone that is emitted when a problem occurs. Off indicates that the tone is
disabled.

Out of Paper Tone

Displays the volume of the tone that is emitted when the printer runs out of paper. Off indicates that the
tone is disabled.

Low Toner Tone

Displays the volume of the tone that is emitted when the toner or some other consumable is low. Off
indicates that the tone is disabled.

Auto Clear Alert Tone

Displays the volume of the tone that is emitted 5 seconds before the printer performs auto clear. Off
indicates that the tone is disabled.

Base Tone

Displays the volume of the tone that is emitted when the operator panel is returned to the default
setting by scrolling the loop menu. Off indicates that the tone is disabled.

Time-Out

Displays the amount of time the printer waits for data to arrive from the computer.

Panel Language

Displays the language to be used on the operator panel.

Auto Log Print

Displays whether or not to automatically print a job history report after every 20 jobs.

Print ID

Displays where to print a user ID on the output paper.

System Settings

Print Text

Displays whether the printer outputs PDL (Page Description Language) data (which is not supported by
the printer) as text when the printer receives it.

RAM Disk *1

Displays whether to allocate RAM for the disk file system for the Secure Print and Proof Print features.

Substitute Tray

Displays an indication to use paper of a different size when the paper that is loaded in the specified tray
does not match the paper size settings for the current job.

mm/inch

Displays the measurement unit used on the operator panel.

Date Format

Displays the selected date format.The default is yy/mm/dd.

Time Format

Displays the selected time format; 24H or 12H.

Clock Settings Time Zone Displays the selected time zone.

Set Date Displays the date setting.

Set Time Displays the time setting.

Plain Displays the plain paper density settings.
Paper Density

Label Displays the label paper density settings.

Auto Registration
Adjustment

Auto Registration
Adjustment

Displays whether to automatically adjust color registration.

Adjust Altitude

Adjust Altitude

Displays the altitude of the location where the printer is installed.

Non-Dell Toner

Non-Dell Toner

Displays whether or not to use another manufacturer's toner cartridge.

Web Link
Customization

Select Regular*

Displays the URL for ordering consumables (accessories.us.dell.com/sna).

Reorder URL | premier

Displays the URL for ordering consumables (premier.dell.com).

*1 This item is only available when the 256 MB optional memory card is installed.

Reports

Purpose:

To print the printer's settings and history information.

The reports are printed in the paper size specified in system settings. The default is A4.

Values:

System Settings

Click to print a detailed list of the system settings.

Panel Settings

Click to print a detailed list of the panel settings.

PCL Fonts List

Click to print a list of the PCL (Hewlett-Packard Printer Control Language) Fonts.

PCL Macro List

Click to print a list of the PCL Macro.

Job History

Click to print the printer's Completed Jobs history.

Error History

Click to print the printer's error history.

Color Test Page

Click to print a color test page.

Stored Documents *1

Click to print a list of the Stored Documents.

Protocol Monitor

Click to print the Protocol Monitor report.

*1 This item is only available when you enable RAM Disk.

TCP/IP Settings

Purpose:

To display the current settings of TCP/IP (Transmission Control Protocol/Internet Protocol) protocol.

Values:
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IP Address Mode | Displays the method for acquiring the IP address.

IP Address Displays the printer's IP address.

Subnet Mask Displays the subnet mask.

Gateway Address | Displays the gateway address.

Tray Settings
Purpose:

To display the paper type and size for the tray 1.

Values:
Paper Type Displays the paper type setting of the tray 1
Paper Size Displays the paper size setting of the tray 1.

Custom Size - Y | Displays the length of custom size paper loaded in the tray 1.

Custom Size - X | Displays the width of custom size paper loaded in the tray 1.

Display Popup Displays whether to use a popup menu that prompts the user to set the paper size and type when the paper is loaded in tray 1.

Defaults Settings
Purpose:

To display the default scan, fax, and copy settings of the printer.

Values:

Scan To Network Displays whether to save scanned documents on a network server or on a computer.
File Format Displays the file format in which scanned documents are to be saved.
Color Displays whether to scan in color or in black and white.
Resolution Displays the default scan resolution.
Document Size Displays the paper size of the original document.
Lighter/Darker Displays the default scan density level.
Sharpness Displays the default sharpness level.
Contrast Displays the default contrast level.

Scan Defaults
Auto Exposure Displays whether to suppress the background of the original to enhance text on the copy.
Auto Expo. Level Displays the background suppression level.
Margin Top/Bottom Displays the value of the top and bottom margins.
Margin Left/Right Displays the value of the left and right margins.
Margin Middle Displays the value of the middle margin.
TIFF File Format Displays the TIFF file format; TIFF V6 or TTN2.
Image Compression Displays the image compression level.
Max E-Mail Size Displays the maximum size of e-mail that can be sent.
Resolution Displays the resolution level to be used for fax transmission.

Fax Defaults | Lighter/Darker Displays the density level to be used for fax transmission.
Delayed Start Displays the fax transmission start time.
Color Displays whether to make copies in color or in black and white.
Select Tray Displays the tray from which the paper is fed.
SSF Paper Size Displays the paper size setting of the single sheet feeder.
SSF Paper Type Displays the paper type settings of the single sheet feeder.
Reduce/Enlarge Displays the default copy reduction/enlargement ratio.
Original Type Displays the type of the original document.

Copy Defaults
Document Size Displays the default paper size.
Lighter/Darker Displays the default copy density level.
Sharpness Displays the default sharpness level.
Color Saturation Displays the default color saturation level.
Auto Exposure Displays whether to suppress the background of the original to enhance text on the copy.
Auto Expo. Level Displays the background suppression level.
Color Balance (Yellow Low) Displays the color balance level of low density yellow.
Color Balance (Yellow Mid) Displays the color balance level of medium density yellow.
Color Balance (Yellow High) Displays the color balance level of high density yellow.




Color Balance (Magenta Low) | Displays the color balance level of low density magenta.

Color Balance (Magenta Mid) | Displays the color balance level of medium density magenta.

Color Balance (Magenta High) | Displays the color balance level of high density magenta.

Copy Defaults

Color Balance (Cyan Low) Displays the color balance level of low density cyan.
Color Balance (Cyan Mid) Displays the color balance level of medium density cyan.
Color Balance (Cyan High) Displays the color balance level of high density cyan.
Color Balance (Black Low) Displays the color balance level of low density black.
Color Balance (Black Mid) Displays the color balance level of medium density black.

Color Balance (Black High) Displays the color balance level of high density black.

Multiple-Up Displays whether the Multiple-Up feature is enabled.
Collated Displays whether to collate the copy.

Copy Defaults | Margin Top/Bottom Displays the value of the top and bottom margins.
Margin Left/Right Displays the value of the left and right margins.
Margin Middle Displays the value of the middle margin.

Fax Settings
Purpose:

To display the fax settings of the printer.

Values:

Receive Mode Displays the fax receiving mode.

Auto Rec Fax Displays the interval at which the printer goes into the fax receive mode after receiving an incoming call.

Auto Rec . . : . . . . . .

Fax/Tel Displays the interval at which the printer goes into the fax receive mode after the external telephone receives an incoming call.

Auto Rec . . . . . " . . . .

Ans/Fax Displays the interval at which the printer goes into the fax mode after the external answering machine receives an incoming call.

Line Monitor Displays the volume of the line monitor, which audibly monitors a transmission through the internal speaker until a connection is made.
Ring Tone Displays the volume of the ring tone, which indicates that an incoming call is a telephone call through the internal speaker when Receive
Volume Mode is set to Telephone/Fax.

Line Type Displays the line type; PSTN or PBX.

Tone/Pulse Displays whether to use tone or pulse dialing.

Resend Delay Displays the interval between transmission attempts.

Redial Attempts | Displays the number of redial attempts.

Redial Delay Displays the redial interval.

Junk Fax Setup | Displays whether to reject faxes sent from unwanted stations.

Remote Receive | Displays whether to receive faxes by pressing a remote receive code on the external telephone.

Remote Rcv

Displays the tone to start Remote Receive.
Tone

Fax Header Displays whether to print the sender’s information on the header of faxes.

Fax Header

Name Displays the sender’'s name that will be printed on the header of faxes.

Fax Number Displays the fax number of the printer, which will be printed on the header of faxes.

Fax Cover Page | Displays whether to attach a cover page to faxes.

DRPD Pattern Displays the Distinctive Ring Pattern Detection (DRPD) setting.

Sent Fax Fwd Displays whether to forward incoming faxes to a specified destination.

Fax Fwd : R [ .

Number Displays the fax number of the destination to which incoming faxes are to be forwarded.
Fax Fwd Print Displays whether or not to print incoming faxes that were successfully forwarded.

Fax Fwd Err

Print Displays whether or not to print incoming faxes that failed to be forwarded.

Prefix Dial Displays whether to set a prefix dial number.

Displays a prefix dial number. This number dials before any auto dial number is started. It is useful for accessing the Private Automatic

Prefix Dial Num Branch Exchange (PABX).

Discard Size Displays whether to delete text or images at the bottom of a fax page when the entire page does not fit onto the output paper.
ECM Displays whether the Error Correction Mode (ECM) is enabled.

Modem Speed Displays the fax modem speed when a fax transmission or reception error occurs.

Fax Activity Displays whether to automatically print a fax activity report after every 50 incoming and outgoing fax communications.

Fax Transmit Displays whether to print a transmission report after every fax transmission or only when an error occurs.

Fax Broadcast Displays whether to print a transmission report after every fax transmission to multiple destinations or only when an error occurs.

Fax Protocol Displays whether to automatically print a protocol monitor report after every fax transmission or only when an error occurs.




Country I Displays the country where the printer is used.

Printer Maintenance

The Printer Maintenance tab includes the System Settings, Clock Settings, Paper Density, Registration Adjustment, Adjust Altitude, Reset Defaults, Non-
Dell Toner, Initialize PrintMeter, Web Link Customization, TCP/IP Settings, Tray Settings, EWS, Scan Defaults, Fax Defaults, Copy Defaults, and Fax

Settings pages.

ﬂ NOTE: Values marked by an asterisk (*) are the factory default menu settings.

System Settings

Purpose:

To configure the printer's power management, auto clear time, alarm tones, time-out time, mm/inch setting, job log auto print, position of the Print ID, setting
of the dump print, setting of the additional memory, setting of the substitute sheet, and operator panel language settings.

Values:

Power Saver Timer | 5-60 minutes

Mode 1*1 i
Power Saver S minutes™

Specifies the time before the printer enters the power saver timer mode 1(sleep
mode) after it finishes a job.

Timer Mode ;
Power Saver Timer | 1-6 minutes

Specifies the time before the printer enters the power saver timer mode 2 (deep

Mode 2*1 6 minutes* sleep mode) after it finishes a job.
45 seconds™
1 minute
. Specifies the time before the printer automatically resets the settings on the
Auto Reset 2 minutes L .
operator panel to the defaults when no additional settings are made.
3 minutes
4 minutes
Low
Panel Select Medium Emits a tone at the specified volume when the operator panel input is correct.
Tone High
Off* Does not emit a tone when the operator panel input is correct.
Low
Panel Alert Medium Emits a tone at the specified volume when the operator panel input is incorrect.
Tone High
Off* Does not emit a tone when the operator panel input is incorrect.
Low
Machine Ready Medium* | Emits a tone at the specified volume when the printer becomes ready.
Tone High
Off Does not emit a tone when the printer becomes ready.
Alert Tone
Low
Medium* | Emits a tone at the specified volume when copying is complete.
Copy Job Tone
High
Off Does not emit a tone when copying is complete.
Low
Medium* Emits a tone at the specified volume when any other job except copying is
Non-Copy Job complete.
Tone High
Off Does not emit a tone when any other job except copying is complete.
Low
Medium™ | Emits a tone at the specified volume when a job ends abnormally.
Fault Tone
High
Off Does not emit a tone when a job ends abnormally.
Low
Medium* | Emits a tone at the specified volume when a problem occurs.
Alert Tone
High
Off Does not emit a tone when a problem occurs.
Low
out of Paper Medium™ | Emits a tone at the specified volume when the printer runs out of paper.
Tone High
Off Does not emit a tone when the printer runs out of paper.

Low




30 seconds™

Medium®* Emits a tone at the specified volume when the toner or some other consumable is
low.
Alert Tone Low Toner Tone High
off Does not emit a tone when the toner or some other consumable is low.
Low
Medi Emits a tone at the specified volume 5 seconds before the printer performs auto
Auto Clear Alert | Medium clear.
Tone High
Off* Does not emit a tone before the printer performs auto clear.
Low
Medium Emits a tone when the operator panel display is returned to the default setting.
Base Tone High
Off* Does not emit a tone when the operator panel display is returned to the default
setting.
[0} Disables the job time-out.
Time-Out 5-300 seconds

Specifies the amount of time the printer waits for additional data from the computer
before it cancels the job.

Substitute Tray

English*
French
Italian
German
Panel Language Spanish Specifies the language to be used on the operator panel.
Dutch
Danish
Norwegian
Swedish
Off* Does not automatically print a job history report after every 20 jobs.
Auto Log Print
on Automatically prints a job history report after every 20 jobs.
Off* Does not print the user ID.
Top Left
Print ID Top Right
Prints the user ID on the specified location.
Bottom Left
Bottom Right
Off Does not print the received PDL data as text data.
Print Text
on* Prints the received PDL data as text data.
" Does not allocate RAM for the disk file system. Secure Print and Proof Print jobs will
Disable h
abort and be recorded to the job log.
RAM Disk SOMBytes
100MBytes* Allocates RAM for the disk file system automatically.
150MBytes
Off No tray size substitute accepted.

Larger Size

Substitutes paper of next largest size. When there is no larger paper size, the
printer substitutes paper of nearest size.

Nearest Size*

Substitutes paper of nearest size.

mm/inch

millimeter (mm)

inch ("")*

Selects millimeter or inch as the default measurement unit.

Apply New Settings

After you complete the settings, press the Apply New Settings button to apply the
changes.

Restart printer to apply new settings

Press the Restart printer to apply new settings button to apply the changes.

notice lights flickering.

*1 Enter 3 in Power Saver Timer Mode 1 or Power Saver Timer Mode 2 to put the printer in the power saver timer mode five minutes after it finishes a
job. This uses much less energy, but requires more warm-up time for the printer. Enter 3 if your printer shares an electrical circuit with room lighting and you

Select a high value if your printer is in constant use. Under most circumstances, this keeps the printer ready to operate with minimum warm-up time. Select a
value between 5 and 60 minutes for the power saver timer mode if you want a balance between energy consumption and a shorter warm-up period.

The printer automatically returns to the standby mode from the power saver timer mode when it receives data from the computer. You can also return the
printer to the standby mode by pressing any button on the operator panel.

Clock Settings

Purpose:

To specify the clock settings.

Values:




Date Format Sets the date format. The default is yy/mm/dd.

Time Format Sets the time format in 24H or 12H.

Time Zone Sets the time zone.

Set Date Sets the date.

Set Time Sets the time.

Apply New Settings After you complete the settings, press the Apply New Settings button to apply the changes.
Restart printer to apply new settings | Press the Restart printer to apply new settings button to apply the changes.

Paper Density

Purpose:

To specify the paper density settings.

Values:
Normal*
Plain Specifies plain paper density settings.
Light
Normal*
Label Specifies label paper density settings.
Light
Apply New Settings After you complete the settings, press the Apply New Settings button to apply the changes.
Restart printer to apply new settings | Press the Restart printer to apply new settings button to apply the changes.

Registration Adjustment

Purpose:

To set Color Registration Adjustment (individual yellow, magenta, cyan correction) settings. When Auto Registration Adjustment is set to On, the printer
prints the color registration chart and to adjust the color registration by using the chart. This function is required after the printer is set up or moved.

Values:
Off Does not perform color registration automatically.
Auto Registration Adjustment
on* Performs color registration automatically.
Auto Correct Click Start to perform color registration automatically.
Color Regi Chart Click Start to print a color registration chart.
-9-
vellow |*9
o*
-9-
Color Registration Adjustment Magenta | *9 Specifies lateral (perpendicular to paper feed direction) color adjustment values that are found in the color
1 (Lateral) 9 registration chart individually for Yellow, Magenta, and Cyan.
o*
-9-
Cyan +9
o*
-9-
Yellow |*9
o*
-9-
Color Registration Adjustment M +9 Specifies process (paper feed direction) color adjustment values that are found in the color registration
agenta AL
2 (Process) chart individually for Yellow, Magenta, and Cyan.
o*
-9-
Cyan +9
o*
Apply New Settings After you complete the settings, press the Apply New Settings button to apply the changes.
Restart printer to apply new settings Press the Restart printer to apply new settings button to apply the changes.

Adjust Altitude

Purpose:

To specify the altitude of the location where the printer is installed.



The discharge phenomenon for charging the photo conductor varies with barometric pressure. Adjustments are performed by specifying the altitude of the
location where the printer is being used.

Values:

0 meter*

1000 meters
Specifies the altitude of the location where the printer is installed.

2000 meters

3000 meters

Apply New Settings After you complete the settings, press the Apply New Settings button to apply the changes.

Restart printer to apply new settings | Press the Restart printer to apply new settings button to apply the changes.

Reset Defaults

Purpose:

To initialize the NV (nonvolatile) memory for system parameters, Address Book data for fax, Address Book data for e-mail. After executing this function to
automatically restart the printer, the menu parameters, or data are reset to their default values.

Values:

System Section | Initializes system parameters.

User (Fax) Initializes the fax number entries in the Address Book.

User (Scan) Initializes the e-mail and server address entries in the Address Book.

Non-Dell Toner
& CAUTION: When Non-Dell toner cartridge is used, the printer may be severely damaged and may not be covered by your warranty.

Purpose:

To specify whether or not to use another manufacturer's toner cartridge.

Values:

Off*> Disables the use of another manufacturer's toner cartridge.

Non-Dell Toner
Oon Enables the use of another manufacturer's toner cartridge.

Apply New Settings After you complete the settings, press the Apply New Settings button to apply the changes.

Press the Restart printer to apply new settings button to apply the changes.

Restart printer to apply new settings

Initialize PrintMeter

Purpose:

To initialize the PrintMeter. When the print meter is initialized, the meter count is reset to 0.

Values:

| Initialize PrintMeterI Click Start to initialize the PrintMeter.

Web Link Customization

Purpose:

To set links used for ordering consumables.

Values:

Select Reorder URL Sets links used for ordering consumables. You can select either Regular or Premier.

Regular* accessories.us.dell.com/sna

Premier premier.dell.com
After you complete the settings, press the Apply New Settings button to apply the changes.

Apply New Settings

Restart printer to apply new settings | Press the Restart printer to apply new settings button to apply the changes.



http://accessories.us.dell.com/sna
http://premier.dell.com/

TCP/IP Settings

Purpose:

To configure TCP/IP settings.

Values:
Automatically sets the IP address.
AutolpP* . . . .
A random value in the range of 169.254.1.0 to 169.254.254.255 that is not currently in use on the network is set as the IP
address. The subnet mask is set as 255.255.0.0.
IP Address DHCP Sets the IP address using DHCP.
Mode
BOOTP Sets the IP address using BOOTP.
RARP Sets the IP address using RARP.
Manually Manually sets the IP address.
Set
Manually sets the IP address allocated to the printer.
IP Address

It is allocated to the printer using the format nnn.nnn.nnn.nnn. Each octet that makes up nnn.nnn.nnn.nnn is a value in the
range of O to 254. 127 and any value in the range of 224 to 254 cannot be specified for the first octet of a gateway address.

Subnet Mask

Manually sets the subnet mask.

It is specified using the format nnn.nnn.nnn.nnn. Each octet that makes up nnn.nnn.nnn.nnn is a value in the range of O to
255. 255.255.255.255 cannot be specified as the subnet mask.

Gateway Address

Manually sets the gateway address.

It is specified using the format nnn.nnn.nnn.nnn. Each octet that makes up nnn.nnn.nnn.nnn is a value in the range of 0 to
254. 127 and any value in the range of 224 to 254 cannot be specified for the first octet of a gateway address.

Apply New Settings After you complete the settings, press the Apply New Settings button to apply the changes.

Restart printer to apply
new settings

Press the Restart printer to apply new settings button to apply the changes.

Tray Settings

Purpose:

To specify the paper types and sizes for tray 1 respectively.

Values:

Paper Type

Plain*

Plain Thick

Covers

Covers Thick

Label

Recycled Specifies the type of paper loaded in the tray 1.

Envelope

Plain S2

Plain Thick S2

Covers S2

Recycled S2

Paper Size

A4*

AS

B5

Letter

Folio

Legal

Executive

Specifies the size of paper loaded in the tray 1.
Monarch

Monarch LEF

DL

DL LEF

C5

Envelope #10




Custom Size

Custom Size -
Y

5.0-14.0 inch (127-355

mm)

Specifies the length of custom size paper.

11.7 inch* (297 mm)

Custom Size -
X

3.0-8.5 inch (77-215 mm)

8.3 inch* (210 mm)

Specifies the width of custom size paper.

Display Popup

on*

Displays a popup message that prompts the user to set Paper Type and Paper Size when the paper is

loaded in the tray 1.

EWS (Embedded Web Server or Dell Printer Configuration Web Tool)

Purpose:

To configure the setup of the printer using your web browser.

Values:

Print Server Settings

Click Display to display the server settings for the Dell Printer Configuration Web Tool.

Display of EWS

Off

Disable to display the server settings for the Dell Printer Configuration Web Tool.

on*

Enable to display the server settings for the Dell Printer Configuration Web Tool.

Apply New Settings

After you complete the settings, press the Apply New Settings button to apply the changes.

Restart printer to apply new settings

Press the Restart printer to apply new settings button to apply the changes.

Scan Defaults

Purpose:

To create your own default Scan settings.

Values:
Server Stores the scanned image on a server using the FTP protocol.
Scan To Network
Computer* Stores the scanned image on a computer using the Server Message Block (SMB) protocol.
PDF* Saves the scanned image in PDF.
Multi Page TIFF Saves the scanned image in Multi Page TIFF.
File Format
TIFF Saves the scanned image in TIFF.
JPEG Saves the scanned image in JPEG.
Black & White Scans in black and white mode.
GrayScale Scan in grayscale mode.
Color
Color* Scans in color mode.
Color(Photo) Scans in color mode. This is suitable for photographic images.
200* Scans an image at 200dpi.
300 Scans an image at 300dpi.
Resolution
400 Scans an image at 400dpi.
600 Scans an image at 600dpi.
A4 Sets the document size to A4.
A5 Sets the document size to A5.
B5 Sets the document size to B5.
Document size Letter* Sets the document size to Letter.
Folio Sets the document size to Folio.
Legal Sets the document size to Legal.
Executive Sets the document size to Executive.
Lighter 3
Lighter 2 Makes the scanned image lighter than the original. Works well with dark print.
Lighter 1
Lighter/Darker Normal* Works well with standard typed or printed documents.
Darker 1
Darker 2 Makes the scanned image darker than the original. Works well with light print or faint pencil markings.
Darker 3
Softer Makes the scanned image softer than the original.
Sharpness Normal* Does not make the scanned image sharper or softer than the original.




Sharper Makes the scanned image sharper than the original.
Low Adjusts the amount of colors to make the contrast of colors lighter than the original.
Contrast Medium* Does not adjust the amount of colors to make the contrast of colors darker or lighter than the original.
High Adjusts the amount of colors to make the contrast of colors darker than the original.
on* Suppresses the background of the original to enhance text on the copy.
Auto Exposure
Off Does not suppress the background.
Normal* Sets the background suppression level to Normal.
Auto Expo. Level Higher(1) Sets the background suppression level to Higher(1).
Higher(2) Sets the background suppression level to Higher(2).

Margin

0.0-2.0 inch (0-50
mm)

Top/Bottom

0.1 inch* (2 mm)

Specifies the value of the top and bottom margins.

Margin Left/Right

0.0-2.0 inch (0-50
mm)

0.1 inch* (2 mm)

Specifies the value of the left and right margins.

Margin Middle

0.0-2.0 inch (0-50
mm)

0.0 inch* (0O mm)

Specifies the value of the middle margin.

TIFF V6* Sets the TIFF file format to TIFF V6.
TIFF File Format

TTN2 Sets the TIFF file format to TTN2.

Low Sets the image compression level to Low.
Image P . . .
Compression Medium Sets the image compression level to Medium.

High Sets the image compression level to High.

50-16384 ; ; —rai i

. Sets the maximum size of e-mail that can be sent within the range of 50 K bytes to 16384 K bytes. The default

Max E-Mail Size h

2048* is 2048 K bytes.

Apply New Settings

After you complete the settings, press the Apply New Settings button to apply the changes.

Restart printer to apply new settings

Press the Restart printer to apply new settings button to apply the changes.

Fax Defaults

Purpose:

To create your own default Fax settings.

Values:
Standard* Improves the output quality of the original. For documents with normal sized characters.
Fine Improves the output quality of the original. For documents containing small characters or thin lines or documents printed
using a dot-matrix printer.
Resolution
Super Eine Improves the output quality of the original. For documents containing extremely fine detail.The super fine mode is
P enabled only if the remote machine also supports the Super Fine resolution.
Photo Improves the output quality of the original. For documents containing photographic images.
Lighter 3
Lighter 2 Makes the documents lighter than the original. Works well with dark print.
Lighter 1
Lighter/Darker Normal> Works well with standard typed or printed documents.
Darker 1
Darker 2 Makes the documents darker than the original. Works well with light print or faint pencil markings.
Darker 3
00:00-23:59
Delayed Start Sets the fax transmission start time when sending a fax at a specified time. The default is 21:00.
21:00*
Apply New Settings After you complete the settings, press the Apply New Settings button to apply the changes.
SReetst?;tspnnter to apply new Press the Restart printer to apply new settings button to apply the changes.

Copy Defaults

Purpose:

To create your own default Copy settings.

Values:




Black & White

Prints in black and white mode.

Color
Color* Prints in color mode.
Tray 1* The paper is fed from the tray 1.
Select Tray
SSF The paper is fed from the single sheet feeder.
A4 Sets the document size to A4.
A5 Sets the document size to AS5.
B5 Sets the document size to B5.
Letter™ Sets the document size to Letter.
Folio Sets the document size to Folio.
SSF Paper Size Legal Sets the document size to Legal.
Executive Sets the document size to Executive.
Monarch Sets the document size to Monarch.
DL Sets the document size to DL.
C5 Sets the document size to C5.

Envelope#10

Sets the document size to Envelope#10.

SSF Paper Type

Plain* Sets the document type to Plain.
Plain Thick Sets the document type to Plain Thick.
Covers Sets the document type to Covers.

Covers Thick

Sets the document type to Covers Thick.

Label

Sets the document type to Label.

Coated

Sets the document type to Coated.

Coated Thick

Sets the document type to Coated Thick.

Recycled Sets the document type to Recycled.
Envelope Sets the document type to Envelope.
Plain S2 Sets the document type to Plain S2.

Plain Thick S2

Sets the document type to Plain Thick S2.

Covers S2

Sets the document type to Covers S2.

Covers Thick S2

Sets the document type to Covers Thick S2.

Reduce/Enlarge

Coated S2 Sets the document type to Coated S2.

Recycled S2 Sets the document type to Recycled S2.

Custom Sets the default enlargement / reduction ratio to the custom size.
200%

A55A4 (141%)

A55B5 (122%)

Sets the default enlargement ratio when you set the default measurement unit to millimeter.

100%

Does not enlarge or reduce the size of a copied image.

B5-A5 (819%)

A4-A5 (70%)

50%

Sets the default reduction ratio when you set the default measurement unit to millimeter.

200%

Statement—Legal (154%0)

Statement—Letter (129%)

Sets the default enlargement ratio when you set the default measurement unit to inch.

100%

Does not enlarge or reduce the size of a copied image.

Legal—Letter (78%)

Ledger—Letter (64%)

Sets the default reduction ratio when you set the default measurement unit to inch.

50%
25-400%
Custom Reduce/Enlarge Reduces or enlarges the image to the custom size when you set Reduce/Enlarge to Custom.
100%*
Text Improves the image quality of documents with text.
Original Type Photo Improves the image quality of documents with photos.

Text & Photo*

Improves the image quality of documents with both text and photos /gray tones.

Document Size

Auto* Detects the document size automatically.
A4 Sets the document size to A4.

Letter Sets the document size to Letter.

B5 Sets the document size to B5.

A5 Sets the document size to A5.
Executive Sets the document size to Executive.
Folio Sets the document size to Folio.

Legal Sets the document size to Legal.

Lighter 3




Lighter 2 Makes the copy lighter than the original. Works well with dark print.
Lighter 1
Lighter/Darker Normal> Works well with standard typed or printed documents.
Darker 1
Darker 2 Makes the copy darker than the original. Works well with light print or faint pencil markings.
Darker 3
Softer Makes the copy softer than the original.
Sharpness Normal* Does not make the copy sharper or softer than the original.
Sharper Makes the copy sharper than the original.
Low Decreases the color saturation to lighten the color of the copy.
Color Saturation Medium™> The color saturation is the same as the original.
High Increases the color saturation to brighten the color of the copy.
on* Suppresses the background of the original to enhance text on the copy.
Auto Exposure
Off Does not suppress the background.
Normal Sets the background suppression level to Normal.
Auto Expo. Level Higher(1) Sets the background suppression level to Higher(1).
Higher(2) Sets the background suppression level to Higher(2).
-3-3
Color Balance (Yellow Low) Sets the color balance level of low density yellow. The default is O.
o*
-3-3
Color Balance (Yellow Mid) Sets the color balance level of medium density yellow. The default is O.
o*
-3-3
Color Balance (Yellow High) Sets the color balance level of high density yellow. The default is O.
o*
-3-3
Color Balance (Magenta Low) Sets the color balance level of low density magenta. The default is O.
o*
-3-3
Color Balance (Magenta Mid) Sets the color balance level of medium density magenta. The default is O.
o*
-3-3
Color Balance (Magenta High) Sets the color balance level of high density magenta. The default is O.
o*
-3-3
Color Balance (Cyan Low) Sets the color balance level of low density cyan. The default is O.
o*
-3-3
Color Balance (Cyan Mid) Sets the color balance level of medium density cyan. The default is O.
o*
-3-3
Color Balance (Cyan High) Sets the color balance level of high density cyan. The default is O.
o*
-3-3
Color Balance (Black Low) Sets the color balance level of low density black. The default is O.
o*
-3-3
Color Balance (Black Mid) Sets the color balance level of medium density black. The default is O.
o*
-3-3
Color Balance (Black High) Sets the color balance level of high density black. The default is O.
o*
Off* Does not perform multiple-up printing.
Auto Automatically reduces the original pages to fit onto one sheet of paper.
Multiple-Up 1D Copy Prints the original pages onto one sheet of paper in the original size.
Prints the original pages onto the one sheet of paper in the size specified in
Manual
Reduce/Enlarge.
Uncollated> Does not sort the copy job.
Collated

Collated

Sorts the copy job.

Margin Top/Bottom

0.0-2.0 inch (0-50 mm)

0.2 inch* (4 mm)

Specifies the value of the top and bottom margins.

Margin Left/Right

0.0-2.0 inch (0-50 mm)

0.2 inch* (4 mm)

Specifies the value of the left and right margins.

Margin Middle

0.0-2.0 inch (0-50 mm)

0.0 inch* (0 mm)

Specifies the value of the middle margin.

Apply New Settings

After you complete the settings, press the Apply New Settings button to apply the changes.

Restart printer to apply new settings

Press the Restart printer to apply new settings button to apply the changes.

Fax Settings




Purpose:

To specify the fax settings.

Values:

Receive Mode

Telephone

Sets the default fax receiving mode to Telephone.

Fax>

Sets the default fax receiving mode to Fax.

Telephone/Fax

Sets the default fax receiving mode to Telephone/Fax.

Ans
Machine/Fax

Sets the default fax receiving mode to Ans Machine/Fax.

Tone/Pulse

DRPD Sets the default fax receiving mode to DRPD.

0-255 Sets the interval at which the printer goes into the fax receive mode after receiving an incoming call in 0-255 seconds.
Auto Rec Fax :

o* The default is O.
Auto Rec 0-255 Sets the interval at which the printer goes into the fax receive mode after the external telephone receives an incoming
Fax/Tel 6* call in 0-255 seconds. The default is 6.
Auto Rec 0-255 Sets the interval at which the printer goes into the fax mode after the external answering machine receives an
Ans/Fax 21% incoming call in 0-255 seconds. The default is 21.

Off Turns off the volume of the line monitor, which audibly monitors a transmission through the internal speaker until a

connection is made.

Line Monitor Low

Medium™> Specifies the volume of the line monitor.

High

Off Turns the volume of the ring tone, which indicates that an incoming call is a telephone call through the internal speaker

when Receive Mode is set to Telephone/Fax.

Ring Tone Low . "
Vo,ﬂme d Specifies the volume of the ring tone.

Medium

High*

PSTN™* Sets the default line type to PSTN.
Line Type

PBX Sets the default line type to PBX.

Tone* Sets the dialing type to Tone.

Pulse(10PPS)

Sets the dialing type to Pulse(10PPS).

Pulse(20PPS)

Sets the dialing type to Pulse(20PPS).

3-255
Resend Delay Specifies the interval between transmission attempts within the range of 3 to 255 seconds. The default is 8 seconds.
g*
. 0-13 Specifies the number of redial attempts to make when the destination fax number is busy, within the range of 0 to 13.
Redial Attempts .
3* The default is 3.
1-15
Redial Delay Specifies the interval between redial attempts within the range of 1 to 15 minutes. The default is 1.
1%
on Rejects faxes sent from unwanted numbers by accepting faxes only from the fax numbers registered in the Phone Book.
Junk Fax Setup
Off* Does not reject faxes sent from unwanted numbers.
on Receives a fax by pressing a remote receive code on the external telephone after picking up the handset of the
Remote telephone.
Receive Off* Does not receive a fax by pressing a remote receive code on the external telephone after picking up the handset of the
telephone.
00-99
Remote Rev Specifies the tone to start Remote Receive. The default is 00.
Tone 00*
on* Prints the sender's information on the header of faxes.
Fax Header
Off Does not print the sender's information on the header of faxes.
I;aaxml—eieader 30byte Sets the sender's name to be printed on the header on faxes.
Fax Number 20byte Sets the fax number of the printer, which will be printed on the header of faxes.
Oon Attaches a cover page to faxes.
Fax Cover Page
Off* Does not attach a cover page to faxes.
Pattern 1-7
DRPD Pattern Provides a separate number for faxing with a distinctive ring pattern. The default is Pattern 4.
Pattern 4*

Only On Error

Forwards the incoming faxes to a specified destination only when an error occurs.

Sent Fax Fwd on Always forwards the incoming faxes to a specified destination.
Off* Does not forward any of the incoming faxes to a specified destination.
l;lax Fwd 50 byte Specifies the destination to which incoming faxes will be forwarded.
umber
on Prints all of the forwarded incoming faxes to the specified destination.
Fax Fwd Print
Off* Does not print all of the forwarded incoming faxes to the specified destination.




Fax Fwd Err on* Prints incoming faxes that failed to be forwarded when Fax Fwd Print is not selected.

Print Off Does not print incoming faxes that failed to be forwarded when Fax Fwd Print is not selected.
Oon Sets a prefix dial number.

Prefix Dial
Off* Does not set a prefix dial number.

Prefix Dial Num | Sbyte

Sets a prefix dial number of up to five digits. This number dials before any auto dial number is started.

Off*

Prints any excess at the bottom of a fax page without discarding it.

Discard Size Oon

Discards any excess at the bottom of the page.

Auto Reduction | Automatically reduces a fax page to fit it onto the appropriate sized paper.

on* Enables the ECM (Error Correction Mode). To use the ECM, the remote machines must also support the ECM.
Eem Off Disables the ECM.

2.4

4.8

Modem Speed 9.6

Allows you to adjust the fax modem speed when a fax transmission or reception error occurs. The default is 33.6.

11.4

33.6*

Auto Print* Automatically prints a fax activity report after every 50 incoming and outgoing fax communications.
Fax Activity

No Auto Print Does not print a fax activity report automatically.

Print Always Prints a transmission report after every fax transmission.
Fax Transmit Print On Error* | Prints a transmission report only when an error occurs.

Print Disable Does not print a transmission report after a fax transmission.

Print Always*> Prints a transmission report after every fax transmission.

Fax Broadcast | Print On Error Prints a transmission report only when an error occurs.

Print Disable Does not print a transmission report after a fax transmission to multiple destinations.
Print Always Prints a protocol monitor report after every fax transmission.
Fax Protocol Print On Error Prints the protocol monitor report only when an error occurs.

Print Disable* Does not print the protocol monitor report.

Country

Selects the country where the printer is used.

The default is United States.

Apply New Settings

After you complete the settings, press the Apply New Settings button to apply the changes.

settings

Restart printer to apply new

Press the Restart printer to apply new settings button to apply the changes.

Diagnosis

The Diagnosis tab includes the Chart Print, Machine Check, Paper Wrinkle Check Mode, Environment Sensor Info, Developer Stir Mode, and Refresh

Mode pages.

ﬁ NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Chart Print

Purpose:

To print various charts that can be used for the printer's diagnosis.

Values:

Pitch Configuration Chart

Outputs full halftone pages for yellow, magenta, cyan, and black. Also outputs pages to check the pitch. A total of five pages
are output. The chart is output to A4 or Letter size paper.

Ghost Configuration Chart

Outputs a chart to check for ghost printing. One page is output. The chart is output to A4 or Letter size paper.

4 Colors Configuration
Chart

Bands of yellow, magenta, cyan, and black are output with varying density. One page is output. The chart is output to A4 or
Letter size paper.

MQ Chart

Outputs charts to check for the binding in A4 or Letter.

Alignment Chart

Outputs a chart to check for proper alignment of the print image on the paper. One page is output. The chart is output to A4 or
Letter size paper.

PHD Refresh
Configuration Chart

Outputs a chart to check the light fatigue of the PHD unit. One page is output. The chart is output to A4 or Letter size paper.

Machine Check

Purpose:




To check the operation of the printer's components.

Values:
Main Motor Operation Check™ | Click Start to operate the main motor inside the printer. Confirm the motor sound.
Fuser Motor Operation Check | Click Start to operate the fuser motor. Confirm the motor sound.
Feed Roll Operation Check*1 | Click Start to operate the feed roll. Confirm the motor sound.
EﬁSCIkCLUTCH Operation Click Start to operate the REGI CLUTCH. Confirm that you can hear the clutch clicking.
Machine Dispense Motor Check
Check

(Yellow)

Dispense Motor Check
(Magenta)

Dispense Motor Check (Cyan)

Dispense Motor Check
(Black)

Click Start to operate the dispense motor for each toner cartridge. Confirm the motor sound.

Play of Sound

Plays back through your computer's speakers a recording of the normal sound for the currently selected
Machine Check item.

Start

Click this button to check the operation of the items selected with Machine Check and output the results to
Result.

*1 When performing the feed roll operation check, remove the paper tray from the printer.

Paper Wrinkle Check Mode

Purpose:

To determine whether or not paper is wrinkled in the fuser.

This function stops printing before the paper enters the fuser. After you remove the paper inside the printer, check the following:

1 If the paper is wrinkled, the wrinkle occurred in the part other than fuser.

1 If the paper is not wrinkled, the wrinkle occurred in the fuser.

Values:

Paper Size

Letter*

Legal

Envelope #10

Folio

Executive

Monarch Specifies the size of paper to be used by the Paper Wrinkle Check Mode.

A4

A5

BS

C5

DL

Paper Type

Plain*

Plain Thick

Covers

Covers Thick | Specifies the type of paper to be used by the Paper Wrinkle Check Mode.

Label

Envelope

Recycled

Rear side

Off* Does not use the Print side 2 of the paper.

Oon Uses the Print side 2 of the paper.

Color Mode

Color* Prints in color mode.

Black Prints in monochrome mode.

Start

Click this button to print in the specified paper size, type, and color mode.

Environment Sensor Info

Purpose:

To output the printer's internal environment sensor information to Result by pressing the Get Environment Sensor Info button.




Developer Stir Mode
Purpose:
To rotate the developer motor and stir the toner in the toner cartridge.

Values:

| Developer Stir Mode I Click Start to stir the toner.

Refresh Mode

Purpose:

To use up a toner cartridge or PHD unit when you need to replace it before the end of its life, or to stir the toner in a new toner cartridge.

A\ CAUTION: Using the Refresh Mode consumes extra toner.

Values:

Yellow | Click Yellow to clean the yellow cartridge.

Magenta | Click Magenta to clean the magenta cartridge.

Toner Refresh Mode

Cyan Click Cyan to clean the cyan cartridge.
Black Click Black to clean the black cartridge.
PHD Refresh Mode |PHD Click PHD to clean the PHD unit.

Back to Contents Page
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Understanding the Menus

Using the COPY Menus

Using the SCAN Menus

Using the FAX Menus

Using the JOB STATUS Menus
Using the SETUP Menus
Setting Panel Lock

When your printer is connected to a network and available to a number of users, the access to the Admi n Menu menus can be limited. This prevents other
users from using the operator panel to inadvertently change a user default that has been set by the administrator.

However, you can use your printer driver to override user defaults and select settings for individual print jobs.

Using the COPY Menus

Use the GOPY menus to configure a variety of copy features.

ﬂ NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Number of Copies
Purpose:

To select the number of copies from 1 to 99.

Color
Purpose:
To select color or black and white copying.

Values:

Color* Prints in color mode.

Black & White | Prints in black and white mode.

Select Tray
Purpose:
To specify the input tray.

Values:

Trayl*| The paper is fed from the tray 1.
S

4]

F The paper is fed from the single sheet feeder.

SSF Paper Size
Purpose:
To specify the default paper size of the single sheet feeder.

Values:

Letter*1

Folio

Legal

Executive

Monarch

DL
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C5

Envelope #10

A4

A5

BS

*1 Denotes country-specific factory default values.

4 NOTE: SSF Paper Si ze is displayed only when print media is inserted in the single sheet feeder.

SSF Paper Type
Purpose:
To specify the default paper type of the single sheet feeder.

Values:

Plain*

Plain Thick

Covers

Covers Thick

Label

Coated

Coated Thick

Recycled

Envelope

Plain s2

Plain Thick S2

Covers S2

Covers Thick S2

Coated S2

Recycled S2

4 NOTE: SSF Paper Type is displayed only when print media is inserted in the single sheet feeder.

Reduce/Enlarge
Purpose:
To reduce or enlarge the size of a copied image.

Values:

100%*
Stmt—Ltr (129%)*1/A5-5B5 (122%)*2

Stmt—>Lgl (154%)*1/A55A4 (141%)*2

200%

Custom 100%o

50%
Ldgr—>Ltr (64%)*1/A4—A5 (70%)*2

LgloLtr (78%)*1/B5—5A5 (81%)*2

*1 These options are displayed when SETUP — Adnin Menu — System Settings — mmii nch is set to i nch.

*2 These options are displayed when SETUP — Adnmi n Menu — System Settings — nni i nch is set to nm

4 NOTE: You can set the value in a percentage for Cust om

Original Type
Purpose:

To improve the image quality by selecting the type of the original document.



Values:

Text & Photo* | Used for documents with both text and photos.

Photo Used for documents with photos.

Text Used for documents with text.

Document Size
Purpose:
To specify the default document size.

Values:

Auto™

A4

Letter

B5S
AS

Executive

Folio

Legal

ﬂ NOTE: When Aut o is selected, the printer assumes that the document size is the size of the print media loaded in the tray 1 or single sheet feeder.

Lighter/Darker

Purpose:
To make the copy lighter or darker than the original.

Values:

Normal™* | Works well with standard typed or printed documents.

Darkerl

Darker2 | Works well with light print or faint pencil markings.

Darker3

Lighter3

Lighter2 | Works well with dark print.

Lighterl

Sharpness

Purpose:

To adjust the sharpness to make the copy sharper or softer than the original.

Values:

Normal™* | Does not make the copy sharper or softer than the original.

Sharper | Makes the copy sharper than the original.

Softer Makes the copy softer than the original.

Color Saturation

Purpose:

To adjust the amount of colors to make the colors darker or lighter than the original.

Values:

Medium™ | The color saturation is the same as the original.

High Increases the color saturation to brighten the color of the copy.




Low | Decreases the color saturation to lighten the color of the copy.

Auto Exposure

Purpose:

To suppress the background of the original to enhance text on the copy.

Values:

On™* | Suppresses the background to enhance text.

Off | Does not suppress the background.

Multiple-Up

Purpose:

To print two original pages to fit onto one sheet of paper.

Values:

Off* Does not perform multiple-up printing.

Auto Automatically reduces the original pages to fit onto one sheet of paper.

ID Copy | Prints the original pages onto one sheet of paper in the original size.

Manual | Prints the original pages onto the one sheet of paper in the size specified in Reduce/Enlarge.
Collated

Purpose:

To sort the copy job.

Values:

Uncollated™* | Does not sort the copy job.

Collated Sorts the copy job.

Margin Top/Bottom

Purpose:

To specify the top and bottom margins of the copy.

Values:

0.2 inch* (4 mm¥*)
0.0-2.0 inch (0-50 mm)

Specify the value in increments of 0.1 inch (1 mm).

Margin Left/Right

Purpose:

To specify the left and right margins of the copy.

Values:

0.2 inch* (4 mm¥*)

Specify the value in increments of 0.1 inch (1 mm).

0.0-2.0 inch (0-50 mm)

Margin Middle

Purpose:




To specify the middle margin of the copy.

Values:

0.0 inch* (O mm¥*)

0.0-2.0 inch (0-50 mm)

Specify the value in increments of 0.1 inch (1 mm).

Copy Defaults

Purpose:

To modify the COPY menu defaults.

Copy Defaul ts allows you to configure the following items in addition to the items under the COPY menu.

Auto Expo. Level

Purpose:

To specify the default background suppression level.

Values:
Normal* Sets the background suppression level to Nor mal .
Higher (1) | Sets the background suppression level to H gher (1).
Higher (2) | Sets the background suppression level to H gher (2).

Color Balance

Purpose:

To specify the default color balance level within the range of -3 to +3.

Values:

Yellow Low Dens.

Sets the color balance level of low density yellow.

Yellow Med. Dens.

Sets the color balance level of medium density yellow.

Yellow High Dens.

Sets the color balance level of high density yellow.

Magen. Low Dens.

Sets the color balance level of low density magenta.

Magen Med. Dens.

Sets the color balance level of medium density magenta.

Magen High Dens.

Sets the color balance level of high density magenta.

Cyan Low Dens.

Sets the color balance level of low density cyan.

Cyan Medium Dens.

Sets the color balance level of medium density cyan.

Cyan High Dens.

Sets the color balance level of high density cyan.

Black Low Dens.

Sets the color balance level of low density black.

Black Med. Dens.

Sets the color balance level of medium density black.

Black High Dens.

Sets the color balance level of high density black.

Using the SCAN Menus

Use the SCAN menus to configure a variety of scanner features.

ﬂ NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Scan to E-mail

Purpose:

To attach the scanned image to e-mail.

Values:

Enter E-Mail*

Allows you to enter an e-mail address.




Address Book Selects an e-mail address from the Address Book.

Group E-Mail Selects an e-mail address from the registered e-mail groups.

Search Address | Allows you search for an e-mail address or group address and specify it as the e-mail recipient.

Specifies the sender using either of the following:

From 1 Enter E-mail
1 Address Book

Scan to Network

Purpose:

To store the scanned image on a network server or a computer.

Values:

Server> Stores the scanned image on a server using the FTP protocol.

Search Address | Allows you search for a server address and specify it as the transfer destination.

Stores the scanned image on a computer using the Server Message Block (SMB) protocol.

Computer

Scan to Application

Purpose:
To save scanned data on a computer.

The Scan to Application feature allows you to import scanned data from the printer to a computer connected via a USB cable. The computer must have
ScanButton Manager installed to receive the data.

File Format

Purpose:

To specify the file format to save the scanned image.

Values:

PDF*

MultiPageTIFF

TIFF

JPEG

Color
Purpose:
To select color or black and white scanning.

Values:

Color*> Scans in color mode.

Color(Photo) | Scans in color mode. This is suitable for photographic images.

Black & White | Scans in black and white mode.

GrayScale Scan in grayscale mode.

Resolution
Purpose:
To specify the resolution of the scanned image.

Values:

L—]



200*

300

400

600

Document Size
Purpose:
To specify the default paper size.

Values:

Auto*

A4

Letter

B5

A5

*1 Denotes country-specific factory default values.

Lighter/Darker

Purpose:

To adjust the density to make the scanned image lighter or darker than the original.

Values:

Normal* | Works well with standard typed or printed documents.

Darkerl

Darker2 | Works well with light print or faint pencil markings.

Darker3

Lighter3

Lighter2 | Works well with dark print.

Lighterl

Sharpness

Purpose:

To adjust the sharpness to make the scanned image sharper or softer than the original.

Values:

Normal* | Does not make the scanned image sharper or softer than the original.

Sharper | Makes the scanned image sharper than the original.

Softer Makes the scanned image softer than the original.

Contrast

Purpose:

To adjust the amount of colors to make the contrast of colors darker or lighter than the original.

Values:

Medium™ | Does not adjust the amount of colors to make the contrast of colors darker or lighter than the original.

High Adjusts the amount of colors to make the contrast of colors darker than the original.

Low Adjusts the amount of colors to make the contrast of colors lighter than the original.

Auto Exposure



Purpose:

To suppress the background of the original to enhance text on the copy.

Values:

On* | Suppresses the background to enhance text.

Off | Does not suppress the background.

Margin Top/Bottom

Purpose:

To specify the top and bottom margins of the scanned image.

Values:

0.1 inch* (2 mm¥*)

Specify the value in increments of 0.1 inch (1 mm).

0.0-2.0 inch (0-50 mm)

Margin Left/Right

Purpose:

To specify the left and right margins of the scanned image.

Values:

0.1 inch* (2 mm¥*)
0.0-2.0 inch (0-50 mm)

Specify the value in increments of 0.1 inch (1 mm).

Margin Middle

Purpose:

To specify the middle margin of the scanned image.

Values:

0.0 inch* (0O mm¥*)
Specify the value in increments of 0.1 inch (1 mm).

0.0-2.0 inch (0-50 mm)

Scan Defaults

To modify the SCAN menu defaults.

Scan Defaul ts allows you to configure the following items in addition to the items under the SCAN menu.

Auto Expo. Level

Purpose:

To specify the default background suppression level.

Ei NOTE:

Values:

Normal* Sets the background suppression level to Nor mal .

Higher (1) | Sets the background suppression level to H gher (1).

Higher (2) | Sets the background suppression level to H gher (2).




TIFF File Format
Purpose:

To specify the default TIFF file format.

E4q NOTE:

Values:

TIFF V6> | Sets the default TIFF file format to TIFF V6.

TTN2 Sets the default Tiff file format to TTN2.

Image Compression
Purpose:

To specify the image compression level.

Ei NoTE:

Values:

Medium™ | Sets the image compression level to Medi um

Low Sets the image compression level to Low.

High Sets the image compression level to H gh.

Max E-Mail Size
Purpose:

To specify the maximum size of e-mail that can be sent. The default is 2048 K bytes.

Using the FAX Menus

Use the FAX menus to configure a variety of fax features.
NOTE: The FAX service cannot be used unless you set up a country code under Country. If Country not set up, a message Set Fax Country appears on
the display.

ﬂ NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Phone Number
Purpose:

To enter the fax number of the destination.

Speed Dial
Purpose:

To select a speed dial code from the Phone Book. Up to 200 speed dial codes can be registered in the Phone Book.

Phone Book
Purpose:

To select a fax number from the Phone Book.

Add PhoneBook Entry

Purpose:



To add a new speed dial number or group dial number to the Phone Book.

Group Dial
Purpose:

To select a group fax number from the Phone Book.

Search PhoneBook

Purpose:

To search the Phone Book for a fax number by name.

Resolution

Purpose:

To specify the scan resolution to improve the output quality.

Values:

Standard* | Suitable for documents with normal sized characters.

Fine Suitable for documents containing small characters or thin lines or documents printed using a dot-matrix printer.
. Suitable for documents containing extremely fine detail. The Super Fi ne mode is enabled only if the remote machine also supports the Super
Super Fine | _.
Fi ne mode. See the notes below.
Photo Suitable for documents containing photographic images.

ﬂ NOTE: Faxes scanned in the Super Fi ne mode transmit at the highest resolution supported by the receiving device.

Lighter/Darker

Purpose:

To adjust the density to make the copy lighter or darker than the original.

Values:

Normal* | Works well with standard typed or printed documents.

Darkerl

Darker2 | Works well with light print or faint pencil markings.

Darker3

Lighter3

Lighter2 | Works well with dark print.

Lighterl

OnHook
Purpose:
To send or receive faxes manually.

Values:

Off* | Does not send or receive faxes manually.

On | Sends or receives faxes manually.

Polling Receive

Purpose:

To receive faxes from the remote fax machine when you want to receive it.



Values:

Off* | Does not receive faxes using Polling Receive.

on Receives faxes using Polling Receive.

Delayed Start
Purpose:
To send a fax at a later time.

Values:

Off*| Does not send a fax at a later time.

On | Sends a fax at a later time.

ﬂ NOTE: A maximum of 19 delayed fax jobs can be stored in the Dell™ 2135cn Color Laser Multifunction Printer.

Fax Cover Page

Purpose:

To set whether to attach a cover page to faxes.

Values:

Off* | Does not attach a cover page to faxes.

On | Attaches a cover page to faxes.

Fax Defaults

Purpose:
To modify the Fax menu defaults.

Fax Defaul ts allows you to configure the following item in addition to the items under the FAX menu.

Delayed Start
Purpose:

To specify the fax transmission start time.

Using the JOB STATUS Menus

Use the JOB STATUS menus to print the stored files and completed fax numbers.

Stored Print

This Stored Print menu provides applicable printing services such as Secure Print and Proof Print.

ﬂ NOTE: The Stored Print menu is displayed only when 256 MB memory is installed on the printer and RAM Di sk under System Setti ngs is enabled.

Secure Print

Purpose:

To print confidential jobs. The printer can hold the job in memory until you arrive at the printer and type the password on the operator panel.

Values:

Print and Save | Prints the job, and then saves it in print memory.




Del after Print | Prints the job, and then deletes it from print memory.

Delete Deletes the job from print memory.

Proof Print
Purpose:

To print only one copy and check the print result before printing all of the copies. This prevents a large number of misprinted copies from being printed at one
time.

Values:

Print and Save | Prints the job, and then saves it in print memory.

Del after Print | Prints the job, and then deletes it from print memory.

Delete Deletes the job from print memory.

Secure Receive
Purpose:

To require a password to print incoming faxes. When the Secure Receive feature is enabled, the printer stores incoming faxes and prints them when the
correct password is entered on the operator panel.

Completed Fax
Purpose:

To list the status of completed fax jobs.

Pending Fax
Purpose:

To list the status of pending fax jobs.

Using the SETUP Menus

Defaults Settings

Use Defaul ts Settings to modify the COPY, SCAN, or FAX menu defaults.

Tray Settings

Use the Tray Settings menu to define the print media loaded in the tray 1.

ﬂ NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Tray 1
Purpose:
To specify the paper loaded in the tray 1.

Values:

Plain*

Plain Thick

Covers

Covers Thick

Label




Paper Type

Recycled

Envelope

Plain S2

Plain Thick S2

Covers S2

Recycled S2

A4*

A5

B5

Letter

Folio

Legal

Executive

Paper Size

Monarch

Monarch LEF

DL

DL LEF

C5

Envelope #10

Custom Size

Oon>* | Displays a popup message that prompts to set Paper Type and Paper Size when paper is loaded in the tray 1.

Display Popup

Off | Does not display a popup message that prompts to set Paper Type and Paper Size when paper is loaded in the tray 1.

E NOTE: For more information on supported paper sizes, see "Supported Paper Sizes".

Reports

Use the Reports menu to print various types of reports and lists.

System Settings

Purpose:

To print a list of the current user default values, the installed options, the amount of installed print memory, and the status of printer supplies.

Panel Settings

Purpose:

To print a detailed list of all the settings on the operator panel menus.

PCL Fonts List

Purpose:

To print a sample of the available PCL fonts.

See also:

“Understanding Fonts", "Printing a Font Sample List"

PCL Macro List

Purpose:

To print the information on the downloaded PCL macro.

Job History

Purpose:
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To print a detailed list of the print, copy, fax, or scan jobs that have been processed. This list contains the last 20 jobs.

Error History
Purpose:

To print a detailed list of paper jams and fatal errors.

Color Test Page
Purpose:

To print a page for testing colors.

Protocol Monitor
Purpose:

To print a detailed list of monitored protocols.

Stored Documents
Purpose:

To print a list of all files that are stored for Secure Print and Proof Print in the RAM disk.

& NOTE: The Stored Docunents is displayed only when 256 MB memory is installed on the printer and RAM Di sk under System Settings is enabled.

Admin Menu

Use the Adnin Menu menu to configure a variety of printer features.

Phone Book

Use the Phone Book menu to configure the speed dial and group dial settings.

Speed Dial
Purpose:

To store up to 200 frequently dialed numbers in speed dial locations.

Group Dial
Purpose:

To create a group of fax destinations and register it under a two-digit dial code. Up to 6 group dial codes can be registered.

Print Language
Purpose:

To specify the settings for PCL.

PCL

Use the PCL menu to change printer settings that only affect jobs using the PCL emulation printer language.

ﬁ NOTE: Values marked by an asterisk (*) are the factory default menu settings.



Paper Size
Purpose:
To specify the default paper size.

Values:

A4*1

A5

BS5

Letter>!

Folio

Legal

Executive

Monarch

DL

C5

Envelope #10

Custom Size

*1 Denotes country-specific factory default values.

ﬂ NOTE: Selecting a custom size for the paper size prompts you to enter a custom length and width.

Orientation
Purpose:
To specify how text and graphics are oriented on the page.

Values:

Portrait* | Prints text and graphics parallel to the short edge of the paper.

Landscape | Prints text and graphics parallel to the long edge of the paper.

Font
Purpose:
To specify the default font from the fonts registered in the printer.

Values:

Courier*

Courier It

Courier Bd

Courier BdIt

LetterGothic

LetterGothic It

LetterGothic Bd

Albertus Md

Albertus XBd

Clarendon Cd

Coronet

Marigold

Arial

Arial It

Arial Bd

Arial BdIt

Times New

Times New It

Times New Bd

Times New BdlIt




Symbol

Wingdings

Line Printer

Times Roman

Times It

Times Bd

Times BdIt

Helvetica

Helvetica Ob

Helvetica Bd

Helvetica BdOb

CourierPs

CourierPS Ob

CourierPS Bd

CourierPS BdOb

SymbolPS

Palatino Roman

Palatino It

Palatino Bd

Palatino BdIt

ITCBookman Lt

ITCBookman Ltit

ITCBookmanDm

ITCBookmanDm It

HelveticaNr

HelveticaNr Ob

HelveticaNr Bd

HelveticaNrBdOb

N C Schbk Roman

N C Schbk It

N C Schbk Bd

N C Schbk BdIt

ITC AG Go Bk

ITC A G Go BkOb

ITCAGGoDm

ITC AG Go DmOb

ZapfC MdIt

ZapfDingbats

CG Times

CG Times It

CG Times Bd

CG Times BdIt

Univers Md

Univers MdlIt

Univers Bd

Univers BdIt

Univers MdCd

Univers MdCdlIt

Univers BdCd

Univers BdCdlIt

AntiqueOlv

AntiqueOlv It

AntiqueOlv Bd

CG Omega

CG Omega It

CG Omega Bd

CG Omega BdIt

GaramondAntiqua

Garamond Krsv




Garamond Hlb

GaramondKrsvHIb

Symbol Set
Purpose:
To specify a symbol set for a specified font.

Values:

ROMAN-8*

SYMBOL

PC-8 TK

Pl FONT

PS MATH

PC-850
PC-852
PC-8 DN

PC-1004

PC-775

PC-8

MATH-8

MC TEXT

MS PUB

ISO L5

ISO L6

LEGAL

1SO-69

ISO L1
1ISO L2
1SO-4

1SO-6

1SO-60
1SO-15
1SO-17

1SO-21

DESKTOP

DNGBTSMS

1SO-11

WIN L1

WIN L2

WIN L5

WIN 3.0

WINBALT

WINGDINGS

PS TEXT

Font Size
Purpose:
To specify the font size for scalable typographic fonts.

Values:

12.00*

Specify the values in increments of 0.25.
4.00 - 50.00

Font size refers to the height of the characters in the font. One point equals approximately 1/72 of an inch.

E NOTE: The Font Si ze menu is only displayed for typographic fonts.



See also:

"Pitch and Point Size"

Font Pitch

Purpose:

To specify the font pitch for scalable monospaced fonts.

Values:

10.00*

Specify the value in increments of 0.01.

6.00-24.00

Font pitch refers to the number of fixed-space characters in a horizontal inch of type. For nonscalable monospaced fonts, the pitch is displayed, but cannot be
changed.

[E4 NOTE: The Font Pitch menu is only displayed for fixed or monospaced fonts.

See also:

"Pitch and Point Size"

Form Line
Purpose:
To set the number of lines in a page.

Values:

64*1

Specify the value in increments of 1.
5-128

*1 Denotes country-specific factory default values.

The printer sets the amount of space between each line (vertical line spacing) based on the Form Li ne and Ori ent ati on menu items. Select the correct For m
Li ne and Ori entati on before changing For m Li ne.

See also:

"Orientation”

Quantity
Purpose:

To set the default print quantity. (Set the number of copies required for a specific job from the printer driver. Values selected from the printer driver always
override values selected from the operator panel.)

Values:

1*

Specify the value in increments of 1.
1-999

Hex Dump
Purpose:

To help isolate the source of a print job problem. With Hex Dump selected, all data sent to the printer is printed in hexadecimal and character representation.
Control codes are not executed.

Values:

Disable* | Disables the Hex Dump feature.

Enable Enables the Hex Dump feature.
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Draft Mode

Purpose:

To save toner by printing in the draft mode. The print quality is reduced when printing in the draft mode.

Values:

Disable* | Does not print in the draft mode.

Enable Prints in the draft mode.

LineTermination

Purpose:

To add the line termination commands.

Values:
The line termination command is not added.
Off*
CR=CR, LF=LF, FF=FF
The LF command is added.
Add-LF
CR=CR-LF, LF=LF, FF=FF
The CR command is added.
Add-CR
CR=CR, LF=CR-LF, FF=CR-FF
The CR and LF commands are added.
CR-XX
CR=CR-LF, LF=CR-LF, FF=CR-FF

Default Color

Purpose:

To specify the color mode to Col or or Bl ack. This setting is used for a print job which does not specify a print mode.

Value:

Black™ | Prints in the black and white mode.

Color | Prints in the color mode.

Wired Network

Use the Wred Network menu to change the printer settings affecting jobs sent to the printer through the wired network.

m NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Ethernet
Purpose:
To specify the communication speed and the duplex settings of Ethernet. The change becomes effective after the printer is turned off and then on again.

Values:

Auto* Detects the Ethernet settings automatically.

10Base Half | Uses 10base-T half-duplex.

10Base Full Uses 10base-T full-duplex.

100Base Half| Uses 100base-TX half-duplex.

100Base Full | Uses 100base-TX full-duplex.

TCP/IP

Purpose:



To configure TCP/IP settings.

Values:
DHCP/Autonet™ Sets the IP address automatically. A random value in the range of 169.254.1.0 to 169.254.254.255 that is not currently in use
on the network is set as the IP address. The subnet mask is set as 255.255.0.0.
BOOTP Sets the IP address using BOOTP.
Get IP

Address RARP

Sets the IP address using RARP.

DHCP

Sets the IP address using DHCP.

Panel

Use this option when you want to set the IP address manually on the operator panel.

IP Address

When an IP address is being set manually, the IP is allocated to the printer using the format nnn.nnn.nnn.nnn. Each octet
that makes up nnn.nnn.nnn.nnn is a value in the range of O to 254. 127 and any value in the range of 224 to 254 cannot be
specified for the first octet of a gateway address.

Subnet Mask

When an IP address is being set manually, the subnet mask is specified using the format nnn.nnn.nnn.nnn. Each octet that
makes up nnn.nnn.nnn.nnn is a value in the range of 0 to 255. 255.255.255.255 cannot be specified as the subnet mask.

Gateway Address

When an IP address is being set manually, the gateway address is specified using the format nnn.nnn.nnn.nnn. Each octet
that makes up nnn.nnn.nnn.nnn is a value in the range of 0 to 254. 127 and any value in the range of 224 to 254 cannot be

specified for the first octet of a gateway address.

Protocol

Purpose:

To enable or disable each protocol. The change becomes effective after the printer is turned off and then on again.

Values:
Enable* | Enables the Line Printer Daemon (LPD) port.
LPD
Disable | Disables the LPD port.
Enable* | Enables the Port9100 port.
Port9100
Disable | Disables the Port9100 port.
Enable* | Enables the Simple Network Management Protocol (SNMP) UDP port.
SNMP UDP
Disable | Disables the SNMP UDP port.
Enable* | Enables the E-Mail Alert feature.
E-Mail Alert
Disable | Disables the E-Mail Alert feature.
Enable* | Enables an access to Dell Printer Configuration Web Tool embedded in the printer.
EWS
Disable | Disables an access to Dell Printer Configuration Web Tool embedded in the printer.
IP Filter
Purpose:

To block data received from certain IP addresses through the wired network. You can set up to five IP addresses. The change becomes effective after the
printer is turned off and then on again.

Values:

No. n/Address (n is 1-5.)

Sets the IP address for Filter n.

No. n/Mask (nis 1-5.)

Sets the address mask for Filter n.

Off*

Disable the IP Filter feature for Filter n.

No. n/Mode (n is 1-5.) | Accept | Accepts an access from the specified IP address.

Reject | Rejects an access from the specified IP address.

m NOTE: This item is only available for LPD or Port 9100.

Initialize NVM

Purpose:

To initialize wired network data stored in non-volatile memory (NVM). After executing this function and rebooting the printer, all wired network settings are

reset to their default values.

Fax Settings

Use the Fax Settings menu to configure the basic fax settings.




ﬂ NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Receive Mode
Purpose:
To select the default fax receiving mode.

Values:

Ans The printer can share a telephone line with an answering machine. In this mode, the printer will monitor the fax signal and pick up the line
Machine/Fax> if there are fax tones. If the phone communication in your country is serial, this mode is not supported.

Before using the Distinctive Ring Pattern Detection (DRPD) option, a distinctive ring service must be installed on your telephone line by the
DRPD telephone company. After the telephone company has provided a separate number for faxing with a distinctive ring pattern, configure the
fax setup to monitor for that specific ring pattern.

Telephone . Lo . . .
P Automatic fax reception is turned off. You can receive a fax by picking up the handset of the external phone and then pressing the remote
receive code, or by setting OnHook to On (you can hear voice or fax tones from the remote machine) and then pressing b .
Fax Automatically receives faxes.

When the printer receives an incoming fax, the external telephone rings for the time specified in Auto Rec Fax/ Tel , and then the printer
Telephone/Fax | automatically receives a fax. If an incoming call is not a fax, the printer beeps from the internal speaker indicating that the call is a
telephone call.

Auto Rec Fax
Purpose:

To set the interval at which the printer goes into the fax receive mode after receiving an incoming call. The interval can be specified within the range of 0 to
255 seconds. The default is O second.

Auto Rec Fax/Tel
Purpose:

To set the interval at which the printer goes into the fax receive mode after the external telephone receives an incoming call. The interval can be specified
within the range of 0 to 255 seconds. The default is 6 seconds.

Auto Rec Ans/Fax
Purpose:

To set the interval at which the printer goes into the fax receive mode after the external answering machine receives an incoming call. The interval can be
specified within the range of 0 to 255 seconds. The default is 21 seconds.

Line Monitor
Purpose:
To set the volume of the line monitor, which audibly monitors a transmission through the internal speaker until a connection is made.

Values:

Medium™ | Sets the volume of the line monitor to Medi um

High Sets the volume of the line monitor to H gh.
Off Turns off the volume of the line monitor.
Low Sets the volume of the line monitor to Low.

Ring Tone Volume
Purpose:

To set the volume of the ring tone, which indicates that an incoming call is a telephone call through the internal speaker when Recei ve Mde is set to
Tel ephone/ Fax.

Values:

High* | Sets the volume of the ring tone to H gh.

Off Turns off the volume of the ring tone.




Low Sets the volume of the ring tone to Low.

Medium | Sets the volume of the ring tone to Medi um

Line Type
Purpose:
To select the default line type.

Values:

PSTN™* | Uses PSTN.

PBX Uses PBX.

Tone/Pulse
Purpose:
To select the dialing type.

Values:

Tone* Uses tone dialing.

Pulse (10PPS) | Sets "DP (10PPS)" (Dial Pulse, 10 Pulse Per Second) as the dial type.

Pulse (20PPS) | Sets "DP (20PPS)" (Dial Pulse, 20 Pulse Per Second) as the dial type.

Resend Delay
Purpose:

To specify the interval between resend attempts within the range of 3 to 255 seconds. The default is 8 seconds.

Redial Attempts
Purpose:

To specify the number of redial attempts to make when the destination fax number is busy, within the range of 0 to 13. If you enter 0, the printer will not
redial. The default is 3.

Redial Delay
Purpose:

To specify the interval between redial attempts within the range of 1 to 15 minutes. The default is 1 minute.

Junk Fax Setup
Purpose:

To reject unwanted faxes by accepting faxes only from the fax numbers registered in the Phone Book.

Off* | Does not reject faxes sent from unwanted numbers.

on Rejects faxes sent from unwanted numbers.

Remote Receive
Purpose:
To receive a fax by pressing a remote receive code on the external telephone after picking up the handset of the telephone.

Values:

Off* | Does not receive a fax by pressing a remote receive code on the external telephone.

On | Receives a fax by pressing a remote receive code on the external telephone.




Remote Rcv Tone
Purpose:

To specify the tone in two digits to start Remote Receive.

Fax Header
Purpose:
To print the sender's information on the header of the faxes.

Values:

On* | Prints the sender's information on the header of faxes.

Off | Does not print the sender's information on the header of faxes.

Fax Header Name
Purpose:

To set the sender's name to be printed on the header on faxes.

Fax Number
Purpose:

To set the fax number of the printer, which will be printed on the header of a fax message.

ﬂ NOTE: Ensure to specify Fax Nunber before using Junk Fax Setup.

Fax Cover Page
Purpose:
To set whether to attach a cover page to faxes.

Values:

Off* | Does not attach a cover page to faxes.

On | Attaches a cover page to faxes.

DRPD Pattern
Purpose:
To provide a separate number for faxing with a distinctive ring pattern.

Values:

DRPD is a service provided by some telephone companies. DRPD Patterns are specified by your telephone company. The patterns provided with
your printer are shown below:
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Ask your telephone company which pattern you need to select to use this service. For example, Pattern 7 is the New Zealand FaxAbility
distinctive ringing pattern: rings for 400ms, stops for 800ms, rings for 400ms and stops for 1400ms. This pattern is repeated over and over
again. This printer only responds to Distinctive Alert cadence(s) DA4 in New Zealand.

Sent Fax Fwd
Purpose:
To set whether to forward incoming faxes to a specified destination.

Values:

Off* Does not forward incoming faxes.

Only On Error | Forwards incoming faxes only when an error occurs.

on Always forwards incoming faxes.

Fax Fwd Number
Purpose:

To enter the fax number of the destination to which incoming faxes will be forwarded.

Fax Fwd Print
Purpose:
To set whether to print all forwarded incoming faxes.

Values:

Off* | Does not print all forwarded incoming faxes.

On | Prints all forwarded incoming faxes.

Fax Fwd Err Print
Purpose:

To print only incoming faxes that failed to be forwarded when Fax Fwd Print is set to Off.

Values

On* | Prints incoming faxes that failed to be forwarded when Fax Fwd Print is set to Off.

Off | Does not print incoming faxes that failed to be forwarded when Fax Fwd Print is set to Off.




Prefix Dial

Purpose:

To select whether or not to set a prefix dial number.

Values:

Off* | Does not set a prefix dial number.

Oon Sets a prefix dial number.

Prefix Dial Num
Purpose:

To set a prefix dial number of up to five digits. This number dials before any auto dial number is started. It is useful for accessing the Private Automatic Branch
Exchange (PABX).

Discard Size
Purpose:

To set the printer to discard images or any text at the bottom of a fax page when the entire page does not fit the output paper.

Values:
Off* Prints excess images or text at the bottom of a fax page without discarding it.
Oon Discards any excess images or text.
Auto Reduction | Automatically reduces a fax page to fit it onto the appropriate paper size.

ECM
Purpose:
To set whether to enable or disable the Error Correction Mode (ECM). To use the ECM, the remote machines must also support the ECM.

Values:

On* | Enables the ECM.

Off | Disable the ECM.

Modem Speed
Purpose:
To adjust the fax modem speed when a fax transmission or reception error occurs. The values are in Kbps.

Values:

33.6™*

2.4

4.8

9.6

14.4

Country
Purpose:

To select the country where the printer is used.

Fax Activity
Purpose:

To set whether to automatically print a fax activity report after every 50 incoming and outgoing fax communications.



Values:

Auto Print* Automatically prints a fax activity report after every 50 incoming and outgoing fax communications.

Does not automatically print a fax activity report after every 50 incoming and outgoing fax communications.

No Auto Print

Fax Transmit

Purpose:

To set whether to print a transmission result after a fax transmission.

Values:

Print Always Prints a transmission report after every fax transmission.

Print On Error™> | Prints a transmission report only when an error occurs.

Print Disable Does not print a transmission report after a fax transmission.

Fax Broadcast

Purpose:

To set whether to print a transmission result after a fax transmission to multiple destinations.

Values:

Print Always™ | Prints a transmission report after every fax transmission.

Print On Error | Prints a transmission report only when an error occurs.

Print Disable | Does not print a transmission report after a fax transmission to multiple destinations.

Fax Protocol

Purpose:

To set whether to print the protocol monitor report, which helps you identify the cause of a communication problem.

Values:

Print Disable* | Does not print the protocol monitor report.

Print Always | Prints a protocol monitor report after every fax transmission.

Print On Error | Prints the protocol monitor report only when an error occurs.

System Settings

Use System Settings to configure the printer's power saving mode, warning tones, time-out duration, device display language, and job log auto print settings.

ﬂ NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Power Saver Timer

Purpose:

To specify the time for transition to power saver mode.

Values:

M 1 i . . . B B
odel| smin* Specifies the time for transition to Power Saver Mode 1 and Power Saver Mode 2 in minutes.

5-60min

6min™>

Mode2

1-6min

Enter 5 to put the printer in power saver mode five minutes after it finishes a job. This uses much less energy, but requires more warm-up time for the printer.
Enter 5 if your printer shares an electrical circuit with room lighting and you notice lights flickering.

Select a high value if your printer is in constant use. Under most circumstances, this keeps the printer ready to operate with minimum warm-up time. Select a
value between 5 and 60 minutes for power save mode if you want a balance between energy consumption and a shorter warm-up period.



The printer automatically returns to the standby mode from the power saver mode when it receives data from the computer or remote fax machine. You can
also change the status of the printer to the standby mode by pressing any button on the operator panel.

Auto Reset
Purpose:

To automatically reset the settings for COPY, SCAN, or FAX to the default settings and return to the standby mode after you do not specify any settings for the
specified time.

Values:

45sec™

1min

2min

3min

4min

Alert Tone

Purpose:

To configure settings for tones emitted by the printer during operation or when a warning message appears.

Values:

Low

Medium | Emits a tone when the operator panel input is correct.

Panel Select Tone
High

Off* Does not emit a tone when the operator panel input is correct.

Low

Medium | Emits a tone when the operator panel input is incorrect.

Panel Alert Tone
High

Off* Does not emit a tone when the operator panel input is incorrect.

Low

Medium™ | Emits a tone when the printer is ready to process a job.

Machine Ready Tone High

Does not emit a tone when the printer is ready to process a job.
Off

Low

Medium™ | Emits a tone when a copy job is complete.

Copy Job Tone
High

Off Does not emit a tone when a copy job is complete.

Low

Medium™ | Emits a tone when a job other than a copy job is complete.

Non-Copy Job Tone

High
Off Does not emit a tone when a job other than a copy job is complete.
Low
Medium™ | Emits a tone when a job ends abnormally.
Fault Tone
High
Off Does not emit a tone when a job ends abnormally.
Low
Medium™ | Emits a tone when a problem occurs.
Alert Tone
High
Off Does not emit a tone when a problem occurs.
Low

Medium™ | Emits a tone when the printer runs out of paper.

Out of Paper
High

Off Does not emit a tone when the printer runs out of paper.

Low




Medium™ | Emits a tone when toner or some other consumable is low.

Low Toner
High

Ooff Does not emit a tone when toner or some other consumable is low.

Low . .
Emits a tone 5 seconds before the printer performs auto clear.

Medium

Auto Clear Alert
High

Off* Does not emit a tone 5 seconds before the printer performs auto clear.

Low

Medium | Emits a tone when the operator panel display is returned to the default setting by scrolling the loop menu.

Base Tone
High
Off* Does not emit a tone when the operator panel display is returned to the default setting by scrolling the loop menu.
Low Sets the volume of all the alert tones at once.
Medium>*

All Tones High

Disables all the alert tones.

Off

Time-Out

Purpose:

To specify the time (in seconds) the printer should wait for data to arrive from the computer. The print job is cancelled if the time-out duration is exceeded.

Values:
30 sec*
Specifies the time the printer should wait for data to arrive from the computer.
5-300 sec
Off Disables the job timeout.

Clock Settings
Purpose:

To specify the date and time formats.

Values:
Set Date Sets the date depending on the Date Format settings.
Set Time Sets the time.

Date Format | Sets the date format.

24H* | Sets the time in the 24-hour format.

Time Format
12H Sets the time in the 12-hour format.

Time Zone Sets the time zone.

mm/inch
Purpose:
Specifies the default measurement unit displayed after the numeric value on the operator panel.

Values:

mm | Selects millimeter as the default measurement unit.

inch | Selects inch as the default measurement unit.

E NOTE: The default for i i nch varies depending on other settings, such as Country and Docunent Size.

ﬁ NOTE: Restart your printer when you change the settings for the RAM Di sk menu.

Auto Log Print
Purpose:

To automatically print a job history report after every 20 jobs.



Values:

Off* | Does not automatically print a job history report.

On | Automatically prints a job history report.

Print logs can also be printed using the Adni n Reports menu.

ﬂ NOTE: Restart your printer when you change the settings for the RAM Di sk menu.

Print ID

Purpose:

To specify a location where the user ID is printed.

Values:
Off* Does not print the user ID.
Top Left Prints the user ID on the top left of the page.
Top Right Prints the user ID on the top right of the page.
Bottom Left | Prints the user ID on the bottom left of the page.
Bottom Right | Prints the user ID on the bottom right of the page.

[E4 NOTE: When printing on DL size paper, a part of the user ID may not be printed correctly.

Print Text

Purpose:

To specify whether the printer outputs PDL data, which is not supported by the printer, as text when the printer receives it. Text data is printed on A4 or

Letter size paper.

Values:

On* | Prints the received data as text data.

Off | Does not print the received data.

RAM Disk

Purpose:
To allocate memory to the RAM disk file system for the Secure Print and Proof Print features. The change becomes effective after the printer is turned off and

then on again.

Values:

100MB* | Allocates 100 MB memory to the RAM disk file system.

150MB | Allocates 150 MB memory to the RAM disk file system.
Does not allocate memory to the RAM disk file system. Secure Print and Proof Print jobs will abort and be recorded to the job log.

Disable
50MB Allocates 50 MB memory to the RAM disk file system.

ﬂ NOTE: The RAM Di sk menu is displayed only when 256 MB memory is installed on the printer.

ﬂ NOTE: Restart your printer when you change the settings for the RAM Di sk menu.

Substitute Tray

Purpose:

Specifies whether or not to use paper of a different size when the paper that is loaded in the specified tray does not match the paper size settings for the

current job.

Values:

Off No tray size substitute accepted.
Substitutes paper of next largest size. When there is no larger paper size, the printer substitutes paper of nearest size.

Larger Size

Nearest Size* | Substitutes paper of nearest size.




Maintenance

Use the Mai nt enance menu to initialize the NV (non-volatile) memory, configure the plain paper quality adjustment settings, and configure the security settings.

ﬂ NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Paper Density
Purpose:
To specify paper density settings.

Values:

Light*

Plain
Normal

Normal*

Label

Light

Adjust BTR

° NOTICE: The print quality changes depending on the setting values you select for this item.

Purpose:

To specify the transfer roller voltage adjustment for each paper type.

Values:

o*
Plain

-6-+6

o*
Plain Thick

-6 - +6

o*
Covers

-6 - +6

o*
Covers Thick

-6 - +6

o*
Label

-6 - +6

o*
Coated

-6 - +6

o*
Coated Thick

-6 - +6

o*
Envelope

-6 - +6

Adjust Fuser

O NOTICE: The print quality changes depending on the setting values you select for this item.

Purpose:

To adjusts the fuser temperature setting for each paper type.

Values:

o*
Plain

-2-+2

o*
Plain Thick

-2-+2

o*
Covers

2-+2




o*
Covers Thick

2-+2

o*
Label

-2-+2

o*
Coated

-2 -+2

o*
Coated Thick

-2-+2

o*
Envelope

-2-+2

Auto Reg Adjust

Purpose:

To specify whether to automatically perform color registration adjustment.

Values:

On™* | Automatically performs color registration adjustment.

Off | Does not automatically perform color registration adjustment.

Color Reg Adjust

Purpose:

To manually perform color registration adjustment.

Manual Color Registration Adjustments are required when the printer is initially installed and after the printer is moved.

ﬁ NOTE: The Col or Reg Adj ust feature can be configured when Auto Reg Adj ust is set to Off.

Values:

Auto Correct

Automatically performs color registration correction.

Prints a color registration chart. The color registration chart prints a lattice pattern of yellow, magenta, and cyan lines. On the chart, find the

Color Reg values on the right side that are next to the straightest lines for each of the three colors. If the value for the straightest line is 0, color
Chart registration adjustment is not required. If the value for the straightest line is any value other than 0, specify the adjustment values under
Lateral Adjustment and Process Adjustnent.
Y
Lateral Adjustment M |-9-+9 Specifies lateral (perpendicular to paper feed direction) color adjustment values individually for
— Yellow, Magenta, and Cyan.
Enter c
Adjustment v
Process Adjustment M |-9-+9 Specifies process (paper feed direction) color adjustment values individually for Yellow, Magenta,
— and Cyan.
C

ﬂ NOTE: Ensure that you remove the paper from the single sheet feeder before performing Auto Correct .

Clean Developer

Purpose:

To stir the toner in a new toner cartridge.

Toner Refresh

Purpose:

To clean the toner in each toner cartridge.

Drum Refresh

Purpose:

To clean the surface of the PHD unit.




Initialize NVM

Purpose:

To initialize the non-volatile (NV) memory. After executing this function and rebooting the printer, all the menu parameters are reset to their default values.

Values:
User (Fax) Initializes the fax number entries in the Address Book.
User (Scan) Initializes the e-mail and server address entries in the Address Book.
System Section | Initializes the system parameters.

Init Print Meter

Purpose:

To initialize the print meter of the printer. When the print meter is initialized, the meter count is reset to zero.

Non-DELL Toner
Purpose:

To specify whether or not to use another manufacturer’s toner cartridge.

NOTICE: Use of a non-Dell toner cartridge may result in some of the printer's functions being unavailable, a reduction in print quality, or deterioration of
the printer's reliability. Use of a new Dell brand toner cartridge is recommended for your printer. The Dell warranty does not cover any problems caused
by the use of any accessory, part, or component that is not supplied by Dell.

Values:

Off* | Does not use another manufacturer's toner cartridge.

On | Uses another manufacturer's toner cartridge.

Adjust Altitude
Purpose:
To specify the altitude of the location where the printer is installed.

The discharge phenomenon for charging the photo conductor varies with barometric pressure. Adjustments are performed by specifying the altitude of the
location where the printer is being used.

O NOTICE: An incorrect altitude adjustment setting leads to poor printing quality, incorrect indication of remaining toner, etc.

Values:

om>

1000m

Specifies the altitude of the location where the printer is installed.
2000m

3000m

Secure Settings

Use the Secure Settings menu to set a password to limit access to the menus. This prevents items from being changed accidentally.
ﬂ NOTE: Values marked by an asterisk (*) are the factory default menu settings.

See also:

“Setting Panel Lock"

Panel Lock



Purpose:

To specify whether or not to lock Admi n Menu with a password, and to set or change the password.

Values:
Disable* Does not lock Admi n Menu with a password.
Panel Lock Set
Enable Locks Admi n Menu with a password.
0000*
Change Password Sets or changes the password required to access Admi n Menu.
0000-9999

Function Enabled
ﬁ NOTE: Before enabling Functi on Enabl ed, ensure that Panel Lock is enabled.

Purpose:
To specify whether to enable or disable each of the printer services, or to require a password to use the services.

Values:

Oon Enables the Copy service.

Copy | On (Password) | Enables the Copy service, but requires a password to use the service.

Off Disables the Copy service.

Oon Enables the Scan service.

Scan | On (Password) | Enables the Scan service, but requires a password to use the service.

Off Disables the Scan service.

Oon Enables the Fax service.

Fax | On (Password) | Enables the Fax services, but requires a password to send faxes (does not require a password to receive incoming faxes).

Off Disables the Fax service (the printer will not send or receive faxes).

Secure Receive
E NOTE: Before enabling Secure Recei ve, ensure that Panel Lock Set is enabled.

Purpose:

To specify whether or not to require a password to receive faxes, and to set or change the password.

Values:
Disable* Does not require a password to receive faxes.
Secure Receive Set
Enable Requires a password to receive faxes.
0000* Sets or changes the password required to receive faxes.
Change Password
0000-9999

Admin Reports

Use the Adnin Reports menu to print various types of Adni n Menu reports and lists.

Speed Dial
Purpose:

To print the Speed Dial report.

Address Book
Purpose:

To print the Address Book report.



Server Address
Purpose:

To print the server address report.

Fax Activity
Purpose:

To print the fax activity report.

Fax Pending
Purpose:

To print the pending faxes report.

Print Meter
ﬂ NOTE: Depending on the settings on Dell Printer Configuration Web Tool, Del | Col or Track is displayed instead of Print Meter.

Purpose:

To print the reports for the total number of pages printed. When printed using either the operator panel or Dell Printer Configuration Web Tool, the report
will be titled Print Volume Report.

Dell ColorTrack
Purpose:

To specify which users have access to color printing and to limit print volume per user.

m NOTE: Depending on the settings on Dell Printer Configuration Web Tool, Print Meter is displayed instead of Del | Col or Track.

Panel Language
Purpose:
To determine the language of the text on the operator panel screen.

Values:

English*

Frangais

Italiano

Deutsch

Espaiiol

Nederlands

Dansk

Norsk

Svenska

Setting Panel Lock

This feature prevents unauthorized personnel from changing the settings made by the administrator. For regular printing, items can be selected from the menu
and printer settings remain unchanged. For regular printing, items can be configured using the printer driver.

1. Press " until >SETUP appears, and then press v .

2. Press W until >Adni n Menu appears, and then press \/ .



3. Press W until >Secure Setti ngs appears, and then press “ .
4. Panel Lock is displayed. Press v .

5. Panel Lock Set is displayed. Press V{

6. Press 2 until Enabl e appears, and then press \/ .

Press O to return to the previous menu.

h

Press W until >Change Password appears, and then press ( .

®

9. Reenter the password to confirm the password that you entered, and then press v .
The password is changed.

ﬁ NOTE: If you forget your password, turn off the printer. Then, while holding Menu, turn on the printer. Continue to hold Menu until the display displays

the top menu. This will recover the factory default panel password.
Note that the password for Panel Lock, Function Enabl ed, and Secure Recei ve is disabled. Also note that the settings for Address Book and FAX are

cleared.

ﬂ NOTE: If Panel Lock is set to Enabl e, the factory-default panel password is 0000. For more information, see "Function Enabled".

Disabling Panel Lock

& NOTE: Before disabling Panel Lock, ensure that Function Enabl ed and Secure Recei ve are disabled.

1. Press "W until >SETUP appears, and then press \/ .

2. Press " until >Adni n Menu appears, and then press v .

3. Press " until >Secure Setti ngs appears, and then press v .
4. Panel Lock is displayed. Press \/ .

5. Panel Lock Set is displayed. Press \(

6. Press » until Disabl e appears, and then press \/ .
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Understanding Your Printer Software

@ Printer Settings Utility

Use the Drivers and Utilities CD that shipped with your printer to install a combination of software programs, depending on your operating system.

Printer Status Window
The Printer Status window alerts you when there is a warning or when an error occurs, for example, when a paper jam occurs or toner is running low.

By default, the Printer Status window launches only when an error occurs. When an error occurs, the error message appears on the Printer Status window.
You can set the Printer Status window to always launch when printing in Printing Status Window Properties.

You can also check toner level, quantity of paper remaining or the configuration of options for the local printer.

Status Monitor Console
Use the Status Monitor Console to manage multiple instances of the Status Window for a particular printer.

Select a printer from the list view (or Printer Selection) by clicking its name to open a Status Window for a particular printer.

Dell Supplies Management System™
You can launch the Dell Supplies Management System dialog box from the All Programs menu or the desktop icon.

You can order consumables by phone or from the web.

1. Click start— All Programs— Dell Printers— Additional Color Laser Software— Dell Supplies Management System.

The Dell Supplies Management System window appears.

2. Select your printer from the Select Printer Model list.

3. If you are ordering from the web:

a. When you cannot get information from the printer automatically by two-way communication, a window prompting you to type the Service Tag
number appears. Type your Dell™ printer Service Tag number in the field provided.

Your Service Tag number is located inside the side cover of your printer.

b. Select a URL from the Select Reorder URL list.

c. Click Visit Dell printer supplies ordering web site.

4. If ordering by phone, call the number that appears under the Order by Phone heading.

User Setup Disk Creating Tool

The User Setup Disk Creating Tool program located in the MakeDisk folder of the Utilities folder on the Drivers and Utilities CD and the printer drivers located
on the Drivers and Utilities CD are used to create driver installation packages that contain custom driver settings. A driver installation package can contain a
group of saved printer driver settings and other data for things such as:

1 Print orientation and Multiple Up (document settings)
1 Watermarks

1 Font references

If you want to install the printer driver with the same settings on multiple computers running the same operating system, create a setup disk in a floppy disk
or in a server on the network. Using the setup disk that you have created will reduce the amount of work required when installing the printer driver.

1 Install the Dell™ 2135cn Color Laser Multifunction Printer printer driver in the computer on which the setup disk is to be created.

1 The setup disk can only be used on the operating system on which the disk was created or computers running the same operating system. Create a
separate setup disk for each of the operating systems.

Software Update

The firmware and/or driver updates can be downloaded from the Dell Support website located at support.dell.com.
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Printer Settings Utility

Using the Quick Launch Utility window, you can open the Status Window, Tool Box, Updater, Troubleshooting, Address Book Editor, ScanButton Manager,
and Dell ScanCenter.

To use the Quick Launch Utility, select to install the Quick Launch Utility when you install the Dell software.

For information about installing the software, see "Setting Up for Shared Printing".

To open the Quick Launch Utility window:

1. Click start— All Programs— Dell Printers— Additional Color Laser Software— Quick Launch Utility.

The Quick Launch Utility dialog box opens.

Sumport Tosk ', AID ity
‘Status Window Tool Box Updater Troubleshootng
Settnas...
[Suppont Took '\ AJD Uity
Address Book ScanButton Del
Edtor Manager ScanCenter Settings...

2. The Quick Launch Utility window provides seven buttons; Status Window, Tool Box, Updater, Troubleshooting, Address Book Editor, ScanButton
Manager, and Dell ScanCenter.

To exit, click the X button at the top-right of the window.

For details, click the Help button of each application.

Status Window

The Status Window button opens the Printer Status window. See "Printer Status Window".

Tool Box

The Tool Box button opens the Tool Box. See "Understanding the Tool Box Menus".

Updater

The Updater button updates the Dell software and printer firmware.

Troubleshooting

The Troubleshooting button opens the Troubleshooting Guide, which allows you to resolve issues by yourself.

Address Book Editor

Click the Address Book Editor button to create and edit Address Book entries.
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1. Read the Address Book entries from the printer to the Address Book Editor.
2. Allows you to edit a selected Address Book entry in the edit dialog box.
3. Deletes a selected Address Book entry.

4. Displays Address Book entries.

& NOTE: You must install the scanner driver before reading or editing the Address Book entries.

ScanButton Manager

The ScanButton Manager button opens the ScanButton Manager, which allows you to specify how the ScanButton Manager behaves for scan events that the
device generates.

The Scan to Application stores the image files in the My Documents folder by default, and then you can open them using the related application. Use
ScanButton Manager to change the output destination of the obtained image files and to select whether to open the image files using the related application.

Configure the image file scanned by the scanner.

Destination Pathc

Dell ScanCenter

The Dell ScanCenter button opens the Dell ScanCenter.

Dell ScanCenter is a PaperPort application that enables you to scan items and send them directly to PaperPort or other programs on your computer without
running the PaperPort program first. For more information about using Dell ScanCenter, refer to PaperPort's Help menu.

_J,nj FETIEREE j

document inko the ADF face up or placa your document on the scanner glars lace down,
ﬁmmmammnmummumm
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Tips for Successful Printing

Sending a Job to Print

Canceling a Job

Printing a Report Page

Using the Print and Hold Function

This chapter covers tips for printing, how to print certain information from your printer, and how to cancel a job.

Tips for Successful Printing

Tips on Storing Print Media

Store your print media properly. For more information, see "Storing Print Media".

Avoiding Paper Jams
ﬂ NOTE: It is recommended that you try a limited sample of any print media you are considering using with the printer before purchasing large quantities.

By selecting appropriate print media and loading it properly, you can avoid paper jams. See the following instructions on loading print media:

1 “"Loading Print Media in the Tray 1"

1 "Loading the Single Sheet Feeder"

1 "Avoiding Jams"

If you experience a paper jam, see "Clearing Jams".

Sending a Job to Print

To support all of the printer features, use the printer driver. When you choose Print from a software program, a window representing the printer driver opens.
Select the appropriate settings for the specific job that you are sending to print. Print settings selected from the driver override the default menu settings
selected from the operator panel or Tool Box.

You may need to click Preferences from the initial Print box to see all of the available system settings you can change. If you are not familiar with a feature in
the printer driver window, open the online Help for more information.

To print a job from a typical Windows® application:

1. Open the file you want to print.

2. From the File menu, select Print.

3. Verify that the correct printer is selected in the dialog box. Modify the system settings as appropriate (such as the pages you want to print or the
number of copies).

4. Click Preferences to adjust system settings that are not available from the first screen, and then click OK.

5. Click OK or Print to send the job to the selected printer.

Canceling a Job

There are several methods for canceling a job.

Canceling From the Operator Panel

To cancel a job after it has started printing:
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1. Press X .

2. From the Job List, Press "W or M until >Pri nt appears, and then press v .

Printing is canceled only for the current job. All the following jobs will continue to print.

Canceling a Job From a Computer Running Windows

Canceling a Job From the Taskbar

When you send a job to print, a small printer icon appears in the bottom right corner of the taskbar.

1. Double-click the printer icon.

A list of print jobs appears in the printer window.

2. Select the job you want to cancel.

3. Press Delete on the keyboard.

Canceling a Job From the Desktop

1. Click start—»>Printers and Faxes
For Windows 2000: Click Start— Settings— Printers.
For Windows Server® 2003: Click Start— Printers and Faxes.
For Windows Vista®: Click Start— Control Panel— Hardware and Sound—» Printers.
For Windows Server 2008: Click Start— Control Panel— Printers.

A list of available printers appears.

2. Double-click the printer that you selected when you sent the job for print.

A list of print jobs appears in the printer window.

3. Select the job you want to cancel.

4. Press Delete on the keyboard.

Printing a Report Page

By using the Reports menu, you can print a variety of settings for your printer including system settings, panel setting, and font list. The following section
describes two examples of printing from the Reports menu.

Printing a System Settings Page

To verify detailed system settings, print a System Settings page. A printed System Settings page also allows you to verify whether or not options have been
installed properly.

See "Understanding the Menus" or "Understanding the Tool Box Menus" to identify the display and operator panel buttons if you need help.

From the Printer Operator Panel

1. Press W until >SETUP appears, and then press \/ .

2. Press " until >Reports appears, and then press v .
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3. System Settings is displayed. Press “ .

The System Settings page is printed.

From Your Computer

1. Click start— All Programs— Dell Printers— Additional Color Laser Software— Quick Launch Utility.

The Quick Launch Utility dialog box opens.

2. Click the Tool Box button.

The Tool Box dialog box opens.

3. Select the printer from Printer Name.

The Tool Box opens.

4. Click the Printer Settings Report tab.

5. Select Reports from the list on the left side of the page.

The Reports page is displayed.

6. Click the System Settings button.
The System Settings page is printed.

The message System Settings - Press X to Stop - Printing appears while the page prints. The printer returns to the standby mode after printing the
System Settings page.

If any other message appears when you print this page, see the online Help for more information.

Printing a Font Sample List

To print samples of all the fonts currently available for your printer:

From the Printer Operator Panel

1. Press " until >SETUP appears, and then press v .

2. Press " until >Reports appears, and then press v .

3. Press 2 until either PCL Fonts List appears.

4. Press v’ .

The PCL fonts list is printed.

From Your Computer

1. Click start— All Programs— Dell Printers— Additional Color Laser Software— Quick Launch Utility.

The Quick Launch Utility dialog box opens.

2. Click the Tool Box button.

The Tool Box dialog box opens.

3. Select the printer from Printer Name.

The Tool Box opens.



4. Click the Printer Settings Report tab.

5. Select Reports from the list at the left side of the page.

The Reports page is displayed.

6. Click the PCL Fonts List button.

The PCL fonts list is printed.

The message PCL Fonts List - Press X to Stop - Printing appears and remains on the operator panel until the page prints. The printer returns to the
standby mode after printing the font sample list.

Using the Print and Hold Function

When you send a job to the printer, you can specify that you want the printer to hold the job in the memory by using the driver settings. When you are ready
to print the job, go to the printer and use the operator panel menus to identify the specific job in the memory that you want to print. You can use this function
to print a confidential job (Secure Print), or verify one copy before printing additional copies (Proof Print).

ﬂ NOTE: The printer holds the job until you delete it using the operator panel or you turn off the printer. The data on memory is cleared when the printer
is turned off.

NOTE: Print and Hold functions require a minimum of 384 MB available print memory.

NOTE: If the number of documents are too many, or the size of the print job is too big for the available memory, an error occurs.

NOTE: If a document name is not assigned to your print job in the printer driver, the job's name will be identified using the PC's time and date of
submission to distinguish it from other jobs stored under your name.

Printing and Deleting Held Jobs

Once held jobs are stored in print memory, you can use the operator panel to specify what you want to do with one or more of the jobs. You can select either
Secure Print and Proof Print from "Stored Print". Then, you select your user name from a list. If you select Secure Print, you must type the password you

specified in the driver when you sent the job. See "Secure Print” for more information.
From either the Secure Print or Proof Print menu items, you have three choices:

1 Print and Save
1 Del after Print

1 Delete

NOTE: To send a job to print as Secure Printing or Proof Printing, select Secure Print or Proof Print in Job Type in the Paper/Output tab of the
Printing Preferences dialog box.

Printing Held and Proof Print Jobs

From the Printer Operator Panel

1. Press " until >SETUP appears, and then press v .
2. Press W until >Reports appears, and then press v

3. Press " until Stored Docunents appears, and then press v,

The stored documents page is printed.

From Your Computer

1. Click start— All Programs— Dell Printers— Additional Color Laser Software— Quick Launch Utility.

The Quick Launch Utility dialog box opens.

2. Click the Tool Box button.

The Tool Box dialog box opens.


file:///C:/data/systems/PRN2135CN/en/ug/sectioaw.htm#wp1188218

3. Select the printer from Printer Name.

The Tool Box opens.

4. Click the Printer Settings Report tab.

5. Select Reports from the list on the left side of the page.

The Reports page is displayed.

6. Click the Stored Documents button.

The stored documents page is printed.

Stored Print

If you send a Stored Print job, the printer does not print the job immediately, but stores the job in memory so you can print the job later. See "Printing and
Deleting Held Jobs" for more information.

ﬂ NOTE: The printer holds the job until you delete it using the operator panel or you turn off the printer.

ﬁ NOTE: When you select Del after Print, the held job is automatically deleted after printing.

Proof Print

If you send a Proof Print job, the printer prints one copy and holds the remaining copies you requested from the driver in print memory. Use Proof Print
function to examine the first copy to see if it is satisfactory before printing the remaining copies.

See "Printing and Deleting Held Jobs" if you need help with printing the additional copies stored in memory.

& NOTE: The printer holds the job until you delete it using the operator panel or you turn off the printer.

ﬂ NOTE: When you select Del after Print, the held job is automatically deleted after printing.

Secure Print

When you send a job to the printer, you can specify a password from the driver. The password must be between 1 and 12 digits using numbers 0-9. The job is
then held in print memory until you enter the same numeric password from the operator panel and choose to print or delete the job. This function is called
"Stored Print". This ensures that the job does not print until you are there to retrieve it, and no one else using the printer can print the job.

When you select Secure Print from Stored Print after selecting your user name, the following prompt is displayed:

User Name

-Enter Secure Print

Password & v

Use the buttons on the operator panel to enter the numeric password associated with your confidential job. As you enter the password, the password you
entered is displayed as * to ensure confidentiality.

If you enter an invalid password, the message Wong Password appears. Wait three seconds, or Press v or X to return to the screen for user selection.

When you enter a valid password, you have access to all print jobs matching the user name and password you entered. The print jobs matching the password
you have entered appear on the screen. You can then choose to print or delete jobs. (See "Printing and Deleting Held Jobs" for more information.)

ﬂ NOTE: The printer holds the job until you delete it using the operator panel or you turn off the printer. The data on memory is cleared when the printer
is turned off.

ﬂ NOTE: When you select Del after Print, the held job is automatically deleted after printing.

Back to Contents Page
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Loading Paper for Copying

Selecting Paper Tray

Preparing a Document

Making Copies From the Document Glass
Making Copies From the ADF

Setting Copy Options

Changing the Default Settings

Setting the Power Saver Timer Option

Loading Paper for Copying

The instructions for loading print materials are the same whether you are printing, faxing, or copying. For more details, see "Print Media Guidelines".

Selecting Paper Tray

After loading the print media for copy output, select the desired paper tray to be used for the copy job.

1. Press M until >COPY appears, and then press V’ .

2. Press W until Sel ect Tray appears.

3. Press € or ¥ until the desired tray appears, and then press v .

You can select Tray 1 or SSF.

Preparing a Document

You can use the document glass or the Automatic Document Feeder (ADF) to load an original document for copying, scanning and sending a fax. You can load
up to 35 sheets of 75 g/m2 (20 Ib) documents for one job using the ADF or one sheet at a time using the document glass.

ﬂ NOTE: To get the best scan quality, especially for color or gray scale images, use the document glass instead of the ADF.

When you use the ADF:

1 Do not load documents smaller than 5.5 by 5.5 in. (140 by 140 mm) or larger than 8.5 by 14 in. (216 by 356 mm).
1 Do not attempt to feed the following types of documents:

1 Carbon-paper or carbon-backed paper

1 Coated paper

1 Onion skin or thin paper

1 Wrinkled or creased paper

1 Curled or rolled paper

1 Torn paper
1 Remove all staples and paper clips before loading documents.
1 Ensure that any glue, ink or correction fluid on the paper is completely dry before loading documents.
1 Do not load documents containing different sizes or weights of paper.

1 Do not load booklets, pamphlets, transparencies or documents having other unusual characteristics.

Making Copies From the Document Glass

ﬂ NOTE: A computer connection is not required for copying.

ﬂ NOTE: Remove any documents from the ADF before copying from the document glass.
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ﬂ NOTE: Contaminants on the document glass may cause black spots on the printout. For best results, clean the document glass before use. For more
information, see "Cleaning the Scanner”.

To make a copy from the document glass:

1. Lift and open the document cover.

2. Place the document face down on the document glass and align it with the registration guide on the top left corner of the glass.

3. Close the document cover.

ﬂ NOTE: Leaving the cover open while copying may affect the copy quality and increase the toner consumption.

ﬂ NOTE: If you are copying a page from a book or magazine, lift the cover until its hinges are caught by the stopper and then close the cover. If the
book or magazine is thicker than 30 mm, start copying with the cover open.

4. Customize the copy settings including the number of copies, copy size, the contrast, and the image quality. See "Setting Copy Options".

To clear the settings, use the X button.

Press b B

a

ﬁ NOTE: You can cancel the copy job at any time. Press X to stop scanning and then press \/ .

Making Copies From the ADF

NOTICE: Do not load more than 35 sheets into the ADF or allow more than 35 sheets to be fed to the ADF output tray. The ADF output tray should be
emptied before it exceeds 35 sheets or your original documents may be damaged.

ﬁ NOTE: A computer connection is not required for copying.

1. Load up to 35 sheets of 75 g/m2 (20 Ib) documents face up on the ADF with top edge of the documents in first. Then adjust the document guides to the
correct document size.
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ﬂ NOTE: Ensure that you use the ADF Paper Stop before copying a Legal-size document.

2. To customize the copy settings including the number of copies, copy size, contrast, and image quality, see "Setting Copy Options".

To clear the settings, use X.

3. Press b B

Setting Copy Options
Set the following options for the current copy job before pressing D to make copies.

ﬂ NOTE: The copy options automatically return to their default status after copying.

Number of Copies

You can select the number of copies from 1 to 99.

1. Load the document(s) face up with top edge in first into the ADF.
OR
Place a single document face down on the document glass.

For details about loading a document, see "Loading an Original Document".

2. Press M until >COPY appears, and then press \/ .

3. Press " until Nunber of Copi es appears.
4. Press P to select the desired settings, and then press ( .

5. Press D to begin copying.

Color

You can select color or black and white copying.
1. Load the document to be copied on the document glass, and close the cover.
2. Press M until >COPY appears, and then press \/ .
3. Press " until Col or appears, and then press v .

4. Press ? to select the desired settings, and then press v .

Color* Prints in color mode.

Black & White | Prints in black and white mode.

5. Press D to begin copying.

Select Tray

You can select the input tray.
1. Load the document to be copied on the document glass, and close the cover.

2. Press M until >COPY appears, and then press v .
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3. Press " until Sel ect Tr ay appears, and then press v .

4. Press Y to select the desired settings, and then press ( .

Tray 1* | The paper is fed from the tray 1.

SSF The paper is fed from the single sheet feeder.

5. Press b to begin copying.

SSF Paper Size

You can select the default paper size of the single sheet feeder.
1. Load the document to be copied on the document glass, and close the cover.
2. Press M until >COPY appears, and then press v .
3. Press W until Sel ect Tr ay appears, and then press ( .

4. Press ? to select SSF, and then press ( .

SSF Paper Size is displayed.

5. Press ¥ to select the desired settings, and then press v .

Letter*1

Folio

Legal

Executive

Monarch

DL

C5

Envelope #10

A4

A5

B5

*1 Denotes country-specific factory default values.

6. Press D to begin copying.

SSF Paper Type

You can select the default paper type of the single sheet feeder.
1. Load the document to be copied on the document glass, and close the cover.
2. Press /M until >COPY appears, and then press v .
3. Press W until Sel ect Tr ay appears, and then press ( .

4. Press ? to select SSF, and then press ( .

SSF Paper Si ze is displayed.

5. Press ? to select the desired settings, and then press ( .

SSF Paper Type is displayed.



6. Press ¥ to select the desired settings, and then press v .

Plain*

Plain Thick

Covers

Covers Thick

Label

Coated

Coated Thick

Recycled

Envelope

Plain S2

Plain Thick S2

Covers S2

Covers Thick S2

Coated S2

Recycled S2

7. Press D to begin copying.

Reduce/Enlarge

You can reduce or enlarge the size of a copied image, from 25 percent to 400 percent when you copy original documents from the document glass or ADF.
m NOTE: When you make a reduced copy, black lines may appear at the bottom of your copy.

To select from the predefined copy sizes:
1. Load the document to be copied on the document glass, and close the cover.

2. Press M until >COPY appears, and then press \/ .

3. Press " until Reduce/ Enl ar ge appears.

4. Press P to select the desired settings, and then press ( .

100%™*

Stmt—>Ltr (129%)*1/A5>B5 (122%)*2

Stmt—>Lgl (154%)*1/A55>A4 (141%)*2

200%

Custom 100%

50%
Ldgr—sLtr (64%)*1/A4—>A5 (70%)*2

Lgl>Ltr (78%)*1/B5->A5 (81%)*2

*1 These options are displayed when SETUP — Adnin Menu — System Settings — nmii nch is set to i nch.

*2 These options are displayed when SETUP — Admi n Menu — System Settings — nniinch is set to nm

ﬁ NOTE: You can set the value in a percent for Custom.

5. Press D’ to begin copying.

Original Type
The Original Type setting is used to improve the image quality by selecting the document type for the current copy job.

To select the image quality:

1. Load the document to be copied on the document glass, and close the cover.



2. Press M until >COPY appears, and then press v .

3. Press "W until i gi nal Type appears.

4. Press Y to select the desired settings, and then press ( .

Text & Photo* | Used for documents with both text and photos.

Text Used for documents with text.

Photo Used for documents with photos.

5. Press D to begin copying.

Document Size

You can select the default document size.
1. Load the document to be copied on the document glass, and close the cover.

2. Press M until >COPY appears, and then press v .

3. Press " until Docunent Si ze appears.

4. Press » to select the desired settings, and then press v .

Auto™

A4

Letter

BS

A5

Executive

Folio

Legal

5. Press D to begin copying.

Lighter/Darker

Adjusts the contrast to make the copy lighter or darker than the original.
1. Load the document to be copied on the document glass, and close the cover.

2. Press M until >COPY appears, and then press v .

3. Press " until Li ghter/ Darker appears.

4. Press » to select the desired settings, and then press v .

Normal* | Works well with standard typed or printed documents.

Darkerl

Darker2 | Works well with light print or faint pencil markings.

Darker3

Lighter3

Lighter2 | Works well with dark print.

Lighterl

5. Press D’ to begin copying.



Sharpness

Adjusts the sharpness to make the copy sharper or softer than the original.
1. Load the document to be copied on the document glass, and close the cover.

2. Press M until >COPY appears, and then press v .

3. Press " until Shar pness appears.

4. Press Y to select the desired settings, and then press ( .

Normal™* | Does not make the copy sharper or softer than the original.

Sharper | Makes the copy sharper than the original.

Softer Makes the copy softer than the original.

5. Press D to begin copying.

Color Saturation

Adjusts the amount of colors to make the colors darker or lighter than the original.
1. Load the document to be copied on the document glass, and close the cover.

2. Press /M until >COPY appears, and then press v .

3. Press " until Col or Saturation appears.

4. Press ? to select the desired settings, and then press v .

Medium™ | The color saturation is the same as the original.

High Increases the color saturation to brighten the color of the copy.

Low Decreases the color saturation to lighten the color of the copy.

5. Press D to begin copying.

Auto Exposure

Suppresses the background of the original to enhance text on the copy.
1. Load the document to be copied on the document glass, and close the cover.

2. Press M until >COPY appears, and then press \/ .

3. Press M until Auto Exposure appears.

4. Press ¥ to select On, and then press « .

5. Press D to begin copying.

Multiple-Up

Prints two original images to fit onto one sheet of paper.
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To make use of the Multiple-Up copying:

1. Load the document(s) face up with top edge in first into the ADF.
OR
Place a single document face down on the document glass.

For details about loading a document, see "Loading an Original Document”.

2. Press M until >C0PY appears, and then press v .

3. Press " until Mil ti pl e- Up appears.

4. Press Y to select the desired setting, and then press \/ .

Off* Does not perform multiple-up printing.

Auto Automatically reduces the original pages to fit onto one sheet of paper.

ID Copy | Prints the original pages onto one sheet of paper in the original size.

Manual | Prints the original pages onto the one sheet of paper in the size specified in Reduce/Enlarge.

5. If necessary, customize the copy settings including the number of copies, contrast, and image quality. See "Setting Copy Options”.

6. Press D to begin copying.

For the document loaded on the document glass, the display asks if you want to load another page. Press > to select Yes or No, and then press (

7. If you select Yes, press > to select Conti nue or Cancel , and then press \( .

Collated

Sorts the copy job. For example, if you make two copies of three page documents, one complete three page document will print followed by the second
complete document.

ﬂ NOTE: You can collate more pages when optional memory card is installed.

1. Load the document(s) face up with top edge in first into the ADF.

OR
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Place a single document face down on the document glass.

For details about loading a document, see "Loading an Original Document”.

2. Press M until >COPY appears, and then press \/ .

3. Press " until Col | ated appears.

4. Press ? to select Col | at ed, and then press « .

5. If necessary, customize the copy settings including the number of copies, contrast, and image quality. See "Setting Copy Options”.

6. Press D to begin copying.

For the document loaded on the document glass, the display asks if you want to load another page. Press ¥ to select Yes or No, and then press “.

7. If you select Yes, press > to select Conti nue or Cancel , and then press v .

Margin Top/Bottom

Specifies the top and bottom margins of the copy.
1. Load the document to be copied on the document glass, and close the cover.

2. Press M until >COPY appears, and then press \/ .

3. Press W until Mar gi n Top/ Bot t omappears.

4. Specify the desired value using the number keypad, and then press v .

0.2 inch* (4 mm¥*)

Specify the value in increments of 0.1 inch (1 mm).
0.0-2.0 inch (0-50 mm)

5. Press D to begin copying.

Margin Left/Right

Specifies the left and right margins of the copy.
1. Load the document to be copied on the document glass, and close the cover.

2. Press M until >COPY appears, and then press \/ .

3. Press W until Margin Left/Ri ght appears.

4. Use ten key to specify the desired value, and then press v .

0.2 inch* (4 mm¥*)

Specify the value in increments of 0.1 inch (1 mm).
0.0-2.0 inch (0-50 mm)

5. Press D to begin copying.

Margin Middle

Specifies the middle margin of the copy.

1. Load the document to be copied on the document glass, and close the cover.
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2. Press M until >COPY appears, and then press \/ .

3. Press " until Margi n M ddl e appears.

4. Use ten key to specify the desired value, and then press ‘/ .

0.0 inch* (O mm>*)

Specify the value in increments of 0.1 inch (1 mm).

0.0-2.0 inch (0-50 mm)

5. Press D to begin copying.

Changing the Default Settings

The CCPY menu options, including contrast, and image quality can be set to the most frequently used modes. When you copy a document, the default settings
are used unless they are changed by using the corresponding buttons on the operator panel.

ﬂ NOTE: While you set copy options, pressing X cancels the changed settings and returns to the default status.
To create your own default settings:

1. Press # until >COPY appears, and then press v .

2. Press W until Copy Defaul ts appears, and then press ( .

3. Press W until the desired menu item appears.

4. Press ? to change the setting, and then press v .
5. Repeat steps 3 to 4, as needed.

6. To return to the standby mode, press X.

Setting the Power Saver Timer Option

You can set the power saver timer for the printer. The printer waits before it restores the default copy settings, if you do not start copying after changing them
on the operator panel.

1. Press " until >SETUP appears, and then press v .

2. Press W until >Adni n Menu appears, and then press \/ .

3. Press " until >System Settings appears, and then press v .

4. Press W until >Power Saver Tiner appears, and then press v

5. Press W to select >Model or >Mbde2, and then press “ .

You can select from 5-60 minutes in Mdel or 1-6 minutes in Mbde2.

6. To return to the standby mode, press X.

Back to Contents Page
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Scanning

Scanning Overview
Scanning From the Operator Panel

Scanning Using the TWAIN Driver

Scanning Using the Windows Image Acquisition (WIA) Driver

Using a Scanner on the Network

Sending an E-Mail with the Scanned Image

Scanning Overview
Use your Dell™ 2135cn Color Laser Multifunction Printer to turn pictures and text into editable images on your computer.
PaperPort is a program that enables you to organize, find and share all your paper and digital documents, and is supplied with your printer.

The resolution setting to use when you scan an item depends on the item type and how you plan to use the image or document after you scan it in to your
computer. For the best results, use these recommended settings.

Type Resolution

Documents 300 dpi black-and-white or 200 dpi grayscale or color

Documents of poor quality or that contain small text| 400 dpi black-and-white or 300 dpi grayscale

Photographs and pictures 100-200 dpi color or 200 dpi grayscale
Images for an inkjet printer 150-300 dpi
Images for a high-resolution printer 300-600 dpi

Scanning above these recommended resolutions may exceed the capabilities of the application. If you require a resolution above those recommended in the
above table, you should reduce the size of the image by previewing (or pre-scan) and cropping before scanning the image.

ﬂ NOTE: You can use PaperPort's built-in Optical Character Recognition (OCR) software to copy text from scanned documents so that you can use and edit
the text in any text editing, word processing, or spreadsheet program. The OCR process requires textual images scanned at 150-600 dpi and 300 dpi or
600 dpi is recommended for graphics.

If you prefer to use another application, such as Adobe PhotoShop, you must assign the application to the printer by selecting it from the list of available
applications through the Select Software button each time you start scanning. If you do not assign an application to the Select Software button, PaperPort is
automatically selected when you start scanning. See "Printer Settings Utility".

Dell ScanCenter is a PaperPort application that enables you to scan items and send them directly to PaperPort or other programs on your computer without
first running PaperPort. Dell ScanCenter runs as a separate application from the Windows start menu and displays the Dell ScanCenter bar. For more
information about using Dell ScanCenter, refer to the PaperPort's Help menu.

_l,n_i FETIEREE j

document inbo the ADF face up or placa your document on the scanner glars lace down.
ﬁmmmammnmmmumm

Icons on the Dell ScanCenter bar represent the programs that are limited to PaperPort and to Dell ScanCenter. To scan and send an item to a program, click
the program icon and then scan the item. Dell ScanCenter automatically starts the selected program when the scan is complete.

Scanning From the Operator Panel

ﬂ NOTE: Ensure that the printer is connected to the computer using the USB cable.

1. Load the document(s) face up with top edge in first into the ADF.
OR
Place a single document face down on the document glass.

For details about loading a document, see "Loading an Original Document”.

2. Press "W until >SCAN appears, and then press v .

3. Press " until Scan to Application, and then press v.
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4. Press D . The selected application window opens. Adjust the scan settings and start scan. For details, refer to the user's guide of the application.

ﬂ NOTE: If the following dialog box appears on your PC, select 2135cn MFP Scan Button Manager, and then click OK.

MFP Scanner

Scanner Button Event

Sedect the program to launch for this action;

[ Asbwaps wse this program for this action

ﬂ NOTE: Once you check the Always use this program for this action check box when selecting 2135cn MFP Scan Button Manager, the selected
application is automatically used without displaying the program selection window.

ﬂ NOTE: Note that you must use ScanButton Manager on your computer to change the settings for scanning. For details, see "Printer Settings Utility".

Scanning Using the TWAIN Driver

Your printer supports the Tool Without An Interesting Name (TWAIN) driver for scanning images. TWAIN is one of the standard components provided by
Microsoft® windows® 2000, Windows XP, Windows server® 2003, Windows Server 2008, and Windows Vista®, and works with various scanners.

To scan an image from the drawing software:

1. Load the document(s) face up with top edge in first into the ADF.
OR
Place a single document face down on the document glass.

For details about loading a document, see "Loading an Original Document”.

2. Start the drawing software, such as Imaging for Windows.

ﬂ NOTE: When you use Windows XP, Windows Server 2003, or Windows Vista, use PaperPort instead of Imaging.

3. Click File»>Scan or Get Photo...
The Available Scanner dialog box appears.

ﬂ NOTE: If the Available Scanner dialog box does not appear, click the Select... button in the left pane of the Scan or Get Photo window.

4. In the Available Scanner dialog box, select TWAIN: Dell 2135cn MFP Scanner, and then click OK.

5. In the left pane of the Scan or Get Photo window, select the Display scanner dialog box check box, and then click Scan.

The Dell 2135cn MFP Scanner window appears.
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ﬂ NOTE: The illustration may vary for different operating systems.

6. Select your scanning preferences and click Preview to display the preview image.
7. Select the desired properties from the Image Quality and Image Options tabs.
8. Click Scan to start scanning.

9. Enter a picture name, and select a file format and destination to save the picture.

10. Follow the on-screen instructions to edit the picture after it is copied to your computer.

Scanning Using the Windows Image Acquisition (WIA) Driver

Your printer also supports the WIA driver for scanning images. WIA is one of the standard components provided by Microsoft Windows XP and later operating
systems and works with digital cameras and scanners. Unlike the TWAIN driver, the WIA driver allows you to scan an image and easily manipulate those
images without using additional software.

ﬂ NOTE: WIA is not available for Windows 2000.

ﬂ NOTE: Ensure that the printer is connected to the computer using the USB cable.

To scan an image from the drawing software:

1. Load the document(s) face up with top edge in first into the ADF.
OR
Place a single document face down on the document glass.

For details about loading a document, see "Loading an Original Document”.

2. Start the drawing software, such as Paint for Windows.

ﬂ NOTE: When you use Windows Vista or Windows Server 2008, use Windows Photo Gallery instead of Paint.

3. Click File»From Scanner or Camera.

The Scan using Dell 2135cn MFP Scanner window appears.
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ﬁ NOTE: The illustration may vary for different operating systems.

4. Select your scanning preferences and click Adjust the quality of the scanned picture to display the Advanced Properties dialog box.
5. Select the desired properties including brightness and contrast, and then click OK.

6. Click Scan to start scanning.

7. Enter a picture name, and select a file format and destination to save the picture.

8. Follow the on-screen instructions to edit the picture after it is copied to your computer.

To scan an image from Control Panel:

1. Load the document(s) face up with top edge in first into the ADF.
OR
Place a single document face down on the document glass.

For details about loading a document, see "Loading an Original Document”.

2. Click start—>Control Panel-Printers and Other Hardware—Scanners and Cameras.

3. Double-click the scanner icon. The Scanner and Camera Wizard launches.

4. Click Next to display the Choose Scanning Preferences page.

0 Black andwi s or bt

Or.\n-

Fapar souce:
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ﬁ NOTE: The illustration may vary for different operating systems.

5. Select your scanning preferences and click Next.
6. Enter a picture name, and select a file format and destination to save the picture.

7. Click Next to start scanning.
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8. Follow the on-screen instructions to edit the picture after it is copied to your computer.

Using a Scanner on the Network

The Scan to Server/Computer feature allows you to scan a document from the printer and store it in a folder on your computer through File Transfer Protocol
(FTP) or Server Message Block (SMB). To retrieve the scanned document from the computer:

1. Create a shared folder in your computer for Scan to Computer. See "Sharing a Folder From Your Computer"” for more details.

2. Setup the address book through the Dell Printer Configuration Web Tool. See "Setting Up the Address Book" for more details.

Create a shared folder with sub-folder in your computer for Scan to Computer. See "Sharing a Folder With Sub-folder From Your Computer” for more
details.

4. Start to send the scanned file on the network. See "Sending the Scanned File on the Network" for more details.

Here are some additional instructions if you need to create a password for your user account or locate the IP address of your computer.
1 Create a Password For Your User Login Account.

1 Locate the IP Address Of Your Computer.

Sharing a Folder From Your Computer
If you are using Microsoft Windows XP or Windows 2000, you can share a folder with the following instructions:
1. Create a folder in the desired directory on your computer (Example of folder name, MyShar e).
2. Right-click on the folder, and then select Properties.
3. The Properties dialog box appears, click on the Sharing tab, and then select Share this folder.
4. Enter a shared name in the Share name box.

ﬂ NOTE: Write down this shared name because you will use this name in the next setting procedure.

e

m:a oo enabie shain for this ok, chck, Shase thes
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5. Click on Permissions to create a write permission for this folder.

6. Click Add.

7. Enter your user login name in the Enter the object names to select box (Example of user login name, Wsel f).



Select this object lype:

ﬁmm;ammm I | otiect Types... |
From this location:
(200611002 | [Ctocstons.. |
Enter the obi o

| Check Names

ﬁ NOTE: User login account with empty password will be rejected in the Scan to Folder authentication. Ensure that all user login accounts have a
valid and non-empty password. See "Creating a Password for Your User Login Account" for details on how to assign a password for your user
login account.

8. Click OK.

ﬁ NOTE: Do not use Everyone as the user login name.

9. Click on the user login name that you have just entered. Select Full Control check box. This will grant you permission to send the document into this
folder.

Proaiszions or Mysek Alow Doy
FullContrel o] [m)]
Change = [m}
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If you are using Windows Vista or Windows Server 2008, you can share a folder with the following or similar instructions:

1. Create a folder in the desired directory on your computer (Example of folder name, MyShar e).

2. Right-click on the folder, and then select Properties.

3. The Properties dialog box appears, click on the Sharing tab, and then select Advanced Sharing.
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4. Select the Share this folder check box.

5. Enter a shared name in the Share name box.



ﬁ NOTE: Note down the shared name as you need to use this name in the next setting procedure.

6. Click on Permissions to create a write permission for this folder.

ey —— |
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7. Click Add.

8. Enter your user login name in the Enter the object names to select box (Example of user login name, Msel f).

T N

Select this object type:

Users. Groups. or Builin securty prncibals Mml
[From this location:

AwFC [tocmons.._] |
Ertor e o .

NOTE: User login account with empty password will be rejected in the Scan to Folder authentication. Ensure that all user login accounts have a
valid and non-empty password. See "Creating a Password for Your User Login Account"” for details on how to assign a password for your user
login account.

9. Click OK when you are done.

10. Click on the user login name that you have just entered. Select Full Control check box. This will grant you permission to send the document into this
folder.

ﬁ NOTE: Do not use Everyone as the user login name.

Lo about
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Setting Up the Address Book

To setup the Scan to Server/Computer address book through the network, you will first need to locate the IP address of the printer. You can obtain this IP
address from the System Settings page by performing the following steps:



From the Printer Operator Panel

1. Press " until >SETUP appears, and then press v .
2. Press W until >Reports appears, and then press V’ .

3. System Settings is displayed. Press v .

The System Settings page is printed.

From Your Computer

1. Click start— All Programs— Dell Printers— Additional Color Laser Software— Quick Launch Utility.

The Quick Launch Utility dialog box opens.

2. Click the Tool Box button.

The Tool Box dialog box opens.

3. Select the printer from Printer Name.

The Tool Box opens.

4. Click the Printer Settings Report tab.

5. Select Reports from the list at the left side of the page.

The Reports page is displayed.

6. Click the System Settings button.
The System Settings page is printed.

Once you have obtained the IP address of the printer, you can setup the Address book by performing the following steps.
1. Open a web browser.
2. Type in the IP address of the printer in the address bar and click Go. The printer's web page appears.

3. Click Address Book, then click the Server Address tab, then click the Create button. If a security login dialog box appears, type in the correct User
Name and Password.
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Printer Status

Printer Jobs

Printer Settings

Print Server Settings
Copy Printer Settings
Print Volume
Address Book

Printer Information
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Dell 2135¢cn MFP
IPe4:

Lacation:

Contact Person:

E-Mail Address

Server Address

SBMIRHNI’ESS] Phone Book ]

Address List to: 01-20 2]-321

Tray Settings Server Addrass
ID:Name: Server Address
E-Mail Alert 01-{Not in Use) _Create |
Set Password 02:(Not in Use) Create
Online Help 03:(Not in Use) Create
Order Supplies at: 04:{Hot in Use) Create
www.dell.com/supplies .
05:(Not in Use) Create
Contact Dell Support at:
support.dell,l:nrﬂp D6:{Not in Use) Create
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D8:{Not in Use) Create
09:¢Nat in Use) Create
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13:(Nat in Use) Create
14:{Not in Use) Create
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16:(Mot in Use) Create 7
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Help

Printer Status
Printer Jobs

Printer Settings
Print Server Settings
Copy Printer Settings
Print Volume
Address Book
Printer Information
Tray Settings

E-Mail Alert

Set Password

Online Help

Order Supplies at:

www.dell.com/supplies

support.dell.com

Contact Dell Support at:

Dell 2136¢cn MFP

Pud;

Lacation
Contact Person:

l E-Mail Address I SEF\IBIRHNI'ESS] Phone Book ]

Server Address
Server Address

[}

Server Type

01 {New Registration)

e.0. PeterShare, Shared Folder

®FTP O SMB

FTP{ ftpJiServer AddressiSener Path )

SHB(WServer AddressiShare NameiServer Path)

Server Address |

.0, myP GG R

Share Name |
e.0. SMB{Share, Sharedfolder)
Server Path |
e.g. FTP{pub, pubvshare), SMB(finance, financelPeter, inancelPetenSales)
Server Port Number | FTP(21, 5000 - 65535), SMB(1 39, 5000 - 65535) =
Login Hame I

e.g. FTP(anonymous, Peter), SMB(Peter, DomainiPeter

|&] pone

F——

sile

To fill in the fields, enter the information as follows:

Name

Enter a friendly name that you want it to appear on the address book.

Server Type

Select Server Message Block (SMB) if you storing the document in a shared folder from your Microsoft Windows operating system. Select
FTP if you have a FTP server.

NOTE: FTP Server depends on Microsoft Internet Information Services (11S) and may not be installed on your computer. See the Microsoft
document for detailed instructions on how to setup FTP server.

Server
Address

Enter the IP address of the computer or the FTP server that you have shared out. (See "Locating the IP Address of Your Computer"” for
more information)

Server Port
Number

Enter the Server Port Number. If you are unsure, you can enter the default value of 139 for SMB and 21 for FTP.

Login Name

Enter the user account name that has access to the shared folder on your computer or FTP server.

Login
Password

Check on Enable Password and enter the password corresponding to the above login name.

NOTE: Empty password is not valid in the Scan to Computer feature. Ensure that you have a valid password for the user login account.
(See "Creating a Password for Your User Login Account"” for details on how to add a password in your user login account).

Share Name

Enter the name of the shared folder on the recipient computer. For SMB only.

Server Path

Enter the path where you want the scanned document to be stored. Ensure that the path is already created in the shared folder or FTP
server.

4. Click the Apply New Settings button.

Example of an entry for Scan to Computer, SMB.
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Printer Status
Printer Jobs

Printer Settings
Print Server Settings
Copy Printer Settings
Print Volume
Address Book
Printer Information
Tray Settings

E-Mail Alert

Set Password

Online Help

Order Supplies at:
www.dell.com/Supplies

Contact Dell Support at:

support.dell.com

1 hndes, hie

Dell 2136¢cn MFP

IPe4:
Location:
Contact Person:

E-Mail Address Server Address ] Phone Book ]

Server Address

Server Address

]

Server Type

Server Address

Share Name

Server Path

Server Port Number

Login Hame

01 {(New Registration)

[MyShareame

e.g. PeterShare, Shared Folder

CFTP & SMB
FTP{ ftpJiServer AddressiSener Path )

SHB(WServer AddressiShare MameiServer Path )

i

.0, myP GG R

|MyShare

e.0. SMB{Share, Sharedfolder)

e.g. FTP{pub, pubishare), SMB(finance, financelPeter, financelPetensales)

[izs FTP(21, 5000 - 65535). SMB(1 39, 5000 - 65535)

|MySe[i

e.0. FTP{anorymous, Peler), SMB(Peter, DomainFeten)

Example of an entry for Scan to Server, FTP.
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Location
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Server Address

Server Address
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Server Type

Server Address

Share Name

Server Path

Server Port Number

Login Hame

01 {(New Registration)

[MyShareame

e.g. PeterShare, Shared Folder

@ FTP O SMBE
FTP{ ftpJiServer AddressiSener Path )
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|MyShare
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[putsshare
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e.9. FTP(anorymous, Peter), SWB(Peter, DomainiPeten

ﬁ NOTE: Ensure that you enter an IP address in the Server Address box correctly.

Sharing a Folder With Sub-folder From Your Computer

b |
[T [ inweme: 7

To create and share a folder, follow the steps found in "Sharing a Folder From Your Computer". To add sub-folder, you will need to create a sub-folder from

your share folder.

1. Create a folder in the desired directory on your computer (Example of folder name, MyShare).

2. From the folder, create your desired sub-folder. (Example of sub-folder name, MyPi c\ John. You should now see My/Shar e\ M/Pi c\ John in your directory)

After you have created a folder and sub-folder, you will now need to setup the Address Book. See "Setting Up the Address Book" for the details.

Example of an entry for Scan to Computer with sub-folder, SMB.
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Server Type
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Share Name

Server Path
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01 {(New Registration)
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e.0. PeterShare, Shared Folder
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SMB(WServer AddressiShare NamelServer Path )
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ﬁ NOTE: Ensure that you enter an IP address in the Server Address box correctly.

Sending the Scanned File on the Network

1. From the operator panel, press W until >SCAN appears, and then press \/ .

2. Press " until Scan to Network appears.

3. Press € or ¥ to select the option you selected in "Setting Up the Address Book", and then press V’ .

Server : Stores the scanned image on the server by using the FTP protocol.

Conput er : Stores the scanned image on the computer by using the SMB protocol.

Search Address: Select the server address registered in Address Book.

ﬁ NOTE: Users need to be registered before you can select Server or Conput er on the operator panel.

4. Press D to send the scanned files.

Creating a Password for Your User Login Account

The Scan to Computer/Server feature requires a user login account with a valid and non-empty password for authentication. If you do not use a password for

=
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your user login, you can create a password on your User Login Account with the following instructions.

For Microsoft Windows XP and Windows 2000:

1. Click start— Control Panel— User Accounts.
2. Click Change an account.

3. Click Create a password and add in a password for your user login account.

For Windows Vista:

1. Click Start— Control Panel.
2. Click User Accounts and Family Safety.
3. Click User Accounts.

4. Click Create a password and add in a password for your user login account.

For Windows Server 2008:

1. Click Start— Control Panel.
2. Double-click User Accounts.

3. Click Create a password for your account and add in a password for your user login account.

Locating the IP Address of Your Computer

You can locate the IP address of your computer with the following instructions.

1. Click start— Run.
For Windows 2000/Windows Server 2003/Windows Server 2008: Click Start— Run.
For Windows Vista: Click Start— All Programs— Accessories— Run.

2. Type cmd in the text field and click OK. A command prompt window will open.

3. Typeipconfig and press Enter.

4. Note down the IP Address XxXx.XXX.XXX.XXX.

Sending an E-Mail with the Scanned Image
To send an e-mail attached with the scanned image from your printer, follow the steps below:

1 Set E-Mail Alert
1 Register a user

1 Start to send e-mail with the scanned file

Setting an E-Mail Alert

1. From the Dell Printer Configuration Web Tool, click E-Mail Alert.

The E-Mail Server Settings page appears.



crosoft Internet Explorer

| Ele Eck Wew Favortes Tooks Help - |
| ek - = - @[ A | Qoearch (lFavortes Freda 3| By S | s
| aetess (] mrpiy e L1 pndex b ol o

Dell 2136¢cn MFP

Ped:

Printer Status

Laocation:

Printer Jobs Contact Person:

Printer Settings

Print Server Settings

Copy Printer Settings Print Server Reports | Print Server Settings I Other Features 1

Print Volume =
Basic Information | Port Settings | TCPAP | E-Mail Alert | SNMP | Scanto PC

Address Book

E-Mail Alert - Refresh

Printer Information

e EMail Server Settings . [
E-Mail Alert Primary SMTP Gateway HEEE

Set Password SMTP Port Number EE {25,587, 5000 - 65535)
Online Help E-Mail Send Authentication E'Inualid vI

Order Supplies at: SMTP Login User

www.dell.com/Supplies

SMTP Login Password E*’ 3!
Contact Dell Support at:
support.dell.com Re-enter SMTP Login Password f"“*‘*
POP3 Server Address |
POP3 Port Number E'I 10 {110, 5000 - 55535)
FOP User Name |
POP User Passworid E** s
Re-enter POP User Password
Reply Address E o -
{Sent with every E-Mail)
SHMTP Server Connection Connection pending until printer sends an alert

E-Mail Alert Settings

E-Mail List 1 E-Mail List 2
= | =
Mnte E-bail lists are rarma delimited and un fn 266 rhararters maw e nsed th etore all adidrecses in earch list ;I
—
5] [ [ [ anteme y

2. Specify the settings for E-Mail Alert as follows:
Primary SMTP Gateway: Enter the IP address of the e-mail server.

E-Mail Send Authentication: Specify Invalid to enable the e-mail server.

ﬁ NOTE: If the error message including 016- 506 or 016- 764 is displayed, contact your server administrator for the settings for E-Mail Send
Authentication.

3. Click the Apply New Settings button.

Registering a New User

1. From the Dell Printer Configuration Web Tool, click Address Book, and then click the E-Mail Address tab.

2. Click the Create button.

The E-Mail Address page for registering a new user appears.
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3. Enter the following:
1 Name

1 Address

4. Click the Apply New Settings button.

Sending an E-mail With the Scanned File

1. From the operator panel, press W until >SCaN appears, and then press \/ .
2. Press " until Scan to E-Mail appears, and then press “ .

3. Press M or W to select the setting listed below, and then press v .
Enter E-Mil : Type the e-mail address directly.

Address Book: Select the e-mail address registered in the Address Book.

ﬁ NOTE: Users need to be registered before you can select Address Book on the operator panel.

4. Press » to select TOor BCC.

A




5. Press D to send e-mail.
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FAX Country Setting

The FAX country setting is used to set the country where your printer is used. This is a requirement for using the FAX service on the printer.
There are two ways to set the country settings:

1 Fax Initial Setup - a part of the installation software

1 Printer operator panel - follow "FAX Country Setting Procedure”

You will have to use the operator panel and follow the instructions below, if:

1 You purchased your printer with a new Dell computer
1 You have finished Windows Installer setup without completing FAX Initial Setup

1 You wish to change the country settings of where your printer is used

FAX Country Setting Procedure

To set the country settings from the printer operator panel:

1. Press " until >SETUP appears, and then press v .
2. Press W until >Adni n Menu appears, and then press \/ .
3. Press " until >Fax Setti ngs appears, and then press v .

4. Press W until >Count ry appears, and then press v .

5. Select the country where the printer is used.

The printer must be rebooted after you set the country settings. When a message prompting you to reboot the printer appears, select Yes. After the reboot,
the top menu is displayed on the operator panel.

6. Press " until >SETUP appears, and then press v,

7. Press " until >Adni n Menu appears, and then press v .

8. Press W until >System Settings appears, and then press ( .

9. Press " until >0 ock Setti ngs appears, and then press v .
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10. >Set Date is displayed. Press “ .

11. Specify the date using the number keypad, and then press v .
12. Press "W until >Set Time appears, and then press v .

13. Specify the time using the number keypad, and then press v .
14. Press " until >Date For mat appears, and then press v .

15. Specify the date format using »or €, and then press \/ .

16. Press " until >Ti me For mat appears, and then press v .

17. Specify the time format using P or €, and then press \/ .

18. Press W until >Ti me Zone appears, and then press v .

19. Specify the time zone using  or € , and then press ¥ .

ﬂ NOTE: In case of either one, when you configure the country setting, the information, which is registered to the device, is initialized.

Setting the Printer 1D

In most countries, you are required by law to indicate your fax number on any fax you send. The printer ID, containing your telephone number and name or
company name, will be printed at the top of each page sent from your printer.

& NOTE: The following settings can be configured also using Fax Initial Setup on the Windows Installer.

1. Press "W until >SETUP appears, and then press v
2. Press " until >Adni n Menu appears, and then press v.
3. Press " until >Fax Setti ngs appears, and then press v .

4. Press W until >Fax Nunber appears, and then press (

5. Enter your fax number using the number keypad.

4 NOTE: If you make a mistake while entering numbers, press € to delete the last digit.

6. Press v when the number on the display is correct.

7. Press W until >Fax Header Name appears, and then press v

8. Enter your name or company name using the number keypad.
You can enter alphanumeric characters using the number keypad, including special symbols by pressing the 1, *, and # buttons.

For details on how to use the number keypad to enter alphanumeric characters, see "Using the Number Keypad to Enter Characters”.

9. Press v when the name on the display is correct.

10. Press X to return to the standby mode.

Using the Number Keypad to Enter Characters

As you perform various tasks, you may need to enter names and numbers. For example, when you set up your printer, you enter your name or your company's
name and telephone number. When you store speed dial or group dial numbers, you may also need to enter the corresponding names.



1 When prompted to enter a letter, press the appropriate button until the correct letter appears on the display.
For example, to enter the letter O, press 6.

o Each time you press 6, the display shows a different letter, M, N, O and finally 6.

o To enter additional letters, repeat the first step.

o Press “ when you are finished.

Keypad Letters and Numbers

Key | Assigned numbers, letters or characters
@:./1
abcABC2

defDEF3

ghiGHI14

jKIJKL5

mnoMNOG6

pqrsPQRS7

tuvTuVvs

wWXyzWXYZ9
0

Clo | |N|o|lu]ld]w]|N|F

*

*

@. ¥ _1"#$5%8& ~~| ;:?,(space) +-*/=()[1{}<>

Changing Numbers or Names

If you make a mistake while entering a number or name, press € to delete the last digit or character. Then enter the correct number or character.

Inserting a Pause

For some telephone systems, it is necessary to dial an access code and listen for a second dial tone. A pause must be entered in order for the access code to

function. For example, enter the access code 9 and then press / before entering the telephone number. "-" appears on the display to indicate when a pause
is entered.

Setting the Time and Date

ﬂ NOTE: It may be necessary to reset the correct time and date if loss of power to the printer occurs.

ﬂ NOTE: The following settings can be configured also using Fax Initial Setup on the Windows Installer.

To set the time and date:

1. Press " until >SETUP appears, and then press v .
2. Press " until >Admi n Menu appears, and then press v .
3. Press W until >System Settings appears, and then press ( .

4. Press " until >0 ock Setti ngs appears, and then press v .



5. >Set Date is displayed. Press (

6. Enter the correct date using the number keypad.

ﬂ NOTE: If you make a mistake while entering numbers, press € to reenter the digit.

7. Press v when the date on the display is correct.

8. Press W until >Set Time appears, and then press v .

9. Enter the correct time using the number keypad.

10. Press V’ when the time on the display is correct.

11. press X to return to the standby mode.

ﬂ NOTE: The printer beeps and does not allow you to proceed to the next step if a wrong number is entered.

Changing the Clock Mode

You can set the current time using either the 12-hour or the 24-hour format.
ﬂ NOTE: The following settings can be configured also using Fax Initial Setup on the Windows Installer.
1. Press " until >SETUP appears, and then press v .
2. Press " until >Admi n Menu appears, and then press v .
3. Press W until >System Settings appears, and then press ( .
4. Press " until >0 ock Setti ngs appears, and then press v .
5. Press W until >Ti e For mat appears, and then press \/ .

6. Press " until the desired format appears, and then press v .

7. press X to return to the standby mode.

Setting Sounds

Speaker Volume

1. Press " until >SETUP appears, and then press v .

2. Press W until >Adni n Menu appears, and then press \/ .

3. Press "W until >Fax Setti ngs appears, and then press v .
4. Press W until >Li ne Moni tor appears, and then press \/ .

5. Press ¥ until the desired volume appears, and then press v .

6. Reboot the printer by turning the power switch off and then on again.

Ringer Volume



1. Press W until >SETUP appears, and then press \/ .

2. Press " until >Adni n Menu appears, and then press v .

3. Press " until >Fax Setti ngs appears, and then press v .

4. Press W until >R ng Tone Vol une appears, and then press ( .

5. Press 2 until the desired volume appears, and then press v .

6. Reboot the printer by turning the power switch off and then on again.

Specifying the Fax Settings

Changing the Fax Settings Options

1. Press W until >SETUP appears, and then press \/ .

2. Press " until >Adni n Menu appears, and then press v .

3. Press "W until >Fax Setti ngs appears, and then press v .

4. Press W until the desired menu item appears, and then press v .

5. Use ? to find the status or use the number keypad to enter the value for the option you have selected.

6. Press v to save the selection.

7. Press O to return to the previous screen.

8. If necessary, repeat steps 4 through 7.

9. To return to the standby mode, press X.

Available Fax Settings Options

You can use the following settings options for configuring the fax system:

Option Description
You can select the default fax receiving mode.

1 Fax: (automatic receive mode)

1 Telephone (manual receive mode): Automatic fax reception is turned off. You can receive a fax by picking up the handset of the
external telephone and then pressing the remote receive code, or by setting OnHook to On (you can hear voice or fax tones from the
remote machine) and then pressing

1 Telephone/Fax: When the printer receives an incoming fax, the external telephone rings for the time specified in Auto Rec Fax/Tel ,

Receive and then the printer automatically receives a fax. If an incoming call is not a fax, the printer beeps from the internal speaker indicating
Mode that the call is a telephone call.

1 Ans Machine/Fax: The printer can share a telephone line with an answering machine. In this mode, the printer will monitor the fax
signal and pick up the line if there are fax tones. If the phone communication is using serial transmission in your country (such as
Germany, Sweden, Denmark, Austria, Belgium, Italy, France and Switzerland), this mode is not supported.

1 DRPD: Before using the Distinctive Ring Pattern Detection (DRPD) option, distinctive ring service must be installed on your telephone
line by the telephone company. After the telephone company has provided a separate number for faxing with a distinctive ring pattern,
configure the fax setup to monitor for that specific ring pattern.

Auto Rec Sets the interval at which the printer goes into the fax receive mode after receiving an incoming call. The interval can be specified within the
Fax range of O to 255 seconds. The default is 0 second.

Auto Rec Sets the interval at which the printer goes into the fax receive mode after the external telephone receives an incoming call. The interval can
Fax/Tel be specified within the range of O to 255 seconds. The default is 6 seconds.

Auto Rec Sets the interval at which the printer goes into the fax receive mode after the external answering machine receives an incoming call. The
Ans/Fax interval can be specified within the range of 0 to 255 seconds. The default is 21 seconds.

Line Monitor | Sets the volume of the line monitor, which audibly monitors a transmission through the internal speaker until a connection is made.




Ring Tone Sets the volume of the ring tone, which indicates that an incoming call is a telephone call through the internal speaker when Recei ve Mde is
Volume set to Tel ephone/ Fax.
You can select the default line type.
Line Type 1 PSTN
1 PBX

Tone/Pulse

You can select the dialing type.

1 Tone
1 Pulse (10PPS)
1 Pulse (20PPS)

g(::;d You can specify the interval between transmission attempts within the range of 3 to 255 seconds. The default is 8 seconds.
Redial You can specify the number of redial attempts to make when the destination fax number is busy, within the range of 0 to 13. If you enter O,
Attempts the printer will not redial.

Redial Delay

Your printer can automatically redial a remote fax machine if it was busy. Intervals from 1-15 minutes can be entered.

You can reject faxes sent from unwanted stations. The system only accepts faxes from the remote stations registered in the speed dial. This
feature is useful for blocking any unwanted faxes.

Junk Fax
Setup Select O f to turn the feature off. Anybody can send you a fax.
Select On to turn the feature on.
Remote . . . s
Receive You can receive a fax by pressing the remote receive code on the external telephone after picking up the handset of the telephone.

Remote Rcv
Tone

You can specify the tone when Renot e Recei ve is set to On.

Fax Header

Prints the sender's information on the header of faxes.

Select O f to turn this feature off.

Select On to turn this feature on.

Fax Header
Name

Specifies the sender's name to be printed on the header of faxes.

Fax Number

Specifies the fax number of the printer, which will be printed on the header of faxes. This feature is available when you set Fax Header to On.
The number specified in Fax Number is used in the printer ID.

Ez)g(ecover You can set whether to attach a cover page to faxes when sending faxes.
Before using the Distinctive Ring Pattern Detection (DRPD) option, distinctive ring service must be installed on your telephone line by the
DRPD . . - PR . !
Pattern telephone company. After the telephone company has provided a separate number for faxing with a distinctive ring pattern, configure the fax
setup to monitor for that specific ring pattern.
You can set your printer to forward incoming faxes to another fax number. When a fax arrives at your printer, it is stored in the memory.
Then, the printer dials the fax number that you have specified and sends the fax.
Sent Fax Select Only On Error to forward incoming faxes when an error occurs.
Fwd
Select On to always forward incoming faxes.
Select O f not to forward incoming faxes.
Fax Fwd P S . .
Number You enter the fax number of the destination to which incoming faxes will be forwarded.
E?i):]tFWd You can set whether to print all forwarded incoming faxes.

Fax Fwd Err
Print

Prints incoming faxes that failed to be forwarded when Fax Fwd Print is set to Off.

Prefix Dial You can specify whether or not to set a prefix dial number.
Prefix Dial You can set a prefix dial number of up to five digits. This number dials before any auto dial number is started. It is useful for accessing the
Num Private Automatic Branch Exchange (PABX).

Discard Size

When receiving a document as long as or longer than the paper installed in your printer, you can set the printer to discard any excess at the
bottom of the page. If the received page is outside the margin you set, it will print on two sheets of paper at the actual size. When the
document is within the margin and Di scard Si ze is set to Auto Reducti on, the printer reduces the document to fit it onto the appropriate
sized paper and discard does not occur. If Di scard Size is set to other than Auto Reducti on, the data within the margin will be discarded.

ECM You can set whether to enable or disable the ECM (Error Correction Mode).
Modem You can set the modem speed.
Speed
Country You can select the country where the printer is used.
Fax Activity | You can set whether to automatically print a fax activity report after every 50 incoming and outgoing fax communications.
Fax ) - .
5 You can set whether to print a transmission result after a fax transmission.
Transmit
Broadcast You can set whether to print a transmission result after a fax transmission to multiple locations.

Fax Protocol

You can set whether to print the protocol monitor report after a fax transmission to monitor fax protocol problems.




ﬂ NOTE: Prefix Dial only supports the environment where you send a fax to the external line number. To use Prefix Dial, you must do the following from
the operator panel.

1. Use " and » to select SETUP—Adni n Menu—Fax Setti ngs—Li ne Type. Select PBX, and then press v .

2. Use W and » to select SETUP>Admi n Menu—Fax Setti ngs—Prefix Dial . Select On, and then press \/ .

3. Use %" and > to select SETUP—Adni n Menu—Fax Setti ngs—Prefix D al Num Enter a maximum of five-digit prefix number from 0-9, *, and #.

Advanced Fax Settings

ﬂ NOTE: The advanced fax settings are only meant for advanced users. Incorrect settings on the Dell™ 2135cn Color Laser Multifunction Printer may
damage the device.

If you are experiencing fax send or receive errors, there is an advanced fax settings menu which you can access and change the settings accordingly.

To enter the Diagnostic Menu (Customer Mode), follow the instructions.

1. Turn off the Dell 2135cn Color Laser Multifunction Printer.
2. Disconnect all network, phone line, and USB cables from the device.
3. Turn on the Dell 2135cn Color Laser Multifunction Printer while holding down the % and A button. The Customer Mbde menu appears.

4. After all the advanced fax settings have been made, you will need to turn off and on the Dell 2135cn Color Laser Multifunction Printer for the new
settings to be effective.

Fax Data Encoding Method

Some of the legacy fax devices do not support the Joint Bi-level Image Experts Group (JBIG) data encoding method. You may experience fax send or receive
errors due to this data encoding method. You can disable the JBIG and select the Modified Huffman (MH), Modified Read (MR), or Modified Modified Read (MMR)
encoding with the following instructions.

You can change the modem transmission encoding with the following instructions.

1. When the printer is in Cust oner Mbde, select Fax/ Scanner Di ag and press v button.

2. Press the W button until Par anet er appears, then press the \( button.

3. Press the " button until FAX Par anet er appears, then press the v button.

4. Press the ¥ button until GM TX Codi ng appears, then press the v button.

5. Press the W button until MR appears, then press the \/ button to enable MMR encoding, select MR to enable MR encoding, or select MH to enable MH

encoding.

You can change the modem receive encoding with the following instructions.
1. When the printer is in Cust oner Mbde, select Fax/ Scanner Di ag and press v button.
2. Press the W button until Par anet er appears, then press the \/ button.
3. Press the " button until FAX Par anet er appears, then press the v button.
4. Press the ¥ button until GM RX Codi ng appears, then press the “ button.
5. Press the W button until MR appears, then press the V’ button to enable MMR encoding, select MR to enable MR encoding, or select MH to enable MH

encoding.

Sending a Fax

You can fax data from your printer. You can also directly fax data transferred from the computer running a Microsoft® windows® operating system.



Loading an Original Document
You can use the ADF or the document glass to load an original document for faxing. Using the ADF, you can load up to 35 sheets of 75 g/m2 (20 |b) paper at a

time. Using the document glass, you can load one sheet at a time.
ﬁ NOTE: To get the best scan quality, especially for gray scale images, use the document glass instead of the ADF.
To fax a document using the Automatic Document Feeder (ADF):

1. Place the document(s) face up on the ADF with the top edge of the documents in first. Then adjust the document guides to the correct document size.

2. Adjust the document resolution, referring to "Adjusting the Document Resolution”.

To fax a document from the document glass:

1. Open the document cover.

2. Place the document face down on the document glass and align it with the registration guide on the top left corner of the glass.

Adjust the document resolution, referring to "Adjusting the Document Resolution".

4. Close the document cover.
NOTE: Ensure that no document is in the ADF. If any document is detected in the ADF, it takes priority over the document on the document glass.

ﬂ NOTE: If you are faxing a page from a book or magazine, lift the cover until its hinges are caught by the stopper and then close the cover. If the book or

magazine is thicker than 30 mm, start faxing with the cover open.

Adjusting the Document Resolution

Use the Document Resolution setting to improve the output quality of the original or if scanning photographic materials.



1. Press W until >FAX appears, and then press v

2. Press " until Resol uti on appears.

3. Press ? to select the desired setting, and then press V’ .

ﬁ NOTE: * denotes the factory default setting.

Standard* | Used for documents with normal sized characters.

Fine Used for documents containing small characters or thin lines or documents printed using a dot-matrix printer.

Used for documents containing extremely fine detail. The super fine mode is enabled only if the remote machine also supports the Super Fine

Super Fine resolution. See the note below.

Photo Used for documents containing photographic images.

ﬂ NOTE: Faxes scanned in the Super Fine resolution transmit at the highest resolution supported by the receiving device.

Lighter/Darker
Adjust the contrast to make the fax lighter or darker than the original.

To adjust the contrast:
1. Load the document to be faxed on the document glass, and close the cover.
2. Press "W until >FAX appears, and then press v .
3. Press " until Li ghter/ Darker appears.

4. Press Y to select the desired setting, and then press \/ .

4 NOTE: * denotes the factory default setting.

Normal* | Works well with standard typed or printed documents.

Darkerl

Darker2 | Works well with light print or faint pencil markings.

Darker3

Lighter3

Lighter2 | Works well with dark print.

Lighterl

5. Press D to begin faxing.

Sending a Fax Automatically

1. Load the document(s) face up with top edge in first into the ADF.
OR
Place a single document face down on the document glass.

For details about loading a document, see "Loading an Original Document”.

2. Press "W until >FAX appears, and then press v .

3. Adjust the document resolution to suit your fax needs (see "Adjusting the Document Resolution").

If you need to change the contrast, see “Lighter/Darker".

4. Press " until Phone Book appears, and then press v .

You can use speed or group dial numbers. For details, see "Automatic Dialing".



5. Press " until the desired number appears, and then press \/ .

Press O

6.

7. Press D .
For the document loaded on the document glass, the display asks if you want to load another page. Press » to select Yes or No, and then press (
After all of the pages are scanned, select No when the display shows "Anot her Page?".

8. The number is dialed and then the printer begins sending the fax when the remote fax machine is ready.

ﬂ NOTE: Press X to cancel the fax job at any time while sending the fax.

Sending a Fax Manually

1. Load the document(s) face up with top edge in first into the ADF.
OR
Place a single document face down on the document glass.

For details about loading a document, see "Loading an Original Document”.

2. Press W until >FAX appears, and then press ( .

3. Adjust the document resolution to suit your fax needs (see "Adjusting the Document Resolution").

If you need to change the contrast, see "Lighter/Darker".
4. Press " until >0nHook appears.

5. Press Y to select On, and then press ( .

6. Enter the remote fax machine's fax number using the number keypad.
1 If the document is loaded on the ADF, press D .

1 If the document is not loaded on the ADF, press D , press » until the desired setting appears, and then press (

ﬂ NOTE: Press X and v to cancel the fax job at any time while sending the fax.

Confirming Transmissions

When the last page of your document has been sent successfully, the printer beeps and returns to the standby mode.
If something goes wrong while sending your fax, an error message appears on the display.

If you receive an error message, press X to clear the message and try to send the document again.

You can set your printer to print a confirmation report automatically after each fax transmission. For further details, see "Printing a Report”.

Automatic Redialing

If the number you have dialed is busy or there is no answer when you send a fax, the printer will automatically redial the number every minute based on the
number set in the redial settings.

To change the time interval between redials and the number of redial attempts, see "Available Fax Settings Options".

ﬂ NOTE: The printer will not automatically redial a number that was busy when the number was manually entered.

Sending a Delayed Fax

The Delayed Start mode can be used to save scanned documents for transmission at a specified time in order to take advantage of lower long distance rates.



1. Load the document(s) face up with top edge in first into the ADF.
OR
Place a single document face down on the document glass.

For details about loading a document, see "Loading an Original Document".

2. Press W until >FAX appears, and then press v

3. Adjust the document resolution to suit your fax needs (see "Adjusting the Document Resolution").

If you need to change the contrast, see "Lighter/Darker"”.
4. Press W until Del ayed Start appears.
5. Press ¥ to select On, and then press V’ .

6. Enter the start time using the number keypad, and then press ( .

7. Press "W until Phone Nunber appears.

8. Enter the number of the remote machine using the number keypad, and then press v .

To enter the number, you can use speed dial or group dial numbers. For details, see "Automatic Dialing".

Press D to scan data.

Once Delayed Start mode is activated, your printer stores all of the documents to be faxed into its memory and sends them at the specified time. After faxing
in the Delayed Start mode is complete, the data in the memory is cleared.

ﬂ NOTE: If you turn off and on the printer, the stored documents are sent as soon as the printer is activated.

Sending a Fax from the Driver (Direct Fax)

You can send a fax directly from your computer by using the driver.

[E4 NOTE: Only black and white faxes can be sent using Direct Fax.

Example

Send data vis the
Dell 2135cn MFP Fax driver

] E Sending machine {Dall Receiving machine (fax
. - 2135cn Color Laser » machinefmuktifunction
iﬁd—“‘ Multifunction Printer) printer}

Sand fax

Procedure

ﬁ NOTE: The names of the dialog boxes and the buttons may be different from those given in the following procedure depending on the application you
are using.

1. Open the file you want to send by fax.
2. Open the print dialog box from the application, and then select Dell 2135cn MFP Fax.

3. Click Preferences.



4. The Printing Preferences dialog box opens. You can use the FAX Settings to set the following settings.

E NOTE: The settings done here are only applied to a single fax job.

| Lmwms=iie wl

o) (o ) o )

a. Transmission image quality
Purpose:
To set the output quality.

Values:

ﬂ NOTE: * denotes the factory default setting.

Standard For documents with normal sized characters.
For documents containing small characters or thin lines or documents printed using a dot-matrix printer.

High Quality*

Super-high image For documents containing extremely fine detail. The super fine mode is enabled only if the remote machine also supports Super Fine
quality resolution. See the notes below.

ﬂ NOTE: Faxes printed in the Super-high image quality by Direct Fax driver transmits at the highest resolution supported by the receiving device.

b. Transmission report

Purpose:

To specify whether or not to print a fax transmission result.
Values:

ﬂ NOTE: * denotes the factory default setting.

Output regularly Prints a transmission result after every fax transmission.

Output for non-transmission™ | Prints a transmission result only when an error occurs.

Does not print fax transmission results.

Do not output




c. Fax Cover Page Settings
Clicking this button displays the Fax Cover Page Settings dialog box.

You can specify if you want to attach a cover page to your fax.

Fax Cover Page
Purpose:
This option allows you to specify whether to attach a cover page to your fax.

Values:

ﬂ NOTE: * denotes the factory default setting.

Use Printer Determines whether or not to attach a cover page to your fax depending on the setting you specify in Fax Cover Page on the operator
Settings panel.

Attach Attaches a cover page to your fax.

None* Does not attach a cover page to your fax.
Sender

Purpose:

Select whether to print the sender's name on the fax cover page.

Values:

& NOTE: * denotes the factory default setting.

Use Printer Settings™ | Determines whether or not to print the sender's name on the fax cover page based on the printer settings.

Enter a sender name | Allows you to enter a sender's name that will be printed on the fax cover page in Sender Name.

Sender Name
This option allows you to enter a sender's name that will be printed on the fax cover page.

The sender's name can be up to 30 characters. If it exceeds 30 characters, only the first 30 characters will be valid.

5. Click OK to close the Printing Preferences dialog box.

6. Click Print. The Set/Check Fax Transmission: dialog box opens.

7. Enter the destination for the recipient. The following procedure is for entering the destination. For details on how to enter the destination, please refer
to the Help file for the driver.
a. Enter the name and phone number directly.

b. Specify a destination that is saved to the Phone Book on the PC.

c. Specify a destination that is saved to the Address Book on the Dell 2135cn Color Laser Multifunction Printer.*

* This can only be used if the PC and the Dell 2135cn Color Laser Multifunction Printer are connected with a USB cable.
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ﬂ NOTE: Enter the password in the Password field in the Authorization area before sending a fax if the Fax service is locked with a password
(SETUP — Adnmin Menu — Secure Settings — Function Enabl ed). If you do not enter the correct password, the fax will not be sent. You can check
whether or not the fax was correctly sent on the Job History Report (SETUP — Reports — Job Hi story).

Receiving a Fax

About Receiving Modes

ﬂ NOTE: To use the Tel ephone/ Fax or Ans Machi ne/ Fax, attach an answering machine to the phone connector () on the back of your printer.

When the memory is full, the fax is received in the Tel ephone mode.

Loading Paper for Receiving Faxes

The instructions for loading paper in the paper tray are the same whether you are printing, faxing, or copying, except that faxes can only be printed on Letter-,
A4-, or Legal-sized paper. For details about loading paper, see "Loading Print Media". For details about setting the paper type and size in the tray, see "Print
Media Guidelines".

Receiving a Fax Automatically in the Fax Mode
Your printer is preset to the fax mode at the factory.
If you receive a fax, the printer automatically goes into the fax mode after a specified period of time and receives the fax.

To change the interval at which the printer goes into the fax mode after receiving an incoming call, see "Available Fax Settings Options".

Receiving a Fax Manually in the Telephone Mode

You can receive a fax by picking up the handset of the external telephone and then pressing the remote receive code (see "Available Fax Settings Options"),

or by setting OnHook to On (you can hear voice or fax tones from the remote machine) and then pressing ¥ .

The printer begins receiving a fax and returns to the standby mode when the reception is completed.

Receiving a Fax Automatically in the Telephone/Fax or Ans Machine/Fax
To use the Tel ephone/ Fax or Ans Machi ne/ Fax mode, you must attach an external telephone to the phone connector () on the back of your printer.

If the caller leaves a message, the answering machine stores the message as it would normally. If your printer hears a fax tone on the line, it automatically
starts to receive a fax.

ﬂ NOTE: If you have set your printer to Ans Machi ne/ Fax and your answering machine is switched off, or no answering machine is connected to your
printer, your printer will automatically go into the Fax mode after a predefined time.
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Receiving a Fax Manually Using an External Telephone

This feature works best when you are using an external telephone connected to the phone connector () on the back of your printer. You can receive a fax
from someone you are talking to on the external telephone without having to go to the printer.

When you receive a call on the external telephone and hear fax tones, press the two-digit keys on the external telephone, or set OnHook to & f and then

press ¥ .
The printer receives the document.
Press the buttons slowly in sequence. If you still hear the fax tone from the remote machine, try pressing the two-digit keys once again.

The remote receive code is set to O f at the factory. You can change the two-digit number to whatever you choose. For details on changing the code, see
"Available Fax Settings Options".

ﬂ NOTE: Set the dialing system of your external telephone to DTMF.

Receiving Faxes Using the DRPD

The DRPD is a telephone company service which enables a user to use a single telephone line to answer several different telephone numbers. The particular
number someone uses to call you on is identified by different ringing patterns, which consist of various combinations of long and short ringing sounds.

Before using the Distinctive Ring Pattern Detection option, Distinctive Ring service must be installed on your telephone line by the telephone company. To set
up Distinctive Ring Pattern Detection, you will need another telephone line at your location, or someone available to dial your FAX number from outside.

To set up the DRPD:

1. Press " until >SETUP appears, and then press v
2. Press " until >Admi n Menu appears, and then press v .

3. Press W until >Fax Setti ngs appears, and then press ( .

4. Press W until >DRPD Pattern appears.

5. Use ¥ to select the desired setting, and then press v .

6. To return to the standby mode, press X.

To receive faxes in the DRPD, you need to set the menu to DRPD; see "Available Fax Settings Options".

Your printer provides seven DRPD patterns. If this service is available from your telephone company, ask your telephone company which pattern you need to
select to use this service.

Receiving Faxes in the Memory

Since your printer is a multi-tasking device, it can receive faxes while you are making copies or printing. If you receive a fax while you are copying, printing, or
run out of paper or toner, your printer stores incoming faxes in the memory. Then, as soon as you finish copying, printing, or re-supply the consumables, the
printer automatically prints the fax.

Polling Receive

You can receive faxes from the remote fax machine when you want to receive it.
1. Press " until >FAX appears, and then press v
2. Press " until Pol | i ng Receive appears.

3. Press » to select On, and then press ‘/ .

4. Enter the fax number of the remote machine.

ﬂ NOTE: For information on how to enter the fax number of the remote machine, see "Sending a Fax Manually" or "Sending a Fax Automatically".

5. Press D B



Automatic Dialing

Speed Dialing
You can store up to 200 frequently dialed numbers in speed dial locations (001-200).

When the speed dial job specified in the delayed fax or redial exists, you cannot change the speed dial number from the operator panel or Dell Printer
Configuration Web Tool.

Storing a Number for Speed Dialing

1. Press " until >FAX appears, and then press v .

2. Press W until Add PhoneBook Ent ry appears, and then press V‘ .

3. Press " until >Speed Di al appears, and then press v .

4. Enter the three-digit speed dial number between 001 and 200, using the number keypad, and then press V{

5. Enter the settings for Name, and Phone Number by using v v and number keys.

If a number is already stored in the location you chose, the display shows the number to allow you to change it. To start over with another speed-dial
number, press .

6. Enter the number you want to store using the number keypad, and then press v .

To insert a pause between numbers, press , . "-" appears on the display.

7. To assign a name to the number, enter the name. For details about how to enter names, see "Using the Number Keypad to Enter Characters”.

If you do not want to assign a hame, skip this step.

8. To store more fax numbers, repeat steps 4 through 6.

To return to the standby mode, press X.

Sending a Fax Using a Speed Dial

1. Load the document(s) face up with top edge in first into the ADF.
OR
Place a single document face down on the document glass.

For details about loading a document, see "Loading an Original Document”.

2. To enter the speed dial number do either of the following:

a. Press W until >FAX appears, and then press v .

b. Press % until Speed Dial appears.

c. Use the Keypad buttons to enter the three-digit speed dial number between 001 and 200, using the number keypad, and then press v .

The corresponding entry's name briefly displays. To confirm the name again, press v .

3. Adjust the document resolution to suit your fax needs (see "Adjusting the Document Resolution”).

If you need to change the contrast, see "Lighter/Darker".

4. Press D .

5. The document scans into the memory.



When the document is loaded on the document glass, the LCD display asks if you want to send another page. Press » to select Yes to add more

documents or to select No to begin sending the fax immediately, and then press v .

6. The fax number stored in the speed dial location is automatically dialed. The document is sent when the remote fax machine answers.

NOTE: Using the asterisk (*) in the first digit, you can send a document to multiple locations. For example, if you enter 00*, you can send a document to
the locations registered between 001 and 009.

Group Dialing

If you frequently send the same document to several destinations, you can create a group of these destinations and set them under a one-digit group dial
location. This enables you to use a group dial number setting to send the same document to all the destinations in the group.

& NOTE: You cannot include one group dial number within another group dial number.

Setting Group Dial

1. Press " until >FAX appears, and then press v .
2. Press " until Add PhoneBook Ent ry appears, and then press v .
3. Press W until >@ oup Dial appears, and then press \/ .

4. Enter the one-digit group dial number between 1 and 6, using the number keypad, and then press v .

If a number is already stored in the location you chose, the display shows the number to allow you to change it. To start over with another group-dial
number, press .

5. Enter the name you want to store using the number keypad, and then press v . For details about how to enter names, see "Using the Number Keypad
to Enter Characters”.

6. Speed Dial No is displayed. Press(.

7. Press W until the desired number appears, and then press ‘/ .

8. To store more group dial numbers, repeat steps 4 through 7.

To return to the standby mode, press X.

Editing Group Dial Numbers

You can delete a specific speed dial number from a selected group or add a new number to the selected group.

1. Press " until >FAX appears, and then press v .

2. Press " until Add PhoneBook Ent ry appears, and then press v .

3. Press W until >@ oup Dial appears, and then press \/ .

4. Enter the one-digit speed dial number between 1 and 6, using the number keypad, and then press v .

5. Enter the one-digit group dial number between 1 and 6, using the number keypad, and then press ( .
6. >Nane is displayed.

To edit the name of an existing group dial number, or enter a name for a new group dial number, press« .

7. Edit or enter the name, and then press“ .

8. To edit the speed dial number of an existing group dial number, or enter a speed dial number for a new group dial number, press W until >Speed Di al
No is displayed, and then press\/.



9. Edit or enter the speed dial number, and then press“.

10. To delete an existing group dial number, press % until >Del et e G oup appears, and then press v .

ﬂ NOTE: When you delete the last speed dial in a group, the group itself is not deleted.
ﬂ NOTE: To cancel your selection after pressing V’ , press X.
11. If you want to edit another group dial number or enter a new group dial number, repeat steps 4 to 9.

12. To return to the standby mode, press X.

Sending a Fax Using Group Dialing (Multi-address Transmission)
You can use group dialing for Broadcasting or Delayed transmissions.

Follow the procedure of the desired operation (For Delayed transmission, see “Specifying the Fax Settings"”).

You can use one or more group numbers in one operation. Then continue the procedure to complete the desired operation.

Your printer automatically scans the document loaded in the Automatic Document Feeder or on the document glass into the memory. The printer dials each of
the numbers included in the group.

Printing a Speed Dial List

You can check your automatic dial setting by printing a Speed Dial list.

1. Press W until >SETUP appears, and then press ‘/ .
2. Press " until >Adni n Menu appears, and then press v .
3. Press W until >Adni n Reports appears, and then press \/ .

4. Speed Dial is displayed. Press «

A list of your speed dial entries is printed.

Other Ways to Fax

Using the Secure Receiving Mode

You may need to prevent your received faxes from being accessed by unauthorized people. You can turn on the secure fax mode using the Secure Receive
option to restrict printing out all of the received faxes when the printer is unattended. In the secure fax mode, all incoming faxes will go in memory. When the
mode turns off, any faxes stored will be printed.

ﬂ NOTE: Before operation, ensure Panel Lock is enabled.
To turn the secure receiving mode on:
1. Press W until >SETUP appears, and then press \/ .
2. Press " until >Adni n Menu appears, and then press v .
3. Press " until >Secure Setti ngs appears, and then press v .
4. Press W until >Secure Recei ve appears, and then press ‘/ .
5. Press " until >Secure Recei ve Set appears, and then press v .

6. Press ? to select Enabl e, and then press ( .



7. Press the O button.
8. Press W to select Change Password, and then press \/ .
9. Enter a four-digit passcode you want to use, using the number keypad and press v .

ﬂ NOTE: When you set Secure Receive Set to Enabl e, 0000 is set by default.

10. To return to the standby mode, press the & button.

When a fax is received in the secure receiving mode, your printer stores it into memory and the JOB STATUS screen displays "Secure Recei ve" to let you
know that there is a fax stored.

To print received documents:

1. Press " until >J0B STATUS appears, and then press v .
2. Press "W until >Secure Recei ve appears, and then press \/ .

3. Enter the password, and then press «
The faxes stored in memory are printed.

To turn the secure receiving mode off:

1. Access the Secure Receive Set menu by following steps 1 to 5 in "To turn the secure receiving mode on:".

2. Press » to select Di sabl e, and then press \/ .

3. To return to the standby mode, press X.
Using an Answering Machine

To the wall
jack Printer Line Telephone Answering Device Fhone

You can connect a telephone answering device (TAD) directly to the back of your printer as shown above.
1 Set your printer to the Ans Machi ne/ Fax and set Auto Rec Ans/ Fax to specify the time for the TAD.
1 When the TAD picks up the call, the printer monitors and takes the line if fax tones are received and then starts receiving the fax.
1 If the answering device is off, the printer automatically goes into the Fax after the ring tone sounds for a predefined time.
1 If you answer the call and hear fax tones, the printer will answer the fax call if you
= Set OnHook to On (you can hear voice or fax tones from the remote machine), and then press D and hang up the receiver.
OR

= Press the two-digit remote receive code and hang up the receiver.

Using a Computer Modem



To the Computer Telephone Answering Device  Phone
Internet

If you want to use your computer modem for faxing or for a dial-up internet connection, connect the computer modem directly to the back of your printer with
the TAD as shown above.

1 Set your printer to the Ans Machi ne/ Fax and set Auto Rec Ans/ Fax to specify the time for the TAD.
1 Turn off the computer modem's fax-receive feature.
1 Do not use the computer modem if your printer is sending or receiving a fax.

1 Follow the instructions provided with your computer modem and fax application to fax via the computer modem.

Printing a Report

The following reports are available:

Speed Dial
This list shows all the numbers currently stored in the printer's memory as speed dial numbers.

You can print this Speed Dial list from the operator panel; see "Printing a Speed Dial List".

Address Book

This list shows all the addresses currently stored in the printer's memory as Address Book information.

Server Address

This list shows all of the numbers currently stored in the printer's memory as Server Address information.

Fax Activity

This report shows information about the faxes you recently received or sent.

Fax Pending

This list shows the status of pending faxes. You may print this list to confirm your changes after changing any settings.

Print Meter
This report shows the total number of pages printed. The report will be titled Dell ColorTrack Report.

Procedures:

1. Press W until >SETUP appears, and then press ‘/ .
2. Press " until >Adnmi n Menu appears, and then press v .

3. Press W until >Adni n Reports appears, and then press \/ .

4. Press ¥ to select the report or list you want to print.
A list showing your speed dial entries prints out.

1 Speed Dial : Speed Dial list



1 Address Book: Address Book list

1 Server Address: Server Address list

1 Fax Activity: Fax activity information
1 Fax Pendi ng: Pending faxes

1 Print Meter: Print volume report

5. Press “ .

The selected information prints out.

Changing Setting Options
1. Press "W until >FAX appears, and then press ( .
2. Press " until Fax Defaults appears, and then press v .

3. Press W to select the desired menu item, and then press ( .

4. When the option you want appears on the display, press > to select the desired status or enter the desired value using the number keypad.

5. Press v to save the selection.

6. You can exit from the setup mode at any time by pressing X.

Back to Contents Page
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Understanding Fonts

@ Typefaces and Fonts
@ Bitmapped and Scalable Fonts
@ Resident Fonts

@ Symbol Sets

Typefaces and Fonts

A font is a set of characters and symbols created with a distinct design. The distinct design is called a typeface. The typefaces you select add personality to a
document. Well-chosen typefaces make a document easier to read.

The printer has numerous resident fonts in PCL 5/PCL 6. See "Resident Fonts" for a listing of all resident fonts.

Weight and Style

Typefaces are often available in different weights and styles. These variations modify the original typeface so you can, for example, emphasize important
words in text or highlight book titles. The different weights and styles are designed to complement the original typeface.

Weight refers to the thickness of the lines that form the characters. Thicker lines result in darker characters. Some words commonly used to describe the
weight of a typeface are bold, medium, light, black, and heavy.

Style refers to other typeface modifications, such as tilt or character width. Italic and oblique are styles where the characters are tilted. Narrow, condensed,
and extended are three common styles that modify the character widths.

Some fonts combine several weight and style modifications; for example, Helvetica BdOb. A group of several weight and style variations of a single typeface is
called a typeface family. Most typeface families have four variations: regular, italic (oblique), bold, and bold italic (bold oblique). Some families have more
variations, as the following illustration for the Helvetica typeface family shows:

Helvetica ABCDEFGHIJKLMNOabcdefghijkimno 234567890
Hetvetica Obligue ABCDEFGHIJKLMNOabodefghikimnol 234567830
Helvetica Bold ABCDEFGHIJKL

Helvelica Bokd Oblique ABCDEFGHIJKLMNabcdefghifkimnoi234567300
Hebvatica Namow ABCDEFGHLIKLMNOabedafghilimno 1234567890

Helvalica Narrow Obligue ABCDEFGHIML mno 1234567990

Hetvetica Narrow Bold ABCDEFGHLIKLMNOabedefghijidmna 1233567800

Halvetica Navrow Bold Obligue  ABCDEFGHIJIKL

Pitch and Point Size

The size of a font is specified as either a pitch or point size, depending on whether the font is fixed space or proportional.

In fixed space fonts, each character has the same width. Pitch is used to specify the size of fixed space fonts. It is a measure of the number of characters that
will print in one horizontal inch of type. For example, all 10-pitch fonts print 10 characters per inch (cpi) and all 12-pitch fonts print 12 cpi:

Courier 10 Pitch 1234567890
Courier-Bold 10 Pitch 1234567890

Courier 12 Pitch 123456789012
Courier-Bold 12 Pitch 123456789012

-
1 Inch

In proportional (or typographic) fonts, every character can have a different width. Since proportional fonts have characters with different widths, the font size is
specified in point size, not pitch. Point size refers to the height of the characters in the font. A point is defined as 1/72 inch. The characters in a font printed at
24 point will be twice as large as the characters in the same font printed at 12 point.

The following illustration shows samples of a font printed in different point sizes:

48 point 36 point

24 pOint 18 point 12 point 10 point

The point size of a font is defined as the distance from the top of the tallest character in the font to the bottom of the lowest character in the font. Due to the
definition of point size, different fonts printed at the same point size may appear quite different in size. This is because there are other font parameters that
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affect how the font looks. However, the point size of a font is an excellent specification of the relative size of a font. The following examples illustrate two very
different proportional fonts at 14 point:

ITC Avant Garde
abcdefghABCDEFGH
I'TC Zapf Chancery
abedefghABCDEFGH

Bitmapped and Scalable Fonts

The printer uses both bitmapped and scalable fonts.

Bitmapped fonts are stored in print memory as predefined patterns of bits that represent a typeface at a specific size, style, and resolution. The following
illustration shows an example of a character from a bitmapped font.

Bitmapped fonts are available in different type styles and point sizes as downloadable fonts.

Scalable fonts (also called outline fonts) are stored as computer programs that define the outlines of the characters in the font. Each time you print characters
from a scalable font, the printer creates a bitmap of the characters at the point size you choose and saves it temporarily in print memory.

PPpr»

These temporary bitmapped fonts are deleted when you turn off or reset the printer. Scalable fonts provide the flexibility of printing in many different point
sizes.

Your printer uses different scalable font formats for downloading fonts to the printer. PCL 5/PCL 6 uses Intellifont and TrueType scalable fonts. There are
thousands of different scalable fonts available in these different font formats from numerous font suppliers.

If you plan to use many downloadable bitmapped or scalable fonts or if you plan to use many different sizes of scalable fonts, you may need to purchase
additional memory for your printer.

Resident Fonts

Your printer is equipped with resident fonts stored permanently in print memory. Different fonts are available in PCL 5/PCL 6. Some of the most popular
typefaces, like Courier and TimesNew, are available for all printer languages.

The following table lists all the fonts resident in your printer. See "Printing a Font Sample List" for instructions on how to print samples of the fonts. You can
select the resident fonts from your software program or from the operator panel.

Resident scalable fonts

PCL 5/PCL 6

CG Times

CG Times It

CG Times Bd

CG Times BdIt

Univers Md

Univers MdIt

Univers Bd

Univers Bdlt

Univers MdCd

Univers MdCdIt

Univers BdCd

Univers BdCdIt
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AntiqueOlv

AntiqueOlv It

AntiqueOlv Bd

CG Omega

CG Omega It

CG Omega Bd

CG Omega BdlIt

Garamond Antiqua

Garamond Krsv

Garamond Hib

Garamond KrsvHIb

Courier

Courier It

Courier Bd

Courier Bdlt

LetterGothic

LetterGothic It

LetterGothic Bd

Albertus Md

Albertus XBd

Clarendon Cd

Coronet

Marigold

Arial

Arial It

Arial Bd

Arial BdIt

TimesNew

TimesNew It

TimesNew Bd

TimesNew BdIt

Symbol

Wingdings

Line Printer

Times Roman

Times It

Times Bd

Times BdIt

Helvetica

Helvetica Ob

Helvetica Bd

Helvetica BdOb

CourierPS




CourierPS Ob

CourierPS Bd

CourierPS BdOb

SymbolPS

Palatino Roman

Palatino It

Palatino Bd

Palatino BdIt

ITCBookman Lt

ITCBookman Ltit

ITCBookmanDm

ITCBookmanDm It

HelveticaNr

HelveticaNr Ob

HelveticaNr Bd

HelveticaNr BdOb

N C Schbk Roman

N C Schbk It

N C Schbk Bd

N C Schbk BdIt

ITC A G Go Bk

ITC A G Go BkOb

ITC A G Go Dm

ITC A G Go DmOb

ZapfC MdIt

ZapfDingbats

Symbol Sets

A symbol set is the collection of alphabetic and numeric characters, punctuation, and special characters available in the font you select. Symbol sets support
the requirements for different languages or specific applications, such as math symbols used for scientific text.

In PCL 5/PCL 6, a symbol set also defines which character will print for each key on the keyboard (or more specifically, for each code point). Some applications
require different characters at some code points. To support multiple applications and languages, your printer has 36 symbol sets for the resident PCL 5/PCL 6

fonts.

Symbol Sets for PCL 5/PCL 6

Not all font names support all of the symbol sets listed.

Roman 8 (Default)

1SO 8859-1 Latin 1

1SO 8859-2 Latin 2

1SO 8859-9 Latin 5

1SO 8859-10 Latin 6

PC-8

PC-8 DN

PC-775 Baltic

PC-850 Multilingual

PC-852 Latin 2

PC-1004 0S/2

PC Turkish

Windows 3.1 Latin 1

Windows 3.1 Latin 2

Windows 3.1 Latin 5

DeskTop PS Text MC Text

Microsoft Publishing | Math 8 PS Math

Pi Font Legal 1SO 4 United Kingdom
1SO 6 ASCII ISO 11 Swedish:names| I1SO 15 lItalian

1SO 17 Spanish

ISO 21 German

1SO 60 Norwegian v1

1SO 69 French

Windows 3.0 Latin 1

Windows Baltic




Symbol | wingdings | ITC ZapfDingbats MS |

Back to Contents Page
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Clearing Jams

Avoiding Jams
Identifying the Location of Paper Jams
Clearing Paper Jams From the ADF

Clearing Paper Jams From the Single Sheet Feeder

Clearing Paper Jams From the Tray 1

Clearing Paper Jams From the Fuser

Careful selection of appropriate print media and proper loading allow you to avoid most jams. See "Print Media Guidelines" for more information.

ﬂ NOTE: Before buying large quantities of any print media, it is recommended to try a sample first.

Avoiding Jams

1 Use only recommended print media. See "Print Media Guidelines"” for more information.

1 See "Loading Print Media in the Tray 1" and "Loading the Single Sheet Feeder" to load print media properly.

1 Do not overload the print media sources. Ensure that the stack print media height does not exceed the maximum height indicated by the load line
labels in the tray.

Do not load wrinkled, creased, damp, or curled print media.

Flex, fan, and straighten print media before you load it. If a jam occurs with print media, try feeding one sheet at a time through the single sheet
feeder.

Do not use print media that you have cut or trimmed yourself.

Do not mix print media sizes, weights, or types in the same print media source.

Ensure that the recommended print side is face up when you insert the print media. Also, the recommended print side should be face down when using
the single sheet feeder.

Keep print media stored in an acceptable environment. For more information, see "Storing Print Media".

Do not remove the feeding tray during a print job.

Push the tray in firmly after loading.

Ensure that all cables that connect to the printer are correctly attached.

Overtightening the guides may cause jams.

Wipe the retard rollers in the tray or single sheet feeder with a cloth that is slightly dampened with water if jams caused by misfeeding paper occur
frequently.

Identifying the Location of Paper Jams

The following illustration shows where paper jams may occur along the print media path.

& CAUTION: Do not attempt to clear any jams using tools or instruments. This may permanently damage the printer.

N

Automatic Document Feeder (ADF)

N

Fuser
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w

Single Sheet Feeder

IN

Tray 1

(&)

Front Cover

Clearing Paper Jams From the ADF

When a document jams while it passes through the Automatic Document Feeder (ADF), remove jams in the following procedure.

ﬂ NOTE: To prevent document jams, use the document glass for thick, thin or mixed documents.

1. Remove the remaining documents from the ADF.

If the document is jammed in the paper feed area:

a. Open the ADF cover.

b. Lift the release lever 90 degrees and remove the document by carefully pulling it gently to the right.

If you find it difficult to pull the document:

c. Remove the release roller assembly and remove the document by gently pulling it straight up.

d. Insert the release roller assembly and press down the release lever.

If the document is jammed in the paper exit area:

a. Remove the jammed documents from the ADF output tray.



b. Close the ADF cover. Then load the documents back into the ADF.

ﬂ NOTE: Ensure that you use the ADF Paper Stop before printing a Legal-size document.

2. If you cannot see the paper or the paper does not move when you pulled, open the document cover.
3. Remove the document from the roller or the feed area by carefully pulling it gently to the right.

4. Close the document cover. Then load the documents back into the ADF.

Clearing Paper Jams From the Single Sheet Feeder

° NOTICE: Protect the drums of the Print Head Device (PHD) against bright light. If the front cover remains open for more than three minutes, print quality
may deteriorate.

ﬂ NOTE: To resolve the error displayed on the operator panel, you must clear all print media from the print media path.

1. Pull the jammed paper out of the single sheet feeder. If no jammed paper can be found or it is hard to remove the paper, go to the next step to remove
the jammed paper from the inside of the printer.

2. Remove the tray 1 from the printer, and then pull out the jammed paper remaining inside the printer. If no jammed paper can be found or it is hard to
remove the paper, go to the next step to remove the jammed paper from the inside of the printer.




3. Open the front cover by pushing the side button and remove the jammed paper. Then, confirm that there are no scraps of paper remaining inside the
printer.

4. Close the front cover.

5. Insert the tray back into the printer, and push until it stops.

Clearing Paper Jams From the Tray 1

NOTICE: Protect the drums of the Print Head Device (PHD) against bright light. If the front cover remains open for more than three minutes, print quality
may deteriorate.

ﬂ NOTE: To resolve the error displayed on the operator panel, you must clear all print media from the print media path.

1. Pull the tray out of the printer carefully. Hold the tray with both hands, lift the front slightly, and remove it from the printer.

2. Remove all the jammed and/or creased paper from the tray.



3. Pull the jammed paper out carefully to avoid tearing it. If it is still hard to remove the paper, go to the next step to remove the jammed paper from the
inside of the printer.

4. Open the front cover by pushing the side button and remove the jammed paper. Then, confirm that there are no scraps of paper remaining inside the
printer.

5. Close the front cover.

6. Insert the tray into the printer, and push until it stops.

& CAUTION: Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.



Clearing Paper Jams From the Fuser

o NOTICE: Ensure nothing touches or scratches the surface (black-colored film) of the belt unit. Scratches, dirt, or oil from your hands on the film of the
belt unit may reduce print quality.

O NOTICE: To protect the drums of the Print Head Device (PHD) against bright light. If the front cover remains open for more than three minutes, print
quality may deteriorate.

ﬂ NOTE: To resolve the error displayed on the operator panel, you must clear all print media from the print media path.

1. Turn off the printer and wait for 30 minutes.

2. Push the side button and open the front cover.

3. Lift the levers at both ends of the fuser, and remove the jammed paper. If any jammed paper cannot be found, go to the next step.

The fuser is hot. Do not touch it, doing so may cause burns.

4. Open the cover of the fuser and remove the jammed paper.

5. Close the cover of the fuser and press down the levers at both ends of the fuser.

6. Confirm that there are no scraps of paper remaining inside the printer, and then close the front cover.
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Troubleshooting Guide
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Scanning Problems
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Scanner Driver/Printer Utility Problems

Other Problems
Contacting Service

Basic Printer Problems
Some printer problems can be easily resolved. If a problem occurs with your printer, check each of the following:
1 The power cable is plugged into the printer and a properly grounded electrical outlet.
1 The printer's power is on.
1 The electrical outlet is not turned off at any switch or breaker.
1 Other electrical equipment plugged into the outlet are working.

1 Optional memory is properly installed.

If you have checked all of the above and still have a problem, turn off the printer, wait for 10 seconds, and then turn on the printer. This often fixes the
problem.

Display Problems

Problem Action

1 Turn off the printer, wait for 10 seconds, and turn on the printer.
After the printer is turned on, the display on the operator panel is blank, 1 Self Test Message appears on the operator panel. When the test is
keeps showing Pl ease wait. .., or the back light is not lit. completed, >Copy Scan Fax is displayed.

Settings in the software program, the printer driver, or the printer utilities are

Menu settings changed from the operator panel have no effect. overriding the settings made on the operator panel.

Printing Problems

Problem Action

Ensure that the top menu appears on the operator panel before you send a job to print. Press B
to return to the top menu.

Ensure that the print media is loaded in the printer. Press B to return to >Copy Scan Fax.

Verify that the printer is using the correct page description language (PDL).

Verify that you are using the correct printer driver.

Job did not print or incorrect characters printed. Ensure that the correct Ethernet or USB cable is securely connected to the printer.

Verify that the correct print media size is selected.

If you are using a print spooler, verify that the spooler has not stalled.

Check the printer's interface from the Adnin Menu.

Determine the host interface you are using. Print a panel settings page to verify that the current
interface settings are correct.

Ensure that the print media you are using meets the specifications for your printer. See "Supported
Paper Types" for more information.
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Print media misfeeds or multiple feeds occur in the tray
1 or single sheet feeder.

Fan the print media before loading it in the tray 1.

Ensure that the print media is loaded correctly.

Ensure that the width and length guides of the print media sources are adjusted correctly.

Ensure that the tray 1 is securely inserted.

Do not overfill the print media sources.

Do not force print media into the single sheet feeder when you load it; otherwise, it may skew or
buckle.

Ensure that the print media is not curled.

Load the recommended print side correctly for the type of print media you are using. See "Loading
Print Media in the Tray 1" for more information.

Turn the print media over or around and try printing again to see if feeding improves.

Do not mix print media types.

Do not mix reams of print media.

Remove the top and bottom curled sheets of a ream before loading the print media.

Load a print media source only when it is empty.

Wipe the retard rollers in the tray or single sheet feeder with a cloth that is slightly dampened with
water.

The envelope is creased after printing.

Make sure that the envelope is loaded in the tray 1 or single sheet feeder as instructed in "Loading
Envelopes" or "Loading an Envelope".

Page breaks in unexpected places.

Increase the value for Time-Out on the operator panel, the Tool Box, or Dell Printer Configuration
Web Tool.

Print media does not stack neatly in the output bin.

Turn the print media stack over in the tray.

Cannot perform manual duplex printing.

Select Flip on Short Edge or Flip on Long Edge from the Duplex menu on the Paper/Output tab in
the printer driver.

Cannot print from the tray 1 because the print media in
the tray is curled.

Load the print media into the single sheet feeder.

Print Quality Problems

ﬁ NOTE: Some of the following procedures that use the Tool Box can also be performed using the operator panel or Dell Printer Configuration Web Tool.
For information on how to use the operator panel and Dell Configuration Web Tool, see "Understanding the Menus" and "Dell Printer Configuration Web

Tool".

The entire output is too light.

N
ABC

DEF

Action Yes No
The toner cartridges may be low or need to be replaced. Confirm the amount of toner left in each toner cartridge.
1 1. Check the toner level in the Status tab in the Status Monitor. The task is Go to action
2. Replace the toner cartridges as necessary. complete. 2.
Is the problem resolved?
If you are using non-Dell brand toner cartridges, disable the Non-Dell Toner option.
> 1. Launch the Tool Box, and click Non-Dell Toner on the Printer Maintenance tab. The task is Go to action
2. Ensure that the On check box is not selected. complete. 3.
Is the problem resolved?
Disable the Toner Saving Mode in the printer driver.
3 1. On the Advanced tab, ensure that the Toner Saving Mode check box is not selected. IQ;;?S&'S Go to action
Is the problem resolved?
The print media surface may be uneven. Try changing the Paper Type setting in the printer driver. For example, change
the plain paper to thick.
4 The task is Go to action
1. On the Paper/Output tab, change the Paper Type setting. complete. 5.
Is the problem resolved?
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Verify that the correct print media is being used. See "Supported Paper Types". If not, use the print media recommended
5 for the printer. The task is Go to action
complete. 6.
Is the problem resolved?
Ensure that the eight yellow ribbons are correctly removed from the Print Head Device (PHD) unit. See "Replacing the
Print Head Device (PHD) Unit” and “Installing the PHD Unit". If not, remove the ribbons. The task is Go to action
6 complete. 7.
Is the problem resolved?
Ensure that the developer motor functions properly.
1. Launch the Tool Box, and click Machine Check on the Diagnosis tab. Contact
7 2. Select Main Motor Operation Check from the drop-down list box and click the Start button. Go to action 8. Dell
3. Click the Play of Sound button to check the motor sound. .
Does the motor function properly?
Ensure that the dispense motor for each toner cartridge functions properly.
1 Launch the Tool Box, and click Machine Check on the Diagnosis tab.
2. Select Dispense Motor Check (Yellow), Dispense Motor Check (Magenta), Dispense Motor Check (Cyan), or
Dispense Motor Check (Black) from the drop-down list box, and click the Start button.
3. Click the Play of Sound button to check the motor sound.
8 4. Repeat step 2 and 3 to perform Dispense Motor Check for the rest of the toner cartridges. Go to action 9. gg:’l\taCt
NOTE: You can perform Dispense Motor Check for CMYK in any order you desire.
Does the dispense motor function properly?
If printing many low density images, execute the Toner Refresh Mode.
1. Launch the Tool Box, and click Refresh Mode on the Diagnosis tab.
2. Click the Yellow button under Toner Refresh Mode.
3. Repeat step 3 for Magenta, Cyan, and Black buttons.
9 The task is Go to action
CAUTION: Using the Refresh Mode consumes extra toner. complete. 10.
4. After you complete the Refresh Mode, select Chart Print from the list on the Diagnosis tab.
5. Click the 4 Colors Configuration Chart button.
The 4 Colors Configuration Chart is printed.
Is the problem resolved?
Replace the PHD unit if you have a spare unit.
1. Replace the PHD unit. See "Replacing the Print Head Device (PHD) Unit" and "Installing the PHD Unit".
2. After you replace the PHD unit, click Chart Print on the Diagnosis tab. .
10| 3. Click the 4 Colors Configuration Chart button. The task is Contact
complete. Dell.
The 4 Colors Configuration Chart is printed.
Is the problem resolved?

Part of the output is too light.

Action Yes No

If printing many low density images, execute the Toner Refresh Mode.

1. Launch the Tool Box, and click Refresh Mode on the Diagnosis tab.
2. Click the Yellow button under Toner Refresh Mode.
3. Repeat step 3 for Magenta, Cyan, and Black buttons.

1 CAUTION: Using the Refresh Mode consumes extra toner. The task is complete. | Go to action 2.
4. After you complete the Refresh Mode, select Chart Print from the list on the Diagnosis tab.
5. Click the 4 Colors Configuration Chart button.
The 4 Colors Configuration Chart is printed.
Is the problem resolved?
Replace the PHD unit if you have a spare unit.
1. Replace the PHD unit. See "Installing the PHD Unit" and "Installing the PHD Unit".
2. After you replace the PHD unit, click Chart Print on the Diagnosis tab.
2 3. Click the 4 Colors Configuration Chart button. The task is complete. [ Contact Dell.

The 4 Colors Configuration Chart is printed.
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| | Is the problem resolved?

Toner smears or print comes off.
AN

ABC

DE

Action Yes No
The print media surface may be uneven. Try changing the Paper Type setting in the printer driver. For example,
change the plain paper to thick.
1 The task is Go to action
1. On the Paper/Output tab, change the Paper Type setting. complete. 2.
Is the problem resolved?
Verify that the correct print media is being used. See "Supported Paper Types". If not, use the print media
2 recommended for the printer. The task is Go to action
complete. 3.
Is the problem resolved?
Replace the PHD unit if you have a spare unit.
3 1. Replace the PHD unit. See "Replacing the Print Head Device (PHD) Unit" and "Installing the PHD Unit". The task is Go to action
2. After you replace the PHD unit, test print your document again. complete. 4.
Is the problem resolved?
Replace the fuser if you have a spare.
1. Replace the fuser. See the fuser replacement guide, Replacing the Fuser. The task is
4 f : Contact Dell.
2. After you replace the fuser, test print your document again. complete.
Is the problem resolved?
Random spots/blurred images
Action Yes No
Ensure that the toner cartridges are installed correctly. See "Installing the Toner Cartridges”. . )
1 The task is Go to action
complete. 2.
Is the problem resolved? P
Ensure that the PHD unit is installed correctly. See "Replacing the Print Head Device (PHD) Unit" and "Installing the
2 PHD Unit". The task is Go to action
complete. 3
Is the problem resolved?
Replace the PHD unit if you have a spare unit.
1. Replace the PHD unit. See "Replacing the Print Head Device (PHD) Unit" and "Installing the PHD Unit".
2. After you replace the PHD unit, click Chart Print on the Diagnosis tab. The task i
3. Click the Pitch Configuration Chart button. € task is
3 9 complete. Contact Dell.
The Pitch Configuration Chart is printed.
Is the problem resolved?

The entire output is blank.
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7

Action Yes No

The toner cartridges may be low or need to be replaced. Confirm the amount of toner left in each toner cartridge.

1 1. Check the toner level in the Status tab in the Status Monitor. The task is Go to
2. Replace the toner cartridges as necessary. complete. action 2.
Is the problem resolved?
If you are using non-Dell brand toner cartridges, disable the Non-Dell Toner option.
> 1. Launch the Tool Box, and click Non-Dell Toner on the Printer Maintenance tab. The task is Go to
2. Ensure that the On check box is not selected. complete. action 3.
Is the problem resolved?
Disable the Toner Saving Mode in the printer driver.
3 1. On the Advanced tab, ensure that the Toner Saving Mode check box is not selected. The task is GD.ID
complete. action 4.
Is the problem resolved?
The print media surface may be uneven. Try changing the Paper Type setting in the printer driver. For example, change the
plain paper to thick.
4 The task is Go to
1. On the Paper/Output tab, change the Paper Type setting. complete. action 5.
Is the problem resolved?
Verify that the correct print media is being used. See "Supported Paper Types". If not, use the print media recommended
5 for the printer. The task is Go to
complete. action 6.
Is the problem resolved?
Ensure that eight yellow ribbons are correctly removed from the PHD (Print Head Device) unit. See "Replacing the Print
Head Device (PHD) Unit" and "Installing the PHD Unit". If not, remove the ribbons. The task is Go to
6 complete. action 7.

Is the problem resolved?

Ensure that the developer motor functions properly.

1. Launch the Tool Box, and click Machine Check on the Diagnosis tab.

7 2. Select Main Motor Operation Check from the drop-down list box and click the Start button. Go to action 8. gglr;,t)a‘:t
3. Click the Play of Sound button to check the motor sound. :
Does the motor function properly?
Ensure that the dispense motor for each toner cartridge functions properly.
1. Launch the Tool Box, and click Machine Check on the Diagnosis tab.
2. Select Dispense Motor Check (Yellow), Dispense Motor Check (Magenta), Dispense Motor Check (Cyan), or
Dispense Motor Check (Black) from the drop-down list box, and click the Start button.
3. Click the Play of Sound button to check the motor sound.
8 4. Repeat step 2 and 3 to perform Dispense Motor Check for the rest of the toner cartridges. Go to action 9. ggn;ﬁﬂ
NOTE: You can perform Dispense Motor Check for CMYK in any order you desire.
Does the dispense motor function properly?
1. Replace the PHD unit. See "Replacing the Print Head Device (PHD) Unit" and "Installing the PHD Unit".
2. After you replace the PHD unit, click Chart Print on the Diagnosis tab.
3. Click the 4 Colors Configuration Chart button.
The task is Contact
9
complete. Dell.

The 4 Colors Configuration Chart is printed.

Is the problem resolved?

Streaks appear on the output.
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Action Yes No
The toner cartridges may be low or need to be replaced. Confirm the amount of toner left in each toner cartridge.
1 1. Check the toner level in the Status tab in the Status Monitor. The task is complete. | Go to action 2.
2. Replace the toner cartridges as necessary.
Is the problem resolved?
If you are using non-Dell brand toner cartridges, disable the Non-Dell Toner option.
1. Launch the Tool Box, and click Non-Dell Toner on the Printer Maintenance tab. : .
2 2. Ensure that the On check box is not selected. The task is complete. | Go to action 3.
Is the problem resolved?
Replace the PHD unit if you have a spare unit.
1. Replace the PHD unit. See "Replacing the Print Head Device (PHD) Unit" and "Installing the PHD Unit".
2. After you replace the PHD unit, click Chart Print on the Diagnosis tab.
3 3. Click the 4 Colors Configuration Chart button. The task is complete. | Contact Dell.
The 4 Colors Configuration Chart is printed.
Is the problem resolved?
Part or the entire output is black.
Action Yes No
Ensure Output Color is set to Color (Auto) in the printer driver.
1 1. On the Advanced tab, ensure that the Output Color is set to Color (Auto). The task is complete. | Go to action 2.
Is the problem resolved?
Replace the PHD unit if you have a spare unit.
1. Replace the PHD unit. See "Replacing the Print Head Device (PHD) Unit" and "Installing the PHD Unit".
2. After you replace the PHD unit, click Chart Print on the Diagnosis tab.
2 3. Click the 4 Colors Configuration Chart button. The task is complete. | Contact Dell.
The 4 Colors Configuration Chart is printed.
Is the problem resolved?

Pitched color dots

ABC
DEF
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Action Yes No
Locate the cause of the problem using the Pitch Configuration Chart.
1. Launch the Tool Box, and click Chart Print on the Diagnosis tab. Proceed to the action corresponding to the
2. Click the Pitch Configuration Chart button. location of the problem:
1 The Pitch Configuration Chart is printed. 1 PHD unit - 2a gglr;tact
1 Fuser - 2b. .
3. Compare the pitch of the color spots on your output with that on the Pitch 1 Main unit of the printer - contact Dell.
Configuration Chart, and locate the cause of the problem.
Is the cause of the problem located?
Replace the PHD unit if you have a spare unit.
1. Replace the PHD unit. See "Replacing the Print Head Device (PHD) Unit" and
"Installing the PHD Unit".
2. After you replace the PHD unit, click Chart Print on the Diagnosis tab. . Contact
2al 3. cClick the Pitch Configuration Chart button. The task is complete. Dell.
The Pitch Configuration Chart is printed.
Is the problem resolved?
Replace the fuser if you have a spare.
1. Replace the fuser. See the fuser replacement guide, Replacing the Fuser.
2. After you replace the fuser, click Chart Print on the Diagnosis tab.
2p| 3. Click the Pitch Configuration Chart button. The task is complete. golrl‘taCt
ell.
The Pitch Configuration Chart is printed.
Is the problem resolved?

Vertical blanks
N
£ B>
DE-

Action

Yes No

Ensure the light path is not covered.

Check the light path, and then remove the shielding.

1

2

3. Reinstall the PHD unit. See "Installing the PHD Unit".

4 Launch the Tool Box, and click Chart Print on the Diagnosis tab.
5. Click the Pitch Configuration Chart button.

The Pitch Configuration Chart is printed.

Is the problem resolved?

Remove the PHD unit, and keep it in the dark place. See "Replacing the Print Head Device (PHD) Unit".

The task is complete.

Go to action 2.

Replace the PHD unit if you have a spare unit.

2. After you replace the PHD unit, click Chart Print on the Diagnosis tab.

1. Replace the PHD unit. See "Replacing the Print Head Device (PHD) Unit" and "Installing the PHD Unit".

2 3. Click the Pitch Configuration Chart button. The task is complete. [ Contact Dell.
The Pitch Configuration Chart is printed.
Is the problem resolved?
Ghosting
Action Yes No

Locate the cause of the problem using the Ghost Configuration Chart.

1. Launch the Tool Box, and click Chart Print on the Diagnosis tab.
2. Click the Ghost Configuration Chart button.

Proceed to the action corresponding to the type
of ghosting.

Positive ghost - 2a

Contact Dell.
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The Ghost Configuration Chart is printed.

Is the type of the problem identified?

Negative ghost - 2b

Replace the PHD unit if you have a spare unit.

1. Replace the PHD unit. See "Replacing the Print Head Device (PHD) Unit" and

“Installing the PHD Unit".
2. After you replace the PHD unit, click Chart Print on the Diagnosis tab.

2a 3. Click the Ghost Configuration Chart button.

The Ghost Configuration Chart is printed.

Is the problem resolved?

The task is complete.

Contact Dell.

If using non-recommended print media, use the print media recommended for the

rinter.
2b P

Is the problem resolved?

Go to action 3.

Go to action
2a.

Adjust the transfer bias.

1. On the operator panel, select SETUP — Adni n Menu — Mai nt enance — Adj ust BTR.
2. Adjust the setting for the type of print media being used.
3. Launch the Tool Box, and click Chart Print on the Diagnosis tab. .
3 4. Click the Ghost Configuration Chart button. The task is complete. Contact Dell.
The Ghost Configuration Chart is printed.
Is the problem resolved?
Light fatigue
Action Yes No
Check the light fatigue pattern using the Pitch Configuration Chart.
1. Launch the Tool Box, and click Chart Print on the Diagnosis tab.
2. Click the Pitch Configuration Chart button. .
1 Go to action 2. Contact Dell.
The Pitch Configuration Chart is printed.
Does the pattern on the output match with that on the Pitch Configuration Chart?
Execute the PHD Refresh Mode.
1. Launch the Tool Box, and click Refresh Mode on the Diagnosis tab.
2. After you start the PHD Refresh Mode, click Chart Print on the Diagnosis tab. . )
2| 3. Click the 4 Colors Configuration Chart button. The task is Go to action
complete. 3.
The 4 Colors Configuration Chart is printed.
Is the problem resolved?
Replace the PHD unit if you have a spare unit. See "Replacing the Print Head Device (PHD) Unit" and "Installing the
PHD Unit". i
3 The task is Contact Dell.
complete.
Is the problem resolved?

Fog
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Action

Yes

Execute the PHD Refresh Mode.

1. Launch the Tool Box, and click Refresh Mode on the Diagnosis tab.
2. After you start the PHD Refresh Mode, click Chart Print on the Diagnosis tab.
1 3. Click the 4 Colors Configuration Chart button.

The 4 Colors Configuration Chart is printed.

Is the problem resolved?

The task is complete.

Go to action 2.

Replace the PHD unit if you have a spare unit.

1. Replace the PHD unit. See "Replacing the Print Head Device (PHD) Unit" and "Installing the PHD Unit".
2. After you replace the PHD unit, click Chart Print on the Diagnosis tab.

2 3. Click the 4 Colors Configuration Chart button. The task is complete. | Contact Dell.
The 4 Colors Configuration Chart is printed.
Is the problem resolved?
Bead-Carry-Out (BCO)
Action Yes No
If the printer is installed in a high altitude location, set the altitude of the location.
1 1. Launch the Tool Box, and click Adjust Altitude on the Printer Maintenance tab. The task is Go to action
2. Select the value close to the altitude of the location where the printer is installed. complete. 2.
Is the problem resolved?
Replace the PHD unit if you have a spare unit. See "Replacing the Print Head Device (PHD) Unit" and "Installing the
PHD Unit". i
2 The task is Contact Dell.
complete.
Is the problem resolved?
Jagged characters
Action Yes No
Set Print Mode to High Quality in the printer driver.
. . - . The task is Go to action
1 1. On the Graphics tab, select High Quality from Print Mode. complete. 5.
Is the problem resolved?
Enable Bitmap Smoothing in the printer driver.
2 1. On the Advanced tab, set Bitmap Smoothing under Items: to On. The task is Go to action
complete. 3.
Is the problem resolved?
Enable Bitmap Text Smoothing in the printer driver.
. . R The task is Go to action
3 1. On the Advanced tab, set Bitmap Text Smoothing under Items: to On. complete. 4.
Is the problem resolved?
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application being used.

If using a downloaded font, ensure that the font is recommended for the printer, operating system, and the

The task is

complete. Contact Dell.
Is the problem resolved?
Banding
Action Yes No
Locate the cause of the problem using the Pitch Configuration Chart. . . X
Proceed to the action corresponding to the location
of the problem:
1. Launch the Tool Box, and click Chart Print on the Diagnosis tab. P
2. Click the Pitch Configuration Chart button.
1 9 1 PHD unit - 2a Contact
Dell.
. ) ) . } 1 Fuser - 2b
The Pitch Configuration Chart is printed. I Main unit of the printer - contact Dell
Is the cause of the problem located?
Replace the PHD unit if you have a spare unit.
1. Replace the PHD unit. See "Replacing the Print Head Device (PHD) Unit" and
“Installing the PHD Unit".
2. After you replace the PHD unit, click Chart Print on the Diagnosis tab. . Contact
2al 3. click the Pitch Configuration Chart button. The task is complete. Dell.
The Pitch Configuration Chart is printed.
Is the problem resolved?
Replace the fuser if you have a spare.
1. Replace the fuser. See the fuser replacement guide, Replacing the Fuser.
2. After you replace the fuser, click Chart Print on the Diagnosis tab.
ob| 3. Click the Pitch Configuration Chart button. The task is complete. go:'l‘ta“
ell.
The Pitch Configuration Chart is printed.
Is the problem resolved?
Auger mark
Action Yes No
Locate the cause of the problem using the Pitch Configuration Chart.
1. Launch the Tool Box, and click Chart Print on the Diagnosis tab.
2. Click the Pitch Configuration Chart button. .
1 Go to action 2. Contact Dell.
The Pitch Configuration Chart is printed.
Does the output match with the pattern for auger mark?
Execute the Developer Stir Mode.
1. Launch the Tool Box, and click Developer Stir Mode on the Diagnosis tab.
2. Click the Start button.
3. After you execute the Developer Stir Mode, click Chart Print on the Diagnosis tab. The task is Go to action
2| 4. click the Pitch Configuration Chart button. complete. 3.

The Pitch Configuration Chart is printed.
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Is the problem resolved?

Replace the PHD unit if you have a spare unit. See "Replacing the Print Head Device (PHD) Unit" and "Installing the

PHD Unit".

The task is
3 complete. Contact Dell.
Is the problem resolved?
Creased/stained paper
TTTm—
Action Yes No
Verify that the correct print media is being used. See "Supported Paper szapnntmg on an envelope, go to action
Types"”. If not, use the print media recommended for the printer. X .
1 The task is complete.
Is the problem resolved? If printing on print m_edla other than
envelopes, go to action 2b.
If the envelope is 220 mm or longer (C5
o ) ) ) or COM-10), go to action 3a.
2a Check the crease. Is the crease within 30 mm of the four edges of the This type of crease is considered
envelope? normal. Your printer is not at fault. .
If the envelope is shorter than 220 mm
(Monarch or DL), go to action 3b.
Execute the Paper Wrinkle Check Mode.
1. Launch the Tool Box, and click Paper Wrinkle Check Mode on
2b the Diagnosis tab. Contact Dell. Go to action 3c.
2. Click the Start button.
Is the paper wrinkled?
3a| Does the envelope have a flap on the long edge? The envelope is C5. Go to action 4a. | The envelope is COM-10. Go to 4b.
Load the envelope long edge feed in the tray 1 with the flap open.
3b The task is complete. Go to action 4b.
Is the problem resolved?
Replace the fuser if you have a spare. See the fuser replacement guide,
Replacing the Fuser. X
3c The task is complete. Contact Dell.
Is the problem resolved?
Load the envelope in the tray 1 with the flap open and face down.
4a The task is complete. Go to 4b.
Is the problem resolved?
Use a different size envelope.
4b The task is complete. Contact Dell.
Is the problem resolved?

A

bnormal Noise

NOTE: Some of the following procedures that use the Tool Box can also be performed using the operator panel or Dell Printer Configuration Web Tool.
For information on how to use the operator panel and Dell Configuration Web Tool, see "Understanding the Menus" and "Dell Printer Configuration Web

Tool".
Action Yes No
Locate the cause of the problem by removing the toner cartridges, fuser, and the PHD unit.
1. Remove the toner cartridges, fuser, and PHD unit. See "Removing the Used Toner Cartridge”, "Replacing the Print Head
Device (PHD) Unit", and the fuser replacement guide, Replacing the Fuser. Contact Go to
1 2. Launch the Tool Box, and click Machine Check on the Diagnosis tab. Dell action 2
3. Select Main Motor Operation Check from the drop-down list box, and click the Start button. . :
4. Click the Play of Sound button to check the motor sound.
Does the noise generated from the printer match with the noise from the Play of Sound button?
1. On the Machine Check page, select Fuser Motor Operation Check from the drop-down list box, and click the Start
button.
2| 2. Click the Play of Sound button to check the motor sound. Contact | Go to
Dell. action 3.
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Does the noise generated from the printer match with the noise from the Play of Sound button?
1. On the Machine Check page, select Dispense Motor Check (Yellow), Dispense Motor Check (Magenta), Dispense
Motor Check (Cyan), or Dispense Motor Check (Black) from the drop-down list box, and click the Start button.
2. Click the Play of Sound button to check the motor sound.
3. Repeat steps 1 and 2 to perform Dispense Motor Check for the rest of the toner cartridges.

3 . i . Contact Go to
NOTE: You can perform Dispense Motor Check for CMYK in any order you desire. Dell. action 4.
NOTE: Do not check the operation of the dispense motor repeatedly.

Does the noise generated from the printer match with the noise from the Play of Sound button?
1. Reinstall the fuser.
2. Perform action 3 again. Contact Go to

4 Dell. action 5.
Does the noise generated from the printer match with the noise from the Play of Sound button?

1. Reinstall the PHD unit.
2. Perform action 3 again. Contact Go to

5 Dell. action 6.
Does the noise generated from the printer match with the noise from the Play of Sound button?

1. Reinstall the toner cartridges.
6 2. Perform action 3 again. Contact Contact
Dell. Dell.
Does the noise generated from the printer match with the noise from the Play of Sound button?

Jam/Alignment Problems

NOTE: Some of the following procedures that use the Tool Box can also be performed using the operator panel or Dell Printer Configuration Web Tool.

For information on how to use the operator panel and Dell Configuration Web Tool, see "Understanding the Menus" and "Dell Printer Configuration Web
Tool".

The top and side margins are incorrect.

N

ABC
DEF

Action Yes No

Ensure that the margins are set correctly on the application being used.

The task is complete. | Contact Dell.
Is the problem resolved?

The color registration is out of alignment.

e
ABC
DEF

Action

Execute auto color registration adjustment.

1 1. Launch the Tool Box, and click Registration Adjustment on the Printer Maintenance tab. The task is

Go to action
2. Click Auto Correct under Color Registration Adjustments.

complete. 2.

Is the problem resolved?
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Go to action

2. ldentify the offset values from the chart and and enter them in Color Registration Adjustment 1 (Lateral) and
Color Registration Adjustment 2 (Process). See "Adjusting Color Registration” for details.

3. Click the Apply New Settings button.

4. Click the Color Regi Chart button to print the Color Regi Configuration Chart again.

Is the problem resolved?

2 | Do you have a spare PHD unit? Go to action 3a. 3b
Replace the PHD unit if you have a spare unit.
1. Replace the PHD unit. See "Replacing the Print Head Device (PHD) Unit" and "Installing the PHD Unit".
2. On the Registration Adjustment page, click the Color Regi Chart button. The task is Contact
3a complete. Dell.
The Color Regi Configuration Chart is printed.
Is the problem resolved?
Print the Color Regi Configuration Chart and manually correct the color registration.
1. On the Registration Adjustment page, click the Color Regi Chart button.
The Color Regi Configuration Chart is printed.
The task is Contact
3b
complete. Dell.

Misfeed jam

Action Yes No

Proceed to the action corresponding to the type of the
print media being used:

1 Thick - 2a
. . 1 Thin-2b
Ensure that the tray 1 is properly inserted. The task is I Coated - 2¢
1 complete. 1 Envelope - 2d
Is the problem resolved?
If performing manual duplex printing, go to action 2e.
If using paper other than the above or if not performing
manual duplex printing, go to action 2f.
Use Thick paper that is 216 gsm or less. X
The task is .
2a Go to action 3a.
complete.
Is the problem resolved?
Use Thin paper that is 216 gsm or less. h Ki
2b The task is Go to action 3a.
complete.
Is the problem resolved?
Load Coated paper one sheet at a time. X
The task is .
2¢ Go to action 3b.
complete.
Is the problem resolved?
Ensure that the envelope is properly loaded in the tray 1 or single sheet
feeder as instructed in "Loading Envelopes" or "Loading an Envelope". The task is .
2d Go to action 3c.
complete.
Is the problem resolved?
Ensure that the print media is not curled. X
The task is .
2e Go to action 3a.
complete.
Is the problem resolved?
2f | Is the print media damp? gg to action Go to action 3a.
Fan the print media. h i
3a Io;;;laestels Go to action 3b.
Is the problem resolved? :
Wipe the retard roller in the tray 1 with a cloth moistened with water. X
The task is .
3b Go to action 4b.
complete.
Is the problem resolved?
If the envelope is deformed, correct it or use another envelope. X
The task is .
3c Go to action 3a.
complete.
Is the problem resolved?
Turn over the print media. Th i
3d © task is Go to action 4a.
complete.
Is the problem resolved?
Use print media that is not damp. X
The task is .
4a Go to action 3a.
complete.
Is the problem resolved?
Replace the PHD unit if you have a spare unit. Th i
4b e task is Contact Dell.
complete.

Is the problem resolved?
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Jam at the Regi Sensor

Action Yes No
Ensure that the PHD unit is installed correctly. See "Replacing the Print Head Device (PHD) Unit" and "Installing the
1 PHD Unit". The task is Go to action
complete. 2.
Is the problem resolved?
Replace the PHD unit if you have a spare unit. See "Replacing the Print Head Device (PHD) Unit" and "Installing the
PHD Unit". i
2 The task is Contact Dell.
complete.
Is the problem resolved?
Jam at the Exit Sensor
Action Yes No
Ensure that the fuser is installed correctly. For information on how to install the fuser, see the fuser replacement
1 guide, Replacing the Fuser. The task is Go to action
complete.
Is the problem resolved?
Replace the PHD unit if you have a spare. See "Replacing the Print Head Device (PHD) Unit" and "Installing the PHD
Unit". The task is
2 complete. Contact Dell.
Is the problem resolved?
Multi-feed jam
Action Yes No
Ensure that the tray 1 is properly inserted. If using Coated paper, go to action 2a.
1 The task is complete.
Is the problem resolved? If using other type of print media, go to action 2b.
Load Coated paper one sheet at a time.
2 The task is complete. | Go to action 4b.
Is the problem resolved?
3 | Is the print media damp? Go to action 4a. Go to action 4b.
Use print media that is not damp.
4a The task is complete. | Go to action 4b.
Is the problem resolved?
Fan the print media.
4b The task is complete. | Go to action 5.
Is the problem resolved?
Wipe the retard roller in the tray 1 with a cloth moistened with water.
5 The task is complete. | Contact Dell.
Is the problem resolved?

A document jam occurs in the ADF if scanning of multiple-sheet document is cancelled
while scanning is in progress.

Action Yes No

Clear the jam. See "Clearing Paper Jams From the ADF".

The task is complete. | Contact Dell.
Is the problem resolved?

Copy Problem
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Problem

Action

A document loaded in the ADF cannot be copied.

Ensure that the ADF cover is firmly closed.

Ensure that the release lever is properly positioned.

Fax Problems

Problem

Action

The printer is not working, there is no display
and the buttons are not working.

Unplug the power cord and plug it in again.

Ensure that there is power to the electrical receptacle.

No dial tone sounds.

Check that the phone line is connected properly. See "Connecting the Telephone Line".

Check that the phone socket in the wall is working by plugging in another phone.

The numbers stored in the memory do not
dial correctly.

Ensure that the numbers are stored in the memory correctly.

Print a Phone Book list.

The document does not feed into the printer.

Ensure that the document is not wrinkled and you are putting it in correctly. Check that the document is of
the right size, not too thick or thin.

Ensure that the ADF cover is firmly closed.

Faxes are not received automatically.

The FAX mode should be selected.

Ensure that there is paper in the paper tray.

Check to see if the display shows Menory Ful | .

The printer does not send faxes.

Ensure that the document is loaded in the ADF or on the document feeder glass.

Sendi ng should show up on the display.

Check the other fax machine you are sending to, to see if it can receive your fax.

The incoming fax has blank spaces or is
received in poor-quality.

The fax machine sending you the fax may be faulty.

A noisy phone line can cause line errors.

Check your printer by making a copy.

The toner cartridge may be empty. Replace the toner cartridge, referring to "Replacing Toner Cartridges".

Some of the words on an incoming fax are
stretched.

The fax machine sending you the fax had a temporary document jam.

There are lines on the documents you send.

Check your scan glass for marks and clean it. See "Cleaning the Scanner”.

The printer dials a number, but the
connection with another fax machine fails.

The other fax machine may be turned off, out of paper, or cannot answer incoming calls. Speak with the
other machine operator and ask her/him to sort out the problem.

Documents are not stored in the memory.

There may not be enough memory to store the document. If the display shows a Menory Ful | message,
delete any documents you no longer need from the memory and then restore the document, or wait for the
job in progress (e.g., a fax transmission or reception) to complete.

Blank areas appear at the bottom of each
page or on other pages, with a small strip of
text at the top.

You may have chosen the wrong paper settings in the user option setting. See "Print Media Guidelines".

The printer will not send or receive faxes.

Ensure that the country code is set correctly under SETUP — Adnin Menu — Fax Settings — Country.

An error often occurs during a fax
transmission or reception.

Reduce the modem speed under SETUP — Adni n Menu — Fax Settings — Mbdem Speed.

Scanning Problems

Problem

Action

The scanner does not work.

Ensure that you place the document to be scanned face down from the document feeder
glass, or face up in the ADF.

There may not be enough available memory to hold the document you want to scan. Try
the Prescan function to see if that works. Try lowering the scan resolution rate.

Check that the USB cable is connected properly.

Ensure that the USB cable is not defective. Switch the cable with a known good cable. If
necessary, replace the cable.

Check that the scanner is configured correctly. Check the application you want to use to
make certain that the scanner job is being sent to the correct port.

The printer scans very slowly.

Graphics are scanned more slowly than text when using the Scan to E-mail or Scan to
Network feature.

Communication speed becomes slow in scan mode because of the large amount of
memory required to analyze and reproduce the scanned image.

Scanning images at a high resolution takes more time than scanning at a low resolution.

Check whether the ADF roller assembly is installed properly.



file:///C:/data/systems/PRN2135CN/en/ug/sectioni.htm#wp1182141
file:///C:/data/systems/PRN2135CN/en/ug/sectiofv.htm#wp1188360
file:///C:/data/systems/PRN2135CN/en/ug/sectiofv.htm#wp1183000
file:///C:/data/systems/PRN2135CN/en/ug/sectiony.htm#wp1180019

Document misfeeds or multiple feeds occur in the Automatic
Document Feeder (ADF).

Ensure the document's paper type meets the specifications for the printer. See
"Supported Paper Types" for more information.

Check whether the document is properly loaded in the ADF.

Ensure that the document guides are adjusted properly.

Ensure that the number of document sheets do not exceed the maximum capacity of the
ADF.

Ensure that the document is not curled.

Fan the document well before loading it in the ADF.

Vertical stripes appear on the output when scanned using the

ADF. Clean the ADF glass.

A smear appears at the same location on the output when
scanned using the document glass.

Clean the document glass.

the job again.

Images are skewed. Ensure that the document is loaded straight in the ADF or on the document glass.
Diagonal lines appear jagged when scanned using the ADF. If the document uses thick media, try scanning it from the document glass.
Message appears on your computer screen: There may be a copying or printing job in progress. When the current job is complete, try

“Device can't be set to the HWnode you want." The selected port is currently being used. Restart your computer and try again.

"Port is being used by another program"

“Port is Disabled. " The printer's cable may be improperly connected or the power may be off.

"Scanner is busy receiving or printing data. Wen the

The scanner driver is not installed or an operating environment is not set up properly.

current job is conpleted, try again."

1 “"Scanning has failed. " your computer.

“I'nvalid handle. ™ Ensure that the port is properly connected and the power is turned on. Then restart

Check if the USB cable is properly connected.

The printer does not properly transfer scan data to a specified
destination via the Scan to E-mail or Scan to Network feature.

Check if the following settings have been set correctly on the Dell Printer Configuration
Web Tool.

Scan to Network
Check the following settings under Address Book — Server Address:

Server Address
Server Path
Share Name
Login Name
Login Password

Scan to E-mail

Check the following setting under Address Book — E-Mail Address:

1 Address

Cannot scan using WIA on a Windows Server 2003 computer.

Enable WIA on the computer.
To enable WIA:

1. Click Start, point to Administrative Tools, and then click Services.
2. Right-click Windows Image Acquisition (WIA), and then click Start.

Cannot scan using TWAIN or WIA on a Windows Server 2008
computer.

Install the Desktop Experience feature on the computer.
To install Desktop Experience:

Click Start, point to Administrative Tools, and then click Server Manager.
Under Features Summary, click Add Features.

Select the Desktop Experience check box, click Next, and then click Install.
Restart the computer.

rone

Option Problem

If an option does not operate correctly following installation or stops working:

1 Turn off the printer, wait for 10 seconds, and then turn on the printer. If this does not fix the problem, unplug the printer, and check the connection

between the option and the printer.

1 Print the System Settings page to see if the option is listed in the Installed Options list. If the option is not listed, reinstall it. See "Printing a System

Settings Page".

1 Ensure the option is selected in the printer driver you are using.

The following table lists printer's option and corrective action for related problem. If the suggested corrective action does not correct the problem, call

customer service.

Problem Action
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Memory cardl Ensure the memory card is securely connected to the memory connector.l

Scanner Driver/Printer Utility Problems

Problem

Action

Unable to retrieve the Address Book data from the printer on the
Address Book Editor.

Ensure that your computer and the printer is properly connected with the USB cable.

Ensure that the printer's power is on.

Ensure that the scanner driver is installed on your computer. (The Address Book
Editor retrieves the Address Book data via the scanner driver.)

The TWAIN driver cannot connect to the printer.

Ensure that your computer and the printer is properly connected with the USB cable.

Check whether the printer is on. If the printer is on, reboot it by turning the power
switch off and then on again.

If a scan application is running, close the application once, restart the application, and
then try scanning again.

The scanner driver has not been registered on your computer and
cannot be accessed from ScanButton Manager.

Install the scanner driver. If the driver is installed, uninstall it and then reinstall it
again.

Failed to scan your document on the printer via ScanButton Manager.

Ensure that your computer and the printer is properly connected with the USB cable.

Check whether the printer is on. If the printer is on, reboot it by turning the power
switch off and then on again.

If a scan application is running, close the application once, restart the application, and
then try scanning again.

Failed to create an image file via ScanButton Manager.

Ensure there is sufficient space in your hard disk.

Uninstall ScanButton Manager from Control Panel - Add or Remove Programs on
your computer and then reinstall it again.

Failed to initialize ScanButton Manager.

Uninstall ScanButton Manager from Control Panel —» Add or Remove Programs on
your computer and then reinstall it again.

Failed to execute ScanButton Manager.

Uninstall ScanButton Manager from Control Panel —» Add or Remove Programs on
your computer and then reinstall it again.

An unexpected error occurred on ScanButton Manager.

Uninstall ScanButton Manager from Control Panel - Add or Remove Programs on
your computer and then reinstall it again.

Other Problems

Problem

Action

Condensation has occurred inside the printer.

This usually occurs within several hours after you heat the room in winter. This also
occurs when the printer is operating in a location where relative humidity reaches 85%
or more. Adjust the humidity or relocate the printer to an appropriate environment.

"CTD Sensor Error Error 009-340 Code: xx Restart Printer",
"Check CTD Unit 092-910 d ean CTD Sensor", or "Check CTD Unit
092- 310" is displayed.

Clean the CTD sensor. See "Cleaning the CTD Sensor Inside the Printer".

"Aut hentication error has occurred. The account is not
registered. Please inquire of the systemadmnistrator.
757" is displayed on the Status Monitor.

016-

Ask your system administrator.

is a function that cannot be used.
016- 758" is

“Function unavailable. It
Pl ease inquire of the system admnistrator.
displayed on the Status Monitor.

Ask your system administrator.

“Printable page limt reached. Printable page linmit reached,
cannot print. Please inquire of the system adm nistrator.
016- 759" is displayed on the Status Monitor.

Ask your system administrator.

"Mul tifunction printer error. Check the PHD unit and the

Replace the toner cartridge of the color displayed on the operator panel.

Toner Cartridge. Contact customer support if this failure is |Replace the PHD unit.
repeat ed. 093-919" is displayed on the Status Monitor.
Contact Customer Support.
. . . . Replace the toner cartridge of the color displayed on the operator panel.
"Mul tifunction printer error. Check the PHD unit and the
Toner Cartridge. Contact custoner support if this failure is |Replace the PHD unit.
repeat ed. 093-920" is displayed on the Status Monitor.
Contact Customer Support.
. . . . Replace the toner cartridge of the color displayed on the operator panel.
"Mul tifunction printer error. Check the PHD unit and the
Toner Cartridge. Contact custoner support if this failure is |Replace the PHD unit.
repeat ed. 093-921" is displayed on the Status Monitor.
Contact Customer Support.
Replace the toner cartridge of the color displayed on the operator panel.
"Multifunction printer error. Check the PHD unit and the P 9 pay L P
Toner Cartridge. Contact custoner support if this failure is |Replace the PHD unit.

repeat ed. 093-922" is displayed on the Status Monitor.

Contact Customer Support.
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Contacting Service
When you call for printer service, be prepared to describe the problem you are experiencing or the error message on the display.

You need to know your printer's model type and serial number. See the label located inside the side door of your printer.

Back to Contents Page
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Installing Printer Drivers

@ Ppersonal Printer Setup
@ Network Printer Setup
@ Troubleshooting Instructions

Personal Printer Setup

1. Insert the Drivers and Utilities CD into your computer to start Easy Setup Navigator.

ﬂ NOTE: If the CD does not automatically launch, click start— Run, and then type D:\ set up_assi st. exe (where D is the drive letter of your CD), and
then click OK.

2. Click Software Installation to launch the installation software.

3. Select Personal Installation (USB or Parallel), and then click Next.

4. Click Install.

5. Follow the instructions that appear on the Found New Hardware Wizard dialog box to install the printer driver on your computer.
6. When the Completing the Found New Hardware Wizard dialog box appears, click Finish.

7. Select either Typical Installation (recommended) or Custom Installation from the installation wizard, and then click Install. If you select Custom
Installation, you can select the specific software you want to install.

8. Click Finish to exit the wizard when the Congratulations! screen appears. If necessary, click Print Test Page to print a test page or FAX Initial Setup to
setup the fax on your printer.

USB Printing

A local printer is a printer attached to your computer or a print server using a USB. If your printer is attached to a network and not your computer, see
“Network Printer Setup".

Network Printer Setup

Printing and Checking the System Settings Page

Before installing the printer driver on your computer, print the System Settings page to check your printer's IP address.

From the Printer Operator Panel

1. Press " until >SETUP appears, and then press v .
2. Press "W until >Reports appears, and then press v .

3. System Settings is displayed. Press ( .

The System Settings page is printed.

4. Look under the TCP/IP heading on the System Settings page.

If the IP address is 0. 0. 0. 0, wait for a few minutes to resolve the IP address automatically, and then print the System Settings page again.

From Your Computer
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Click start— All Programs— Dell Printers— Additional Color Laser Software— Quick Launch Utility.

The Quick Launch Utility dialog box opens.

Click the Tool Box button.

The Tool Box dialog box opens.

Select the printer from Printer Name.

The Tool Box opens.

Click the Printer Settings Report tab.
Select Reports from the list at the left side of the page.

The Reports page is displayed.

Click the System Settings button.

The System Settings page is printed.

Look under the TCP/IP heading on the System Settings page.

If the IP address is 0. 0. 0. 0, wait for a few minutes to resolve the IP address automatically, and then print the System Settings page again.

Disable Microsoft® Windows® XP, Windows Vista®, or Windows Server® 2008 Firewall
Before Printer Software Installation

ﬁ NOTE: This step may not be necessary if you have Windows XP Service Pack 2 installed.

If your printer is connected directly to a network and the Windows XP, Windows Vista, or Windows Server 2008 firewall is enabled, you cannot view your
networked printer(s) when you run the Dell™ printer installation software. To prevent this situation, disable the firewall before you install the Dell printer
software. To disable or enable the firewall, perform the following steps.

(~)

NOTICE: It is recommended that you enable your Windows XP, Windows Vista, or Windows Server 2008 firewall after you install the printer software.
Enabling the firewall after you install the printer software does not limit the use of your printer.

Click the start button and click Help and Support.

In the Search box, type firewal | and then press Enter.

In the list, click Turn Windows Firewall on or off and then follow the instructions on the screen.

Local Printer Setup

Insert the Drivers and Utilities CD into your computer to start Easy Setup Navigator.

ﬂ NOTE: If the CD does not automatically launch, click start— Run, and then type D:\ set up_assi st. exe (where D is the drive letter of your CD), and
then click OK.

Press Software Installation to launch the installation software.
Select Network Installation, and then click Next.
Select Local Installation, and then click Next.

Select the printer you want to install from the printer list, and then click Next. If the target printer is not displayed on the list, click Refresh to refresh the
list or click Add Printer to add a printer to the list manually. You may specify the IP address and port name at this point.

If you have installed this printer on the server computer, select the 1 am setting up this printer on a server check box.

ﬂ NOTE: When using Aut ol P, 0. 0. 0. 0 is displayed in the installer. Before you can continue, you must enter a valid IP address.

Specify the printer settings, and then click Next.



a. Enter the name of your printer.

b. If you want other users on the network to access this printer, select the Share this printer with other computers on the network check box,
and then enter a share name that users will easily identify.

c. If you want to set a printer as the default, select the Set this printer as default check box.

d. If you want to restrict color printing, select the appropriate Dell ColorTrack option. Enter the password when Color - Password Enabled is
selected for Dell ColorTrack.

e. If you want to install the fax driver, check the FAX Driver check box.

7. Select the software and documentation that you want to install, and then click Next. You can specify folders in which you install the Dell software and
documentation. To change the folders, click Browse.

8. Click Finish to exit the wizard when the Congratulations! screen appears. If necessary, click Print Test Page to print a test page or FAX Initial Setup to
setup the fax on your printer.

9. If you go on to FAX Initial Setup:
a. On the FAX Settings page, specify Country, Date, Time, Line Type and Tone/Pulse, and then click Next.
b. On the Printer unique Settings page, specify Receive Mode, DRPD Pattern, FAX Header Name, and FAX Number, and then click Next.
c. On the Confirm Settings page, confirm the current settings, and then click Send.

d. On the FAX Setting is Completed page, click Finish.

Enable Network Discovery and File Sharing for all Public Networks

You can skip "Disable User Account Control” for this procedure.

ﬂ NOTE: This step is required when you use Windows Vista or Windows Server 2008 for the server computer.

1. Click Start—> Network.
2. Click Network discovery and file sharing are turned off. Network computers and devices are not visible. Click to change.
3. Click Turn on network discovery and file sharing.

4. Click Yes, turn on network discovery and file sharing for all public networks.

Remote Printer Setup

Before Installation

Before you start remote installation, perform the following procedures.

Allow Print Spooler to Accept Client Connections

ﬂ NOTE: This step is required for Windows XP 64-bit Edition, Windows Server 2003, Windows Server 2003 Enterprise x64 Edition, Windows Vista,
Windows Vista 64-bit Edition, Windows Server 2008, and Windows Server 2008 Enterprise x64 Edition.

1. Click start—> Run.
For Windows Server 2003/Windows Server 2008: Click Start— Run.

For Windows Vista: Click Start— All Programs— Accessories— Run.

2. Type gpedit. nmsc, and then click OK.

3. Click Computer Configuration— Administrative Templates— Printers.

4. Right-click Allow Print Spooler to accept client connections and select Properties.
5. From the Setting tab, select Enabled, and then click OK.

6. Restart the computer.



Share the Firewall File and Printer

ﬂ NOTE: This step is required for Windows XP, Windows XP 64-bit Edition, Windows Vista, Windows Vista 64-bit Edition, Windows Server 2008, and
Windows Server 2008 Enterprise x64 Edition.

For Windows XP:
1. Click start— Control Panel.
2. Select Security Center.
3. Click Windows Firewall.

4. From the Exceptions tab, check the File and Printer Sharing check box, and then click OK.

For Windows Vista:

1. Click Start— Control Panel.
2. Select Security.

3. Click Windows Firewall.

4. Click Change settings.

5. Click Continue.

6. From the Exceptions tab, check the File and Printer Sharing check box, and then click OK.

For Windows Server 2008:

1. Click Start— Control Panel.
2. Double-click Windows Firewall.
3. Click Change settings.

4. From the Exceptions tab, check the File and Printer Sharing check box, and then click OK.

Start Remote Registry
4 NOTE: This step is required for Windows Vista or Windows Server 2008.

For Windows Vista:

1. Click Start— Control Panel.

2. Select System and Maintenance.

3. Click Administrative Tools.

4. Double-click Services.

5. Click Continue.

6. Right-click Remote Registry and select Start.

7. Right-click Remote Registry and select Properties.

8. Change Startup type: to Automatic, and then click OK.

For Windows Server 2008:

1. Click Start—> Administrative Tools.



2. Click Services.
3. Right-click Remote Registry and select Start.
4. Right-click Remote Registry and select Properties.

5. Change Startup type: to Automatic, and then click OK.

Disable User Account Control
m NOTE: This step is required for Windows Vista or Windows Server 2008.
For Windows Vista:
1. Click Start— Control Panel.
2. Select User Accounts and Family Safety.
3. Click User Accounts.
4. Click Turn User Account Control on or off.
5. Click Continue.
6. Clear the Use User Account Control (UAC) to help protect your computer check box.

7. Restart the computer.

For Windows Server 2008:

1. Click Start— Control Panel.

2. Double-click User Accounts.

3. Click Turn User Account Control on or off.

4. Clear the Use User Account Control (UAC) to help protect your computer check box.
5. Click OK.

6. Restart the computer.

Enable Network Discovery and File Sharing for all Public Networks

You can skip "Disable User Account Control” for this procedure.

& NOTE: This step is required when you use Windows Vista or Windows Server 2008 for the server computer.

1. Click Start— Network.
2. Click Network discovery and file sharing are turned off. Network computers and devices are not visible. Click to change.
3. Click Turn on network discovery and file sharing.

4. Click Yes, turn on network discovery and file sharing for all public networks.

Disable Simple File Sharing

ﬂ NOTE: This step is required for Windows XP or Windows XP 64-bit Edition.

1. Click start— Control Panel.

2. Select Appearance and Themes.



3. Select Folder Options.
4. From the View tab, clear the Use simple file sharing(Recommended) check box, and then click OK.
5. Click start— Control Panel.
6. Select Performance and Maintenance.
7. Select Administrative Tools.
8. Click Local Security Policy.
9. Click Local Policies— Security Options.
10. Right-click Network access: Sharing and security model for local accounts and select Properties.

11. Ensure Classic - local users authenticate as themselves is selected.

Installing the Printer Driver

1. Insert the Drivers and Utilities CD into your computer to start Easy Setup Navigator.

ﬂ NOTE: If the CD does not automatically launch, click start— Run, and then type D:\ set up_assi st. exe (where D is the drive letter of your CD), and
then click OK.

2. Press Software Installation to launch the installation software.
3. Select Network Installation, and then click Next.

4. Select Remote Installation, and then click Next.

ﬂ NOTE: Installation on Windows XP Home Edition, Vista Home Basic, Vista Home Premium, or Windows Server 2008 is not supported.

5. Enter the computer name, user ID, and password. Then, click Add.
6. Click Next.

7. Select the printer you want to install from the printer list, and then click Next. If the target printer is not displayed on the list, click Refresh to refresh the
list or click Add Printer to add a printer to the list manually. You may specify the IP address and port name at this point.

ﬂ NOTE: When using Aut ol P, 0. 0. 0. 0 is displayed in the installer. Before you can continue, you must enter a valid IP address.

8. Specify the printer settings, and then click Next.
a. Enter the name of your printer.

b. If you want other users on the network to access this printer, select the Share this printer with other computers on the network check box,
and then enter a share name that users will easily identify.

c. If you want to set a printer as the default, select the Set this printer as default check box.

d. If you want to restrict color printing, select the appropriate Dell ColorTrack option. Enter the password when Color-Password Enabled is
selected for Dell ColorTrack.

e. If you want to install the fax driver, check the FAX Driver check box.

9. Select the software and documentation that you want to install, and then click Next. You can specify folders in which to install the Dell software and
documentation. To change the folders, click Input.

10. Click Finish to exit the wizard when the Congratulations! screen appears.

Use the Dell Printer Configuration Web Tool to monitor the status of your network printer without leaving your desk. You can view and/or change the printer
configuration settings, monitor toner level, and when it is time to order replacement consumables, just click the Dell supplies link right from your web browser.

ﬂ NOTE: The Dell Printer Configuration Web Tool is not available when the printer is locally attached to a computer or a print server.

To launch the Dell Printer Configuration Web Tool, type the printer's IP address in your web browser, and the printer configuration appears on the screen.

You can set up the Dell Printer Configuration Web Tool to send you an email when the printer needs supplies or intervention.



To set up e-mail alerts:

1. Launch the Dell Printer Configuration Web Tool.
2. Click E-Mail Alert link.

3. Under E-Mail Server Settings, enter the Primary SMTP Gateway, the Reply Address, and enter your email address or the key operator's email
address in the email list box.

4. Click Apply New Settings.

ﬂ NOTE: The SMTP server will display Connection pending untill printer sends an alert until an error occurs.

Troubleshooting Instructions

Use the Customer Mode to locate the unit in the printer that causes a problem.

Checking the Printer Operations

1. Click start— All Programs— Dell Printers— Additional Color Laser Software— Quick Launch Utility.

The Quick Launch Utility dialog box opens.

2. Click the Tool Box button.

The Tool Box dialog box opens.

3. Select the printer from Printer Name.
4. The Tool Box opens.
5. Click the Diagnosis tab.

6. Select Machine Check from the list at the left side of the page.

The Machine Check page is displayed.

7. Click the Start button after selecting the desired item.

The selected page is printed.

Resetting Defaults

After executing this function and rebooting the printer, all the menu parameters, except the parameters for the network, are reset to their default values.

From the Printer Operator Panel

1. Press " until >SETUP appears, and then press v .

2. Press W until >Adni n Menu appears, and then press \/ .

3. Press " until >Mai nt enance appears, and then press v .

4. Press W until > nitialize NWM appears, and then press v .
5. Press W until >Syst em Secti on appears, and then press ‘/ .

6. The Are you sure? message appears on the operator panel , and then press € or > to select Yes. Press v

The printer restarts automatically to apply the settings.



From Your Computer

1. Click start— All Programs— Dell Printers— Additional Color Laser Software— Quick Launch Utility.

The Quick Launch Utility dialog box opens.

2. Click the Tool Box button.

The Tool Box dialog box opens.

3. Select the printer from Printer Name.

The Tool Box opens.

4. Click the Printer Maintenance tab.

5. Select Reset Defaults from the list at the left side of the page.

The Reset Defaults page is displayed.

6. Click System Section button.

The printer restarts automatically to apply the settings.

Back to Contents Page
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Setting Up for Shared Printing

@ Ppoint and Print

@ peer-to-Peer

You can share your printer on the network using the Drivers and Utilities CD that shipped with your printer, or using Microsoft® point and print or peer-to-peer
method. However, if you use one of the Microsoft methods, features such as the Status Monitor and other printer utilities will not be available.

To share a locally-attached printer on the network, you need to share the printer, and then install the shared printer on network clients:

For Windows® XP, Windows Server® 2003, and Windows 2000:

1. Click start— Printers and Faxes (Printers for Windows 2000).
2. Right-click the printer icon and select Properties.

3. From the Sharing tab, check the Share this printer (Share as for Windows 2000) check box, and then type a name in the Share name (Share as for
Windows 2000) text box.

4. Click Additional Drivers and select the operating systems of all network clients printing to this printer.

5. Click OK.

If you are missing files, you will be prompted to insert the server operating system CD.

For Windows Vista®:

1. Click Start— Control Panel— Hardware and Sound— Printers.

2. Right-click the printer icon and select Sharing.

3. Click Change sharing options button.

4. The dialog box displaying "Windows needs your permission to continue"” appears.

5. Click Continue button.

6. Check the Share this printer check box, and then type a name in the Share name text box.

7. Click Additional Drivers and select the operating systems of all network clients printing to this printer.

8. Click OK.

For Windows Server 2008:

1. Click Start— Control Panel— Printers.

2. Right-click the printer icon and select Sharing.

3. Check the Share this printer check box, and then type a name in the Share name text box.

4. Click Additional Drivers and select the operating systems of all network clients printing to this printer.

5. Click OK.
To check that the printer is successfully shared:

1 Ensure that the printer object in the Printers or Printers and Faxes folder is shared. A icon of sharing is shown underneath the printer icon.

1 Browse Network or My Network Places. Find the host name of the server and look for the shared name you assigned to the printer.

Now that the printer is shared, you can install the printer on the network clients using the point and print method or the peer-to-peer method.
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Point and Print

This method is usually the best use of system resources. The server handles driver modifications and print job processing. This lets network clients return to
their programs much faster.

If you use the point and print method, a subset of driver information is copied from the server to the client computer. This is just enough information to send a
print job to the printer.

For Windows XP, Windows Server 2003, and Windows 2000:

1. Click start->My Network Places.
For Windows 2000: Double-click My Network Places.

For Windows Server 2003: Click Start—>All Programs—Accessories— Windows Explorer-»My Network Places.

2. Locate the host name of the server computer, and then double-click the host name.

3. Right-click the shared printer name, and then click Connect.

Wait for the driver information to copy from the server computer to the client computer, and for a new printer object to be added to the Printers and
Faxes (Printers for Windows 2000) folder. The copy time varies, based on network traffic and other factors.

Close My Network Places.

4. Print a test page to verify installation.

5. Click start— Printers and Faxes (Printers for Windows 2000).
6. Select the printer you just created.

7. Click File> Properties.

8. From the General tab, click Print Test Page.

When a test page prints successfully, installation is complete.

For Windows Vista and Windows Server 2008:

1. Click Start— Network.

2. Locate the host name of the server computer, and then double-click the host name.

3. Right-click the shared printer name, and then click Connect.

4. Click Install driver.

5. Click Continue in User Account Control dialog box (You can skip this step in Windows Server 2008).

6. Wait for the driver information to copy from the server computer to the client computer, and for a new printer object to be added to the Printers folder.
The time this takes varies, based on network traffic and other factors.

7. Print a test page to verify installation.
8. Click Start— Control Panel—» Hardware and Sound— Printers (Start— Control Panel— Printers for Windows Server 2008).
9. Right-click the printer you just created and select Properties.

10. From the General tab, click Print Test Page.

When a test page prints successfully, installation is complete.

Peer-to-Peer

If you use the peer-to-peer method, the printer driver is fully installed on each client computer. Network clients retain control of driver modifications. The client



computer handles the print job processing.

For Windows XP, Windows Server 2003, and Windows 2000:

1. Click start— Printers and Faxes (Printers for Windows 2000).
2. Click Add a Printer to launch the Add Printer wizard.

3. Click Next.

4. Select A network printer, or a printer attached to another computer, and then click Next (For Windows 2000, select the network printer from the
Shared printers list). If the printer is not listed, type in the path of the printer in the text box.

For example: \\ <server host nane>\<shared printer name>

The server host name is the name of the server computer that identifies it to the network. The shared printer name is the name assigned during the
server installation process.

5. Click Browse for a printer, and then click Next (For Windows 2000, click OK).

If this is a new printer, you may be prompted to install a printer driver. If no system driver is available, then you will need to provide the path to the
available drivers.

6. Select whether you want this printer to be the default printer for the client, click Next, and then click Finish (For Windows 2000, click Finish).

7. Print a test page to verify installation:
a. Click start— Settings— Printers and Faxes (Printers for Windows 2000).
b. Select the printer you just created.
c. Click File—> Properties.

d. From the General tab, click Print Test Page.

When a test page prints successfully, installation is complete.

For Windows Vista and Windows Server 2008:
1. Click Start— Control Panel-» Hardware and Sound— Printers (Start— Control Panel— Printers for Windows Server 2008).

2. Click Add a Printer to launch the Add Printer wizard.

3. Select Add a network, wireless or Bluetooth printer, and then click Next. If the printer is listed, select the printer and click Next, or select The printer
that I want isn't listed and type in the path of the printer in the Select a shared printer by name text box and click Next.

For example: \\ <server host nane>\<shared printer name>

The server host name is the name of the server computer that identifies it to the network. The shared printer name is the name assigned during the
server installation process.

4. If this is a new printer, you may be prompted to install a printer driver. If no system driver is available, then you will need to provide the path to the
available drivers.

5. Select whether you want this printer to be the default printer for the client, click Next.
6. If you want to verify installation then click Print a test page.

7. Click Finish.

When a test page prints successfully, installation is complete.

Back to Contents Page
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Maintaining Your Printer

Determining the Status of Supplies

Replacing

Conserving Supplies
Ordering Supplies
Storing Print Media
Storing Consumables

Toner Cartridges

Replacing the Print Head Device (PHD) Unit

Replacing Retard Roller
Cleaning the Feed Roller Inside the Printer

Cleaning the CTD Sensor Inside the Printer

Adjusting Color Registration
Cleaning the Scanner
Cleaning the ADF Feed Roller

You need to complete certain tasks to maintain optimum print quality. If several people are using the printer, you may want to designate a key operator to
maintain your printer. Refer printing problems and maintenance tasks to this key operator.

Determining the Status of Supplies

If your printer is connected to the network, the Dell™ Printer Configuration Web Tool can provide instant feedback on remaining toner levels. Type the
printer's IP address in your web browser to view this information. To use the E-Mail Alert Setup feature that notifies you when the printer requires new
supplies, type your name or the name of the key operator in the e-mail list box.

On the operator panel, you can also confirm the following:

1 Any supply or maintenance items that require attention replacing (However, the printer can only display information about one item at a time.)

1 Amount of toner remaining in each toner cartridge

Conserving Supplies

You can change several settings in your printer driver to conserve toner cartridge and paper.

Layout tab

Supply Setting Function
Toner Toner Saving Mode in | This check box allows the users to select a print mode that uses less toner. The image quality will be lower when this
cartridge the Advanced tab feature is used.

Multiple Up in the The printer prints two or more pages on one side of a sheet. Values for Multiple Up are 2 Up, 4 Up, 8 Up, 16 Up, or 32
Print media p P Up. Combined with the duplex setting, Multiple Up allows you to print up to 64 pages on one sheet of paper. (32

images on the front and 32 on the back)

Ordering Supplies

You can order consumables from Dell on the Internet when using a networked printer. Type the IP address of your printer in your web browser, launch the
Dell Printer Configuration Web Tool, and click the Order Supplies at: to order toner for your printer.

You can also order toner cartridges by the following method.

1. Click start— All Programs— Dell Printers— Additional Color Laser Software— Dell Supplies Management System.

The Dell Supplies Management System window appears.

2. Select your printer from the Select Printer Model list.

3. If ordering from the web:

a.

b.

C.

When you cannot get information from the printer automatically by two-way communication, a window that prompts you to type the Service Tag
number appears. Type your Dell printer Service Tag number in the field provided.

Your Service Tag number is located inside the side cover of your printer.

Select a URL from the Select Reorder URL list.

Click Visit Dell printer supplies ordering web site.
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4. If ordering by phone, call the number that appears under the Order by Phone heading.

Storing Print Media
To avoid potential paper feeding problems and uneven print quality, there are several things you can do.

1 To achieve the best possible print quality, store print media in an environment where the temperature is approximately 21°C (70°F) and the relative
humidity is 40%.

Store cartons of print media on a pallet or shelf, rather than directly on the floor.

If you store individual packages of print media out of the original carton, ensure that they rest on a flat surface so the edges do not buckle or curl.

Do not place anything on top of the print media packages.

Storing Consumables
Store consumables in their original packaging until you need to use them. Do not store consumables in:

1 Temperatures greater than 40°C (104°F).

1 An environment with extreme changes in humidity or temperature.
1 Direct sunlight.

1 Dusty places.

1 A car for a long period of time.

1 An environment where corrosive gases are present.

1 A humid environment.

Replacing Toner Cartridges

& CAUTION: Before performing any of the following procedures, read and follow the safety instructions in your Product Information Guide.
Dell toner cartridges are available only through Dell. You can order more cartridges online at http://www.dell.com/supplies or by phone. To order by phone,
see "Contacting Dell™".

It is recommended to use Dell toner cartridges for your printer. Dell does not provide warranty coverage for problems caused by using accessories, parts, or
components not supplied by Dell.

& CAUTION: Never throw used toner cartridges into fire. The residual toner could explode resulting in burns and injuries.

& CAUTION: Do not shake the used toner cartridge to avoid spilling of toner.

Removing the Used Toner Cartridge

1. Open the side cover.

2. Push the latch(es) backwards to pop open the toner cartridge(s) that you want to replace.
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3. Pull the cartridge holder until it clicks, and then pull out the toner cartridge.

& CAUTION: Do not shake the toner cartridge as it may spill some toner.

Installing a New Toner Cartridge

1. Ensure that the color of the new toner cartridge matches that on the handle before replacing it. Shake the toner cartridge five or six times to distribute
the toner evenly.

2. Insert the toner cartridge into the associated cartridge holder, and slide the latches of the toner cartridge.




3. Close the side cover.

Replacing the Print Head Device (PHD) Unit

1. Ensure that the printer is turned off.

2. Press the side button and open the front cover.

3. Turn the four PHD lock levers counterclockwise.

4. Pull the PHD unit out of the printer.



Installing the PHD Unit

1. Open the PHD packaging.

2.

3. Completely remove the eight yellow ribbons from the PHD unit.

4. Remove the rear protective cover from the PHD unit.

ﬂ NOTE: Do not remove the front protective cover at this moment.



- Rear protective cover

_ — — Frontprotective cover

5.

6. Turn the four PHD lock levers 90 degrees clockwise to lock the PHD unit.

7. Carefully remove the front protective cover from the PHD unit.

° NOTICE: Ensure that you do not hit the belt unit when removing the front protective cover.

8. Close the front cover.



Replacing Retard Roller

Keeping the retard roller in the paper tray clean helps ensure the best possible copies. It is recommended to clean the separator at regular intervals.

& CAUTION: To prevent electric shock, always turn off the printer and disconnect the power cable from the grounded outlet before performing
maintenance.

& CAUTION: Before performing any of the following procedures, read and follow the safety instructions in your Product Information Guide.

Dell retard rollers are available only through Dell. To order by phone, see "Contacting Dell™".

It is recommended to use Dell retard rollers for your printer. Dell does not provide warranty coverage for problems caused by using accessories, parts, or
components not supplied by Dell.

Removing the Used Retard Roller in the Tray 1

ﬂ NOTE: Remove all paper or media from the tray before pulling the tray out of the printer.

1. Pull the tray 1 out of the printer carefully. Hold the tray with both hands, lift the front slightly, and remove it from the printer.

ﬂ NOTE: Ensure that you remove all the paper from the tray 1 before removing the retard roller.

ﬂ NOTE: Carefully replace the tray 1 so that it does not fall down.

2. By holding the retard roller tabs with your fingers, pull the retard roller out of the groove in the axle.
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Installing the New Retard Roller in the Tray 1

1. Align the new retard roller to the groove on the axle.

2. Insert the retard roller into the axle till it snaps fit so the protrusions fit completely into the slots and the roller hook reseats into the groove on the axle.

3. Load paper and place it in the printer.

Cleaning the Feed Roller Inside the Printer

Clean the feed roller inside the printer if print media does not feed correctly.

1. Ensure that the printer is turned off.

2. Push the side button and open the front cover.

3. Turn the four PHD lock levers counterclockwise, and then pull the PHD unit out of the printer.



4. Hold the gray tabs, and then pull out the PHD unit.

4 NOTE: Keep the PHD unit in a dark place.

5. Clean the feed roller inside the printer with a dry cloth.

6. Insert the PHD unit until it stops and turn the four PHD lock levers clockwise to lock the PHD unit.

7. Close the front cover.



Cleaning the CTD Sensor Inside the Printer

Clean the Color Toner Density (CTD) sensor only when an alert for the CTD sensor is shown on the Status Monitor or operator panel.

1. Ensure that the printer is turned off.

2. Push the side button and open the front cover.

3. Clean the CTD sensor inside the printer with a clean dry cotton swab.

4. Close the front cover.

Adjusting Color Registration

To adjust the color registration when you first install the printer or after moving it to a new location, follow the procedure below.

Printing the Color Registration Chart

From the Printer Operator Panel

1. Press " until >SETUP appears, and then press v .

2. Press " until >Adni n Menu appears, and then press v .

3. Press W until >Mai nt enance appears, and then press ‘/ .

4. Press W until >Col or Reg Adj ust appears, and then press v .

5. Press " until >Col or Reg Chart appears, and then press ( .



The color registration chart is printed.

From Your Computer

1. Click start— All Programs— Dell Printers— Additional Color Laser Software— Quick Launch Utility.

The Quick Launch Utility dialog box opens.

2. Click the Tool Box button.

The Tool Box dialog box opens.

3. Select the printer from Printer Name.

The Tool Box opens.

4. Click the Printer Maintenance tab.

5. Select Registration Adjustment from the list at the left side of the page.

The Registration Adjustment page is displayed.

6. Click the Start button next to Color Regi Chart.

The color registration chart is printed.

Determining Values
On the color registration chart, there are two types of charts: Chart 1 (fast scan) and Chart 2 (slow scan).

The Chart 1 is used to adjust the color registration for the fast scan direction, which is vertical to paper feed direction. The Chart 2 is used to adjust the color
registration for the slow scan direction, which is horizontal to paper feed direction.

The following explains how to determine the adjustment values for the fast scan and the slow scan using Chart 1 and Chart 2.

First Scan

On the Chart 1 of the color registration chart, find the straightest lines where the two black lines and the colored line are most closely aligned for each color
(Y, M, and C). If you find the straightest line, make a note of the value (-9 - +9) indicated by the straightest line for each color.

When the value is O for each color, you do not need to adjust the color registration for the fast scan.

When the value is not O, enter the value using the procedure in "Entering Values".
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Slow Scan

On the Chart 2 of the color registration chart, find the medium line within the range of white area for each color pattern (Y, M, and C). If you find the medium
line, make a note of the value (-9 - +9) indicated by the medium line for each color.

When the value is O for each color, you do not need to adjust the color registration for the slow scan.

When the value is not O, enter the value using the procedure in "Entering Values".
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Entering Values

From the Printer Operator Panel

Using the operator panel, enter the values found in the color registration chart to make adjustments.

1. Press "W until >SETUP appears, and then press \/ .

2. Press " until >Adni n Menu appears, and then press v .

3. Press " until >Mai nt enance appears, and then press v .

4. Press W until >Col or Reg Adj ust appears, and then press \/ .
5. Press " until >Enter Adj ust ment appears, and then press v .

6. >Lateral Adjustnent is displayed. Press \( to specify the values for the lateral direction.

The cursor is located at the first digit of the Lateral Adj ustnent.
7. Press # or W until you reach the value (for example, +3) displayed on the chart.
8. Press ? once and move the cursor to the next value.
9. Repeat steps 6 and 7 to enter all of the digits of the Lateral Adjustnent, and then press v .

10. Press " until >Process Adj ust nent appears, and then press “ to specify the values for the process direction.

The cursor is located at the first digit of the Process Adj ust nent .
11. Press # or W until you reach the value (for example, +3) displayed on the chart.
12. Press » once and move the cursor to the next value.
13. Repeat steps 11 and 12 to enter all of the digits of the Process Adj ustnent, and then press v .
14. Press the O button.

15. Press " until >Col or Reg Chart appears, and then press v .

The color registration chart is printed with the new values.

16. Press « .

17. Adjust till all straight lines are at the value of 0. Viewing the images before and after will help.

From Your Computer

Using the Tool Box, enter the values that you found in the color registration chart to make adjustments.

1. Click start—> All Programs— Dell Printers— Additional Color Laser Software— Quick Launch Utility.

The Quick Launch Utility dialog box opens.

2. Click the Tool Box button.

The Tool Box dialog box opens.

3. Select the printer from Printer Name.

The Tool Box opens.



4. Click the Printer Maintenance tab.

5. Select Registration Adjustment from the list at the left side of the page.

The Registration Adjustment page is displayed.

6. Select the value with the straight line, and then click the Apply New Settings button.

7. Click the Start button next to Color Regi Chart.

The color registration chart is printed with the new values.

8. Adjust till all straight lines are at the value of 0. Show image of before and after adjustment will help.

& CAUTION: After printing the color registration chart, do not turn off the printer until the printer motor has stopped running.

ﬂ NOTE: If 0 is not next to the straightest lines, determine the values and adjust the printer again.

Cleaning the Scanner

Keeping the scanner clean helps ensure the best possible copies. It is recommended to clean the scanner at the start of each day and during the day, as
needed.

1. Slightly dampen a soft lint-free cloth or paper towel with water.

2. Open the document cover.

3. Wipe the surface of the document glass and ADF glass until it is clean and dry.

White Sheet

NOTE: Handle with care.

N

Document Cover

w

Document Glass

IN

ADF Glass

4. Wipe the underside of the white document cover and white sheet until it is clean and dry.

5. Close the document cover.



Cleaning the ADF Feed Roller

Keeping the ADF feed roller clean helps ensure the best possible copies. It is recommended to clean the ADF feed roller at regular intervals.

1. Open the ADF cover.

2. Wipe the ADF feed roller with a dry soft lint-free cloth or paper towel until it is clean.

If the ADF feed roller gets soiled with ink stains, paper from the ADF may also be soiled. In this case, slightly dampen a soft lint-free cloth or paper towel
with a neutral detergent or water, and then remove the contamination from the ADF feed roller until it is clean and dry.

Back to Contents Page
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Removing the Optional Memory Card

@ Pprinting and Checking the System Settings Page

@ Updating your PCL Driver

This chapter describes how to remove the printer's optional memory card.

The optional memory card must be removed and carefully packed to avoid damage if the printer is shipped.

1. Ensure that the printer is turned off and unplug all the cables including the power cord from the rear of the printer.

2. Turn the screw on the memory cover in a counter-clockwise direction.

4. Open the memory cover halfway until it stops, and then slide it again towards the back of the printer.

5. Open the memory cover completely.

6. Push the clips on both sides of the slot outward to raise the memory card up.
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7. Hold the memory card and pull it out.

8. Close the memory cover halfway until it stops, and then slide it towards the front of the printer.

9. Close the memory cover completely and slide it again towards the front of the printer.

10. Turn the screw clockwise.

11. Turn on the printer.



Printing and Checking the System Settings Page

Print a System Settings page to verify that the optional memory card is removed correctly.

From the Printer Operator Panel

1. Press " until >SETUP appears, and then press v .
2. Press "W until >Reports appears, and then press v .

3. System Settings is displayed. Press ( .

The System Settings page is printed.

4. Verify the capacity of the memory listed in the system settings under General.

From Your Computer

1. Click start— All Programs— Dell Printers— Additional Color Laser Software— Quick Launch Utility.

The Quick Launch Utility dialog box opens.

2. Click the Tool Box button.

The Tool Box dialog box opens.

3. Select the printer from Printer Name.

The Tool Box opens.

4. Click the Printer Settings Report tab.
5. Select Reports from the list at the left side of the page.

The Reports page is displayed.

6. Click the System Settings button.

The System Settings page is printed.

7. Verify the capacity of the memory listed in the system settings under General.

Updating your PCL Driver

Update your driver by following the instructions for the operating system you are using. If the printer is on a network, update the driver for each client.

1. Click start—»Printers and Faxes.
For Windows® 2000: Click Start— Settings— Printers.
For Windows Server® 2003: Click Start— Printers and Faxes.

For Windows Vista®: Click Start— Control Panel— Hardware and Sound— Printers.

For Windows Server 2008: Click Start— Control Panel— Printers.

2. Right-click the printer and select Properties.
3. Click the Options tab, and then select Get Information from Printer.
4. Verify the capacity of the memory listed on the Memory Capacity drop- down list.

5. Click Apply, and then click OK.



6. Close the Printers and Faxes folder.
For Windows Server 2003: Close the Printers and Faxes folder.

For Windows 2000/Windows Vista/Windows Server 2008: Close the Printers folder.

Back to Contents Page
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Printer Specifications

Operating System Compatibility

Power Supply
Dimensions

Memory

Page Description Language (PDL)/Emulation, Operating System, and Interface

Environment
Cables

Operating

Copier Specifications
Scanner Specifications
Eacsimile Specifications

System Compatibility

Your Dell™ 2135cn Color Laser Multifunction Printer is compatible with Microsoft® Windows® 2000, Windows XP, Windows XP 64-bit Edition, Windows server®
2003, Windows Server 2003 Enterprise x64 Edition, Windows Server 2008, Windows Server 2008 Enterprise x64 Edition, Windows Vista®, and Windows Vista

64-bit Edition.

1 Dell technical phone support only supports factory-installed operating systems (Microsoft) for the first 30 days for free. You will have to purchase technical
support from the manufacturer of the operating system in order to get technical assistance beyond 30 days.

2 f you have other operating systems and have purchased Gold Technical Support, the telephone support will be a "best effort" attempt to resolve the

operating system issue. If the manufacturer needs to be contacted, the customer must pay an additional fee for that support. The only time that Dell pays for
the third party support is when Dell is responsible for the issue. In the case of getting the printer installed and working, this is configuration and the customer
would be responsible for paying.

Power Supply

Rated Voltage

220-240 VAC|110-127 VAC

50/60 Hz 50/60 Hz
Frequency

5A 9A
Current
Dimensions

Height: 580 mm (22.83 inches) Width: 436 mm (17.16 inches) Depth: 494 mm (19.45 inches)

Weight (not including cartridge and PHD unit): 24.5 kg (54 |b)

Memory

Base memory

128 MB

Maximum memory

384 MB (128+256 MB)

Connector 144pin EP2-2100 DDR2 SDRAM 32b-SO-DIMM
DIMM Size 256 MB
Speed EP2-2100

Page Description Language (PDL)/Emulation, Operating System, and Interface

PDL/Emulations

PCL 6, PCL5e

Operating
Systems

Microsoft Windows 2000, Windows XP, Windows XP 64-bit Edition, Windows Server 2003, Windows Server 2003 Enterprise x64 Edition,

Windows Server 2008, Windows Server 2008 Enterprise x64 Edition, Windows Vista, and Windows Vista 64-bit Edition
T
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Standard local: uUsB

Interfaces
Standard network: 10Base-T/100Base-TX Ethernet

MIB Compatibility

A Management Information Base (MIB) is a database containing information about network devices (such as adapters, bridges, routers, or computers). This
information helps network administrators manage the network (analyze performance, traffic, errors, and so on). Dell™ 2135cn Color Laser Multifunction Printer
complies with standard industry MIB specifications, allowing the printer to be recognized and managed by various printer and network management software

systems.
Environment

Operation
Temperature 10-32°C

Relative humidity | 10-85% RH (no condensation)

Print Quality Guarantee

Temperature 15-28°C

Relative humidity | 20-70% RH (no condensation)

Storage

Temperature range -20-40°C (0-104°F)

Storage humidity range | 5-85% RH (no condensation)

Altitude

Operating | Up to 3,100 m (10,000 feet)

Storage 70.9275 Kpa

Cables

Your interconnection cable must meet the following requirements:

Connection type | Connection specifications and symbols
PHONE

&

LINE

@

1 | Phone connector

2 | Wall jack connector

3 | Ethernet 10 Base-T/100 Base-TX

_F

4 |USB UsSB2.0




Copier Specifications

Item

Description

Copy Resolution

Optical: 600 x 600 dpi

Copy Speed

Color 12 cpm or more, Black&White 16 cpm or more (When using the document glass to make sequential copies of a document
with pages scanned one by one.)

Color 8 cpm or more, Black&White 16 cpm or more (When using the ADF to make sequential copies of multiple documents.)

Paper Size

A4, A5, B5, Executive, Letter, Folio, Legal, Monarch, DL, C5, Envelope #10

Zoom Rate

Document glass: 25% - 400%, ADF: 25% - 400%

Multiple copies

1 - 99 pages

Copy mode (=Original
Type)

Text, Text & Photo, Photo

Scanning method

Charge coupled device (CCD) module

Scanner Specifications

Item

Description

Compatibility

Tool Without An Interesting Name (TWAIN), Windows Image Acquisition (WIA)

NOTE: WIA is not available for Windows 2000.

Scan Resolution

Optical: 600 x 600 dpi, 1,200 x 1,200 dpi

Enhanced: 9,600 x 9,600 dpi (Gray and Color only in TWAIN)

Color bit depth

24 bit (WIA, TWAIN)

Mono bit depth

1 bit for Line art 8 bit for Gray scale

Effective scanning length

Document glass: 297 mm. ADF: 355.6 mm

Effective scanning width

215.9 mm

Scan speed (Text mode)

Monochrome: 665 ps/line (600 dpi), 1330 ps/line (1200 dpi)

Color: 1330 ps/line (600 dpi), 2660 us/line (1200 dpi)

Facsimile Specifications

Item

Description

Compatibility

ITU-T Group 3

Applicable line

Public Switched Telephone Network (PSTN) or behind Private Automatic Branch Exchange (PABX)

Data coding

MH/MR/MMR/JBIG

Max modem speed

33.6 Kbps




Approx. 3 seconds/page *Transmission time applies to memory transmission of text data scanned in Standard resolution with ECM

Transmission speed using only ITU-T No.1 Chart.

- Document glass: approx. 3 seconds/A4 (at standard fax resolution mode) ADF: approx. 5 seconds/Letter (at standard fax resolution
Scanning speed - .
mode), 7.5 seconds/Letter (at fine fax resolution mode)

Maximum document Document glass: 297 mm ADF: 356 mm

length

Paper size Letter, A4, Legal

Resolution Standard: R8 x 3.85 I/mm, Fine: R8 x 7.7l/mm, Super Fine: 400 x 400 dpi
User Memory 4 MB (320 pages)

Halftone 256 levels

Back to Contents Page
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Appendix

@ Dell Technical Support Polic

@ warranty and Return Policy
@ Contacting Dell™

Dell Technical Support Policy

Technician-assisted technical support requires the cooperation and participation of the customer in the troubleshooting process and provides for restoration of
the operating system, software program and hardware drivers to the original default configuration as shipped from Dell, as well as the verification of
appropriate functionality of the printer and all Dell-installed hardware. In addition to this technician assisted technical support, online technical support is
available at Dell Support. Additional technical support options may be available for purchase.

Dell provides limited technical support for the printer and any Dell-installed software and peripherals. Support for third-party software and peripherals is
provided by the original manufacturer, including those purchased and/or installed through Software & Peripherals (DellwWare), ReadyWare, and Custom Factory
Integration (CF1/DellPlus).

Online Services
You can learn about Dell products and services on the following websites:
www.dell.com
www.dell.com/ap (Asian/Pacific countries only)
www.dell.com/Zjp (Japan only)
www.euro.dell.com (Europe only)
www.dell.com/Zla (Latin American and Caribbean countries)
www.dell.ca (Canada only)
You can access Dell Support through the following websites and e-mail addresses:
1 Dell Support websites
support.dell.com
support.jp.dell.com (Japan only)
support.euro.dell.com (Europe only)
1 Dell Support e-mail addresses
mobile_support@us.dell.com
support@us.dell.com
la-techsupport@dell.com (Latin America and Caribbean countries only)
apsupport@dell.com (Asian/Pacific countries only)
1 Dell Marketing and Sales e-mail addresses
apmarketing@dell.com (Asian/Pacific countries only)
sales_canada@dell.com (Canada only)
1 Anonymous file transfer protocol (FTP)
ftp.dell.com

Log in as user: anonynous, and use your e-mail address as your password.

Warranty and Return Policy

Dell Computer Corporation ("Dell”) manufactures its hardware products from parts and components that are new or equivalent to new in accordance with
industry-standard practices. For information about the Dell warranty for your printer, see support.dell.com.
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Recycling Information

It is recommended that customers dispose of their used computer hardware, monitors, printers, and other peripherals in an environmentally sound manner.
Potential methods include reuse of parts or whole products and recycling of products, components, and/or materials.

For specific information on Dell's worldwide recycling programs, see www.dell.com/recyclingworldwide.

Contacting Dell™

For customers in the United States, call 800-WW W-Dell (800-999-3355).

ﬂ NOTE: If you do not have an active Internet connection, you can find contact information on your purchase invoice, packing slip, bill, or in your Dell™
catalog.

Dell™ provides several online and telephone-based support and service options. Availability varies by country and product, and some services may not be
available in your area. To contact Dell™ for sales, technical support, or customer service issues:

1. Visit support.dell.com.
2. Verify your country or region in the Choose A Country/Region drop-down menu at the bottom of the page.

3. Click Contact Us on the left side of the page.
4. Select the appropriate service or support link based on your need.

5. Choose the method of contacting Dell™ that is convenient for you.

Back to Contents Page
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Finding Information

4 NOTE: The following is an option that you need to buy separately.

n Additional memory card (256 MB)

What are you looking for?

Find it here

1 Drivers for my printer
1 My User's Guide

Drivers and Utilities CD

The Drivers and Utilities CD contains documentation and drivers for your printer. You can use the CD to
uninstall/reinstall drivers or access your documentation.

Readme files may be included on your CD to provide last-minute updates about technical changes to your
printer or advanced technical reference material for experienced users or technicians.

1 How to load print media into my
printer

1 How to print, scan, and copy

1 How to send and receive faxes

1 How to care for and maintain my
printer

1 How to contact Dell

Owner's Manual

|Enuepy s1aumg

NOTE: The Owner's Manual may not be available in your country or region.

1 Safety information
1 Warranty information

Product Information Guide

CAUTION: Read and follow all safety instructions in your Product Information Guide prior to setting up
and operating your printer.

1 How to set up my printer

Setup diagram

User's Guide



file:///C:/data/systems/PRN2135CN/en/ug/index.htm

How to use the operator panel menus
of my printer

How to use the Dell Printer
Configuration Web Tool and Tool Box
How to print, scan, and copy

How to send and receive faxes
Print media guidelines

How to use the software for my
printer

How to clear jams

Troubleshooting

[| o =remurmmm—

el

” AL e 8 i et s o et e,

i T T
B [[Z==e |
H A eyt eedn e e B B b, g o3 B

et =

| ey . o e e e e e

il

| e s st s s o vt i e
e e e e
B ] |!h....“' TN S A e

18 oJf| imarew srares commaens mesmico mas

Express Service Code and Service Tag
number

The Express Service Code and Service Tag numbers are located inside the side door of your printer.

Latest drivers for my printer
Documentation for my printer

See the Dell Support website at support.dell.com.

Answers to technical service and
support questions

The Dell Support website, support.dell.com provides several online tools, including:

Solutions - Troubleshooting hints and tips, articles from technicians, and online courses
Upgrades - Upgrade information for components, such as the printer drivers

Customer Care - Contact information, order status, warranty, and repair information
Downloads - Drivers

Manuals- Printer documentation and product specifications

OO0 0O0O0

You can access the Dell Support website at support.dell.com. Select your region on the support page, and fill
in the requested details to access help tools and information.

Back to Contents Page
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Printer Settings

Printing a System Settings Page

Using the Operator Panel to Change the Printer Settings

Using Your Computer to Change the Printer Settings

Using the Dell Printer Configuration Web Tool to Change the Printer Settings
Resetting Defaults
Adjusting the Language

You can change most system settings from your software program. If your printer is attached to the network, you can change settings from the Dell Printer
Configuration Web Tool. To launch the Dell Printer Configuration Web Tool, type the printer's IP address in your web browser. To find your printer's IP
address, see "Printing a System Settings Page".

Settings from the software program update the default system settings for the printer. Settings from the printer driver only apply to the job that you are
currently sending to the printer.

If you cannot change a setting from your software program, use the operator panel, Tool Box or the Dell Printer Configuration Web Tool. Changing a system
setting from the operator panel, Tool Box or from the Dell Printer Configuration Web Tool makes that setting the user default.

Printing a System Settings Page

You can verify the detailed system settings by printing a System Settings page.

From the Printer Operator Panel

1. Press " until >SETUP appears, and then press v .
2. Press "W until >Reports appears, and then press v .

3. System Settings is displayed. Press ( .

The System Settings page is printed.

From Your Computer

1. Click start— All Programs— Dell Printers— Additional Color Laser Software— Quick Launch Utility.

The Quick Launch Utility dialog box opens.

2. Click the Tool Box button.

The Tool Box dialog box opens.

3. Select the printer from Printer Name.

The Tool Box opens.

4. Click the Printer Settings Report tab.

5. Select Reports from the list at the left side of the page.

The Reports page is displayed.

6. Click the System Settings button.

The System Settings page is printed.

Using the Operator Panel to Change the Printer Settings

You can select menu items and corresponding values from the operator panel.
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When you first browse through the menus from the operator panel, you see an asterisk (*) next to a value in the menus.

This asterisk indicates the factory default menu setting. These settings are the original system settings.
ﬁ NOTE: Factory defaults may vary for different countries.

When you select a new setting from the operator panel, an asterisk appears next to the setting to identify it as the current user default menu setting.
These settings are active until new ones are selected or the factory defaults are restored.

To select a new value as a setting:

1. Press W until >SETUP appears, and then press ‘/ .
2. Press " or A until the desired menu appears, and then press v .

3. Press W € > or A until the desired menu or menu item appears, and then press v
1 If the selection is a menu, the menu is opened and the first system setting in the menu appears.

1 If the selection is a menu item, the default menu setting for the menu item appears. (The current user default menu setting has an asterisk (*)
beside it.)

Each menu item has a list of values for the menu item. A value can be:
o A phrase or word to describe a setting
o A numerical value that can be changed
o An On or Off setting

4. Press ¥ or M to scroll until the desired value appears, and then press v .

ﬂ NOTE: Some menu items require you to use the ten key to enter the value.

5. Press O to return to the previous menu.
To continue setting other items, select the desired menu. To quit setting new values, press X.

Driver settings may override changes previously made and may require you to change the operator panel defaults.

Using Your Computer to Change the Printer Settings

You can select menu items and corresponding values from the Tool Box.

ﬂ NOTE: Factory defaults may vary for different countries.

These settings are active until new ones are selected or the factory defaults are restored.

To select a new value as a setting:

1. Click start— All Programs— Dell Printers— Additional Color Laser Software— Quick Launch Utility.

The Quick Launch Utility dialog box opens.

2. Click the Tool Box button.

The Tool Box dialog box opens.

3. Select the printer from Printer Name.

The Tool Box opens.

4. Click the Printer Maintenance tab.

5. Select the desired menu item.
Each menu item has a list of values for the menu item. A value can be:

o A phrase or word to describe a setting

o A numerical value that can be changed



o An On or Off setting

6. Select the desired value, and then click the associated button with each menu item.

Driver settings may override changes previously made and may require you to change the Tool Box defaults.

Using the Dell Printer Configuration Web Tool to Change the Printer Settings

If your printer is connected to the network, you can change the printer settings from your web browser. If you are a network administrator, you can clone the
system settings of one printer to one or all the printers on the network.

Type the IP address of your printer in your web browser. Choose Printer Settings from the topics list, and then select the System Settings you want to
change.

To copy your system settings to another printer on the network, choose Copy Printer Settings from the topics list, and then type the other printer's IP
address.

If you do not know your printer's IP address, see the System Settings page. To print a System Settings page:

From the Printer Operator Panel

1. Press " until >SETUP appears, and then press v
2. Press " until >Reports appears, and then press v .

3. System Settings is displayed. Press ( .

The System Settings page is printed.

From Your Computer

1. Click start— All Programs— Dell Printers— Additional Color Laser Software— Quick Launch Utility.

The Quick Launch Utility dialog box opens.

2. Click the Tool Box button.

The Tool Box dialog box opens.

3. Select the printer from Printer Name.

The Tool Box opens.

4. Click the Printer Settings Report tab.

5. Select Reports from the list at the left side of the page.

The Reports page is displayed.

6. Click the System Settings button.

The System Settings page is printed.

Resetting Defaults

After executing this function and rebooting the printer, all the menu parameters, except the parameters for the network, are reset to their default values.

From the Printer Operator Panel

1. Press " until >SETUP appears, and then press v .



2. Press W until >Adni n Menu appears, and then press \( .

3. Press " until >Mai nt enance appears, and then press v .

4. Press W until >Initialize N\WM appears, and then press v .
5. Press W until >Syst em Secti on appears, and then press \/ .

6. The Are you sure? message appears on the operator panel, and then press € or ¥ to select Yes. Press v

The printer is turned off automatically to apply the settings.

From Your Computer

1. Click start— All Programs— Dell Printers— Additional Color Laser Software— Quick Launch Utility.

The Quick Launch Utility dialog box opens.

2. Click the Tool Box button.

The Tool Box dialog box opens.

3. Select the printer from Printer Name.

The Tool Box opens.

4. Click the Printer Maintenance tab.

5. Select Reset Defaults from the list at the left side of the page.

The Reset Defaults page is displayed.

6. Select System Section button.

The printer is turned off automatically to apply the settings.

Adjusting the Language

To display a different language on the operator panel:

From the Printer Operator Panel

1. Press " until >SETUP appears, and then press ( .
2. Press " until >Panel Language appears, and then press ‘/ .

3. Press ? until the desired language appears, and then press v .

From Your Computer

1. Click Start— All Programs— Dell Printers— Additional Color Laser Software— Quick Launch Utility.

The Quick Launch Utility dialog box opens.

2. Click the Tool Box button.

The Tool Box dialog box opens.

3. Select the printer from Printer Name.



The Tool Box opens.

4. Click the Printer Maintenance tab.

5. Select System Settings from the list at the left side of the page.

The System Settings page is displayed.

6. Select the desired language from Device Language, and then press the Apply New Settings button.

Back to Contents Page
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About Your Printer

@ Automatic Document Feeder (ADF)

@ Operator Panel
@ Protecting Your Printer
@ Ordering Supplies

The following illustrations show the standard Dell™ 2135cn Color Laser Multifunction Printer.

ﬂ NOTE: In this manual, Dell™ 2135cn Color Laser Multifunction Printer is referred to as the "printer".

Front View

1 | Automatic Document Feeder (ADF) |5 Tray 1

2| Side Button

[}

Single Sheet Feeder (SSF)

Front Cover
3| Side Cover (toner cartridges inside) | 7

NOTE: You can open the front cover by pushing the side button (2).

4 | Belt Unit

©

Operator Panel

Rear View

Automatic Document Feeder (ADF) Wall Jack Connector

Memory Cover "Blue" Plug

USB Port Power Connector

Ethernet Port RESET Button

afsjw N |-

Phone Connector 10| Power Switch
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NOTICE: To avoid irregular screen image or malfunctioning of your printer, avoid placing the printer in direct sunlight with the single sheet feeder
opened.

Provide enough room to open the printer tray, covers, and optional equipment. It is also important to ensure that there is enough space around the printer for
proper ventilation.

320 mm{12.60 inches
580 mm/22.83 inc hes

100 mm/3 94 inches

494 mmy19.45 inches \<

600 mm/2362 inchas

50 mmy5.90 inches

Automatic Document Feeder (ADF)

ADF Cover

Document Guides

Document Glass

Alw N |-

Document Feeder Tray

Operator Panel

For details on the operator panel, see "Operator Panel".

Protecting Your Printer

To protect your printer from theft, you can use the optional Kensington lock.

Attach the Kensington lock to the security slot of your printer.
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Security Slot

For details, see the operating instructions supplied with the Kensington lock.

Ordering Supplies

To order replacement toner cartridges or supplies from Dell:

1. Double-click the icon on your desktop.

If you cannot find the icon on your desktop:

a. Click the "DLRMM.EXE" file under "C:\ Program Fi | es\Del | Printers\Additional Color Laser Software\Reorder".

ﬂ NOTE: "C:\ Program Fi | es\ " may be different depending on the destination of the folder in which you have installed the Dell software and
documentation.

b. Click File on the toolbar, and then Create Shortcut on the drop-down menu that appears.
c. Right-click on the shortcut icon that is created.

d. Choose Send To from the drop-down menu, and then click Desktop (create shortcut) on the submenu that appears.

2. Visit the Dell Printer Supplies website at www.dell.com/supplies, or order Dell printer supplies by phone.
To ensure that you get the best service, have your Dell printer Service Tag available.

For information regarding locating your Service Tag number, see "Express Service Code and Service Tag number".

Back to Contents Page
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Installing the Toner Cartridges and Print Head Device (PHD) Unit

@ Installing the Toner Cartridges

@ |Installing the PHD Unit

A

° NOTICE: To protect the drums of the Print Head Device (PHD) against bright light, close the front cover within three minutes. If the front cover remains
open for more than three minutes, the print quality may deteriorate.

CAUTION: Before performing any of the following procedures, read and follow the safety instructions in your Product Information Guide.

O NOTICE: Ensure that nothing touches or scratches the surface (black-colored film) of the belt unit. Scratches, dirt, or oil from your hands on the film of
the belt unit may affect the print quality.

Installing the Toner Cartridges

1. Open the side cover.

3.
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Installing the PHD Unit

1. Press the side button and open the front cover.

2. Turn the four PHD lock levers counterclockwise to unlock the unit.

° NOTICE: Do not touch the belt unit.

3. Hold the gray tabs, and then pull the PHD unit out of the printer totally.

4. Completely remove the four yellow ribbons from the PHD unit.




° NOTICE: Pull the ribbons straight out of the unit.

5. Insert the PHD unit until the line on the handle aligns with the white line on the printer.

6. Turn the four PHD lock levers 90 degrees in clockwise direction, and then remove the protective sheet.

Back to Contents Page
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Connecting Your Printer

Choosing the Right Cable

Connecting the Printer Directly to a Computer
Turning On the Printer

Connecting the Printer to the Network

Connecting the Telephone Line
Using the RESET Button

Choosing the Right Cable

Your Dell™ 2135cn Color Laser Multifunction Printer interconnection cable must meet the following requirements:

Connection type Connection specifications

use USB 2.0

Ethernet 10 Base-T/100 Base-TX

Wall jack connector | RJ11

Phone connector RJ11

1| Phone connector %

LINE
2 | wall jack connector
3| Ethernet port Egﬁ
E‘
4| USB port

Connecting the Printer Directly to a Computer

A local printer is a printer which is directly attached to your computer using a USB cable. If your printer is attached to a network instead of your computer, skip
this section and go to "Connecting the Printer to the Network".

Microsoft® windows® 2000, Windows XP, Windows XP 64-bit Edition, Windows Server® 2003, Windows Server 2003 Enterprise x64 Edition, Windows Server
2008, Windows Server 2008 Enterprise x64 Edition, Windows Vista®, and Windows Vista 64-bit Edition support USB connections.

See your computer operating system documentation to see if your system supports USB.

To attach the printer to a computer:

1. Ensure that the printer, computer, and any other attached devices are turned off and unplugged.

2. Connect the printer to the computer using a USB cable.
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A USB port requires a USB cable. Ensure that you match the USB symbol on the cable to the USB symbol on the printer.

Plug the other end of the cable into a USB port at the back of the computer. Do not plug it into the USB keyboard.

Turning On the Printer

1. Connect the power cable to the printer and plug it into a power source.

Do not use extension cords or power strips.

The printer should not be plugged into a UPS system.

2. Turn on the computer and the printer. When you use the USB cable, the USB driver is automatically installed.

Connecting the Printer to the Network

To attach the printer to a network:

1. Ensure that the printer, computer, and any other attached devices are turned off and unplugged.

2. Connect the printer to the network using an ethernet cable.



Ethernet port

To connect the printer to the network, plug one end of an Ethernet cable into the Ethernet port at the back of the printer, and the other end into a LAN drop
or hub.

Turn On the Printer

1. Plug one end of the power cable into the socket at the back of the printer and the other end into a properly grounded power outlet.
Do not use extension cords or power strips.

The printer should not be plugged into a UPS system.

2. Turn on the computer and the printer.

Print and Check the System Settings Page

Print the System Settings page.

From the Printer Operator Panel

1. Press W until >SETUP appears, and then press v .
2. Press "W until >Reports appears, and then press v .

3. System Settings is displayed. Press ( .

The System Settings page is printed.



From Your Computer

1. Click start—> All Programs— Dell Printers— Additional Color Laser Software— Quick Launch Utility.

The Quick Launch Utility dialog box opens.

2. Click the Tool Box button.

The Tool Box dialog box opens.

3. Select the printer from Printer Name.
The Tool Box opens.
4. Click the Printer Settings Report tab.
5. Select Reports from the list at the left side of the page.

The Reports page is displayed.

6. Click the System Settings button.

The System Settings page is printed.

Assign an IP Address

An IP address is a unique number that consists of four sections that are delimited by a period and can include up to three digits in each section, for example,
111. 222. 33. 44.

Assigning an IP address already in use can cause network performance issues.

ﬂ NOTE: Assigning an IP address is considered as an advanced function and is normally done by a system administrator.

From the Printer Operator Panel

For more information on using your operator panel, see "Operator Panel".

1. Turn on the printer.

>CCPY appears.

Press " until >SETUP appears, and then press \/ .

N

w

Press W until >Adni n Menu appears, and then press v .
4. Press W until >Wred Network appears, and then press v .

Press W until >TCP/ | P appears, and then press ( .

a

6. >Cet | P Address is displayed. Press v .

Panel is displayed. Press \/ .

7.
8. Press the O button.
9. Press " until > P Addr ess appears, and then press \( .

The cursor is located at the first digit of the IP address.

10. Use the ten keys to enter the first digit of the IP address, and then press >.

The cursor moves to the next digit.

ﬂ NOTE: You can only enter one digit at a time and must press » after entering each digit.
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11. Enter the rest of the digits, and then press v .

12. Press the O button.

13. Press " until >Subnet Mask appears, and then press v .

14. Repeat steps 10 to 11 to set Subnet Mask, and then press ( .
15. Press the O button.

16. Press "W until >Gat eway Address appears, and then press ( .

17. Repeat steps 10 to 11 to set the Gateway Address, and then press v .

18. Turn off the printer, and then turn it on again.

From Your Computer

1. Click start— All Programs— Dell Printers— Additional Color Laser Software— Quick Launch Utility.

The Quick Launch Utility dialog box opens.

2. Click the Tool Box button.

The Tool Box dialog box opens.

3. Select the printer from Printer Name.

The Tool Box opens.

4. Click the Printer Maintenance tab.

5. Select TCP/IP Settings from the list at the left side of the page.

The TCP/IP Settings page is displayed.

6. Select the mode from IP Address Mode, and then enter the values in IP Address, Subnet Mask, and Gateway Address.

7. Press the Apply New Settings button to take effect.

You can also assign the IP address to the printer when installing the printer drivers with the installer. When you use the Network Installation feature, and
the Get | P Address is set to Aut ol P or DHCP on the operator panel menu, you can set the IP address from 0.0.0.0 to the desired IP address on the printer
selection window.

Verify the IP Settings

1. Print another System Settings page.

2. Look under the TCP/IP heading on the System Settings page to ensure that the IP address, subnet mask, and gateway are what you expected.
OR

Ping the printer and verify that it responds. For example, at a command prompt on a network computer, type ping followed by the new IP address (for
example, 192.168.0.11):

ping 192.168.0.11

If the printer is active on the network, you will receive a reply.

Connecting the Telephone Line

NOTE: Do not connect your printer directly to a DSL (digital subscriber line). This may damage the printer. To use a DSL, you will need to use an
appropriate DSL filter. Contact your service provider for the DSL filter.



1. Plug one end of a telephone line cord into the wall jack connector and the other end into an active wall jack.

Wall jack connector

To the wall jack

Phone connector

"Blug” plug

BHTHE]

Phone conngctor

To an external telephone or
answering maching

If the phone communication is serial in your country (such as Germany, Sweden, Denmark, Austria, Belgium, Italy, France and Switzerland), and that you
are supplied with a "Yellow" terminator, insert the "Yellow" terminator into the phone connector ().

Phang connectar

“Yellow® terminatar

Using the RESET Button

Your printer is supplied with an electric leakage detector, which prevents an electric shock or fire due to an electric leakage by automatically cutting circuits
inside the printer.

When an electric leakage is detected, the RESET button is tripped. In this case, press the RESET button to turn the printer back on. If the RESET button is
tripped again after you press the RESET button, contact Dell.



RESET button

TEST button

At least once a month, check whether or not the electric leakage detector is functioning by following the steps below:

1. Turn on the printer, and then press the TEST button.

1 If the RESET button is tripped and the printer is turned off, the electric leakage detector functions correctly. Press the RESET button to turn the
printer back on.

1 If the RESET button is not tripped, contact Dell. Do not continue to use the printer if the electric leakage detector is not functioning.

Back to Contents Page
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Dell Printer Configuration Web Tool

@ Using the Dell Printer Configuration Web Tool
@ Setting Up Your Web Browser

@ Page Display Format

@ Changing the Settings of the Menu Items

ﬁ NOTE: This web tool is not available unless the printer is connected to a network using a network cable.

One of the features of the Dell™ Printer Configuration Web Tool is the E-Mail Alert Setup, which sends an e-mail to you or the key operator when the printer
needs supplies or intervention.

To fill out printer inventory reports requiring the asset tag number of all the printers in your area, use the Printer Information feature in the Dell Printer
Configuration Web Tool. Just type the IP address of each printer on the network to display the asset tag number.

35cn MFP - Microsoft Internet Explorer

| Ele Edt iew Favortes Jook Hep

| pe e ) |
| ek - = - @[5 A | Qsearch [aiFsvortes Frieda 3| 5 S 5 | unks
| agovess o] retp:ri - ee 11 dindex b =] o |

- Dell 2135¢cn MFP
Printer Status 1P

Location

Printer Jobs Contact Person;

Printer Settings

Print Server Settings

Copy Printer Settings [ Printer Status I

Print Yolume
Printer Status | Printer Events | Printer Information

Address Book

Printer Status - Refiesh

Printer Information

Tray Settings

Cyan Cartridge Level ~ 60 %
E-Mail Alert I
Set Password Magenta Cartridge Level ~ 80 %
Online Help

Yellow Cartridge Level ~ 60 %

Order Supplies at
wwaw.dell.com/supplies Black Cartridge Level ~ 60 %
Contact Dell Support at:
support.dell.com

Paper Trays: Status: Capacity: Size:
Single Sheet Feeder {Manual) Add Paper 1 sheets -
Tray 1 0K 250 sheets Ad (210 % 297 mm)
Qutput Tray: Status: Capacity:
Output Tray 0K 150 sheets
Cover: Status:
Front Caver Closed
Side Cover Closed
ADF Cover Closed
Printer Type Color Laser
Printing Speed 12Pages/Minute (Color), 16P Tinute (hd h
[] pone 1 T mntemet 4

The Dell Printer Configuration Web Tool feature also allows you to change the printer settings and keep track of printing trends. If you are a network
administrator, you can easily copy the printer settings to one or all printers on the network using your web browser.

To launch the Dell Printer Configuration Web Tool, type your printer's IP address in your web browser.

If you do not know the IP address of your printer, print the System Settings page, which lists the IP address:

From the Printer Operator Panel
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1. Press " until >SETUP appears, and then press v
2. Press " until >Report s appears, and then press v.

3. System Settings is displayed. Press v .

The System Settings page is printed.

From Your Computer

1. Click start— All Programs— Dell Printers— Additional Color Laser Software— Quick Launch Utility.

The Quick Launch Utility dialog box opens.

2. Click the Tool Box button.

The Tool Box dialog box opens.

3. Select the printer from Printer Name.

The Tool Box opens.

4. Click the Printer Maintenance tab.

5. Select EWS (Embedded Web Server or Dell Printer Configuration Web Tool) from the list on the left side of the page.

The EWS page is displayed.

6. Press the Display button.
The System Settings page is printed.

If the IP address shows 0. 0. 0. 0 (factory default), an IP address has not been assigned. To assign one for your printer, see "Assign an IP_Address".

Using the Dell Printer Configuration Web Tool

Use the Dell Printer Configuration Web Tool for:

Printer Status

Use the Printer Status menu to get immediate feedback on the printer supply status. When a toner cartridge is running low, click the order supplies link on
the first screen to order an additional toner cartridge.

Printer Jobs
Use the Printer Jobs menu to access information on the Job List page and Completed Jobs page.

These pages show the details of the status regarding each protocol or job.

Printer Settings

Use the Printer Settings menu to change the printer settings and to view the settings in the operator panel remotely.

Print Server Settings

Using the Print Server Settings menu, you can change the type of printer interface and the necessary conditions for communications.

Copy Printer Settings

Use the Copy Printer Settings menu to copy the printer settings to another printer or printers on the network just by typing each printer's IP address.


file:///c:/data/systems/prn2135cn/en/ug/sectioni.htm#wp1180185

ﬂ NOTE: You must log in as an administrator to use this feature.

Print Volume

Use the Print Volume option to check the history of printing, such as paper usage, the types of jobs being printed, limit to which users can use the color
mode, and the maximum number of pages they can print.

Address Book

Use the Address Book menu to view or edit the e-mail address, server address, and fax number entries in the Address Book, or to register new entries.

Printer Information

Use the Printer Information menu to get information on service calls, inventory reports, or the status of current memory and engine code levels.

Tray Settings

Use the Tray Settings menu to get information about the paper type and size for each tray.

E-Mail Alert

Use the E-Mail Alert menu to receive an e-mail when the printer needs supplies or intervention. To be notified, type your name or the key operator's name in
the e-mail list box. Set E-mail Alert also when using the Scan to E-mail feature.

Set Password

Use the Set Password menu to lock the Dell Printer Configuration Web Tool with a password so that other users do not inadvertently change the printer
settings that you have selected.

ﬂ NOTE: You must log in as an administrator to use this feature.

Online Help

Click Online Help to visit the Dell Support website.

Order Supplies at:

www.dell.com/supplies

Contact Dell Support at:

support.dell.com

Setting Up Your Web Browser
Ensure that you activate JavaScript in your browser before using the Dell Printer Configuration Web Tool.

It is recommended to configure the environment settings for your web browsers before using the Dell Printer Configuration Web Tool.

ﬂ NOTE: The Dell Printer Configuration Web Tool pages that are displayed may be unreadable if the pages were configured by a language different from
your web browser's.

For Internet Explorer® 6.0 or Internet Explorer® 7.0:

Setting Up the Display Language

1. Select Internet Options from Tools on the menu bar.
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2. Select Languages in the General tab.

3. Specify the display language in order of preference in the Language list.
For example:

1 Italian (Italy) [it]

1 Spanish (Traditional Sort) [es]

1 German (Germany) [de]

1 French (France) [fr]

1 English [en] or English (United States) [en-us]
1 Danish [da]

1 Dutch [nI]

1 Norwegian [no]

1 Swedish [sv]

Setting the Printer's IP Address to Non-Proxy

1. Select Internet Options from the Tools menu.
2. Select Proxy server under LAN Settings in the Connections tab.

3. Clear the Use a proxy sever for your LAN check box.
OR

Click Advanced, and then specify the printer's IP address in the Do not use proxy server for addresses beginning with field under Exceptions.

4. After setting the language and proxy, type <http://nnn. nnn. nnn. nnn/ > (the printer's IP address) in the URL entry field of the browser to activate the
Dell Printer Configuration Web Tool.

For Firefox 2.0 or Later:

Setting Up the Display Language

1. Select Options from the Tools menu.
2. Click Advanced.
3. Click Choose in the General tab.

4. Specify the display language in order of preference in the Languages in order of preference list.
For example:

1 English [en] or English/United States [en-us]
1 ltalian [it]

1 Spanish [es]

1 German [de]

1 French [fr]

1 Dutch [nI]

1 Norwegian [no]

1 Swedish [sv]

1 Danish [da]

Setting the Printer's IP Address to Non-Proxy



1. Select Options from the Tools menu.
2. Click Network in the Options dialog box.
3. Click Connection — Settings.

4. Do one of the following:
1 Select the Direct connection to the Internet check box.
1 Select the Auto-detect proxy settings for this network check box.
1 Select the Manual proxy configuration check box, and then enter the printer's IP address in the No Proxy for edit box.

1 Select the Automatic proxy configuration URL check box.

After setting the language and proxy, type <http://nnn. nnn. nnn. nnn/ > (the printer's IP address) in the URL entry field of the browser to activate the Dell
Printer Configuration Web Tool.

Page Display Format

The layout of the page is divided into three sections listed below:

Top Frame

The top frame is located at the top of all pages. When the Dell Printer Configuration Web Tool is activated, the current status and specifications of the
printer are displayed in the top frame on every page.

The following items are displayed in the top frame.

I\D/I?:II'L 2135¢cn Displays the product name of the printer.
1Pv4 Displays the IP address of the printer.
Location Displays the printer's location. The location can be changed in the Basic Information section on the Print Server Settings page.

Displays the name of the printer's administrator. The name can be changed in the Basic Information section on the Print Server

Contact Person Settings page.

Machine image Shows the bitmap image of the printer. The Printer Status menu appears in the right frame when you click on the image.

Left Frame

The left frame is located on the left side of all the pages. The menu titles displayed in the left frame are linked to corresponding menus and pages. You can go
to the corresponding page by clicking their characters.

The following menus are displayed in the left frame.

Printer Status Links to the Printer Status menu.

Printer Jobs Links to the Printer Jobs menu.

Printer Settings Links to the Printer Settings Report menu.
Print Server Settings Links to the Print Server Reports menu.

Copy Printer Settings Links to the Copy Printer Settings menu.

Print Volume Links to the Print Volume menu
Address Book Links to the Address Book menu.
Printer Information Links to the Printer Status menu.

Tray Settings Links to the Tray Settings menu.

E-Mail Alert Links to the Print Server Settings menu.
Set Password Links to the Other Features menu.
Online Help Links to the Dell Support website.

Order Supplies at: Links to the Dell web page.

Contact Dell Support at: | Links to the Dell support page web address: support.dell.com/

Right Frame

The right frame is located on the right side of all the pages. The contents of the right frame correspond to the menu that you select in the left frame. For
details on the items displayed in the right frame, see "Details of the Menu Items"”.
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Buttons in the Right Frame

Refresh Button

Receives the current printer configuration and updates the latest information in the right frame.

Apply New Settings
Button

Submits new settings made on the Dell Printer Configuration Web Tool to the printer. The old printer settings will be replaced by
the new settings.

Restore Settings Button | Restores the old settings that existed from before any changes were made. New settings will not be submitted to the printer.

Changing the Settings of the Menu Items

Some menus allow you to change the printer settings through the Dell Printer Configuration Web Tool. When you are accessing these menus, the
authentication dialog appears on the screen. Type a user name and password for the printer's administrator by following the prompts displayed in the dialog

box.

The default user name is admin, and the default password is left blank (NULL). You can change only the password in the Set Password page in the Other
Features menu. The user name cannot be changed. See "Set Password” for more information.

Details of the Menu Items

"Printer Status"

“Printer Status"

“Printer Events"

“Printer Information"

“Printer Jobs"

"Job List"

Completed Jobs"

“Menu Settings"
"Reports"

Printer Settings Report"

System Settings"
“"PCL Settings"
“Secure Settings"
Copy Defaults"

“Printer Settings" "Copy Color Balance"

“Copy Settings"

"Scan Defaults"

“Fax Defaults"

“Fax Settings"

Printer Settings"

“"Paper Density"

"Adjust BTR"

“Adjust Fuser"

"Auto Reaqistration Adjustment”
"Color Registration Adjustments"

Clean Developer”
“Adjust Altitude"

"Reset Defaults"

“Printer Maintenance"

“Non-Dell Toner"

ialize PrintMeter"

Clock Settings"

“"Web Link Customization"”

“Print Server Setup Page"
“E-Mail Alert Setup Page"

“Print Server Reports"

"Print Server Settings"

“Basic Information™

Port Settings”
"TCP/IP"

"Print Server Settings"

"E-Mail Alert"

"SNMP"

“Scan To Network"

“Set Password"

"Other Features"
“Reset Print Server"

"Copy Printer Settings"

“Copy Printer Settings"

“Copy Printer Settings Report"

"Print Volume"




"Print Volume"

“Dell ColorTrack"

"Edit Print User Registration™

"Print User Settings (Confirm/Change, Create)"

"Address Book"

"E-Mail Address" "E-Mail Group - Top Page"

E-Mail Address - Top Page"
“E-Mail Address (Confirm/Change, Create)"

“E-Mail Address (Delete)"

"E-Mail Group (Confirm/Change, Create)"
“E-Mail Group (Delete)"
"Default Setup"

“Server Address" “Server Address (Confirm/Change, Create)"

“Server Address - Top Page"

"Server Address (Delete)"

“"Phone Book"

“EAX Speed Dial - Top Page"

"EAX Speed Dial (Confirm/Change. Create)"
"EAX Speed Dial (Delete)"

"EAX Group - Top Page"

"EAX Group (Confirm/Change, Create)"
“"EAX Group (Delete)"

"Tray Settings"

Printer Status

Use the Printer Status menu to check the status of consumables, hardware, and specifications of the printer.

The following pages are displayed in the Printer Status menu.

Printer Status

Purpose:

To check the status of the consumables and trays.

Values:

Cyan Cartridge Level
Magenta Cartridge Level
Yellow Cartridge Level

Black Cartridge Level

Displays the percent of toner remaining in each toner cartridge. When a cartridge is empty, a message appears. The text
Print Cartridge is linked to the Dell Printer Supplies website.

OK Indicates that there is some paper in the tray but the quantity is unknown.
Status | agqq . . .
Paper Paper Indicates that there is no paper in the tray.
Trays
Capacity Displays the maximum capacity of the paper tray.
Size Displays the size of paper in the tray.
output Status | OK Indicates that the tray is available.
Tray Capacity Displays the maximum capacity of the paper tray.
Closed Indicates that the cover is closed.
Cover Status
Open Indicates that the cover is open.

Printer Type

Displays the type of the printer. Color Laser is displayed normally.

Printing Speed

Displays the printer's printing speed.

Printer Events

Purpose:

When faults occur, such as Out of Paper or Cover is Open, the details of all alerts or indications of faults are displayed in the Printer Events page.

Values:

| Locationl Displays the location where a fault occurred.
r T




Details | Displays the details of the fault. |

Printer Information

Purpose:

To verify the printer details such as the hardware configuration and software version. This page can also be displayed by clicking on the Printer Information
tab in the left frame.

Values:
Dell Service Tag Number Displays Dell's service tag number.
Asset Tag Number Displays the printer's asset tag number.
Printer Serial Number Displays the printer's serial number.
Memory Capacity Displays the memory capacity.
Processor Speed Displays the processing speed.
Firmware Version Displays the revision date (revision level).
Printer Revision Levels
Network Firmware Version | Displays the revision date (revision level).

Printer Jobs

The Printer Jobs menu contains information on the Job List and Completed Jobs pages. These pages show the details of the status regarding each protocol
or the print jobs.

Job List

Purpose:

To confirm the print jobs that are being processed. Click the Refresh button to update the screen.

Values:
1D Displays the job ID.
Job Name Displays the file name of the job being printed.
Owner Displays the job owner's name.
Host Name Displays the name of the host computer.
Job Status Displays the status of the job being printed.
Job Type Displays the type of the job.
Host I/F Displays the status of the host interface.
Job Submitted Time | Displays the date the print job was submitted.

Completed Jobs

Purpose:

To check the completed jobs. Up to the last 20 jobs are displayed. Click the Refresh button to update the screen.

Values:
1D Displays the job ID.
Job Name Displays the file name of the job.
Owner Displays the job owner's name.
Host Name Displays the name of the host computer.
Output Result Displays the status of the job.
Job Type Displays the type of the job.
Impression Number | Displays the job's total number of pages.
No. of Sheets Displays the job's total number of sheets.
Host I/F Displays the status of the host interface.

Job Submitted Time | Displays the date the job was submitted.

Printer Settings



Use the Printer Settings menu to display the Printer Settings Report and to configure the printer settings.

The following tabbed pages are displayed at the top of the right frame.

Printer Settings Report

The Printer Settings Report tab includes the Menu Settings and Reports pages.

Menu Settings

Purpose:

To display the current settings of the operator panel menus.

Values:

System Settings

Power Saver Timer
Mode 1

Displays the time for transition to Power Saver Mode 1.

Power Saver Timer
Mode 2

Displays the time for transition to Power Saver Mode 2.

Auto Reset

Displays the amount of time before the printer automatically resets the settings on the operator panel to the
defaults when no additional settings are made.

Panel Select Tone

Displays the volume of the tone that is emitted when the operator panel input is correct. Off indicates that the
tone is disabled.

Panel Alert Tone

Displays the volume of the tone that is emitted when the operator panel input is incorrect. Off indicates that
the tone is disabled.

Machine Ready Tone

Displays the volume of the tone that is emitted when the printer becomes ready. Off indicates that the tone is
disabled.

Copy Job Tone

Displays the volume of the tone that is emitted when a copy job is complete. Off indicates that the tone is
disabled.

Non-Copy Job Tone

Displays the volume of the tone that is emitted when a job other than a copy job is complete. Off indicates
that the tone is disabled.

Fault Tone

Displays the volume of the tone that is emitted when a job ends abnormally. Off indicates that the tone is
disabled.

Alert Tone

Displays the volume of the tone that is emitted when a problem occurs. Off indicates that the tone is disabled.

Out of Paper Tone

Displays the volume of the tone that is emitted when the printer runs out of paper. Off indicates that the tone
is disabled.

Low Toner Tone

Displays the volume of the tone that is emitted when the toner or some other consumable is low. Off indicates
that the tone is disabled.

System Settings

Auto Clear Alert Tone

Displays the volume of the tone that is emitted 5 seconds before the printer performs auto clear. Off indicates
that the tone is disabled.

Displays the volume of the tone that is emitted when the operator panel screen is returned to the default

Base Tone setting by scrolling the loop menu. Off indicates that the tone is disabled.
All Tones Displays the volume of all the alert tones. Off indicates that all the tones are disabled.
Time-Out Displays the amount of time that the printer waits for data to arrive from the computer.

Panel Language

Displays the language that is used on the operator panel screen.

Auto Log Print

Displays whether or not to automatically print a job history report after every 20 jobs.

Print ID Displays where to print a user ID on the output paper.
. Displays whether or not the printer outputs PDL (Page Description Language) data (which is not supported by
Print Text H . . .
the printer) as text when the printer receives it
RAM Disk Displays whether or not to allocate RAM for the file system for the Secure Print and Proof Print features. This

item is only available when the 256 MB optional memory card is installed.

Substitute Tray

Displays if paper of another size has to be used when the paper that is loaded in the specified tray does not
match the paper size setting for the current job.

mm / inch

Displays the measurement unit that is used on the operator panel screen.

PCL Settings

Paper Size

Displays the paper size setting.

Custom Size - Y

Displays the length of custom size paper.

Custom Size - X

Displays the width of custom size paper.

Orientation Displays how text and graphics are oriented on the page.
Font Displays the selected font from the list of registered fonts.
Symbol Set Displays a symbol set for the specified font.

Font Size Displays the font size for scalable typographic fonts.

Font Pitch Displays the font pitch for scalable monospaced fonts.
Form Line Displays the number of characters in a line.

Quantity Displays the number of copies to print.

Hex Dump Displays whether the Hex Dump feature is enabled.

Draft Mode Displays whether or not to print in the draft mode.




Line Termination

Displays whether or not to set the line termination.

Default Color

Displays the color mode setting.

Secure Settings

Panel Lock Set

Displays whether or not to lock Adni n Menu with a password.

Copy Service Lock
Set

Displays whether or not to lock the Copy service with a password.

Scan Service Lock
Set

Displays whether or not to lock the Scan service with a password.

Fax Service Lock Set

Displays whether or not to lock the Fax service with a password.

Secure Receive Set

Displays whether or not a password is required to receive faxes.

Copy Defaults

Color

Displays whether to make copies in color or in black and white.

Select Tray

Displays the default input tray.

SSF Paper Size

Displays the paper size setting of the single sheet feeder.

SSF Paper Type

Displays the paper type settings of the single sheet feeder.

Reduce/Enlarge

Displays the default copy reduction/enlargement ratio.

Original Type

Displays the type of the original.

Document Size

Displays the paper size of the original.

Lighter/Darker

Displays the default copy density.

Sharpness

Displays the default sharpness level.

Color Saturation

Displays the default color saturation level.

Auto Exposure

Displays whether to suppress the background of the original to enhance text on the copy.

Auto Exposure Level

Displays the background suppression level.

Copy Color
Balance

Yellow Low Dens.

Displays the color balance level of low density yellow.

Yellow Medium Dens.

Displays the color balance level of medium density yellow.

Yellow High Dens.

Displays the color balance level of high density yellow.

Magenta Low Dens.

Displays the color balance level of low density magenta.

Magenta Medium
Dens.

Displays the color balance level of medium density magenta.

Magenta High Dens.

Displays the color balance level of high density magenta.

Cyan Low Dens.

Displays the color balance level of low density cyan.

Cyan Medium Dens.

Displays the color balance level of medium density cyan.

Cyan High Dens.

Displays the color balance level of high density cyan.

Black Low Dens.

Displays the color balance level of low density black.

Black Medium Dens.

Displays the color balance level of medium density black.

Black High Dens.

Displays the color balance level of high density black.

Copy Settings

Multiple-Up

Displays whether the Multiple-Up feature is enabled.

Collated

Displays whether or not to collate the copy.

Margin Top/Bottom

Displays the value of the top and bottom margins.

Margin Left/Right

Displays the value of the left and right margins.

Margin Middle

Displays the value of the middle margin.

Scan Defaults

Scan To Network

Displays whether to save scanned documents on a network server or on a computer.

File Format

Displays the file format in which scanned documents are to be saved.

Color

Displays whether to scan in color or in black and white.

Resolution

Displays the default scan resolution.

Document Size

Displays the paper size of the original.

Lighter/Darker

Displays the default scan density level.

Sharpness

Displays the default sharpness level.

Contrast

Displays the default contrast level.

Auto Exposure

Displays whether to suppress the background of the original to enhance text on the copy.

Auto Exposure Level

Displays the background suppression level.

Margin Top/Bottom

Displays the value of the top and bottom margins.

Margin Left/Right

Displays the value of the left and right margins.

Margin Middle

Displays the value of the middle margin.

TIFF File Format

Displays the selected TIFF file format; TIFF V6 or TTN2.

Image Compression

Displays the image compression level.

Max E-Mail Size

Displays the maximum size of e-mail that can be sent.

Fax Defaults

Resolution

Displays the resolution level to be used for fax transmission.

Lighter/Darker

Displays the density level to be used for fax transmission.

Delayed Start

Displays the fax transmission start time.

Receive Mode

Displays the fax receiving mode.

Auto Receive Fax

Displays the interval at which the printer goes into the fax receive mode after receiving an incoming call.




Fax Settings

Auto Receive Fax/Tel

Displays the interval at which the printer goes into the fax receive mode after the external telephone receives
an incoming call.

Auto Receive
Answer/Fax

Displays the interval at which the printer goes into the fax mode after the external answering machine receives
an incoming call.

Line Monitor

Displays the volume of the line monitor, which audibly monitors a transmission through the internal speaker
until a connection is made.

Ring Tone Volume

Displays the volume of the ring tone, which indicates that an incoming call is a telephone call through the
internal speaker when Receive Mode is set to Telephone/Fax.

Line Type

Displays the line type; PSTN or PBX.

Tone/Pulse

Displays whether to use tone or pulse dialing.

Resend Delay

Displays the interval between resend attempts.

Redial Attempts

Displays the number of redial attempts to make if the destination fax number is busy.

Redial Delay

Displays the interval between redial attempts.

Junk Fax Setup

Displays whether to reject faxes sent from unwanted stations.

Remote Receive

Displays whether to receive faxes by pressing a remote receive code on the external telephone.

Remote Receive Tone

Displays the 2-digit remote receive code when Remote Receive is On.

Fax Header

Displays whether to print the sender’s information on the header of faxes.

Fax Header Name

Displays the sender's name that will be printed on the header of faxes.

Fax Settings

Fax Number

Displays the fax number of the printer, which will be printed on the header of faxes.

Fax Cover Page

Displays whether to attach a cover page to faxes.

DRPD Pattern

Displays the Distinctive Ring Pattern Detection (DRPD) setting.

Sent Fax Forward

Displays whether to forward incoming faxes to a specified destination.

Fax Forward Number

Displays the fax number of the destination to which incoming faxes are to be forwarded.

Fax Forward Print

Displays whether to print forwarded faxes.

Fax Forward Error
Print

Displays whether to print only faxes that failed to be forwarded when Fax Forward Print is Off.

Prefix Dial

Displays whether to set a prefix dial number.

Prefix Dial Number

Displays a prefix dial number. This number dials before any auto dial number is started. It is useful for
accessing the Private Automatic Branch Exchange (PABX).

Discard Size

Displays whether to delete text or images at the bottom of a fax page when the entire page does not fit onto
the output paper.

ECM

Displays whether the Error Correction Mode (ECM) is enabled.

Modem Speed

Displays the modem speed.

Fax Activity

Displays whether to automatically print a fax activity report after every 50 incoming and outgoing fax
communications.

Fax Transmit

Displays whether to print a transmission report after every fax transmission or only when an error occurs.

Fax Broadcast

Displays whether to print a transmission report after every fax transmission to multiple destinations or only
when an error occurs.

Fax Protocol

Displays whether to automatically print a protocol monitor report after every fax transmission or only when an

error occurs.

Country Displays the country where the printer is used.
Plain Displays the paper density of plain paper.

Paper Density
Label Displays the paper density of labels.
Plain Displays the voltage setting of the transfer roller (-6-6) for plain paper.
Plain Thick Displays the voltage setting of the transfer roller (-6-6) for thick plain paper.
Covers Displays the voltage setting of the transfer roller (-6-6) for cover paper.

Adjust BTR

Covers Thick

Displays the voltage

setting of the transfer

roller (-6-6) for thick cover paper.

Label

Displays the voltage

setting of the transfer

roller (-6-6) for labels.

Coated

Displays the voltage

setting of the transfer

roller (-6-6) for coated paper.

Coated Thick

Displays the voltage

setting of the transfer

roller (-6-6) for thick coated paper.

Adjust Fuser

Envelope Displays the voltage setting of the transfer roller (-6-6) for envelopes.
Plain Displays the temperature setting of the fuser (-2-2) for plain paper.
Plain Thick Displays the temperature setting of the fuser (-2-2) for thick plain paper.
Covers Displays the temperature setting of the fuser (-2-2) for cover paper.

Covers Thick

Displays the temperature setting of the fuser (-2-2) for thick cover paper.

Label

Displays the temperature setting of the fuser (-2-2) for labels.

Coated

Displays the temperature setting of the fuser (-2-2) for coated paper.

Coated Thick

Displays the temperature setting of the fuser (-2-2) for thick coated paper.

Envelope

Displays the temperature setting of the fuser (-2-2) for envelopes.

Auto Registration Adjustment

Displays whether to automatically perform color registration adjustment.

Adjust Altitude

Displays the altitude of the location where the printer is installed.

Non-Dell Toner

Displays whether or not to use another manufacturer's toner cartridge.

Date Format

Displays the default date format.




Time Format

Displays the default time format; 24H or 12H.

Clock Settings

Time Zone Displays the default time zone.
Set Date Displays the date setting.
Set Time Displays the time setting.

Web Link

Select Reorder URL

Displays a link used for ordering consumables, which can be accessed from Order Supplies at: in the left
frame.

Customization

Regular

Displays the regular URL (http://accessories.us.dell.com/sna) that can be linked to Order Supplies at:.

Premier

Displays the premier URL (http://premier.dell.com) that can be linked to Order Supplies at:.

Tray 1 Paper Type

Displays the paper type setting of the tray 1

Tray 1 Paper Size

Displays the paper size setting of the tray 1.

Tray Settings

Tray 1 Custom Size -
Y

Displays the length of custom size paper loaded in the tray 1.

Tray 1 Custom Size -
X

Displays the width of custom size paper loaded in the tray 1.

Display Popup

Displays a popup menu that prompts the user to set the paper size and type when the paper is loaded in the

tray 1.

Reports
Purpose:
To print various types

Values:

of reports and lists.

System Settings

Click the Start button to print the System Settings page.

Panel Settings

Click the Start button to print the panel settings page.

PCL Fonts List

Click the Start button to print the PCL (Hewlett-Packard Printer Control Language) Fonts List.

PCL Macro List

Click the Start button to print the PCL Macro List.

Job History

Click the Start button to print the Job History report.

Error History

Click the Start button to print the Error History report.

Print Meter

Click the Start button to print the Print Meter report.

Color Test Page

Click the Start button to print the Color Test Page.

Stored Documents

Click the Start button to print the Stored Documents list.

This item is only available when the RAM Disk is set to on.

Speed Dial

Click the Start button to print the Speed Dial report.

Protocol Monitor

Click the Start button to print the Protocol Monitor report.

Address Book

Click the Start button to print the Address Book report.

Server Address

Click the Start button to print the Server Address report.

Fax Activity

Click the Start button to print the Fax Activity report.

Fax Pending

Click the Start button to print the Fax Pending report.

Printer Settings

The Printer Settings tab includes System Settings, PCL Settings, Secure Settings, Copy Defaults, Copy Color Balance, Copy Settings, Scan Defaults, Fax

Defaults, and Fax Settings pages.

System Settings

Purpose:

To configure the basic printer settings.

Values:

Power Saver Timer
Mode 1

Sets the time for transition to Power Saver Mode 1.

Power Saver Timer
Mode 2

Sets the time for transition to Power Saver Mode 2.

Auto Reset

Sets the amount of time before the printer automatically resets the settings on the operator panel to the defaults when no
additional settings are made.

Panel Select Tone

Sets the volume of the tone that is emitted when the operator panel input is correct, or disables the tone.

Panel Alert Tone

Sets the volume of the tone that is emitted when the operator panel input is incorrect, or disables the tone.

Machine Ready Tone

Sets the volume of the tone that is emitted when the printer becomes ready, or disables the tone.



http://accessories.us.dell.com/sna
http://premier.dell.com/

Copy Job Tone

Sets the volume of the tone that is emitted when a copy job is complete, or disables the tone.

Non-Copy Job Tone Sets the volume of the tone that is emitted when a job other than a copy job is complete, or disables the tone.
Fault Tone Sets the volume of the tone that is emitted when a job ends abnormally, or disables the tone.

Alert Tone Sets the volume of the tone that is emitted when a problem occurs, or disables the tone.

Out of Paper Tone Sets the volume of the tone that is emitted when the printer runs out of paper, or disables the tone.

Low Toner Tone

Sets the volume of the tone that is emitted when the toner or some other consumable is low, or disables the tone.

Auto Clear Alert Tone Sets the volume of the tone that is emitted 5 seconds before the printer performs auto clear, or disables the tone.

Sets the volume of the tone that is emitted when the operator panel screen returns to the default setting by scrolling the loop

Base Tone menu, or disables the tone.
All Tones Sets the volume of all the alert tones, or disables all the tones.
Time-Out Specifies time (in seconds) the printer should wait for data to arrive from the computer. The print job is cancelled if the time-out

time is exceeded.

Panel Language

Sets the language to be used on the operator panel.

Auto Log Print

Specifies whether or not to automatically print a job history report after every 20 jobs.

Print ID Specifies where to print the user ID on the output paper.

Print Text Specifies whether the printer outputs PDL data (which is not supported by the printer) as text when the printer receives it.
Specifies whether to allocate RAM for the file system for the Secure Print and Store Print features.

RAM Disk

This item is only available when the 256 MB optional memory card is installed.

Substitute Tray

Specifies whether or not to use another size paper when the paper that is loaded in the specified tray does not match the paper
size settings for the current job.

mm / inch

Specifies the measurement unit to be used on the operator panel screen as either mm or inches.

PCL Settings

Purpose:

To change the printer settings that only affect jobs using the PCL emulation printer language.

Values:
Paper Size Specifies the paper size.
\C(uStom Size - Specifies the length of custom size paper. The available range is from 127 mm (5.0 in.) to 355 mm (14.0 in.).
)(iustom Size - Specifies the width of custom size paper. The available range is from 77 mm (3.0 in.) to 215 mm (8.5 in.).
Orientation Specifies how text and graphics are oriented on the page.
Font Specifies the font from the list of registered fonts.
Symbol Set Specifies a symbol set for the specified font.
Font Size Specifies the font size for scalable typographic fonts.
Font Pitch Specifies the font pitch for scalable monospaced fonts.
Form Line Specifies the number of characters in a line.
Quantity Sets the number of copies to print.
Hex Dump ﬁpecifies_ whether to help isolate the source of a print job problem. With Hex Dump selected, all data sent to the printer is printed in
exadecimal and character representation. Control codes are not executed.
Draft Mode Specifies whether to print in the draft mode.
'Il_'ier:’fnination Specifies how to handle line terminations.
Default Color Specifies the print color mode as Color or Black. This setting is used for print jobs without a specified color print mode.

Secure Settings
Panel Lock
Purpose:

To set whether to

lock Admi n Menu with a password, and to set or change the password.

Set the password of the Dell Printer Configuration Web Tool from Set Password in Print Server Settings.

Values:

Panel Lock Set

Sets whether to lock Adnmi n Menu with a password.

New Password

Sets a password that is required to access Adnin Menu.

Re-enter Password | Enter the new password again to confirm.




& NOTE: This menu sets a password to lock the operator panel. When changing the password for the Dell Printer Configuration Web Tool, click Set
Password on the left frame and set the password.

Function Enabled

Purpose:

To set whether to lock the Copy, Scan, and Fax services with a password, and to set or change the password.
Set the password of the Dell Printer Configuration Web Tool from Set Password in Print Server Settings.

Values:

Copy Service Lock Set| Sets whether to lock the Copy service with a password.

Scan Service Lock Set | Sets whether to lock the Scan service with a password.

Fax Service Lock Set | Sets whether to lock the Fax service with a password.

New Password Sets a password that is required to access the Copy, Scan, and Fax services.

Re-enter Password Enter the new password again to confirm.

Secure Receive
Purpose:

To require a password to print incoming faxes. When the Secure Receive feature is enabled, the printer stores incoming faxes and prints them when the
correct password is entered on the operator panel.

Set the password of the Dell Printer Configuration Web Tool from Set Password in Print Server Settings.

Values:

Secure Receive Set| Sets whether to require a password to receive faxes.

New Password Sets a password that is required to receive faxes.

Re-enter Password | Enter the new password again to confirm.

Copy Defaults
Purpose:

To create your own default Copy settings.

Values:
Color Sets whether to print in color or in black and white.
Select Tray Sets the default input tray.
SSF Paper Size Sets the size paper loaded in the single sheet feeder.
SSF Paper Type Sets the type of paper loaded in the single sheet feeder.
Reduce/Enlarge Sets the default reduction/enlargement ratio.

Custom Reduce/Enlarge | Sets a custom reduction/enlargement ratio within the range of 25% to 400% when the Reduce/Enlarge is set to Custom.

Original Type Sets the type of the original.

Document Size Sets the paper size of the original.

Lighter/Darker Sets the default copy density.

Sharpness Sets the default sharpness level.

Color Saturation Adjusts the saturation of colors to make the colors lighter or darker than the original.
Auto Exposure Sets whether to suppress the background of the original to enhance text on the copy.
Auto Exposure Level Sets the background suppression level.

Copy Color Balance
Purpose:
To set the copy color balance.

Values:

Yellow Low Dens. Sets the color balance level of low density yellow.

Yellow Medium Dens. | Sets the color balance level of medium density yellow.

Yellow High Dens. Sets the color balance level of high density yellow.

Magenta Low Dens. Sets the color balance level of low density magenta.




Magenta Medium Dens. | Sets the color balance level of medium density magenta.

Magenta High Dens.

Sets the color balance level of high density magenta.

Cyan Low Dens.

Sets the color balance level of low density cyan.

Cyan Medium Dens.

Sets the color balance level of medium density cyan.

Cyan High Dens.

Sets the color balance level of high density cyan.

Black Low Dens.

Sets the color balance level of low density black.

Black Medium Dens.

Sets the color balance level of medium density black.

Black High Dens.

Sets the color balance level of high density black.

Copy Settings

Purpose:

To confirm the Copy settings.

E NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Values:
Off* Does not perform multiple-up printing.
Auto Automatically reduces the original pages to fit onto one sheet of paper.
Multiple-Up
ID Copy | Prints the original pages onto one sheet of paper in the original size.
Manual | Prints the original pages onto one sheet of paper in the size specified for Reduce/Enlarge.
Collated Sets whether or not to collate the copy.

Margin Top/Bottom

Sets the value of the top and bottom margins within the range of 0 mm to 50 mm (0.0-2.0 inch).

Margin Left/Right

Sets the value of the left and right margins within the range of 0 mm to 50 mm (0.0-2.0 inch).

Margin Middle

Sets the value of the middle margin within the range of 0 mm to 50 mm (0.0-2.0 inch).

Scan Defaults

Purpose:

To create your own default Scan settings.

E NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Values:

Scan To Network

Computer™ | Stores scanned documents on a computer using the Server Message Block (SMB) protocol.

Server Stores scanned documents on a server using the FTP protocol.

File Format

Sets the file format in which scanned documents are to be saved.

Color

Sets whether to scan in color or in black and white.

Resolution

Sets the default scan resolution.

Document Size

Sets the paper size of the original.

Lighter/Darker

Sets the default scan density.

Sharpness

Sets the default sharpness level.

Contrast

Sets the default contrast level.

Auto Exposure

Sets whether to suppress the background of the original to enhance text on the copy.

Auto Exposure Level

Sets the default background suppression level.

Margin Top/Bottom

Sets the value of the top and bottom margins within the range of 0 mm to 50 mm (0.0-2.0 inch).

Margin Left/Right

Sets the value of the left and right margins within the range of 0 mm to 50 mm (0.0-2.0 inch).

Margin Middle

Sets the value of the middle margin within the range of 0 mm to 50 mm (0.0-2.0 inch).

TIFF File Format

Sets the TIFF file format to TIFF V6 or TTN2.

Image Compression

Sets the image compression level.

Max E-Mail Size

Sets the maximum size of e-mail that can be sent, within the range of 50 K bytes to 16384 K bytes.

Fax Defaults

Purpose:

To create your own default Fax settings.




ﬂ NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Values:
Standard™ | Suitable for documents with normal sized characters.
Fine Suitable for documents containing small characters or thin lines or documents printed using a dot-matrix printer.
Resolution Super Fine Suitable for documen_ts containing extremely fine detail. The super fine mode is enabled only if the remote machine also
supports the Super Fine resolution.
Photo Suitable for documents containing photographic images.

Lighter/Darker

Sets the default density to fax your documents lighter or darker.

Delayed Start

Sets the fax transmission start time when sending a fax at a specified time.

Fax Settings

Purpose:

To confirm the Fax settings.

ﬂ NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Values:

Receive Mode

Fax* Automatically receives faxes.
Automatic fax reception is turned off. You can receive a fax by picking up the handset of the external phone and then
Telephone pressing a remote receive code, or by setting OnHook to On (you can hear voice or fax tones from the remote machine)

and then pressing ¥ .

Telephone/Fax

When the printer receives an incoming fax, the external telephone rings for the time specified in Auto Receive
Fax/Tel, and then the printer automatically receives a fax. If an incoming call is not a fax, the printer beeps from the
internal speaker indicating that the call is a telephone call.

Answer
Machine/Fax

The printer can share a telephone line with an answering machine. In this mode, the printer will monitor the fax signal
and pick up the line if there are fax tones. If the phone communication in your country is serial, this mode is not
supported.

DRPD

Before using the Distinctive Ring Pattern Detection (DRPD) option, a distinctive ring service must be installed on your
telephone line by the telephone company. After the telephone company has provided a separate number for faxing
with a distinctive ring pattern, configure the fax setup to monitor for that specific ring pattern.

Auto Receive
Fax

Sets the interval at which the printer goes into the fax receive mode after answering an incoming call.

Auto Receive
Fax/Tel

Sets the interval at which the printer goes into the fax receive mode after the external telephone receives an incoming call.

Auto Receive
Answer/Fax

Sets the interval at which the printer goes into the fax receive mode after the external answering machine receives an incoming call.

Line Monitor

Sets the volume of the line monitor, which audibly monitors a transmission through the internal speaker until a connection is made.

Ring Tone Sets the volume of the ring tone, which indicates that an incoming call is a telephone call through the internal speaker when Receive
Volume Mode is set to Telephone/Fax.
Line Type Sets the default line type; PSTN or PBX.

Tone/Pulse

Sets whether to use tone or pulse dialing.

Resend Delay

Sets the interval (3-255 seconds) between resend attempts.

Redial Attempts

Sets the number of redial attempts (0-13) to make if the destination fax number is busy. If you enter 0, the printer will not redial.

Redial Delay

Sets the interval (1-15 minutes) between redial attempts.

Junk Fax Setup

Sets whether or not to reject unwanted faxes by accepting only the faxes from the numbers registered in the Phone Book

Remote Receive

Sets whether or not to receive a fax by pressing a remote receive code on the external telephone.

Remote Receive
Tone

Specifies a 2-digit remote receive code when Remote Receive is On.

Fax Header

Sets whether to print the sender's information on the header of faxes.

Fax Header
Name

Allows you to enter a name that will be printed on the header of faxes.

Fax Number

Allows you to enter the fax number of the printer, which will be printed on the header of faxes.

Fax Cover Page

Sets whether or not to attach a cover page to faxes.

DRPD Pattern

companies.

Sets the Distinctive Ring Pattern Detection (DRPD) setting from Patternl to Pattern7. DRPD is a service provided by some telephone

Sent Fax
Forward

Sets whether to forward incoming faxes to a specified destination.

Fax Forward
Number

Allows you to enter the fax number of the destination to which incoming faxes will be forwarded.

Fax Forward
Print

Sets whether to print all forwarded faxes.

Fax Forward
Error Print

Sets whether to print only faxes that failed to be forwarded when Fax Forward Print is Off.




Prefix Dial

Specifies whether to set a prefix dial number.

Prefix Dial
Number

Sets a prefix dial number of up to five digits. This number dials before any auto dial number is started. It is useful for accessing the
Private Automatic Branch Exchange (PABX).

Discard Size

Sets whether or not to delete text or images at the bottom of a fax page when the entire page does not fit onto the output paper.
Selecting Auto Reduction automatically reduces the fax page to fit it onto the output paper, and does not discard any images or text at
the bottom of the page.

ECM

Sets whether or not to enable the Error Correction Mode (ECM). To use the ECM, the remote machines must also support the ECM.

Modem Speed

Allows you to adjust the fax modem speed when a fax transmission or reception error occurs.

Fax Activity

Sets whether to automatically print a fax activity report after every 50 incoming and outgoing fax communications.

Fax Transmit

Sets whether to print a transmission report after every fax transmission or only when an error occurs.

Fax Broadcast

Sets whether to print a transmission report after every fax transmission to multiple destinations or only when an error occurs.

Fax Protocol

Sets whether to print the protocol monitor report after every fax transmission or only when an error occurs.

Country

Sets the country where the printer is used.

Printer Maintenance

The Printer Maintenance tab includes Paper Density, Adjust BTR, Adjust Fuser, Auto Registration Adjustment, Color Registration Adjustments, Clean
Developer, Adjust Altitude, Reset Defaults, Non-Dell Toner, Initialize PrintMeter, Clock Settings, and Web Link Customization pages.

Paper Density

Purpose:

To specify the paper density.

Values:

Plain | Sets the density of plain paper to Light or Normal.

Label | Sets the density of labels to Light or Normal.

Adjust BTR

Purpose:

To specify the reference voltage settings for the transfer roller.

Values:
Plain Sets the reference voltage setting for the transfer roller for plain paper within the range of -6 to 6.
Plain Thick Sets the reference voltage setting for the transfer roller for thick plain paper within the range of -6 to 6.
Covers Sets the reference voltage setting for the transfer roller for cover paper within the range of -6 to 6.

Covers Thick

Sets the reference voltage setting for the transfer roller for thick cover paper within the range of -6 to 6.

Label

Sets the reference voltage setting for the transfer roller for labels within the range of -6 to 6.

Coated

Sets the reference voltage setting for the transfer roller for coated paper within the range of -6 to 6.

Coated Thick

Sets the reference voltage setting for the transfer roller for thick coated paper within the range of -6 to 6.

Envelope

Sets the reference voltage setting for the transfer roller for envelopes within the range of -6 to 6.

Adjust Fuser

Purpose:

To specify the temperature settings value for the fuser.

Values:
Plain Sets the temperature settings for the fuser for plain paper within the range of -2 to 2.
Plain Thick Sets the temperature settings for the fuser for thick plain paper within the range of -2 to 2.
Covers Sets the temperature settings for the fuser for cover paper within the range of -2 to 2.
Covers Thick| Sets the temperature settings for the fuser for thick cover paper within the range of -2 to 2.




Label Sets the temperature settings for the fuser for labels within the range of -2 to 2.

Coated Sets the temperature settings for the fuser for coated paper within the range of -2 to 2.

Coated Thick | Sets the temperature settings for the fuser for thick coated paper within the range of -2 to 2.

Envelope Sets the temperature settings for the fuser for envelopes within the range of -2 to 2.

Auto Registration Adjustment
Purpose:

To specify whether to automatically perform color registration adjustment.

Color Registration Adjustments
Purpose:
To specify whether to manually perform color registration adjustment.

Manual Color Registration Adjustments are required such as when the printer is initially installed and after the printer is moved.
ﬂ NOTE: The Color Registration Adjustments feature can be configured when Auto Registration Adjustment is set to Off.

Values:

Auto Correct Click Start to automatically perform color registration correction.

Click Start to print a color registration chart. The color registration chart prints a lattice pattern of yellow, magenta, and cyan lines. On
the chart, look at the values on the right side that are next to the straightest lines for each of the three colors. If the value for the
straightest line is O, color registration adjustment is not required. If the value for the straightest line is any value other than 0, specify
the adjustment values under Color Registration Adjustments.

Color Regi Chart

golqr N Specifies lateral (perpendicular to paper feed direction) and process (paper feed direction) color adjustment values individually for Yellow,
egistration M 4c ithin th £.9 109
Adjustments agenta, and Cyan within the range of -9 to 9.

Clean Developer
Purpose:
To clean each toner cartridge or PHD unit, or to stir the toner in a new toner cartridge.

Values:

Clean Developer Stirs the toner in a new toner cartridge.

Yellow Toner Refresh | Cleans the toner in the yellow toner cartridge.

Magenta Toner Refresh | Cleans the toner in the magenta toner cartridge.

Cyan Toner Refresh Cleans the toner in the cyan toner cartridge.
Black Toner Refresh Cleans the toner in the black toner cartridge.
Drum Refresh Cleans the surface of the PHD unit.

Adjust Altitude
Purpose:
To specify the altitude of the location where the printer is installed.

The discharge phenomenon for charging the photo conductor varies with barometric pressure. Adjustments are performed by specifying the altitude of the
location where the printer is being used.

Reset Defaults
Purpose:

To initialize the NV (nonvolatile) memory. After executing this function to automatically restart the printer, all the menu parameters are reset to their default
values.

Values:

Reset Defaults and restart printer Click Start to initialize the non-volatile memory (NVM).

Reset Defaults User (Fax) Section | Click Start to initialize the fax number entries in the Address Book.




Reset Defaults User (Scan) Section | Click Start to initialize the e-mail and server address entries in the Address Book.l

Non-Dell Toner
Purpose:

To specify whether or not to use another manufacturer’s toner cartridge.

NOTICE: Use of a non-Dell toner cartridge may result in some of the printer's functions being unavailable, a reduction in print quality, or deterioration of
the printer's reliability. Use of a new Dell brand toner cartridge is recommended for your printer. The Dell warranty does not cover any problems caused
by the use of any accessory, part, or component that is not supplied by Dell.

Initialize PrintMeter

Purpose:

To initialize the print meter of the printer. When the print meter is initialized, the meter count is reset to 0.

Clock Settings
Purpose:
To specify the clock settings.

Values:

Date Format | Specifies the date format; yy/mm/dd, mm/dd/yy, or dd/mm/yy.

Time Format | Specifies the time format; 24H or 12H.

Time Zone Specifies the time zone.

Set Date Specifies the current date.

Set Time Specifies the current time.

Web Link Customization
Purpose:
To specify a link used for ordering consumables, which can be accessed from Order Supplies at: in the left frame.

Values:

Select Reorder URL | Sets a URL to be linked to Order Supplies at:

Regular Displays the regular URL (http://accessories.us.dell.com/sna) that can be linked to Order Supplies at:.

Premier Displays the premier URL (http://premier.dell.com) that can be linked to Order Supplies at:.

Print Server Settings
Use the Print Server Settings menu to set the type of printer interface and the necessary conditions for communication.

The following tabbed pages are displayed in the top of the right frame.

Print Server Reports

The Print Server Reports tab includes the Print Server Setup Page and the E-Mail Alert Setup Page.

Print Server Setup Page
Purpose:

To verify the current settings of TCP/IP (Transmission Control Protocol/Internet Protocol) protocol and printing ports. On this page, you can only verify the
settings of items. If you want to change the settings, go to the pages in the Print Server Settings tab.

Values:

Ethernet Settings Displays the current settings of Ethernet transmission rate and the duplex settings.

Ethernet Current Ethernet Settings Displays the current Ethernet settings.



http://accessories.us.dell.com/sna
http://premier.dell.com/

MAC Address

Displays the printer's Media Access Control Address (MAC) address.

TCP/IP Settings

Host Name

Displays the host name.

IP Address Mode

Displays the IP address mode.

IP Address

Displays the IP address.

Subnet Mask

Displays the subnet mask.

Gateway Address

Displays the gateway address.

Get DNS Server Address from

Displays whether to automatically set the DNS server address via DHCP.

DNS DHCP
Current DNS Server Address Displays the current DNS server address.
WINS Mode I:D)isg:pa.ys whether to automatically set the primary and secondary WINS server addresses via
WINS WINS Primary Server Displays the primary WINS server address.
WINS Secondary Server Displays the secondary WINS server address.
Port Status Displays the port status of the Line Printer Daemon (LPD) protocol.
+PD Connection Time-Out Displays the connection timeout period.
Port Status Displays the port status.
Port9100 Port Number Displays the port number.
Connection Time-Out Displays the connection timeout period.
Port Status Displays the port status.
Port Number Displays the port number.
HTTP
Simultaneous Connections Displays the maximum number of simultaneous connections.
Connection Time-Out Displays the connection timeout period.
SNMP Port Status Displays the port status.
Connection Time-Out Displays the connection timeout period.
FTP Client
FTP Passive Displays whether to enable the FTP Passive mode.
SMB Client Connection Time-Out Displays the connection timeout period.

IP Filter (1Pv4)
*1

Access List

Displays the list of IP addresses that are permitted or denied access to the printer.

*1 This item is only available for LPD or Port9100.

E-Mail Alert Setup Page

Purpose:

To verify the current settings of SMTP/POP (Simple Mail Transfer Protocol/Post Office Protocol) used for the e-mail feature and E-Mail Alerts feature. In this

page, you can only verify the settings of items. If you want to change the settings, go to the pages in the Print Server Settings tab.

Values:

E-Mail Server
Settings

Port Status

Displays the port status.

Primary SMTP Gateway

Displays the primary SMTP (Simple Mail Transfer Protocol) gateway.

SMTP Port Number

Displays the SMTP port number.

E-Mail Send
Authentication

Displays the authentication method for outgoing e-mail.

POP3 Server Address

Displays the POP3 (Post Office Protocol 3) server address.

POP3 Port Number

Displays the POP3 port number.

Reply Address

Displays the IP address of servers connected with SMTP protocol when data is incoming.

SMTP Server Connection

Displays the status of the SMTP server connection.

E-Mail Alert Settings

E-Mail List 1

Mail List 1.

Supplies Alerts Displays the status, and whether to receive an E-Mail Alert, for consumables.

Select Alerts for List 1

Paper Handling
Alerts

Service Call Displays the status, and whether to receive an E-Mail Alert, for Service Call.

E-Mail List 2

Mail List 2.

Supplies Alerts Displays the status, and whether to receive an E-Mail Alert, for consumables.

Select Alerts for List 2

Paper Handling
Alerts

Service Call Displays the status, and whether to receive an E-Mail Alert, for Service Calls.

Print Server Settings

Displays the acceptable e-mail addresses for the E-Mail Alert feature specified in E-

Displays the status, and whether to receive an E-Mail Alert, for paper handling.

Displays the acceptable e-mail addresses for the E-Mail Alert feature specified in E-

Displays the status, and whether to receive an E-Mail Alert, for paper handling.




The Print Server Settings tab includes Basic Information, Port Settings, TCP/IP, E-Mail Alert, SNMP, and Scan To Network pages.

Basic Information

Purpose:

To configure the printer's basic information.

Values:
Printer Name Specifies the name of the printer using up to 31 alphanumeric characters.
Location Specifies the location of the printer using up to 63 alphanumeric characters.
System Contact Person Specifies the contact name, number, and other information of the printer's administrator and service center using
Szzlttings up to 63 alphanumeric characters.

Administrator E-Mail
Address

Specifies the contact address of the printer's administrator and service center using up to 63 alphanumeric
characters.

Asset Tag Number

Enter the asset tag number for the printer.

EWS Settings

Auto Refresh

Sets whether or not to automatically refresh the contents of the status display pages.

Auto Refresh Interval

Sets the time interval for refreshing the contents of the status display pages automatically from 15 to 600
seconds.

ﬂ NOTE: The Auto Refresh feature is effective for the contents of the top frame, Printer Status page, Job List page, and Completed Jobs page.

Port Settings

Purpose:

To specify whether to enable or disable printing ports and management protocol features.

Values:
Auto Detects the Ethernet transmission rate and the duplex settings automatically.
10BASE-T Half-Duplex Selects 10Base-T Half-Duplex as the default value.
Ethefnet 10BASE-T Full-Duplex Selects 10Base-T Full-Duplex as the default value.
ettings
Ethernet 100BASE-TX Half-Duplex Selects 100Base-TX Half-Duplex as the default value.
100BASE-TX Full-Duplex Selects 100Base-TX Full-Duplex as the default value.
Current Ethernet Settings Displays the current settings of the Ethernet.
MAC Address Displays the printer's MAC address.
LPD Select the check box to enable LPD.
Port9100 Select the check box to enable Port9100.
E-Mail Alert Select the check box to enable the E-Mail Alert feature.
ggarttus Select the check box to enable the Simple Network Management Protocol (SNMP) agent.
SNMP Agent You can also configure the transport protocol to be used. UDP and IPX can be selected simultaneously as the transport
protocol.
IPX is only available when the multi-protocol card is installed.

ﬂ NOTE: The settings in the Port Settings page will be valid only when the printer is rebooted. When you change or configure the settings, click the Apply
New Settings button to apply the new settings.

TCP/IP

Purpose:

To configure the IP address, subnet mask, and gateway address of the printer.

Values:
Host Name Specifies the host name.
IP Address Mode Specifies the method for acquiring the IP address.
When an IP address is being set manually, the IP is allocated to the printer using the format nnn.nnn.nnn.nnn. Each
Manual IP Address octet that makes up nnn.nnn.nnn.nnn is a value in the range of 0 to 254. 127 and any value in the range of 224 to
TCP/IP 254 cannot be specified for the first octet of a gateway address.
Settings When an IP address is being set manually, the subnet mask is specified using the format nnn.nnn.nnn.nnn. Each octet

Manual Subnet Mask

that makes up nnn.nnn.nnn.nnn is a value in the range of 0 to 255. 255.255.255.255 cannot be specified as the
subnet mask.

Manual Gateway
Address

When an IP address is being set manually, the gateway address is specified using the format nnn.nnn.nnn.nnn. Each
octet that makes up nnn.nnn.nnn.nnn is a value in the range of 0 to 254. 127 and any value in the range of 224 to
254 cannot be specified for the first octet of a gateway address.




DNS Domain Name Sets the DNS domain name.
Get DNS Server ) . . .
DNS Address from DHCP Allows you to enable or disable the automatic setting of the DNS server address via DHCP.
Manually sets the DNS server address in xxx.xxx.xxx.xxx format when Get DNS Server Address from DHCP is not
DNS Server Address
selected.
WINS Mode Allows you to enable or disable the automatic setting of the primary and secondary WINS server addresses via DHCP.
WINS Primary Manually sets the primary WINS server address in xxx.xxx.xxx.xxx format when WINS Mode is not selected
WINS Server*2 ) ) ) )
WINS Secondary Manually sets the secondary (backup) WINS server address in xxx.xxx.xxx.xxx format when WINS Mode is not
Server*2 selected.
Connection Time-Out | Sets the connection timeout period from 1 to 1000 seconds.
LPD
IP Filter (1Pv4) To set the IP Filter settings, click IP Filter (1Pv4). The IP Filter (IPv4) page is displayed.
Port Number Sets the port number from 9000 to 9999.
Port9100 Connection Time-Out | Sets the connection timeout period between 1 and 1000 seconds.
IP Filter (1Pv4) To set the IP Filter settings, click IP Filter (1Pv4). The IP Filter (IPv4) page is displayed.
Port Number Sets the port number to 80 or from 8000 to 9999.
Simultaneous . . . .
HTTP Connections Displays the maximum number of simultaneous connections.
Connection Time-Out | Sets the connection timeout period from 1 to 255 seconds.
Address Sets the address in the address field. Enter a numeric value between 0 and 255 in each field of "aaa.bbb.ccc.ddd.”
However, "aaa" cannot be 127 or 224-254.
IP Filter*1 | Address Mask Sets the Subnet Mask in the Mask field. Enter a numeric value between 0 and 255 in each field.
. Sets whether to reject or permit printing from the specified network addresses, or disables IP filtering for the specified
Active Mode
addresses.
*1 This item is only available for LPD or Port9100.

To configure the IP Filter feature, enter an IP address to be filtered in the Address field and the Subnet Mask in the Address Mask field. Enter a numeric value
between 0 and 255 in each field. "*" is appended to the current value.

Setup Procedure

You can set up to a maximum of five items and the first item set takes priority. When setting multiple filters, enter the shortest address first followed by a
slightly longer address, a longer address and so on.

The following section explains how the IP Filter operates.

1. IP Filter Procedure

a.

Enabling Printing From a Specified User

The following describes the procedure to enable printing only from the "192. 168. 100. 10" IP address.

Procedures:

b.

i. Click the first column of the Access List row 1.

ii. Enter "192. 168. 100. 10" in the Address field and "255. 255. 255. 255" in the Address Mask field.

iii. Select Permit.

iv. Click Apply New Settings.

Disabling Printing From a Specified User

The following describes the procedure to disable printing only from the "192. 168. 100. 10" IP address.

Procedures:

C.

i. Click the first column of the Access List row 1.

ii. Enter "192. 168. 100. 10" in the Address field and "255. 255. 255. 255" in the Address Mask field.

iii. Select Reject.

iv. Click the first column of the Access List row 2.

v. Enter "0. 0. 0. 0" in the Address field and "0. 0. 0. 0" in the Address Mask field.

vi. Select Permit.

vii. Click Apply New Settings.

Enabling and Disabling Printing from Network Addresses

You can enable printing from the "192. 168" network address and disable printing from the "192. 168. 200" network address.

The example below describes how to enable printing from the "192. 168. 200. 10" IP address.




Procedures:

i. Click the first column of the Access List row 1.

ii. Enter "192. 168. 200. 10" in the Address field and "255. 255. 255. 255" in the Address Mask field.

iii. Select Permit.

iv. Click the first column of the Access List row 2.

v. Enter "192. 168. 200. 0" in the Address field and "255. 255. 255. 0" in the Address Mask field.

vi. Select Reject.

vii. Click the first column of the Access List row 3.

viii. Enter "192. 168. 0. 0" in the Address field and "255. 255. 0. 0" in the Address Mask field.

ix. Select Permit.

X. Click Apply New Settings.

E-Mail Alert

Purpose:

To configure detailed settings for the E-Mail Alert. This page can also be displayed by clicking E-Mail Alert in the left frame.

Values:

E-Mail Server

Primary SMTP
Gateway

Sets the primary SMTP gateway.

SMTP Port Number

Specifies the SMTP port number. This must be 25, 587 or between 5000 and 65535.

E-Mail Send
Authentication

Specifies the authentication method for outgoing e-mail.

SMTP Login User

Specifies the SMTP login user. Up to 63 alphanumeric characters, periods, hyphens, under bars, and at symbols
(@) can be used. If specifying more than one address, separate them using commas.

SMTP Login Password

Specifies the SMTP account password using up to 31 alphanumeric characters.

Re-enter SMTP Login
Password

Enter the SMTP account password again to confirm.

POP3 Server

Specifies the POP3 server address in IP address format of "aaa.bbb.ccc.ddd" or as a DNS host name using up to

E-Mail List 2

Settings Address*1 63 characters.
POP3 Port Number*1 | Specifies the POP3 server port number. This must be 110 or between 5000 and 65535.
POP User Name*1 Specifies the POP3 account user name. Up to 63 alphanumeric characters, periods, hyphens, under bars, and at
symbols (@) can be used. If specifying more than one address, separate them using commas.
POP User Password*1 | Specifies the POP3 account password using up to 31 alphanumeric characters.
Re-enter POP User . .
password Enter the password again to confirm.
Reply Address Designates the reply e-mail address sent with each E-mail Alert.
SMTP Server . .
Connection Displays the status of the SMTP server connection.
PR Sets acceptable e-mail addresses for the E-Mail Alert feature using up to 255
E-Mail List 1 N
alphanumeric characters.
Supplies Alerts Select the check box to receive an E-Mail Alert for consumables.
Select Alerts for List 1 | Paper Handling Alerts | Select the check box to receive an E-Mail Alert for paper handling.
E-Mail Alert Service Call Select the check box to receive an E-Mail Alert for Service Calls.
Settings

Sets acceptable e-mail addresses for the E-Mail Alert feature using up to 255
alphanumeric characters.

Select Alerts for List 2

Supplies Alerts Select the check box to receive an E-Mail Alert for consumables.

Paper Handling Alerts | Select the check box to receive an E-Mail Alert for paper handling.

Service Call Select the check box to receive an E-Mail Alert for Service Calls.

*1 Available when POP before SMTP (Plain) or POP before SMTP (APOP) for E-Mail Send Authentication is selected.

SNMP

Purpose:

To configure the detailed settings of SNMP.

Values:




Community Name
(Read only)

Specifies the community name to access (read only) data using up to 31 alphanumeric characters. The
original setting will remain valid if no input is made. Characters entered for the Community Name (Read
Only) in the previous settings will not be displayed on the screen. The default Read Community is public.

Re-enter Community
Name (Read only)

Enter the community name (read only) again to confirm.

Community

Community Name
(Read/Write)

Specifies the community name to access (read and write) data using up to 31 alphanumeric characters. The
original setting will remain valid if no input is made. Characters entered for the Community Name
(Read/Write) in the previous settings will not be displayed on the screen. The default Read/Write

SNMP | (o me Community is private.
Eg;ﬁgt?éecaoén/\n/#:ig Enter the community name (read and write) again to confirm.
Community Name Specifies the community name used for trap up to 31 alphanumeric characters. The original settings will
(Trap) Y remain valid if no input is made. Characters entered for the Community Name (Trap) in the previous
P settings will not be displayed on the screen. The default Trap Community is " " (NULL).
Re-enter Community . . .
Name (Trap) Enter the community name (trap) again to confirm.
Select the trap address type from Off and IPv4. Selecting Off clears the settings in Trap Address, Port
Trap Address Type Number, and Notify, and does not notify trap occurrence. Selecting IPv4 allows you to enter Trap Address
in IPv4 format.
Trap_ i Specify the IP address in the nnn.nnn.nnn.nnn:mmmmm format. Each section of "nnn" is a variable value
Notification Trap Address between 0 and 255. Note that values 127 and 224-254 are not valid for the first three-digits only. IP
SNMP | (1P) 1-4 socket mmmmm is a variable value between 0 and 65535.

Port Number

Enter the SNMP trap destination port number.

Notify

Select the check box to notify trap occurrence.

Authenticate Error Trap

Select the check box to notify Authenticate Error Trap.

Scan To Network

Purpose:

To specify the client when

Values:

scanning data.

Connection Time-Out

Sets the connection timeout period from 1 to 60 seconds.

FTP Client

FTP Passive

Sets whether or not to enable the FTP Passive mode.

SMB Client

Connection Time-Out

Sets the connection timeout period from 1 to 60 seconds.

Other Features

The Other Features tab includes Set Password and Reset Print Server pages.

Set Password

Purpose:

To set or change the password that is required to access the printer's setup parameters from the Dell Printer Configuration Web Tool.

Set the password of the operator panel from Panel Lock in the Printer Settings. This page can also be displayed by clicking Set Password in the left frame.

[E4 NOTE: To restore the password to the default (NULL), initialize the non-volatile memory (NVM).

Values:

Administrator Password

is entered.

Sets the password using up to 10 alphanumeric characters. The password will appear as asterisks (*) in the field when it

Re-enter Administrator
Password

Enter the password again to confirm.

Reset Print Server

Purpose:

To initialize NVRAM (non-volatile RAM) for the network feature and reboot the printer. You can also initialize the printer's NVRAM from Reset Defaults in the

Printer Settings menu.

Values:

printer

Initialize NIC NVRAM Memory and restart

Click the Start button to initialize NVRAM. Network settings will revert to the factory default settings and reboot
the network capability.




Restart Printer

|Click the Start button to reboot the printer.

Copy Printer Settings

The Copy Printer Settings menu includes the Copy Printer Settings and Copy Printer Settings Report pages.

ﬂ NOTE: You cannot copy the following printer settings:

n

Copy Defaults

Copy Color Balance

Copy Settings
Scan Defaults
Fax Defaults
Fax Settings
Clock Settings

Address Book

Copy Printer Settings

Purpose:

To copy the printer settings to one or more of the same model of the printer.

To copy the settings to another printer, specify the IP address and password of the printer to which the settings are copied in the IP Address text box and
Password text box. Then, click the Copy the settings to the Host in the above list button. Copying the settings is complete. The connection time-out period is
60 seconds. After that, you can check whether the settings were copied to this page. And you need to check the Copy the settings to the Host in the above
list and reboot the printer menu of the Dell Printer Configuration Web Tool in the destination printer to verify if the settings were actually copied or not.

If the settings can be copied but the printer configuration is different, the settings of only the same items are copied. Printer settings are simultaneously

copied to printers of up to 10 IP addresses.

Copy Printer Settings Report

Purpose:

To verify the histories of copying.

4 NOTE: The history is cleared by turning off the printer.

Print Volume

The Printer Volume menu includes the Print Volume and Dell ColorTrack pages.

Print Volume

Purpose:

To verify the number of printed pages. This page can also be displayed by clicking Print Volume in the left frame.

Values:

Printer Page Count

Displays the total number of pages printed since the printer was shipped from the factory.

Paper Used

Displays the number of pages printed for each paper size.

Dell ColorTrack

Purpose:

To specify which users have access to color printing and to limit print volume per user.

Values:

Print User Limitation Select the check box to restrict users from using the printer.




Perm_lt _pnntlng without Select the check box to use the printer without user limitations.
specifying user

User Registration Displayed when Print User Limitation is enabled. To register a user, click Edit User Registration to open the Edit Print User
9 Registration page, and then specify User Registration No. and click Edit to open the Print User Settings page.

Edit Print User Registration
Purpose:
To edit the print meter setting for each user.

Values:

User No. List to: Selecting each button displays a list of print meter settings for the group of user registration numbers indicated on the button.

No.: User Name: Displays a user registration number and name of the user registered under that number. User registration numbers without an entry
o ) show (Not in Use) in the User Name column.

MonoCount Displays the total number of monochrome pages printed to date and the maximum number of monochrome pages the user is permitted
(Limit) to print.

ColorCount isplays th I number of col inted to d d th i ber of col h i itted to pri

(Limit) Displays the total number of color pages printed to date and the maximum number of color pages the user is permitted to print.
Delete Deletes the entry for the selected user registration number.

Confirm/Change | Displays a dialog box where you can edit the entry for the selected user registration number.

Create Displays a dialog box where you can create a new entry under the selected user registration number.

Print User Settings (Confirm/Change, Create)

Purpose:

To view or edit the user entries on the Edit Print User Registration page, or create a new entry. The following items are in the dialog box that appears when
you click the Confirm/Change or Create button on the Edit Print User Registration page.

Values:

User Registration No. Displays the selected user registration number.

User Name Allows you to view or edit the name of the user registered under the selected user registration number, or enter a user
name for the new entry.

Displays the password associated with the user name in asterisks, or allows you to enter a password for the new entry.

Password

Re-enter Password Enter the password again to confirm.

Color Mode Limitation Specifies whether to permit only monochrome printing or both color and monochrome printing.
Upper Limit for Color Print Sets the maximum number of color pages the user is permitted to print.

Cumulative Color Page Count Displays the total number of color pages printed to date.

gﬁﬁfr Limit for Monochrome Sets the maximum number of monochrome pages the user is permitted to print.

. Displays the total number of monochrome pages printed to date.
Cumulative Monochrome Page

Count

Apply New Settings Press this button to apply the new settings.

Restore Settings Press this button to restore the previous settings.

Back Press this button to return to the Edit Print User Registration page.

Print User Settings (Delete)

Purpose:

To delete the user entries registered on the Edit Print User Registration page. The following items are in the dialog box that appears when you click the
Delete button on the Edit Print User Registration page.

Values:

User Registration No. | Displays the selected user registration number.

User Name Displays the name of the user registered under the user registration number.

Apply New Settings Press this button to apply the new settings.

Back Press this button to return to the Edit Print User Registration page.

Address Book



The Address Book menu includes the E-Mail Address, Server Address, and Phone Book pages.

E-Mail Address

Allows you to view,

edit,

or create e-mail address entries.

E-Mail Address

E-Mail Group

Allows you to view,

edit,

or create e-mail group entries.

Default Setup

Allows you to view,

edit,

or set the default e-mail subject and message.

Server Address

Server Address

Allows you to view, edit, or create server address entries.

FAX Speed Dial

Allows you to view,

edit,

or create speed dial entries.

Phone Book

FAX Group

Allows you to view,

edit,

or create fax group entries.

E-Mail Address

The E-mail Address page includes the following subpages.

E-Mail Address | Allows you to view, edit, or create e-mail address entries.

E-Mail Group Allows you to view, edit, or create e-mail group entries.

Default Setup | Allows you to view, edit, or set the default e-mail subject and message.

E-Mail Address - Top Page
Purpose:
To view the e-mail address entries registered on the E-Mail Address page.

Values:

Address List to: Selecting each button displays a list of entries for the group of user IDs indicated on the button.

ID : Name Displays a user ID and the name of the user registered under that user ID. IDs without an entry show (Not in Use) in the Name column.
Address Displays the e-mail address of the user.
Delete Deletes the entry for the selected user ID.

Confirm / Change | Displays a dialog box where you can edit the entry of the selected user ID.

Create Displays a dialog box where you can create a new entry under the selected user ID.

E-Mail Address (Confirm/Change, Create)
Purpose:

To view or edit the e-mail address entries on the E-Mail Address page, or create a new entry. The following items are in the dialog box that appears when
you click the Confirm/Change or Create button on the E-mail Address top page.

Values:
1D Displays the selected user ID.
Name Allows you to view or edit the name of the user registered under the user ID, or enter a name for the new entry.
Address Allows you to view or edit the e-mail address of the user, or enter an e-mail address for the new entry.
Delete Press this button to delete the entry for the user ID. This button is available only on the dialog box for editing an existing entry.

Apply New Settings | Press this button to apply the new settings.

Restore Settings Press this button to restore the previous settings.

Back Press this button to return to the top page.

E-Mail Address (Delete)
Purpose:

To delete the e-mail address entries registered on the E-Mail Address page. The following items are in the dialog box that appears when you click the Delete
button on the E-mail Address top page.

Values:
1D Displays the selected user ID.
Name Displays the name of the of the user registered under the selected user ID.
Address Displays the e-mail address of the user.

Apply New Settings | Press this button to apply the new settings.

Back Press this button to return to the top page.




E-Mail Group - Top Page

Purpose:

To view the e-mail address entries registered on the E-Mail Group page.

Values:

GrouplID : Name

Displays a group ID and the assigned group name. IDs without an entry show (Not in Use) in the Name column.

Delete

Deletes the entry for the selected group ID.

Confirm / Change

Displays a dialog box where you can edit the entry for the selected group ID.

Create

Displays a dialog box where you can create a new entry under the selected group ID.

E-Mail Group (Confirm/Change, Create)

Purpose:

To view or edit the e-mail address group entries on the E-Mail Group page, or create a new entry. The following items are in the dialog box that appears
when you click the Confirm/Change or Create button on the E-Mail Group top page.

Values:
1D Displays the selected group ID.
E-Mail Group
Name Allows you to view or edit the name assigned for the group ID, or enter a new group name.
Address List to: Selecting each button displays a list of entries for the group of IDs indicated on the button.
ID : Name Displays a user ID and the name of the user registered under that user ID. IDs without an entry show (Not in Use) in
. the Name column.
Allows you to view or edit the e-mail address of an entry registered under the selected user ID, or enter an e-mail
E-Mail Address
address for the new entry.
Address
Apply New . .
Settings Press this button to apply the new settings.
Restore Settings | Press this button to restore the previous settings.
Back Press this button to return to the top page.

E-Mail Group (Delete)

Purpose:

To delete the e-mail group entries registered on the E-Mail Group page. The following items are in the dialog box that appears when you click the Delete
button on the E-mail Group top page.

Values:
1D Displays the selected group ID.
Name Displays the name assigned for the group ID.

Apply New Settings | Press this button to apply the new settings.

Back

Press this button to return to the top page.

Default Setup

Purpose:

To set the default e-mail subject and message.

Values:

Default Subject

Allows you to enter the default e-mail subject.

Body Text

Allows you to enter the default e-mail message.

Apply New Settings | Press this button to apply the new settings.

Restore Settings

Press this button to restore the previous settings.

Server Address




Server Address -

Purpose:

Top Page

To view the server address entries registered on the Server Address page.

Values:

Address List to:

Selecting each button displays a list of entries for the group of IDs indicated on the button.

ID : Name

Displays a server ID and the name of a file directory registered under that server ID. IDs without an entry show (Not in Use) in the
Name column.

Server Address

Displays the address of the file directory.

Delete Deletes the entry for the selected server ID.
gﬁg:g: / Displays a dialog box where you can edit the entry for the selected server ID.
Create Displays a dialog box where you can create a new entry under the selected server ID.

Server Address (Confirm/Change, Create)

Purpose:

To view or edit the server address entries on the Server Address page, or create a new entry. The following items are in the dialog box that appears when
you click the Confirm/Change or Create button on the Server Address top page.

Values:
1D Displays the selected server ID.
Name Allows you to view or change the server name assigned to the server ID, or enter a new server name.
FTP Select this to store scanned documents on a server via the FTP protocol.
Server Type
SMB Select this to store scanned documents on a computer via the Server Message Block (SMB) protocol.

Server Address

Allows you to view or edit the server address registered under the server ID, or enter a new server address.

Share Name

Allows you to view or edit the assigned shared name, or enter a new shared name, when Server Type is set to SMB.

Server Path

Allows you to view or edit the assigned server path, or enter a new path.

Server Port
Number

Allows you to view or edit the assigned server port number, or enter a new port number. If you leave the text box blank, the default port
number (FTP: 21, SMB: 139) will be used.

Login Name

Allows you to view or edit the login name that is required to access the selected protocol, or enter a new login name.

Login Password

Allows you to view or edit the password that is required to access the selected protocol, or enter a new password.

Re-enter Enter the password again to confirm.
Password

Apply New . .
Settings Press this button to apply the new settings.

Restore Settings

Press this button to restore the previous settings.

Back

Press this button to return to the top page.

Server Address (Delete)

Purpose:

To delete the server address entries registered on the Server Address page. The following items are in the dialog box that appears when you click the Delete
button on the Server Address top page.

Values:
1D Displays the selected server ID.
Name Displays the name assigned for the server ID.

Server Address

Displays the server address registered under the server ID.

Apply New Settings

Press this button to apply the new settings.

Back

Press this button to return to the top page.

Phone Book

The Phone Book page includes the following subpages.

FAX Speed Dial

Allows you to view, edit, or create speed dial entries.

FAX Group

Allows you to view, edit, or create fax group entries.




FAX Speed Dial - Top Page

Purpose:

To view the fax number entries registered on the FAX Speed Dial page.

Values:

Speed Dial List
to:

Selecting each button displays a list of entries for the group of speed dial codes indicated on the button.

Speed Dial :
Name

Displays the IDs registered in the group.

Phone Number

Displays a speed dial code and the name of an entry registered under the speed dial code. IDs without an entry show (Not in Use) in
the Name column.

Delete Deletes the entry for the selected speed dial code.
(nggrf:gg / Displays a dialog box where you can edit the entry for the selected speed dial code.
Create Displays a dialog box where you can create a new entry under the selected speed dial code.

FAX Speed Dial (Confirm/Change, Create)

Purpose:

To view or edit the speed dial entries on the FAX Speed Dial page, or create a new entry. The following items are in the dialog box that appears when you
click the Confirm/Change or Create button on the FAX Speed Dial top page.

Values:
Speed Dial Displays the selected speed dial code.
Delete Press this button to delete the entry for the speed dial code. This button is available only on the dialog box for editing an existing
entry.
Name

Allows you to view or edit the name of an entry registered under the speed dial code, or enter a name for the new entry.

Phone Number

Allows you to view or edit the fax number of an entry registered under the speed dial code, or enter a fax number for the new entry.

Apply New
Settings

Press this button to apply the new settings.

Restore Settings

Press this button to restore the previous settings.

Back

Press this button to return to the top page.

FAX Speed Dial (Delete)

Purpose:

To delete the speed dial entries registered on the FAX Speed Dial page. The following items are in the dialog box that appears when you click the Delete
button on the FAX Speed Dial top page.

Values:
Speed Dial Displays the selected speed dial code.
Name Displays the name registered under the speed dial code.

Phone Number

Displays the fax number registered under the speed dial code.

Apply New Settings

Press this button to apply the new settings.

Back

Press this button to return to the top page.

FAX Group - Top Page

Purpose:

To view the fax group entries registered on the FAX Group page.

Values:
ID : Name Displays a fax group ID and the assigned group name. IDs without an entry show (Not in Use) in the Name column.
Delete Deletes the entry for the selected group ID.

Confirm / Change

Displays a dialog box where you can edit the entry for the selected group ID.

Create

Displays a dialog box where you can create a new entry under the selected group ID.




FAX Group (Confirm/Change, Create)

Purpose:

To view or edit the fax number group entries on the FAX Group page, or create a new entry. The following items are in the dialog box that appears when you
click the Confirm/Change or Create button on the FAX Group top page.

Values:

1D Displays the selected group ID.

FAX Group
Name Allows you to view or edit the name assigned for the group ID, or enter a new group name.
tsgeed Dial List Selecting each button displays a list of entries for the group of speed dial codes indicated on the button.
Speed Dial : Displays a speed dial code and the names of an entry registered under the speed dial code. Speed dial codes without an
Name entry show (Not in Use) in the Name column.

Allows you to view or edit the fax number of an entry registered under the selected speed dial code, or enter a fax number

Phone Number

FAX Speed for the new entry.

Dial
Apply New . .
Settings Press this button to apply the new settings.
Restore . " .
Settings Press this button to restore the previous settings.
Back Press this button to return to the top page.

FAX Group (Delete)
Purpose:

To delete the fax number group entries registered on the FAX Group page. The following items are in the dialog box that appears when you click the Delete
button on the FAX Group top page.

Values:
1D Displays the selected group ID.
Name Displays the name assigned for the group ID.

Apply New Settings | Press this button to apply the new settings.

Back Press this button to return to the top page.

Tray Settings

Use the Tray Settings menu to set the paper size and type of paper loaded in the tray 1.

Values:
Tray 1 Paper Type Sets the type of paper loaded in the tray 1.
Tray 1 Paper Size Sets the size of paper loaded in the tray 1.

yay 1 Custom Size - Sets the length of custom size paper loaded in the tray 1.

')I'(ray 1 Custom Size - Sets the width of custom size paper loaded in the tray 1.

Sets whether to display a popup message that prompts the user to set the paper size and type when the paper is loaded in the

Display Popup tray 1.

Back to Contents Page
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Installing the Optional Memory Card

@ print and Check the System Settings Page

@ Updating your PCL Driver

This chapter describes how to install the printer's optional memory card.

Your printer supports 256 MB additional memory card.

1. Ensure that the printer is turned off.

2. Turn the screw on the memory cover in the counter-clockwise direction.

ﬂ NOTE: Loosen the screw. You do not need to remove the screw.

4. Open the memory cover halfway until it stops, and then slide it again towards the back of the printer.

5. Open the memory cover completely.

6. Orient the connector of the memory card to the slot and insert the memory card into the slot.
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7. Push the memory card into the slot firmly.

ﬂ NOTE: Ensure that the memory card is firmly fixed in the slot and cannot be moved easily.

8. Close the memory cover halfway until it stops, and then slide it towards the front of the printer.

9. Close the memory cover completely and slide it again towards the front of the printer.

10. Turn the screw in the clockwise direction.

11. Turn on the printer.

Print and Check the System Settings Page

Print a System Settings page to verify that the optional memory card is installed correctly.



From the Printer Operator Panel

1. Press W until >SETUP appears, and then press \/ .
2. Press " until >Reports appears, and then press v .

3. System Settings is displayed. Press v .

The System Settings page is printed.

4. Verify the capacity of the installed memory listed in the system settings under General.

If the memory capacity has not increased, turn off the printer, unplug the power cable, and reinstall the memory card.

From Your Computer

1. Click start— All Programs— Dell Printers— Additional Color Laser Software— Quick Launch Utility.

The Quick Launch Utility dialog box opens.

2. Click the Tool Box button.

The Tool Box dialog box opens.

3. Select the printer from Printer Name.

The Tool Box opens.

4. Click the Printer Settings Report tab.
5. Select Reports from the list at the left side of the page.

The Reports page is displayed.

6. Click the System Settings button.

The System Settings page is printed.

7. Verify the capacity of the installed memory listed in the system settings under General.

If the memory capacity has not increased, turn off the printer, unplug the power cable, and reinstall the memory card.

Updating your PCL Driver

If you installed the additional print memory after installing the printer driver, update your driver by following the instructions for the operating system you are
using. If the printer is on a network, update the driver for each client.

1. Click start— Printers and Faxes.
For Windows® 2000: Click Start—> Settings— Printers.
For Windows Server® 2003: Click Start— Printers and Faxes.

For Windows Vista®: Click Start— Control Panel— Hardware and Sound— Printers.
For Windows Server 2008: Click Start— Control Panel— Printers.
2. Right-click the printer and select Properties.
3. Click the Options tab, and then select Get Information from Printer.
4. Verify the capacity of the installed memory listed on the Memory Capacity: drop-down list.
5. Click Apply, and then click OK.

6. Close the Printers and Faxes folder.



For Windows Server 2003: Close the Printers and Faxes folder.

For Windows 2000/Windows Vista/Windows Server 2008: Close the Printers folder.

Back to Contents Page
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Print Media Guidelines

Paper

Envelopes

Labels

Storing Print Media

Identifying Print Media Sources and Specifications

Print media refers to paper, labels, envelopes, and coated paper among others. Your printer provides high-quality printing on a variety of print media.
Selecting the appropriate print media for your printer helps avoid printing troubles. This section describes selecting print media, caring for print media, and
loading the print media in the tray 1.

Paper

For the best print quality in color, use 75 g/m2 (20 Ib) xerographic, grain long paper. For the best print quality in black and white, use 90 g/m2 (24 Ib)
xerographic, grain long paper. Before buying large quantities of any print media, it is recommended to try a sample first.

When loading paper, identify the recommended print side on the paper package, and load the paper accordingly. See "Loading Print Media in the Tray 1" and
“Loading the Sinale Sheet Feeder" for detailed loading instructions.

Paper Characteristics

The following paper characteristics affect print quality and reliability. It is recommended that you follow these guidelines when evaluating new paper stock.

Weight
The tray automatically feeds paper weights from 60 to 216 g/m2 (16 to 80 Ib bond) grain long. The single sheet feeder automatically feeds paper weights from

60 to 216 g/m2 (16 to 80 Ib bond) grain long. Paper lighter than 60 g/m2 (16 Ib) may not feed properly, and could cause paper jams. For best performance,
use 75 g/m2 (20 Ib bond) grain long paper.

Curl

Curl is the tendency of print media to curve at its edges. Excessive curl can cause paper feeding problems. Curl usually occurs after the paper passes through
the printer, where it is exposed to high temperatures. Storing paper unwrapped, even in the paper tray, can contribute to paper curling prior to printing and
cause feeding problems regardless of humidity. When printing on curled paper, straighten the paper and then insert it into the single sheet feeder.

Smoothness

The degree of paper smoothness directly affects the print quality. If the paper is too rough, the toner does not fuse on to the paper properly, resulting in poor
print quality. If the paper is too smooth, it can cause paper feeding problems. Smoothness between 150 and 250 Sheffield points produces the best print
quality.

Moisture Content

The amount of moisture in the paper affects both the print quality and the ability of the printer to feed the paper properly. Leave the paper in its original
packaging until you are ready to use it. This limits the exposure of the paper to moisture changes that can degrade its performance.

Grain Direction

Grain refers to the alignment of the paper fibers in a sheet of paper. Grain is either grain long, running the length of the paper, or grain short, running the

width of the paper. For 60 to 135 g/m2 (16 to 36 Ib bond) paper, grain long fibers are recommended. For paper heavier than 135 g/m2 (36 Ib bond), grain
short is preferred.

Fiber Content

Most high-quality xerographic paper is made from 100% chemically pulped wood. Paper containing fibers such as cotton may lead to degraded paper handling.

Recommended Paper
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To ensure the best print quality and feed reliability, use 75 g/m2 (20 Ib) xerographic paper. Business paper designed for general business use also provides
acceptable print quality. Only use paper able to withstand high temperatures without discoloring, bleeding, or releasing hazardous emissions. The laser
printing process heats paper to high temperatures. Check with the manufacturer or vendor to determine whether the paper you have chosen is acceptable for
laser printers.

Always print several samples before buying large quantities of any type of print media. When choosing any print media, you should consider the weight, fiber
content, and color.

Unacceptable Paper
The following paper types are not recommended for use with the printer:

1 Chemically treated paper used to make copies without carbon paper, also known as carbonless paper, carbonless copy paper (CCP), or no carbon
required (NCR) paper.

Preprinted paper with chemicals that may contaminate the printer.

Preprinted paper that can be affected by the temperature in the fuser.

Preprinted paper that requires a registration (the precise print location on the page) greater than +0.09 inches, such as optical character recognition
(OCR) forms.

In some cases, you can adjust registration with your software program to successfully print on these forms.

Coated paper (erasable bond), synthetic paper, and thermal paper.

Rough-edged, rough or heavily textured surface paper, or curled paper.

Recycled paper containing more than 25% post-consumer waste that does not meet DIN 19 309.

Multiple-part forms or documents.

Print quality may deteriorate (blank spaces or blotches may appear in the text) when printing on talc or acid paper.

Selecting Paper
Proper paper selection helps prevent jams and ensures trouble-free printing.
To help avoid jams or poor print quality:
1 Always use new, undamaged paper.
1 Before loading the paper, identify the recommended print side of the paper. This information is usually indicated on the paper package.
1 Do not use paper that you have cut or trimmed.
1 Do not mix print media sizes, weights, or types in the same source. This may result in a paper jam.
1 Do not remove the tray while a job is printing.
1 Ensure that the paper is properly loaded in the tray.

1 Flex the paper back and forth, and then fan them. Straighten the edges of the stack on a level surface.

Selecting Preprinted Forms and Letterheads

When selecting preprinted forms and letterhead paper for the printer:

1 Use grain long paper for best results.

1 Use only forms and letterheads printed using an offset lithographic or engraved printing process.

Select paper that absorb ink, but does not bleed.

Avoid paper with rough or heavily textured surfaces.

Use paper printed with heat-resistant inks designed for use in xerographic copiers. The ink must withstand temperatures of 225°C (437°F) without
melting or releasing hazardous emissions.

Use inks that are not affected by the resin in the toner or the silicone in the fuser. Inks that are oxidation-set or oil-based should meet these
requirements; latex inks might not. If you are in doubt, contact your paper supplier.

Printing on a Letterhead



Check with the manufacturer or vendor to determine whether the pre-printed letterhead that you have selected is acceptable for laser printers.

Page orientation is important when printing on letterhead. Use the following table for help when loading letterheads in the print media sources.

Print media source Print side Page orientation

Face up

Tray 1 Letterhead enters the printer last

Face down

Single sheet feeder Letterhead enters the printer first

Selecting Pre-Punched Paper

Pre-punched paper brands can differ in the number and placement of holes and in manufacturing techniques. However, it may or may not be possible to print
on the paper depending on the placement of holes on the paper.

To select and use pre-punched paper:

1 Test paper from several manufacturers before ordering and using large quantities of pre-punched paper.

1 Paper should be punched at the paper manufacturer and not drilled into paper already packaged in a ream. Drilled paper can cause jams when multiple
sheets feed through the printer. This may result in a paper jam.

1 Pre-punched paper can include more paper dust than standard paper. Your printer may require more frequent cleaning and feed reliability may not be
as good as standard paper.

1 Weight guidelines for pre-punched paper are the same as non-punched paper.

Envelopes

Depending on the choice of envelopes, it is possible to expect variable levels of wrinkling. Before buying large quantities of any print media, it is recommended
to try a sample first. See "Loading Print Media in the Tray 1" or "Loading the Single Sheet Feeder" for instructions on loading an envelope.

When printing on envelopes:

1 Use only high-quality envelopes that are designed for use in laser printers.

1 Set the print media source to the single sheet feeder or the tray 1. Set the paper type to Envelope, and select the correct size of envelope from the
printer driver.

For best performance, use envelopes made from 75 g/m2 (20 Ib bond) paper. You can use up to 105 g/m2 (28 Ib bond) weight for the envelope feeder
as long as the cotton content is 25% or less. Envelopes with 100% cotton content must not exceed 90 g/m2 (24 Ib bond) weight.

Use only freshly unpackaged, undamaged envelopes.

Use envelopes that can withstand temperatures of 205°C (401°F) without sealing, excessive curling, wrinkling, or releasing hazardous emissions. If
you have any doubts about the envelopes you are considering, check with the envelope supplier.

Adjust the guide to fit the width of the envelopes.

To load an envelope into the single sheet feeder, insert the envelope with the flaps closed and the short-edge of the envelope facing into the printer.
The print side must be facing down.

See "Loading Print Media in the Tray 1" or "Loading the Single Sheet Feeder" for instructions on loading an envelope.

Use one envelope size during a print job.

Ensure that the humidity is low because high humidity (more than 60%) and the high printing temperatures may seal the envelopes.

For best performance, do not use envelopes that:

o Have excessive curl or twist
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o Are stuck together or damaged in any way

o Contain windows, holes, perforations, cutouts, or embossing

o Use metal clasps, string ties, or metal folding bars

o Have an interlocking design

o Have postage stamps attached

o Have any exposed adhesive when the flap is in the sealed or closed position
o Have nicked edges or bent corners

o Have rough, cockle, or laid finishes

Labels

Your printer can print on many labels designed for use with laser printers. Label adhesives, face sheet (printable stock), and topcoats must be able to
withstand temperatures of 205°C (401°F) and pressure of 25 pounds per square inch (psi). Before buying large quantities of any print media, it is
recommended to try a sample first.

When printing on labels:

1 Set the paper type to Label from the printer driver.

Do not load labels together with paper in the same tray. This may result in a paper jam.

Do not use label sheets with a slick backing material.

Do not print within 1 mm (0.04 inches) of the die cut.

Use full label sheets. Partial sheets may cause labels to peel off during printing, resulting in a jam. Partial sheets also contaminate your printer and your
cartridge with adhesive, and could void your printer and cartridge warranties.

Use labels that can withstand temperatures of 205°C (401°F) without sealing, excessive curling, wrinkling, or releasing hazardous emissions.

Do not print within 1 mm (0.04 inches) of the edge of the label, of the perforations, or between die-cuts of the label.

1 Do not use label sheets that have adhesive right up to the edge of the sheet. It is recommended that the zone coating of the adhesive to be at least 1
mm (0.04 inches) away from edges. Adhesive material contaminates your printer and could void your warranty.

If zone coating of the adhesive is not possible, a 3 mm (0.125 inches) strip should be removed on the leading and driver edge, and a non-oozing
adhesive should be used.

Remove a 3 mm (0.125 inches) strip from the leading edge to prevent labels from peeling inside the printer.

Portrait orientation is preferred, especially when printing bar codes.

1 Do not use labels that have exposed adhesive.

Storing Print Media
For proper print media storage, the following guidelines will help to avoid media feeding problems and uneven print quality.

1 For best results, store print media in an environment where the temperature is approximately 21°C (70°F) and the relative humidity is 40%.
1 Store cartons of print media on a pallet or shelf, rather than directly on the floor.
1 If you store individual packages of print media out of the original carton, ensure that they rest on a flat surface so that the edges do not buckle or curl.

1 Do not place anything on top of the print media packages.

Identifying Print Media Sources and Specifications

The following tables provide information on standard and optional print media sources.

Supported Paper Sizes

Paper size Single sheet feeder | Tray 1

A4 (210x297 mm)

B5 (182x257 mm)

A5 (148x210 mm)

C5 (162x229mm)

Monarch (3.875x7.5 in)

Envelope #10 (4.125x9.5 in)

<|=<[<I<]<]<]=<
<|=<[<I<]<]<]=<

DL(110x220mm)




Letter (8.5x11 in)

Folio (8.5x13 in)

Y
Legal (8.5x14 in) Y
Y
Y

Executive (7.25 x 10.5 in)

<|<f<|<1=<

Custom™ Y

*Custom: 76.2 and 215.9 mm or between 3.00 and 8.5 inches

127.0 and 355.6 mm or between 5.00 and 14.00 inches.

Supported Paper Types

Single sided printing Duplex printing
Paper type
Single sheet feeder | Tray 1| Single sheet feeder | Tray 1
Plain Y* Y* Y* Y*
Plain - Side 2 Y Y N N
Plain Thick Y Y Y Y
Plain Thick - Side 2 Y Y N N
Recycled Y Y Y Y
Recycled - Side 2 Y Y N N
Label Y Y N N
Covers Y Y Y Y
Covers - Side 2 Y Y N N
Covers Thick Y Y Y N
Covers Thick - Side 2| Y N N N
Envelope Y Y N N
Coated Y N Y N
Coated - Side 2 Y N N N
Coated Thick Y N N N
* Values marked by an asterisk (*) are the factory default menu settings.
Paper Type Specifications
Paper type Weight (gsm) Remarks
Plain Paper 60-90 -
Plain Thick Paper| 80/90-105 -
Covers 106-163 -
Covers Thick 164-216 -
Coated 106-163 (Low Speed) | Inkjet printer paper cannot be used.
Coated Thick 164-216 (Low Speed) | Inkjet printer paper cannot be used.
Label 3R97408 Inkjet printer paper cannot be used.
Envelopes - -
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Loading Print Media

ray 1

d

Loading Print Media in the Tray 1

Single Sheet Feeder

Loading the Single Sheet Feeder
Manual Duplex Printing

Using the Output Tray

Loading print media properly helps prevent jams and ensures trouble-free printing.

Before loading any print media, identify the recommended print side of the print media. This information is usually on the print media package.

Tray 1

Capacity
The tray 1 can hold:

1 250 sheets of the standard paper.

Print Media Dimensions
The maximum dimensions of print media that the tray 1 can handle are:

1 Width - 76.2 mm (3.00 inches) to 215.9 mm (8.5 inches)

1 Length - 127 mm (5.00 inches) to 355.6 mm (14.00 inches)

Loading Print Media in the Tray 1

ﬂ NOTE: To avoid paper jams, do not remove the tray while printing is in progress.

ﬂ NOTE: Use only laser print media. Do not use ink jet paper in the printer.

1. Remove the paper tray from the printer.

2. Adjust the paper guides.
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ﬂ NOTE: Extend the rear side of the tray when you need to feed Legal size paper.

3. Before loading the print media, flex the sheets back and forth, and then fan them. Straighten the edges of the stack on a level surface.

4. Place the print media into the tray with the recommended print side facing up.

ﬂ NOTE: Do not exceed the maximum fill line in the tray. Overfilling the tray may cause paper jams.

5. Adjust the width guides until they rest lightly against the edges of the stack of paper.

g I 4

NOTE: When loading user-specified print media, adjust the width guides and slide the extendable part of the tray by squeezing the length guide
and sliding it until it rests lightly against the edge of the stack of paper.

6. After confirming that the guides are securely adjusted, insert the tray into the printer.

7. On the operator panel, press € or ¥ until the desired paper size appears, and then press v .

8. Press € or » until the desired paper type appears, and then press \/ .

Loading Letterhead
When using the trayl, the letterhead enters the printer with the print side facing up as shown below.

When using the single sheet feeder, the letterhead enters the printer first with the print side facing down.

Print media source Print side Page orientation




Face up

Tray 1 Letterhead enters the printer last

Face down

Single sheet feeder Letterhead enters the printer first

Loading Envelopes

Use the following guidelines when loading envelopes in the tray 1:

ﬂ NOTE: If you do not load envelopes in the tray 1 right after they have been removed from the packaging, they may bulge. To avoid jams, flatten them
as shown below before loading them in the tray 1.

Envelope#10

Load the envelopes short edge feed with the flaps closed and the print side up. Ensure that the flaps come at the right when you face towards the printer.

Monarch or DL
The Monarch or DL envelopes can be loaded in one of the following ways:

Load the envelopes short edge feed with the flaps closed and the print side up. Ensure that the flaps come at the right when you face towards the printer.

OR

Load the envelopes long edge feed with the flaps open and the print side up. Ensure that the flaps come at the top when you face towards the printer.



C5

Load the envelopes short edge feed with the flaps closed and the print side up. Ensure that the flaps come at the bottom when you face towards the printer.

Single Sheet Feeder

Capacity
The single sheet feeder can hold:

1 1 sheet of the standard paper.

Print Media Dimensions
The maximum dimensions of print media that the single sheet feeder can handle are:

1 Width - 76.2 mm (3.00 inches) to 215.9 mm (8.5 inches)

1 Length - 127 mm (5.00 inches) to 355.6 mm (14.00 inches)

Loading the Single Sheet Feeder

1. Adjust the width guides to the print media's width.

2. Hold both sides of the print media facing down close to the single sheet feeder, and push it into the printer until it automatically feeds.

ﬂ NOTE: Do not force the print media into the single sheet feeder.
ﬁ NOTE: Load letterhead face-down, with the top of the sheet entering the printer first.

ﬂ NOTE: If you experience problems with paper feed, turn the paper around.

Loading an Envelope

Envelope#10 , Monarch, or DL

To load an envelope into the single sheet feeder, insert the envelope short edge feed with the flap closed and the print side down. Ensure that the flap comes



at the right when you face towards the printer.

° NOTICE: Never use envelopes with windows, coated linings, or self-stick adhesives. These lead to paper jams and can cause damage to the printer.

ﬂ NOTE: Ensure that you load an envelope with the flap completely closed.

ﬂ NOTE: Insert an envelope with the flap side face up and with the stamp area on the top right side.

C5

To load an envelope into the single sheet feeder, insert the envelope short edge feed with the flap open and the print side down. Ensure that the flap comes
at the bottom when you face towards the printer.

o NOTICE: Never use envelopes with windows, coated linings, or self-stick adhesives. These lead to paper jams and can cause damage to the printer.

ﬂ NOTE: Ensure that you load an envelope with the flap completely opened.

ﬂ NOTE: Insert an envelope with the flap side face up and with the stamp area on the bottom right side.

Manual Duplex Printing

Manual duplex printing (or two-sided printing) allows you to manually print on both sides of the paper. For information on the paper sizes that support manual
duplex printing, see "Supported Paper Sizes".

To use the manual duplex printing feature:

1. Click start—»Printers and Faxes.
2. Right-click the printer and select Printing Preferences.
The Paper/Output tab is displayed.
3. From Paper Source, select Tray 1 or SSF.
4. From Duplex, select Flip on Long Edge or Flip on Short Edge.

5. Click OK.

A window that shows the instructions for manual duplex printing is displayed.

The even-numbered pages are printed from the printer.

Proceed to the following steps provided for each input tray.

o

4 NOTE: You cannot duplex print mix-sized documents.

ﬁ NOTE: For details on the Flip on Long Edge and Flip on Short Edge options, see "Flip on Long Edge” and "Flip on Short Edge”.

& NOTE: The paper types that can be used for manual duplex printing include:
Single sheet feeder: Plain, Plain Thick, Covers (106-163g/m2), Covers Thick (164-216g/m2), Coated (106-163g/m2), and Recycled

n
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n Tray 1: Plain, Plain Thick, Covers (106-163g/m2), and Recycled

When Using the Tray 1

Clicking the OK button on your printer driver will first print the even-numbered pages of your document. If your document consists of six pages, its even-
numbered pages are printed in the order of page 6, 4, and then 2. After the even-numbered pages are printed, a message I nsert CQutput 071-920 Insert
Qutput to Tray appears on the operator panel.

Follow the steps below to continue printing the odd-numbered pages of your document.
1. Remove the stack of output from the output tray. Load the stack back into the tray 1 without turning it over (with the blank side face up).

2. A message 071-921 Printer Press v to continue printing appears on the operator panel. Press v .

The odd-numbered pages are printed in the order of page 1, 3, and then 5.

When Using the Single Sheet Feeder

Clicking the OK button on your printer driver will first print the even-numbered pages of your document. If your document consists of six pages, its even-
numbered pages are printed in the order of page 2, 4, and then 6. After the even-numbered pages are printed, a message I nsert CQutput 075-920 Insert
Qutput to SSI appears on the operator panel.

Follow the steps below to continue printing the odd-numbered pages of your document.

1. Remove the stack of output from the output tray. Turn the stack over so that page 2 comes at the top.

A message 075-921 Printer Press v to continue printing appears on the operator panel.




2. Insert page 2 with its blank side face down into the single sheet feeder, and then press v on the operator panel.
Page 1 of your document is printed on the print side 2 of page 2.

Print the rest of the odd-numbered pages one page at a time in the same manner.

ﬂ NOTE: Warped or curled prints can cause paper jams. Straighten them before loading them in the single sheet feeder.

Assumes binding along the long edge of the page (left edge for portrait orientation and top edge for landscape orientation). The following
illustration shows long-edge binding for portrait and landscape pages:
Portrait Landscape
= 2
Flip on Long T
Edge D ::: 3 1111111
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2 3
Assumes binding along the short edge of the page (top edge for portrait orientation and left edge for landscape orientation). The following
illustration shows short-edge binding for portrait and landscape pages:
Portrait Landscape
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Using the Output Tray
The output tray holds up to:

1 150 sheets of plain paper

Back to Contents Page


file:///C:/data/systems/PRN2135CN/en/ug/index.htm

